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Preface

Preface

This Preface provides supporting information for the Oracle Financial Services Analytical Applications Profitability Pack
Installation Guide and includes the following topics:

©® Summary

® Audience

® Documentation Accessibility
® Related Documents

® Conventions

Summary

You can find the latest copy of this document in OTN library which includes all the recent additions/revisions (if any) done
till date.

Before you begin the installation, ensure that you have an access to the Oracle Support Portal with the required login
credentials to quickly notify us of any issues at any stage. You can obtain the login credentials by contacting Oracle
Support.

Audience

The Oracle Financial Services Analytical Applications (OFSAA) profitability pack Installation and Configuration Guide is
intended for Administrators, Business User, Strategists, and Data Analyst, who are responsible for installing and
maintaining the application pack components.

The document assumes you have experience in installing Enterprise components. Basic knowledge about the OFSAA
PROFITABILITY pack components, OFSAA Architecture, UNIX commands, Database concepts and Web Server/ Web
Application Server is recommended.

Following are the expected preparations from the administrator before starting the actual installation:
® Awareness of the OFSAA Tier Architecture. For more information, see the Application Tiers section.

® Decision on the appropriate OFSAA Deployment Option. For more information, refer the Recommended Deployment
Options section.

Related Documents

This section identifies additional documents related to OFSAA Infrastructure. You can access Oracle documentation online
from Documentation Library (OTN).

® Oracle Financial Services Funds Transfer Pricing Management User Guide
Oracle Financial Services Profitability Management User Guide
Oracle Financial Services Enterprise Financial Performance Analytics User Guide

Oracle Financial Services Institutional Performance Analytics User Guide

® 6 & ©

Oracle Financial Services Retail Performance Analytics User Guide

Oracle Financial Services Profitability Management Application Pack Installation Guide 1
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Conventions and Acronyms

Conventions Description

AIX Advanced Interactive executive
DEFQ Data Entry Forms and Queries
DML Data Manipulation Language

EAR Enterprise Archive

EJB Enterprise JavaBean

ERM Enterprise Resource Management
FTP File Transfer Protocol

GUI Graphical User Interface

HTTPS Hypertext Transfer Protocol Secure
J2Cc J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

JDK Java Development Kit

JNDI Java Naming and Directory Interface
JRE Java Runtime Environment

VM Java Virtual Machine

2 Oracle Financial Services Profitability Management Application Pack Installation Guide



About Oracle Financial Services Analytical Applications (OFSAA)
Chapter 1—About OFSAA and OFSAA Application Packs

CHAPTER 1 About OFSAA and OFSAA
Application Packs

This chapter includes the following topics:

® About Oracle Financial Services Analytical Applications (OFSAA)

® About Oracle Financial Services Analytical Applications (OFSAA) Pack
® About Oracle Financial Services Profitability 8.0.2.0.0 Applications Pack
()

About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)
About Oracle Financial Services Analytical Applications (OFSAA)

In today's turbulent markets, financial institutions require a better understanding of their risk-return, while strengthening
competitive advantage and enhancing long-term customer value. Oracle Financial Services Analytical Applications
(OFSAA) enable financial institutions to measure and meet risk adjusted performance objectives, cultivate a risk manage-
ment culture through transparency, lower the costs of compliance and regulation, and improve insight into customer
behavior.

OFSAA uses industry-leading analytical methods, shared data model and applications architecture to enable integrated
risk management, performance management, customer insight, and compliance management. OFSAA actively incorpo-
rates risk into decision making, enables to achieve a consistent view of performance, promote a transparent risk manage-
ment culture, and provide pervasive intelligence.

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of financial services analytical
applications for both banking and insurance domain.

About Oracle Financial Services Analytical Applications (OFSAA) Pack

OFSAA applications are packaged, and released as Application Packs starting from 8.0 release. An Application Pack is a
group of OFSAA products packaged together in a single installer and addresses specific functional area via its products that
are grouped together. Packaging applications in a group ensures simplified installation, maintenance, development and
integration in an integrated deployment.

The following figure depicts the various application packs that are available across the OFSAA Banking and Insurance
domains:

Oracle Financial Services Profitability Management Application Pack Installation Guide 3



About Oracle Financial Services Profitability 8.0.2.0.0 Applications Pack
Chapter 1—About OFSAA and OFSAA Application Packs

/" Insurance Market Risk I
- Insurance Market Risk Analytics
Insurance Operational Risk Standard
Edition/Enterprise Edition
Insurance Operational Risk
Insurance Operational Risk Analytics
Insurance Model Risk Management
Insurance Enterprise Risk Management
Insurance Governance and Compliance
Management
Insurance Solvency || Management
Insurance Operational Risk Economic

. Capital
% INSURANCE

Advanced Analytical
Application
Infrastructure

- Data Management Pack
( A A - Data Foundation Pack
OFS Others - Risk Regulatory
Solution Pack
Connectors

Behavior Detection
Pack

Compliance Regulatory
Reporting Solution Pack
Governance Risk and
Compliance Pack

—[ BANKING ]——[Compliance

T

S/

Pricing Management

Pack
- Performance - Customer Analytics
and Customer Pack
+ Profitability Pack

Asset Liability
Management Pack

~
L | Risk d Credit Risk Management
Pack

Treasury Risk Pack
Capital Adequacy Pack
Enterprise Stress Testing
and Capital Planning Pack
International Financial
Reporting Standard Pack

About Oracle Financial Services Profitability 8.0.2.0.0 Applications Pack

OFS Profitability 8.0.2.0.0 Pack includes the following applications:

©

Oracle Financial Services Analytical Applications Infrastructure: Oracle Financial Services Analytical Applications
Infrastructure (OFS AAIl) powers the Oracle Financial Services Analytical Applications family of products to perform the
processing, categorizing, selection and manipulation of data and information needed to analyze, understand and
report on specific performance, risk, compliance and customer insight issues by providing a strong foundation for the
entire family of Oracle Financial Services Analytical Applications across the domains of Risk, Performance, Compliance
and Customer Insight.
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® Oracle Financial Services Funds Transfer Pricing Management: It enables the bank to apply various transfer pricing
methods on products to calculate funds transfer price. It calculates transfer price across all product types varying in
terms of characteristics like fixed rate or floating rate instruments, bullet or amortizing or fixed tenor or perpetual
instruments. In addition it also supports the calculation of transfer price at account level or ledger level including
migration of charge or credit to ledger if required.

® Oracle Financial Services Profitability Management: It helps Banks and Financial services institutions manage and
monitor interest rate risk, liquidity risk, foreign currency risk and earnings risk. The application models every loan,
deposit, investment portfolio individually to help institutions better understand the risks they have assumed and their
sensitivity to economic conditions.

® Oracle Financial Services Enterprise Financial Performance Analytics: It is based upon a dedicated reporting mart
built on the new Financial Services Data Model. OFSEFPA leverages several components of OBIEE technology
including Dashboards and Answers. It includes various Dashboards and Reports for the user to carry out various
Profitability Management based analytics.

® Oracle Financial Services Institutional Performance Analytics: It provides strategic insights on - Profitability of the
business and the underlying customers, Product holdings and Relationship depth across the organization, Behavioral
and Engagement trends of it's target segments - exposures, commitments, line utilization, assets/liabilities, deposits,
withdrawals, Fees, Income, recent transactions and so on, Efficiency of investments (like marketing, partner
development), Efficiency of the sales force in terms of ongoing customer revenue generation, cross-sell and up-sell,
product usage and pipeline.

® Oracle Financial Services Retail Performance Analytics: It focalizes on Summary performance of the LOBs and overall
profitability, Portfolio mix, LOB specific profitability reports to be analyzed against key dimensions like customer
segments, product family, region, branch, risk scores and so on, Product holdings and Relationship depth across the
LOBs, Customer Trends across performance drivers like Sales, Balances, Deposits, Product subscriptions (revenue
services), Credit scores and delinquency bands, losses, and so on, Wallet Share analysis and customer lifetime value,
Efficiency of investments (like marketing, branch, channel and so on) over time.

About Oracle Financial Services Analytical Applications Infrastructure
(OFS AAl)

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle Financial Services Analytical
Applications family of products to perform the processing, categorizing, selection and manipulation of data and
information needed to analyze, understand and report on specific performance, risk, compliance and customer insight
issues by providing a strong foundation for the entire family of Oracle Financial Services Analytical Applications across the
domains of Risk, Performance, Compliance and Customer Insight.

Components of OFSAAI

The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the Oracle Financial Services
Analytical Applications Data Model and form the array of components within the Infrastructure.

The OFSAA Infrastructure components/ frameworks are installed in two layers; primarily the metadata server and
Infrastructure services run on one layer, and the Ul and presentation logic runs on the other. The Ul and presentation layer
is deployed on any of the supported J2EE Servers.

The following figure depicts the various frameworks and capabilities that make up the OFSAA Infrastructure:
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OFSAA Infrastructure High Availability

The current release of the OFSAA Infrastructure supports only "Single Instance" installation for the Infrastructure
components. However, the High Availability (HA) for the Database Server and/ or the Web Application Server clustering
and deployment are supported in this release.

This release supports Active-Passive model of implementation for OFSAAI components. For more information, see
Configuration for High Availability- Best Practices Guide.
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CHAPTER 2 Understanding OFS PFT Application
Pack Installations

This chapter includes the following topics:
® Installation Overview

® Hardware and Software Requirements
® Verifying the System Environment
()

Understanding Installation Modes
Installation Overview

This release (8.0.2.0.0) of the OFS Profitablity Applicaton Pack bundles the upgrade patch set along with the base installer.
Users/ Administrators who wish to install a new OFS Profitablity Application Pack 8.0.2.0.0 instance or upgrade an existing
OFS Profitablity Application Pack 8.0.x instance to 8.0.2.0.0 should download this installer. Figure 1 shows the order of
procedures you will need to follow to install a new OFS Profitablity Pack 8.0.2.0.0 instance. For upgrading a current OFS
Profitablity Application Pack 8.0.x instance to 8.0.2.0.0 release, refer Upgrading to OFS Profitablity Application Pack
8.0.2.0.0.

This section gives an overview of the OFS Profitablity Applications Pack Installation. The following figure shows the order
of procedures you need to follow:
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Installation Workflow
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The following table describes the tasks and their descriptions:

Tasks

Details and Documentation

Verify Systems Environment

To verify that your system meets the minimum necessary requirements for installing and
hosting the OFS Profitability Application Pack, see Verifying the System Environment.

Obtain the software

To access and download the OFS Profitability Application Pack, see Obtaining the Software.

Configure and Execute the Schema
Creator Utility

For instructions on creating the database schemas, see Configuring and Executing the
Schema Creator Utility.

Install OFS Profitability Application
Pack

For instructions on Installing OFS Profitability Application Pack , see Installing the OFS
Profitability Applications Pack.

Configure OFS Profitability Setup

See Post Installation Configuration.
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Upgrading to OFS Profitability Application Pack 8.0.2.0.0

To upgrade the current OFS Profitability Application Pack 8.0.x instance to 8.0.2.0.0, follow these steps:

1. Refer the sections Download and copy the OFS Profitability Applications Pack Installer and Copying and Extracting the
Softwareg and Extracting the Software.

2. See Upgrading the OFS PFT Application Pack for detailed instructions for upgrading.

Deployment Topology

The following figure depicts the typical deployment topology implemented for OFSAA Applications.
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Hardware and Software Requirements

This section describes the various Operating Systems, Database, Web Server, and Web Application Server versions, and
other variant details on which this release of the Oracle Financial Services Profitability Application Pack has been qualified.

Note: OFS Profitability Application Pack installation can be performed on both Virtual and Physical servers.
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Configurations Supported for Java 7

The following table shows the minimum hardware and software requirements for installing OFS Profitability Application

Pack (for Java 7).

Requirement

Sub-Category Value

Operating System

Oracle Linux / Red Hat Enterprise Linux (x86-64) Oracle Linux Server release 5.3 up to 5.10 - 64 bit
Oracle Linux Server release 6.0 and above - 64 bit

Note: Same versions of RHEL are supported

Oracle Solaris (SPARC)/ Solaris x86 Oracle Solaris v5.10 Update 11 and above - 64 bit
Oracle Solaris v5.11 update 1 and above - 64 bit

IBM AIX (PowerPC) AIX 6.1 (TL 09 and above) - 64 bit
Shell KORN Shell (KSH)
Note:

® Ifthe OSis IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small, configure
the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change the
file size limit for a particular user, add or edit the fsize attribute for the user in the /etc/secu-
rity/limits file on the AlX system. Change the file size limit to unlimited (fsize = -1) or to a size
equal to the size of the file being transferred. This may require an restart of the AIX server to
pick up the new configuration. For more information refer IBM Support.
® If the operating system is RHEL, install the package Isb_release using one of the following commands
by logging in as root user:

® yum install redhat-Isb-core
® yum install redhat-Isb

The above is required as during the installation process, the following command is executed to
get the OS version and release:
1sb release -r
Based on the returned information, the installer copies the appropriate binary and library files into the
SFIC_DB_HOME/bin and SFIC_DB_HOME/lib folders.

Java Runtime
Environment

Oracle Linux / Red Hat Enterprise Linux Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit

IBM AIX IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit

12
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Requirement

Sub-Category

Value

Oracle Database
Server and Client

Oracle Database Server Enterprise Edition 11g
Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC with/
without partitioning option

Oracle Database Server Enterprise Edition 12c
Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC with/
without partitioning option

Oracle Client 11g Release 2 (11.2.0.3.04) - 64 bit
Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle
thin driver)

Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle
thin driver)

Oracle Distribution of R version 3.0.1 (Optional)

Oracle R Enterprise (Server) version 1.4. (Optional)

Note: Ensure that the following patches are applied:

® Oracle Server 12¢, v12.1.0.1 - 17082699

® Oracle Server 12¢, v12.1.0.2 - 19392604, 19649591

® Also for latest information, see http://support.oracle.com/, 12.1.0.2 Bundle Patches for Engineered
Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

® Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 12.1.0.1.

OLAP Oracle Hyperion Essbase V 11.1.2.1+ (Server and Client) with Oracle 11g
Database
V 11.1.2.3+ (Server and Client) with Oracle 12c
Database
Oracle OLAP V 11.2.0.3+ with Oracle 11g Database
V 12.1.0.1+ with Oracle 12c Database
Note:
Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of OFSAAI. For
Oracle OLAP, ensure that you have configured the Oracle Database server with OLAP option.
Web Server/ Web Oracle Linux / Red Hat Enterprise Linux Oracle HTTP Server 11.1.1.1/ Apache HTTP Server

Application Server

Oracle Solaris

2.2.x/ IBM HTTP Server
Oracle HTTP Server 11.1.1.1/ Apache HTTP Server

IBM AlX 2.2.x/ IBM HTTP Server
® Oracle WebLogic Server 12.1.2+ (64 bit)
® |BM WebSphere Application Server 8.5.5.9+
(Full Profile) with IBM Java Runtime - 64 bit
® Apache Tomcat 8.0.x (64 bit)
Note:

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit is not

supported.
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Requirement

Sub-Category Value

Desktop
Requirements

Browser MS Internet Explorer 9,10 and 11

Oracle Java plug-in 1.7.0+* (64- bit) /Oracle Java
plug-in 1.8.0+ (64- bit)

Turn off Pop-up blocker settings. For more
information, refer Internet Explorer Settings.

Office Tools MS Office 2007/ 2010/2013

Adobe Acrobat Reader 8 and above

Screen Resolution 1024*768 or 1280*1024

Other Softwares

Directory Services OFSAAl is qualified on both OPEN LDAP 2.2.29+ and
Oracle Internet Directory v 11.1.1.3.0. However, it
can be integrated with other directory services
software like MS Active Directory.

Note:

Configuration of Directory services software for OFSAAI installation is optional. For more information on
configuration, see Infrastructure LDAP Configuration. Open LDAP needs to be installed on MS Windows
Server machine only.

14
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Configurations Supported for Java 8

The following table shows the minimum hardware and software requirements for installing OFS PFT Application Pack (for
Java 8).

Reqquirement Sub-Category Value

Operating System Oracle Linux / Red Hat Enterprise Linux (x86-64) Oracle Linux Server release 5.3 up to 5.10 - 64 bit
Oracle Linux Server release 6.0 and above - 64 bit

Note: Same versions of RHEL are supported.

Oracle Solaris (SPARC)/ Solaris x86 Oracle Solaris v5.10 Update 11 and above - 64 bit

Oracle Solaris v5.11 update 1 and above - 64 bit

IBM AIX (PowerPC) AIX 6.1 (TL 09 and above) - 64 bit
Shell KORN Shell (KSH)
Note:

® Ifthe OSis IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small, configure
the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change the
file size limit for a particular user, add or edit the fsize attribute for the user in the /etc/secu-
rity/limits file on the AlX system. Change the file size limit to unlimited (fsize = -1) or to a size
equal to the size of the file being transferred. This may require an restart of the AIX server to
pick up the new configuration. For more information refer IBM Support.
® If the operating system is RHEL, install the package Isb_release using one of the following commands
by logging in as root user:

® yum install redhat-Isb-core
® yum install redhat-Isb

The above is required as during the installation process, the following command is executed to
get the OS version and release:

1sb release -r

Based on the returned information, the installer copies the appropriate binary and library files
into the $FIC_DB_HOME/bin and $FIC_DB_HOME/lib folders.

Java Runtime Oracle Linux / Red Hat Enterprise Linux//IBM AIX/ Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit
Environment

Oracle Solaris

IBM AIX IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit
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Reqquirement Sub-Category Value
Oracle Database Oracle Database Server Enterprise Edition 11g
Server and Client Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC with/

without partitioning option

Oracle Database Server Enterprise Edition 12c
Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC with/
without partitioning option

Oracle Client 11g Release 2 (11.2.0.3.04) - 64 bit
Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle
thin driver)

Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle
thin driver)

Oracle Distribution of R version 2.15.1, 2.15.2 or
2.15.3.(Optional)

Oracle R Enterprise (Server) version 1.4. (Optional)

Note: Ensure that the following patches are applied:
® Oracle Server 12¢, v12.1.0.1 - 17082699
® Oracle Server 12¢, v12.1.0.2 - 19392604, 19649591

® Also for latest information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

® Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/11.2.0.4/ 12.1.0.1.

OLAP Oracle Hyperion Essbase V 11.1.2.1+ (Server and Client) with Oracle 11g
Database

V 11.1.2.3+ (Server and Client) with Oracle 12c
Database

Oracle OLAP V 11.2.0.3+ with Oracle 11g Database

V 12.1.0.1+ with Oracle 12c Database

Note:

Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of OFSAAI. For
Oracle OLAP, ensure that you have configured the Oracle Database server with OLAP option.

Web Server/ Web Oracle Linux / Red Hat Enterprise Linux /IBM AIX Oracle HTTP Server 11.1.1.1/ Apache HTTP Server

Application Server . 2.2.x/ IBM HTTP Server
Oracle Solaris

Server Oracle 11g and 12c¢ Database:

® Oracle WebLogic Server 12.1.3+ (64 bit)

® |BM WebSphere Application Server 8.5.5.9+
with bundled IBM Java Runtime - 64 bit

® Apache Tomcat 8.0.x (64 bit)

Note:

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit is not
supported.

For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install patch
18729264 from http://support.oracle.com/.
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Reqquirement

Sub-Category

Value

Desktop
Requirements

Operating System

MS Windows 7/ Windows 8/ Windows 8.1

Browser MS Internet Explorer 9, 10 and 11
Oracle Java plug-in 1.7.0+* (64- bit)
Turn off Pop-up blocker settings. For more
information, refer Internet Explorer Settings.
Office Tools MS Office 2007/ 2010/2013

Adobe Acrobat Reader 8 and above

Screen Resolution

1024*768 or 1280*1024

Other Software

Directory Services

OFSAAI is qualified on both OPEN LDAP 2.2.29+ and
Oracle Internet Directory v 11.1.1.3.0. However, it
can be integrated with other directory services
software like MS Active Directory.

Note:

Configuration of Directory services software for OFSAAI installation is optional. For more information on
configuration, see Infrastructure LDAP Configuration.

Open LDAP needs to be installed on MS Windows Server machine only.

Note: To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, see Upgrading an Existing OFSAA 8.0.x
Java 7 Instance to Java 8.

OFS PFT Application Pack recommends the following software combinations for deployment:

Operating System

Database

Web Application
Server

Web Server R

Oracle Linux 5.3 up to
5.10/ 6.0 and above

Oracle Database

Oracle WebLogic
Server/ Apache Tomcat
Server

Oracle HTTP Server/ 3.01
Apache HTTP Server

Oracle Solaris 5.10/
5.11

Oracle Database

Oracle WebLogic
Server/ Apache Tomcat
Server

Oracle HTTP Server/ 3.0.1
Apache HTTP Server

IBM AIX 6.1

Oracle Database

IBM WebSphere
Application Server/
Apache Tomcat Server

IBM HTTP Server/ 3.0.1
Apache HTTP Server

Verifying the System Environment

To verify if your system environment meets the minimum requirements for the installation, a Pre-Install Check utility
(Environment Check) is available within the Install Kit archive file. This utility can also be obtained separately by contacting

Oracle Support.

Though the system environment verification is an integral and automated part of the installation of this software product,
Oracle strongly recommends running this utility prior to beginning the installation as part of your organization's

"Installation Readiness Verification Process".

Oracle Financial Services Profitability Management Application Pack Installation Guide
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Note: For more details on download and usage of this utility, see Oracle Financial Services Analytical
Applications Infrastructure Environment Check Utility Guide given in the Related Documents section.

Understanding Installation Modes

The following modes of installation are available for the OFS Profitability Application Pack.

GUI Mode

This mode launches the product installation in a Graphical User Interface (GUI) Mode. You need to enter the required
information on various panels within the Ul in a user interaction format at various stages.

Note: See GUI Mode Installation for details on configuration required for GUI Mode installation.

SILENT Mode

This mode mandates updating the installation configuration files with required details and performs installation in a
"SILENT" non user interactive format.
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CHAPTER 3 Preparing for Installation

This chapter provides necessary information to review before installing the OFS Profitability Pack v8.0.2.0.0.
This chapter includes the following topics:

® Installer and Installation Prerequisites

® Obtaining the Software

® Common Installation Tasks
Installer and Installation Prerequisites

The following table mentions the list of prerequisites required before beginning the installation for OFS Profitability
Application Pack. The Installer/ Environment Check utility notifies you if any requirements are not met.

Requirement Sub-Category Expected Value

Environment Settings Java Settings PATH in .profile to be set to include the Java Runtime Environment
absolute path. The path should include java version (java 6, java 7 or java
8) based on the configuration.

Note: Ensure the absolute path to JRE/bin is set at the beginning of PATH
variable.

For example, PATH=/usr/java/jre1.6/bin:SORACLE_ HOME/bin:SPATH

Ensure no SYMBOLIC links to JAVA installation is being set in the PATH
variable.

Oracle Database Settings TNS_ADMIN to be set in .profile pointing to appropriate
tnsnames.ora file

ORACLE_HOME to be setin .profile pointing to appropriate Oracle
Client installation

PATH in .profile to be set to include appropriate
SORACLE_HOME/bin path.

Ensure to add an entry (with SID/ SERVICE NAME) in the
tnsnames.ora file on the OFSAA server.

Oracle Essbase Settings ARBORPATH, ESSBASEPATH, HYPERION_HOME to be set in the .profile
pointing to an appropriate Oracle Essbase Client installation.

Note: These settings are required only if you want to use Oracle
Hyperion Essbase OLAP features.
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Requirement

Sub-Category

Expected Value

0S/ File System Settings

File Descriptor Settings

Greater than 15000

Total Number of Process
Settings

Greater than 4096

Port Settings

Default port numbers to be enabled on the system are 6500, 6501, 6505,
6507, 6509, 6510, 6666, 9999, and 10101.

.profile permissions

User to have 755 permission on the .profile file.

Installation Directory

A directory where the product files will be installed.
Set 755 permission on this directory.

This directory needs to be set as FIC_HOME.

Temporary Directory

Default temporary directory where installation files are stored for a short
period of time to support faster installation.

® For installation on UNIX OS, you UNIX administrator must give you
the required read-write permissions for the /tmp directory and
disable the NOEXEC option.

® Configure adequate space on the /tmp directory. It is
recommended that you allocate more than 10 GB of space.

Note: If NOEXEC is enabled, the extraction of files by the installer in to
/tmp directory is prevented and the binaries will not execute in the
directory, which will fail the installation.

Staging Area/ Metadata
Repository

The directory should exist on the same system as the OFSAA Installation.
This directory can be configured on a different mount or under a
different user profile. However, the owner of the installation directory
that is mentioned in the previous row, must have RWX permissions on
this folder.

Note: This directory is also referred to as FTPSHARE folder.

The directory should exist on the same system as the OFSAA Installation.
This directory can be configured on different mount or under a different
user profile.

Set 777 permission on this directory.

Download Directory

A directory where the product installer files will be downloaded/ copied.

Set 755 permission on this directory.

OS Locale

® Linux: en_US.utf8
® AIX: EN_US.UTF-8
® Solaris: en_US.UTF-8

To check the locale installed, execute the following command:

locale -a | grep -i 'en US.utf'

Database Settings

Database Instance
Settings

NLS_CHARACTERSET to be AL32UTF8
NLS_LENGTH_SEMANTICS to be BYTE
OPEN CURSORS limit to be greater than 1000

20
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Requirement

Sub-Category

Expected Value

Web Application Server

WebSphere/ WebLogic/
Tomcat

Web Application Server should be installed and profile /domain created.

You will be prompted to enter the WebSphere Profile path or WebLogic
Domain path or Tomcat Deployment path during OFSAAI installation.

Note: See Configuring Web Server for WebSphere Profile Creation and
WebLogic Domain Creation.

For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8,
download and install patch 18729264 from
http://support.oracle.com/.

Web Server Apache HTTP Server/ This is an optional requirement.
Oracle HTTP Server/ HTTP Server Installation to be present.
IBM HTTP Server You will be required to enter the Web Server IP/ Hostname and Port
details during installation.
Note: See Configuring Web Server for Web Server installation.
Others Oracle R/ Oracle R This is an optional requirement.
Enterprise . . .
Refer section Installation of R and Oracle R Enterprise (ORE) for more
details.
OFS AAI 1-Off Download the 1- off patch for bug number 22305774 from

http://support.oracle.com/.

Download the 1- off patch for bug number 22755805 from
http://support.oracle.com/.

Note: Ensure that the tablespace(s) used for the database user(s) is set to AUTOEXTEND ON.

Obtaining the Software

This release of OFS Profitability Application Pack v8.0.2.0.0 is available for download in MOS as Patch 23054124. You need
to have a valid Oracle account in order to download the software.

Common Installation Tasks

The following are the common pre-installation activities that you need to carry out before installing the OFS Profitability

Application Pack.

This section includes the following topics:

® 6 6 & & 8

Configuration for GUI Mode Installation

Copying and Extracting the Software

Identifying the Installation, Download and Metadata Repository Directories

Download and copy the OFS Profitability Applications Pack Installer

Setting up the Web Server/ Web Application Server
Installation of Oracle R distribution and Oracle R Enterprise (ORE)
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Configuration for GUI Mode Installation

To install OFS Profitability Application Pack in GUI mode, you need to ensure the below software and configurations are
available:

® Install and configure any PC X Server software such as Open Text Exceed (formerly Hummingbird Exceed) on the user
desktop system from which the installation is triggered.

® Configure DISPLAY variable.

® Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed, to point to the user desktop
system where the PC X Server software has been installed.

Syntax:
export DISPLAY=hostname:n.nl
where hostname is the IP Address/ Host Name of the user desktop system and n is the sequence number (usually 0).

For example, 10.11.12.13:0.0 ormyhostname:0.0

Identifying the Installation, Download and Metadata Repository Directories

For installation of any OFSAA Application Pack, the below folders/ directories required to be created.

® OFSAA Download Directory (Optional): Create a download directory and copy the OFSAA Application Pack Installer
File (Archive). This is the directory where the downloaded installer/ patches can be copied.

® OFSAA Installation Directory (Mandatory): Create an installation directory where the product binaries will be
installed. Set the variable FIC_HOME in the .profile file to point to the OFSAA Installation Directory.

® OFSAA Staging/ Metadata Repository Directory (Mandatory): Create a Staging/Metadata Repository Directory to
copy data files, save data extracts, and so on. Additionally, this directory also maintains the OFSAA metadata artifacts.
This directory is also referred to as "FTPSHARE". This directory must be created on the same host as the OFSAA
Installation Directory mentioned in the previous point in this list..

Note: Ensure that the user permission is set to 755 on the Installation and Download Directory and the user
permission is set to 775 on the Staging Directory.

Download and copy the OFS Profitability Applications Pack Installer
To download and copy the OFS Profitability Applications Pack Installer, follow these steps:

® This release of OFS Profitability Application Pack v8.0.2.0.0 is available for download in MOS as Patch 23054124. You
need to have a valid Oracle account in order to download the software.

® Copy the downloaded installer archive to the Download Directory (in Binary Mode) on the setup identified for OFSAA
installation.
Copying and Extracting the Software

Once you obtain the installer, copy the installer (in BINARY mode) to the system on which the OFSAA Infrastructure
components will be installed.

Note: You must be logged in to the UNIX operating system as a non-root user.
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Download the unzip utility (OS specific) unzip_<os>.Z and copy it in Binary mode to the directory that is included in
your PATH variable. If you already have the unzip utility to extract the contents of the downloaded archive, skip to the
next step.

Uncompress the unzip installer file using the command:

uncompress unzip <os>.Z

Note: In case you notice an error message "uncompress: not found [No such file or directory]" when the
package is not installed, contact your UNIX administrator.

Give EXECUTE permission to the file using the command:
chmod 751 unzip <os>

For example, chmod 751 unzip sparc

Extract the contents of the Oracle Financial Services Advanced Analytical Applications Infrastructure Application Pack
8.0.2.0.0 to Download Directory using the following command:

unzip OFS_PFT PACK.zip

Note: DO NOT rename the Application Pack installer folder name on extraction from the archive.

Give below permission to the installer folder. Navigate to the Download Directory and execute the command:

chmod -R 750 OFS_PFT PACK

Setting up the Web Server/ Web Application Server

For more information to set up the environment based on your selected Web Server/ Web Application Server, see
Configuring Web Server.

Installation of Oracle R distribution and Oracle R Enterprise (ORE)

This is an optional step and required only if you intend to use Oracle R scripting in the Oracle Financial Services Enterprise
Modeling Application. Follow these steps:

Install Oracle R Distribution and Oracle R Enterprise (Server Components) on the Oracle Database server. See Oracle® R
Enterprise Installation and Administration Guide for Windows, Linux, Solaris and AlX, Release 1.4 at Oracle R Enterprise
Documentation Library.

® Oracle R Distribution versions supported- Oracle Distribution of R version 3.0.1.

® ORE version supported- Oracle R Enterprise (Server) version 1.4.

Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 12.1.0.1.

Note: If you are using ORE 1.4.1 and Oracle R 3.1.1 with Oracle Financial Services Enterprise Modeling, you
need to set the session timezone in 'R_HOME/etc/Rprofile.site' file on the database server, where R_HOME
is the home directory of the R instance on which ORE server packages are installed. Alternatively, you may
set session timezone in scripts registered within OFS EM by using the 'Sys.env(TZ=<time zone>)' R function.
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CHAPTER 4 Installing OFS Profitability Application
Pack

This chapter describes the steps to be followed to install the OFS Profitability pack.
This chapter includes the following sections:
® Schema Creator Utility
®  About Schema Creator Utility
®  Execution Modes in Schema Creator Utility
m  Execution Options in Schema Creator Utility
® Configuring and Executing the Schema Creator Utility
B Prerequisites
m  Configuring the Schema Creator Utility
B Executing the Schema Creator Utility
® Installing the OFS Profitability Applications Pack
®  GUI Mode Installation
m  SILENT Mode Installation

Schema Creator Utility

Creating database users/ schemas is one of the primary steps in the complete OFSAA installation. This release of OFSAA
provides a utility to quickly get started with the OFSAA 8.0 installation by allowing easier and faster creation of database
User(s)/ Schema(s), assign the necessary GRANT(s) and so on. Additionally, it also creates the required database objects in
these schemas. The schema creator utility should be configured and executed mandatorily every time prior to installation
of any OFSAA Application Pack.

This section includes the following topics:

® About Schema Creator Utility

® Execution Modes in Schema Creator Utility

® Execution Options in Schema Creator Utility
About Schema Creator Utility

The schema creator utility should be configured and executed mandatorily every time prior to installation of any OFSAA
Application Pack.

The following are the types of schemas that can be configured in the OFSAA:

® CONFIG - Denotes the unique OFSAA setup configuration schema. It contains entities and other objects required for
OFSAA setup information.
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Note: There can be only one CONFIG schema per OFSAA instance.

ATOMIC - Denotes the schema that contains the data model entities. One ATOMIC schema is attached to one
Information Domain.

Note: For some application packs, there can be multiple ATOMIC schemas per OFSAA Instance, but the
Profitability Pack supports only one atomic schema per OFSAA instance.

SANDBOX - Denotes the schema that contains the data for all Sandbox executions. One SANDBOX schema is attached
to one Sandbox Information Domain.

Note: This Schema type is not applicable for OFS Profitability Application Pack. There can be multiple
SANDBOX schemas per OFSAA Instance and a Sandbox Information Domain can have only one SANDBOX
schema.

ADDON - Denotes any additional schema used by the OFSAA Applications.

Note: This Schema type is not applicable for OFS Profitability Application Pack.

Execution Modes in Schema Creator Utility

The Schema Configuration Utility supports the following modes of execution:

o

Online Mode: In the Online mode, the utility connects to the database and executes the DDLs for Users, Objects and
Grants. If you have the SYSDBA privileges you can execute the Schema Creator Utility in Online mode and thereby
create the Users, Objects and Grants during the execution process.

Note: To execute the utility in Online mode, you need to connect as "<User> AS SYSDBA".

Offline Mode: In the Offline mode, the utility generates SQL script with all the required DDLs for Users, Objects and
Grants. This script needs to be executed by the DBA on the appropriate database identified for OFSAA usage. If you do
not have the SYSDBA privileges, you can execute the Schema Creator Utility in Offline mode and generate the script
file that contains the Schemas, Objects and Grants, information. Subsequently, a SYSDBA user can execute the script
file manually.

a. To execute the utility in Offline mode, you need to connect as any user with below grants(alternatively, you can
also connect as a user with SYSDBA privileges):
SELECT ON DBA ROLES
SELECT ON DBA USERS
SELECT ON DBA DIRECTORIES
SELECT ON DBA TABLESPACES
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CREATE SESSION
For more details, see Executing the Schema Creator Utility in Offline Mode.

b. If there are any errors during the script execution, reconfigure the OFS_PFT SCHEMA.XML file and execute the
utility. This ggenerates the scripts with corrected information. For more information, see Configuring
OFS_PFT_SCHEMA_IN.xml.

Note: Do not modify the OFS PFT SCHEMA OUT.XML file generated after the execution of this utility.

Execution Options in Schema Creator Utility

Depending on the option you choose to run the OFSAA Application Pack Installer, you need to choose the schema creator
utility execution option. To run the OFSAA Application Pack installer in SILENT mode, it is mandatory to execute the
schema creator utility with -s option.

Note: If the schema creator utility is executed without the option -s, it is mandatory to run the OFSAA
Application Pack Installer in GUI mode.

Configuring and Executing the Schema Creator Utility

This section includes the following topics:
©® Prerequisites

® Configuring the Schema Creator Utility
® Executing the Schema Creator Utility

Prerequisites

The following prerequisites must be ensured before configuring the Schema Creator Utility:
® You must have the Oracle User ID/Password with SYSDBA privileges.

® You must have the JDBC Connection URL for RAC/Non RAC database.

® The HOSTNAME/IP of the server on which OFSAA is getting installed.
(0]

The following configuration is required only if you intend to use Oracle Linux/Red Hat Enterprise Linux v7.x for OFSAAI
8.0.4.0.0 version.

For Oracle Linux/RHEL 7.x, navigate to OFS_PFT_PACK/bin/ and modify the value for property Linux VERSION to
include 7 in the VerInfo. txt file and save the changes.

For example, Linux VERSION=5, 6,7

Note: Install the One-off patch for Bug 22930093 as per the instructions in the Readme.txt packaged along
with the patch.
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For IBM AIX 7.1, navigate to OFS_PFT_PACK/bin/ and modify the value for property ATX VERSION to include 7.1 in
the VerInfo. txt file and save the changes.

For example, AIX VERSION=6.1,7.1

It is recommended to set the PGA AGGREGATE_LIMIT database-parameter value sufficiently, when Oracle 12c is
installed

You must add a TNS entry before the installation.

Note: The TNS Entry for an atomic schema should be without any special character, i.e '_'. If the atomic
schema name is like 'DEV_ATOM', the TNS name should be like 'DEVATOM'.

If this release of the OFS PFT Application Pack version 8.0.2.0.0 is being installed on an OFSAA setup where
the underlying OFSAA Infrastructure (OFS AAI) version is upgraded to version 8.0.1.x.x, download and install
the patch for schema creator utility (Bug 21133780 ) by following the instructions in the Readme.txt
packaged in it prior to executing the utility.

If this release of the OFS PFT Application Pack version 8.0.2.0.0 is being installed on an OFSAA setup where
the underlying OFSAA Infrastructure (OFS AAl) version is upgraded to version 8.0.2.x.x, download and install
the patch for schema creator utility (Bug 21657319) by following the instructions in the Readme.txt
packaged in it prior to executing the utility.

Configuring the Schema Creator Utility

To configure the Schema Creator Utility, follow these steps:

1.

2
3
4.
5

Log in to the system as non-root user.

Navigate to the following path: OFS_PFT_PACK/schema_creator/conf.

Edit the OFS PFT SCHEMA IN.xmnl filein a text editor.

Configure the elements as described in the Configuring OFS_PFT_SCHEMA_IN.xml.

Save the OFS_PFT SCHEMA IN.xml file.

Note: On successful execution of the utility, the entered password in the OFS AAAT SCHEMA IN.xml file
is nullified.

Executing the Schema Creator Utility

This section includes the following topics:

® Executing the Schema Creator Utility in Online Mode

® Executing the Schema Creator Utility in Offline Mode

® Executing the Schema Creator Utility with -s option

® Executing the Schema Creator Utility for Subsequent Application Pack

® Verifying the Log File
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Executing the Schema Creator Utility in Online Mode

In Online Mode, the Schema Creator Utility will create all the Schemas, Schema Objects, Tablespaces, Grants, and Roles in
the database during the execution process.

To execute the Schema Creator Utility in Online Mode, follow these steps:

1. Login to the system as non-root user.

2. Navigate to the following folder path: OFS_PFT_PACK/schema_creator/bin/
3. Execute the following command.

./osc.sh

4. The following message is displayed: You have chosen ONLINE mode. Triggering the utility in ONLINE mode will execute
the DDLs directly on the Database. Do you wish to proceed? (Y/y or N/n).

o ohaliTEK e srerinaoe - FeTTY =

5. Enter Y/y to proceed.
6. Enter the DB Username with SYSDBA Privileges.
For example: SYS as SYSDBA.

7. Enter the User Password.

8. The console runs the initial validation checks and then displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic Schema > ATOMIC schema. Do you want to
proceed? (Y/N).

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N).
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9. Enter Y/y to start the schema creation.
Or

Enter N/n if you want to quit executing the schema creation.

Note: On successful execution of schema creator utility, the console displays the following status message:
Schema Creator executed successfully. Please proceed with the installation.

Refer log file in OFS_PFT_PACK/schema_creator/logs folder for execution status. In case of any errors,
contact Oracle Support.

Executing the Schema Creator Utility in Offline Mode

In Offline Mode, the Schema Creator Utility will create an output in SQL file format. This script has to be executed
manually by logging as database user with SYSDBA privileges. The SQL file will contain the scripts for creation of Schemas,
Schema Objects, Tablespaces, Grants, and Roles.

Prerequisites:

® Database user with below privileges:
m  SELECT ON DBA_ROLES

SELECT ON DBA_USERS

SELECT ON DBA_DIRECTORIES

SELECT ON DBA_TABLESPACES

CREATE SESSION
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Note: Explicit Grants to the user are required. Grants assigned through Roles are not supported.

To execute the schema creator utility in the offline mode, follow these steps:

1.
2.
3.

Log in to the system as non-root user.

Navigate to the following path: OFS_PFT_PACK/schema_creator/bin
Execute the osc.sh file using the following command:

./osc.sh -o

The following message is displayed:

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate the script. Do you wish to
proceed? (Y/y or N/n).

Enter Y/y to proceed.
Enter the DB Username with SELECT privileges.

Enter the User Password.

The console runs the initial validation checks and displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic Schema > ATOMIC schema. Do you want to
proceed? (Y/N).

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N).
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9. Enter Y/y to start the script generation.
Or

Enter N/n if you want to quit the script generation.
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10.
11.
12.

Note: On successful execution of schema creator utility, the console displays the following status message:

Schema Creator executed successfully. Please execute
scratch/ofsaaapp/OFS_PFT PACK/schema creator/sysdba output scripts.sqgl before
proceeding with the installation.

Navigate to the directory: OFS_PFT PACK/schema creator.

Login to SQLPLUS with a user having SYSDBA Privileges.

Execute the sysdba output scripts.sql file using the following command:
SQL>@sysdba_ output scripts.sql

Alternatively, you can copy the sysdba_output_scripts.sql file and SQLScripts folder to a remote server and
execute sysdba_output_scripts.sql file, after providing appropriate execute permissions.

Note: Refer log sysdba output_scripts.log file for execution status. In case of any errors, contact
Oracle Support. This log would be empty if there are no errors in the execution.

Executing the Schema Creator Utility with -s option

If you want to run the OFSAA Application Pack Installer in SILENT mode, it is mandatory to execute the schema creator
utility with -s option.

To execute the utility with -s option, follow these steps:

1.

13.

14.

Edit the file OFS_PFT_PACK/schema_creator/conf/OFS_PFT SCHEMA IN.xml in text editor.

Set the value for attribute "INFODOM" of <SCHEMA> tag(s) to specify a specific Information Domain name. By
default, the value is empty and the utility will derive the Information Domain name. If the attribute value is set, the
utility/ installer will configure the Information Domain against this <SCHEMA>.

Execute the utility with -s option.

For Example: . /osc.sh -s.

Note: If the utility is executed without the -s option, it is mandatory to launch the OFSAA Application Pack
Installer in GUI mode.

To execute the utility in OFFLINE mode with SILENT option, enter following command:
/osc.sh -o -s.
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Executing the Schema Creator Utility for Subsequent Application Pack

While executing the schema creator utility for subsequent Application Pack, you can choose to install the pack either on
the same Information Domain/Atomic Schema or on a new Information Domain/Atomic Schema. You can execute the
Schema Creator Utility either in Online or Offline Mode.

Note: OFS PFT Application Pack can be installed on any Information Domain/ Atomic schema where any OFS
Application Packs are installed other than OFS Behavior Detection Application Pack or OFS Compliance
Regulatory Reporting Application Pack.

To execute the schema creator utility while installing OFS PFT Application Pack over an existing Application Pack, follow
these steps:

1. Repeat the steps 1 to 9 from the Executing the Schema Creator Utility section.

Note: Ensure to use the same config schema user name as the previous Application Pack.

2. The utility identifies the Application Packs that are already installed on the current OFSAA setup and displays the
following on console:

B Atomic schema of the Existing Application Pack
® Information Domain Name of the Existing Pack, and the

m  List of Installed Application PacksExecute the ./osc.sh file.

3. Select the Atomic User, on which you want to install the Application Pack.

4. On successful execution or schema creator utility, the following message is displayed: Schemas Creation Completed.

Refer the log file in OFS_PFT_PACK/schema_creator/logs folder for execution status.

34 Oracle Financial Services Profitability Management Application Pack Installation Guide



Installing the OFS Profitability Applications Pack
Chapter 4—Installing OFS Profitability Application Pack

Refer the log sysdba_output_scripts.log file for execution status, if executed in offline mode. This log would be empty
if there are no errors in the execution.

In case of any errors, contact Oracle Support.

Verifying the Log File

If schema creation is successful, the console would display an appropriate message.

B ofss222582.in.oracle.com - PuTTY

If the schema creation runs into errors, do refer the log files:

<<OFSPFT Installer folder>>/<<OFS_PFT_PACK>>/schema_creator/logs/ and <<OFS_PFT>>_0SC_<timestamp>.log for
further details.

You may contact Oracle support anytime for assistance.

Installing the OFS Profitability Applications Pack

Follow the instructions in this section to install the OFS Profitability Applications Pack depending on the mode of
installation.

This section includes the following topics:

® GUI Mode Installation

® SILENT Mode Installation

® \Verifying the Log File

GUI Mode Installation

Ensure that you have followed the steps as mentioned in the Configuration for GUI Mode Installation section prior to
proceeding with the next steps.

1.
2.

Log in to the system as non-root user.

Identify a directory for installation and set the same in the user .profile file as below:
ORACLE HOME=<oracle installed dir>

Export FIC HOME

Execute the user .profile.

Navigate to path: OFS_PFT_Pack.
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5. Editthe OFS PFT PACK/schema creator/conf/OFS PFT SCHEMA IN.xml file to set the appropriate attribute
values.

Note: See Configuring <<APP Pack>>_SCHEMA_IN.XML file for details on configuring this XML file.

6. Execute the schema creator utility.

Note: This step is mandatory and should be executed before every OFSAA Application Pack installation. See
Executing the Schema Creator Utility for more details.

7. Navigate to the path: OFS_PFT_PACK/bin.
8. Toinstall OFS PFT Application Pack on :
®  ForJava 6 and 7: Proceed with step 9.

B ForJava 8: Edit the verInfo. txt file to modify the value for property JAVA_VERSION to 1.8. Save the changes
and proceed with step 9.

9. Execute ./setup.sh GUIin the console.

Note: Refer the console for any errors during Pre-install checks.
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Welcome to the OFSAA 8.0.2 Application Pack
Installation

ORACLE’
FINANCIAL SERVICES

Copyright @ 1993, 2015, Oracle and/or its affiliates. All rights reserved.

Figure 2. Initialization Window
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Fo e ol D T e T

License Agreement

Welcome to the OFSAA Application Pack
(D Preinztall Setup Thiz program will guide you thraugh the installation of OFSAA Application Pack.
(D Installation
[@ Install Complete

Copyright © 1992, 2015, Oracle and / or its affiliates. Al rights reserved

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual
property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, ranslate, broadcast, modify, license,
transmit, distribute, exhibit, perfarm, publish or display any par, in any form, or 2y any means. Rewerse engineering, disassembly, or decompilation of this
software, unless required by law for interoperability, is prohibited

The information contained herein is subject to change without notice and is not warranted to be errar-free. If you find any errors, please report them to us in writing

If this software or related documentation is delivered to the U5, Government or anyone licensing it on kehalf of the U.5. Government, the following notice is
applicable:

11.5. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, andfor
documentation, delivered ta LLS. Government end users are "commercial computer software” pursuant to the applicable Federal Acquisition Regulation and
agency-specific supplemenal regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system,
imegrated softwars, any programs installec on the harcware, and/or documentation, shall be subject 10 license terms and license restrictions applicable ta the
programs. Mo other rights are granted ta the LS. Government.

This software or harcware is developed for general use in a variety of infarmation management applications. It is not developed or intended for use in any
inherently dangerous applications, including applications that may create a risk of personal injury. If vou use this software or harchware in dangeraus applications,
then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates
disclaim any liability for amy damages caused by use of this software or hardware in dangerous applications

This software or harchware and documemation may prowide access 1o or information on content, products, and senvices from third parties. Oracle Corporation and
itz affiliates are not respaonsible for and expresshy disciaim all warranties of any Kind with respect 1o third-party content, products, and senices, Oracle Corporation
and its affiliates will not be responsible for any Ioss, costs, or damages incurred due 10 your access 1o or use of third-party content, products, or services.

ORACLE
FIVANCIAL SERVICES

(31 2ccoptthe tarms of the Licenss Agrasment

(8) 1 do NOT accept the terms of the License Agreement

Figure 3. License Agreement
10. Select I accept the terms if the License Agreement option.

11. Click Next to display the The Application Pack details.

S Preinstall Setup Application Pack ID : OF5_PFT_PACK

ORACLE"
" FINANCIAL SERVICES _

Install Complete Application Pack Version:  £.0.0.0.0 ANALYTICAL APPLICATIONS

(O Installation Application Pack Name @ Financial Services Profitability Applications Pack

The following products are available in this application pack:

inancial Services Analytical Applications Infrastructure

inancial Services Profitability Management

inancial Services Funds Transfer Pricing

inancial Services Institutional Performance Analytics
inancial Services Retail Performance Analytics

inancial Services Enterprise Financial Performance Analytics

ORACLE
FINANCML SERWCES 1 Select the praductis) you have licensed and click “Next” 1o praceed

2. Froduct Anatical Applications Infrastructure does not need to be selectad explicitly. This product is the base infrastructure and gets installed automatically.

Notes:

3. Product Enterprise Madeling Option would get enabled / installed automarically if other productis) has dependent license:
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12. Select the product to enable for which you have already obtained license. Refer to Appendix for enabling additional
products post the Application pack installation at a later time.

13. Click Next to display the License Agreement page.

@ Preinstall Setup
(O Installation
[@ Install Complete

ORACLE
FIANCIAL SERVIES

Financial Services Profitability Applications Pack License Agreement

and use of Financial Services Profitability Applications Pack Installer requires acceptance of the following license agreement:

OFS A& APPLICATION PACK LICEMSE AGREEMENT

Oracle Financial Serces Anahdical Applications (OFSAA) application packs are groups of OFSAA products packaged together inta a single installer. Each application
pack contains OF3A4 applications that address specific functional domains

Ewery application pack alzo includes the following OFSAA Infrastructure application options which are autoratically installed by ewery application pack installer:
1. Oracle Financial Services Anahytical Applications Infrastructure

2. Oracle Financial Senvices Enterprise Modeling

3. Oratle Financial Services In-line Processing Engine

4. Oracle Financial Services Big Data Processing
Oracle Financial Services Anahytical Applications Infrastructure (OFS AAl is the base infrastructure for all OFSAA applications and is therefore automatically installed
and enabled by the application pack installer.

The application pack installer always installs Oracle Financial Sendces Enterprise Modeling, Oracle Financial Services In-line Processing Engine and Oracle Financial
Services Big Data Processing application options along with the application pack applications, but enables them only if any application that recjuires their functionality
is enabled

Any OFSAA application that is enabled must be licensed for use. Oracle Financial Services Anaktical Applications Infrastructure, Oracle Financial Services Enterprise
Muodeling, Oracle Financial Senices In-line Processing Engine and Oracle Financial Services Big Data Processing are incivicually licensatle application options,

Application products once enabled cannat be disabled. Application products not enabled on installation, may later be enabled using the "Manage OFSAA Product
License(s)' feature of the platform.

@ [ acosptthe tams of the Licanse Aareement

) 1 do MOT acceptthe terms of the License Agreement

14. Select | accept the terms if the License Agreement option.

15. Click Next.
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= 0
B —— e ——— = T

Pre Installation Summary

Please review the ing before o

) Preinstall Setup

O Installation..
2 Install Complete

Application Pack ID
OFS_PFT_PACK

Application Pack Name
Financial Services Profitability Applications Pack

Application Pack Yersion
8.0.0.00

Below products are selected to be enabled:

Financial Services Analytical Applications Infrastructure
Financial Services Profitability Management

Financial Services Funds Transfer Pricing

Financial Services Institutional Performance Analytics
Financial Services Retail Performance Analytics

Financial Services Enterprise Financial Performance Analytics

ORACLE
FIANCIAL SERICES

In

16. Click Next to display the Manage Information Domain page.

Information Domain Nami Application Name Information Domain Description Type DB Schema

@ Preinstall Setup
(O Installation
[@ Install Complete

ORACLE
FIANCIAL ERVIES

OFSPFTIMNFO

Financial Services Profability
Managerment

Information Domain for OFS_PFT

PRODUCTION

pitEatm

Financial Services Funds
[Transfer Pricing

Financial Services Institutional
Performance Anahyics

Financial Services Retail
Performance Analtics

Financial Services Enterprise
Financial Performance
[&nalyics

Information Domain for OFS_PFT

Information Domain for OFS_PFT

Information Domain for OFS_PFT

Information Domain for OFS_PFT

PRODUCTION

PRODUCTION

PRODUCTION

PRODUCTION

pft8atm

phgatm

pitdatm

pftaatm

17. Edit the Information Domain Name if it is a new Information domain and you wish to change the name of the
information domain name.
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In case of subsequent Application Pack installation on the same Information Domain, the Information Domain Name
is not editable.
Permissible length is 10 characters and only alphanumeric characters allowed. No special characters allowed.

18. Click Next to display the following window.

[=. . = e TR . Geoaaes TS Wm0 e o (ohx [
= pockinsall R W T— T ——= e |
Plaase Wait
& Prelnstall Setup

Installation.
Install Complete

2y 1ake a moment..

ORACLE
FINANCIAL SERVICES

Copyright © 1983, 2015, Oracle andior its afflistes. Al rights reserved.

ORACLE
FIVANCIAL SERVICES

[ Installamywhere

19. Click Next to display the User Installation Directory window.
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~
= OFS_LE‘QM

User Installation Directory )

License User Installation Directory
| jscratchjofsaaweb /FFTS02

= Prelnstall Setup

Installation..
() Install Complete

ORACLE"
FINANCIAL SERVICES

20. Enter the installation directory path. This is the directory you have set in the user .profile file in step 2.

21. Click Next to display the OFSAA Infrastructure Server Details window.

= DFS_@ﬂu

OFSAA Infrastructure Server Details

License Enter requested information :

=¥ Prelnstall Setup
Mote: If the |DEC_UEL is of EAC type then DB Server IPfHostname

(D Installation. field name should be NA,
() Install Complete

OF5AAl Server IP [ Hosthame :
|10.184.148.251

Database Server IP [ Hosthame :

ORACLE"
FINANCIAL SERVICES

22. Enter the IP address or hostname of the OFSAAI server and Database server.
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23. Click Next to display the Web Application Server window.

i
F orsansnucure I ol
- R

Web Application Server

License Choose the Web Application Server type

=¥ Prelnstall Setup
() Installation..

Install Complete

@ Tomcat
) Websphere
) Weblogic

ORACLE
FINANCIAL SERVICES

InstallA

24. Select the appropriate Web Application server type. The options are Tomcat, WebSphere, and WebLogic.
25. Click Next. Based on the selection, corresponding screens are displayed.

For Tomcat: The Absolute Tomcat Path window is displayed.

= OFSAAInfrastructure

Absolute Tomcat Path ||

License Enter absolute Tomcat Installation path where Oracle Financial

= Prelnstall Setup Senvices Anakdical Applications Infrastructure is to be deployved.
Example: - fhomefdatal ftomcat-7.0. 19 fwebapps

Installation..
() Install Complete

Jscratchfofsaaweb/apache-tomcat-7.0.64 fwebapps

ORACLE’
FINANCIAL SERVICES

Ins

h h _—
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m  Enter the Tomcat installation path (till /webapps) where OFSAAI will be deployed.
For WebSphere: The WebSphere Setup Details window is displayed.

WebSphere Setup Details

& License Enter WebSphere installation Path up to the Host name directory
S Prelnstall Setup For Ex:- jdataz ftestf/WebSpherefAppServer/profilesf <Profile_Na
(2 Installation me > finstalledappsf < cellName >

(D Install Complete

iIsuzratch.fwas?,fIBM;‘WebSphereMDpSenfermrnfllesfProrsa?BBI |

ORACLE’
FINANCIAL SERVICES

Cancel m Previous Next

m  Enter the installation path (up to the host name directory) of the WebSphere. The format is WebSphere path
<WebSphere profile directory>/installedApps/ <NodeCellName>.

For WebLogic: The Weblogic Home window is displayed

Weblogic Home

@ License Enter Weblogic Home
&) Prelnstall Setup Far Ex: fhome/weblogic/beafweblogic 10.3.5.0

() Installation

Install Complete

ORACLE’
FINANCIAL SERVICES

Do | ven |

m  Enter the WeblLogic home directory path.
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Weblogic Home

P License Enter Weblogic Home
¥ Prelnstall Setup For Ex: fhome fweblogicfbeafweblogic 10.3.5.0

() Installation

Install Complete

ORACLE’
FINANCIAL SERVICES

Do | ven |

m  Enter the path of the Weblogic domain home directory.
26. Click Next to display the OLAP Details window.

OLAP Daeatails

License Mate -

= Prelnstall Setup 1 = Enahkled 0=Disabled
Installation If walue is 1 then ARBORPATH, HYPERION_HOME & ESSEASEPATH
- wariahles should be set in . profile before installation.

() Install Complete

CONFIGURE OFSAAI OLAP FEATURE :
0

ORACLE’
FINANCIAL SERVICES

h r _—

Enter 1 if you want to configure OFSAAI OLAP feature. By default, value 0 is displayed.
27. Click Next to display the Web Server Details window.
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of) License

= Prelnstall Setup
() Installation..

() Install Complete

ORACLE’
FINANCIAL SERVICES

Iy a2

Web Server Details

mote : Context name will e used in wour Application URL
http: [ f < webServerlP = <Serdet port > J <contextname = flogin. jsp
Example:- http: f 1080, 50, 206 3080 myapp flogin. jsp

WEE SERVER IP

|10.184.148.251

Context name for deployment

| OFSAN

WEE LOCAL PATH

| fscratchfofsaawehffipshare

[4] Il |

m  Select the Enable HTTPS checkbox to configure HTTPS.

®  Enter Web Server (HTTP Server) Port, Web App Server (HTTP Server) IP address, context name for deployment
and the local path to any folder on the Web Application Server (Tomcat/ Websphere/ Weblogic).

28. Click Next to display the Database Details window.

Prelnstall Setup
Installation..

Install Complete

NOTE

Specify the Darabase user name which is the user created for configuration database schema. For example: configuser

Specify the Database driver path as <ORACLE_HOME> /jdbc/lib where <ORACLE HOME> should be replaced with ORACLE_HOME value

The ABZOLUTE DRIVER PATH refers to the JDBC driver files path.

ORACLE SID [ SERVICE_NAME :

ALMBSETDOC

JDBC URL:

Jjdbc:oracle:thin:@10.184. 148.251: 152 L ALMBSETDOC

COMFIC SCHEMA USER ID :

[ prigcont

Oracle C. ion Schema Password

ABSOLUTE DRIVER PATH :

‘fSEraVEhfuraEIE/E\ienL12E/mﬂduﬂfl2 1.0/clien_1fjdbcflib

Restore Default H Chonse ‘
ORACLE
FIVANGIAL SERVICES
———

29. Enter Oracle SID/Service Name, JDBC URL, Configuration Schema User ID and Password, and Absolute Driver Path.
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Note: Absolute Driver Path can be the path where Oracle DB client is installed or JDBC driver is installed.
For example, /scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/lib

30. Click Next to display the Ports Configuration window.

S oFsmma_[E‘ﬂu

Ports Configuration

o) License Enter required information :
=¥ Prelnstall Setup Maote: Parts must hawe unigque walue,

() Installation..

Install Complete

Java Port
(9997

Native Port
6667

Agent Port

ORACLE' o517
FINANCIAL SERVICES

ICC Server Port
[

Enter Java Port, Native Port, Agent Port, ICC Server Port, and ICC Native Port. You can proceed with the default port
values configured.

31. Click Next to display the Ports Configuration window.
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Ports Configuration ||

Enter requested infarmation :
Mate: Ports must hawve unigque walue,

() Installation..

Install Complete

11231

Message Server Port
(6756

Router Port
(6971

ORACLE

FINANCIAL SERVICES AM Fort
15231

32. Enter OLAP Port, Message Server Port, Router Port, and AM Port.

33. Click Next and then select the File Transfer protocol.

Note: Ensure the system on which the OFSAA Infrastructure is being installed, has either FTP/ SFTP enabled.

34. Enter the port to be used for file transfer.
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Eor: e T O . - =

CHOOSE FILE TRANSFER PROTOCOL :
@ SFTP (D FTP

Prelnstall Setup
Installation FILE TRANSFER FORT :

Install Complete 22

ORACLE
FIANCIL SERVICES

35. Click Next to display the OFSAAI Post Install Details window.

T
OFSAAI FTP/SFTP Details

FTPSHARE PATH
| fscratchjofsaaweb fftpshare

o License
= Prelnstall Setup
(D) Installatian..
() Install Camplete
FTP / SFTP USER ID
|adana\fak

Eestare Default || Choose. .. |

Please enter Infrastructure FTP/SFTP password:

ORACLE’
FINANCIAL SERVICES

36. Enter the path of the ftpshare directory and the User Id and password for OFSAAI Server.

Note: The transfer of data (files) between the OFSAAI Server and the Web Application Server happens over
FTP/ SFTP. Ensure the necessary host configurations are made for a successful handshake.

37. Click Next to display the Pre Installation Summary window.
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d Licenze Please review the following before continuing:
= Product Name:
OFSAAINfrastructure

Prelnstall Setup
Installation..

() Install Complete Yersion
2.0,2.0.0

Installation Folder
fseratchfofsaaweb PFTS02

Required Space
930 MegaBytes

Available Space
" 77082 MegaBytes
ORACLE gatyt
FINAMNCIAL SERVICES Selected Locale
en_LUS. utfd

Presious Install

38. Click Install to display the Installing OFSAA Infrastructure window.

-
= OFSAMnﬁa_LE‘ﬂu

Installing OFSAAlInfrastructure

License
Prelnstall Setup
) Installation..

Install Complete

O

ORACLE Installation is in progress...

This process may take several minutes. Please Wait.
FINANCIAL SERVICES

Extracting duplicates...

Anytime during the installation you can click Cancel to stop the installation. Once completed, the Installation
Summary screen is displayed.
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(o o S |

INSTALLATION SUMMARY

License
Prelnstall Setup
Installation..
Install Complete

maore details.

ORACLE
FINANCIAL SERVICES

IMETALLATIOMN SUMBMARY:

Please see the installation log under
fecratchfofsaaweb/OFS_PFT _PACK JOFS_AAlflogs/OFRALEZ 016 _ 06
_02_11_41_14 log and
fecratchfofsaaweb /PFTE02 fOFSAAINfrastructure_Install. log for

Click an Mext ta cantinue.

The Summary screen displays the number of Fatal Errors, Errors, Debug Statements, Information, and Warnings along

with the location of log files.
39. Click Next to display the Installation Complete window.

Installation Complete

License
Prelnstall Setup
Installation..
Install Complete

ORACLE
FINANCIAL SERVICES

Congratulations! Oracle Financial services Anahtical Applications
Infrastructure has been successfully installed.

Click. on "Done" to exit the installer. Please do not close the console.
Fast Install activites will be perfarmed in console..

Prewious
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Note: If the installation is successful with some warnings, you can navigate to the installation log for more
details and address them.

40. Click Done. The following message is displayed:

Please wait, pack_install is being configured for your system. This may take a moment.

Fa

% Solution Setup

ORACLE
FINANCIAL SERVICES

Copyright @ 1993, 2015, Oracle andfor its affiliates. &l rights reserved.

41. After the pack installation is complete, the Solution Setup - Introduction window will be displayed.

T T R« e
EETy _\

=¥ Introduction This user interface will guice wou through the solution setup.Before proceeding
(3 Pre-nstall Canfiguration with the installation, you must ensure the following:

() Pre-Install Summary - The Qracle Financial Services Anakdical Applications Infrastructure (OFSAAJ
(D Installing. . rrust be installed and configured on the machine.

D Install Complete - The FICserver is running and all other OFSAAl servers are shut down prior to

start of the solution installation.
- Please ensure the OF3AA version is 8.0.2.0.0

Miote: At any point if wou wish 1o edit previoushky entered information, sou may
access the previaus screens by clicking on the Previous button.

ORACLE

FINANCIAL SERVICES

42. Click Next to display the Log mode window. Select the Log Mode.
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P Introduction Please select the Log Mode required far this Installation.
Pre-Install Canfiguration

() Pre-Install Summary e ) ) ) :
If wou select Debug mode, the passwoards will be printed in the log file. The log

() Installing... file will be written in the path specified in the log4dj. xml file of the installer.

Install Complete

® Debug
) General

ORACLE

FINANCIAL SERVICES

43. Click Next to display the Segment creation window. Enter the log paths.

f) Introduction Flease enter the following to create a new information domain
S Pre-Install Configuration
() Pre-Install Summary
() Installing. ..

() Install Complete

Profitability Applications Segment
| OFSPFTSEG

Application Server ftpshare log path
| Jscratchfofsaaweb fftpshare/ fOFSPFTINFOflogs

Database Server ftpshare log path
| Jscratch/fofzaaweb fftpshare/ fOFSPFTINFOflogs

ORACLE

FINANCIAL SERVICES

44. Click on Next to display the Pre-Infodom Creation Summary window.

Oracle Financial Services Profitability Management Application Pack Installation Guide

53



Installing the OFS Profitability Applications Pack
Chapter 4—Installing OFS Profitability Application Pack

[ - — — B

o Introcuction Please review the following before continuing:

& Pre-Install Configuration Information Domain Name

(L) Pre-Install Summary QFSPETINFG

() Installing... Infodom Description
Install Complete Information Domain for OFS_PFT

Application Schema User
pft8atml

Application Schema JOBC Url
jdbecioraclerthin:@10.184.1458.251:152 1L ALMEBSETDOC

Infodom Schema Database Name
pftBatml

Infodom Maintenance Application Server Log

ORACLE Hath

W ol e fscratchfofsaaweb fftpshare/ fOFSPFTINFO/ logs
FINAMCIAL SERVICES

Infodom Maintenance Database Server Log
Path

45. Click Next to display the Infodom creation window.

Note: Permissible length for information domain is maximum 10 characters and only alphanumeric
characters allowed. No special characters allowed.

46. After creation of inofodom, the Tablespace specification window will be displayed.
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Please specify the Tablespace name (nfodom database)
MNarne | ALMBSETDOC

o) Introcuction

= Pre-Install Configuration
() Pre-Install Summary

() Installing. ..

() Install Camplete

ORACLE’

FINANCIAL SERVICES

47. Click Next to display the Model Upload window.

o) Introduction If wou want to perform Model Upload, please start the FICserver before
proceeding to next step.

= Pre-Install Configuration
() Pre-Install Summary

() Installing. ..

() Install Camplete

Do you want to perform Model upload ??
® Yes
2 Ma, | have already dane it.

ORACLE’

FINANCIAL SERVICES

48. Select Yes and click Next to display the Model Type window.
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Do you want to upload Released Data Model or Customized Data Model ?

o Introduction
= Pre-Install Configuration ® Released Data Madel

[0) Pre-Install Summal :
v () Customized Data Maodel

() Installing. ..

() Install Camplete

ORACLE’

FINANCIAL SERVICES

49. Select Released Data Model and click Next. Model will get copied into ftpshare.

=@ = [

§= Solution Setup

o Introduction
= Pre-Install Configuration
() Pre-Install Summary

() Installing. ..
() Install Camplete

%onse‘up Jyour system. This may

Copving Data Madel to erwinXhL directory
[ |

ORACLE’

FINANCIAL SERVICES

50. After Model is copied to ftpshare, the Model Review Window will be displayed.
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o Intraduction Please review the following before conti

= Pre-Install Configuration
(D Pre-Install Surmary Information domain Name

_ COFSPFTIMFC
() Installing. ..

() Install Complete Data Model xml
path
fseratchfofsaaweb /OFS_PFT_PACKOFS_PFT/DataMadel

Crata Model xml file
QFS_PFT_Datameodel.xml

ERwin xml

Path
fscratehfofsaaweb /ftpshare/fOFSPFTINFO arwinferwinxML

ORACLE’

FINANCIAL SERVICES

Note: If Heap Memory Warning is displayed, then click on Back, and update your .profile entry with
required heap memory size.

®  Open a new session in Putty.
m  Shutdown Reveleus server using $FIC_HOME/ficapp/common/FICServer/bin/ reveleusshutdown.sh.
m Update the X ARGS APPentryin .profile following eg.

Example:

X ARGS APP="-Xms2g -Xmx18g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=1024M
-XX:+UseParallelOldGC -XX:+DisableExplicitGC"

B Run .profile.
W Start Reveleus using SFIC_HOME/ficapp/common/FICServer/bin/ reveleusstartup.sh.

®  Proceed for model Upload by clicking on Next.
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o) Introduction
= Pre-Install Configp
() Pre-Install Summi

(D) Installing...
g ® Please check..

(O Install Complete Insufficient heapsize settings in . profile file
Heapsize should be greater than or equal to 16080 MB

ORACLE’

FINANCIAL SERVICES

51. Click Next to display Oracle Business Intelligence Configuration screen.

o Intraduction Oracle Business Intelligence Configuration

= Pre-Install Configuration Oracle Bl Host IP
() Pre-Install Summary

() Installing. ..

() Install Camplete |

Port

ContextName

ORACLE’

FINANCIAL SERVICES

The Pre Setup Information screen requests for setup information.
The following panel seeks input from the user on whether to create new ETL application/source pair or use an existing
one.
Choose a desired option.
52. Click Next to continue.
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§= Solution Setup

o) Introduction

= Pre-Install Configuration
() Pre-Install Summary

() Installing. ..

() Install Camplete

ORACLE’

FINANCIAL SERVICES

Do you want to create a new ETL application/ source pair or use the

existing one?
® New application/source pair

() Existing application/source pair

53. Select New Application source and click Next. Staging details will be displayed:

§= Solution Setup

o) Introduction

= Pre-Install Configuration
() Pre-Install Summary

() Installing. ..

() Install Camplete

ORACLE’

FINANCIAL SERVICES

ETL Application Details

Name | Fsapps

Description | FSAPPS

ETL STAGING Source Details

Name [sTaGING

Description | STAGING

ETL PROCESSING Source Details

Name | PROCESSING

Description | PROCESSING

54. After Creation, click Next, Installation Details Review window.

Oracle Financial Services Profitability Management Application Pack Installation Guide

59



Installing the OFS Profitability Applications Pack
Chapter 4—Installing OFS Profitability Application Pack

§= Solution Setup

of Introcuction Please review the following before conti

of) Fre-Install Configuration
PLATFORM

& Pre-Install Summary : ) ) ) —
Oracle Financial Services Analytical Applications Infrastructure

() Installing. ..

() Install Complete PLATFORM VERSION
8.0.2.0.0

PRODUCT NAME
COracle Financial Services Profitability Management Pack

PRODUCT VERSION
8.0.2.0.0

INFODOM NAME ENTERED
QOFSPFTINFO

ORACLE’ OFSAAI USER 1D ENTERED

S SYSADMN
FINANCIAL SERVICES

CONFIG SCHEMA USER

55. Click Install. A Pop window will ask for the confirmation.

§= Solution Setup E.)n(.

of Introcuction Please review the following before conti

of) Fre-Install Configuration
PLATFORM

¥ Pre-Install Summary v _ _ _ o
Oracle Financial Services Analytical Applications Infrastructure

() Installing. ..
() Install Camplete

QOFSPFTINFO

ORACLE’ OFSAAI USER 1D ENTERED

S SYSADMN
FINANCIAL SERVICES

CONFIG SCHEMA USER

56. Click Yes to begin the installation. The installation progress will be in the Installation Progress window.

60 Oracle Financial Services Profitability Management Application Pack Installation Guide



Installing the OFS Profitability Applications Pack
Chapter 4—Installing OFS Profitability Application Pack

“m Solution Setup

o) Introcuction

of) Fre-Install Configuration
o) Pre-Install summary

S Installing. ..

() Install Camplete

ORACLE'

FINANCIAL SERVICES

O

Installation is in progress...
This process may take several minutes. Please Wait.

Extracting duplicates...

57. After Installation completion, Installation Completion window will be displayed.

§= Solution Setup

o) Introcuction

of) Fre-Install Configuration
o) Pre-Install summary

o Installing. ..

& Install Complete

ORACLE’

FINANCIAL SERVICES

Installation is complete ,but some errors accurred during the install. Your
installation log has been written to
fscratchfofsaaweb fOFS_PFT _PACK fOFS_PFT flogsfOFS_PFT _installation.lag

Previous Done

58. Click Done. The Panel will go back to Main App Pack Installation window and the Installation Summary window will

be displayed.
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INSTALLATION SUMRMARY

Il a LAl G4 UK F AR
a2l T2

2 The, Sl EFFUF:

@ raa =hn

o i

1y
WARMIRG - -0

e
R ST R R TR B e e e R A O R Y]
Il ar e byeark e

ORACLE
FRAICALSERVICES

59. Click Next to display the Installation Complete window.

I L et s i Pl o L o IE Ll Pt 1Ll e L el L wnend
@ riaeen

¥ rota Triplez

ORACLE

FRIAMNCIAL SERVIGES

[IORNTE N

BT T

60. Click Done.

Note: The installation process continues on the console. Do not close the console until the installation
process is complete.
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Post Install Health checks are displayed:

61. Install the following mandatory one-off patches for the applications mentioned:
m  PFT application: 28254269
B FTP application: 27564796.

Refer to the Readme files available with the patches for further the installation instructions.
62. Perform steps mentioned in the Post Installation Configuration section.

Note: Download and install patch for Bug 21160684 if installing this release of the OFS PFT Application Pack
version 8.0.2.0.0 on Java 8.
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SILENT Mode Installation

Note: For Schema Creator Utility steps, see Executing the Schema Creator Utility.

1. Login to the system as non-root user.
2. Identify a directory for installation and set the same in the user .profile file as below:

FIC HOME=< OFSAA Installation Directory > export FIC HOME
3. Execute the user .profile.

4. Pre-Installation XML/ File Populations:
Before Proceeding to SILENT Installer, we need to populate following files with pre-defined values.

B OFSAAI InstallConfig.xml (Location: OFS BFND PACK/OFS_AAI/conf). Refer to Configuring
OFSAAI_InstallConfig.xml File.

Note: If value for HTTPS ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA
and the same is configured on your web application server.

B SILENT.props File. (Location: OFS_PFT PACK/OFS_PFT/conf)

Note: The file name will be SILENT. template in the installer and it has to be renamed as SILENT .props.

Important: Do not install the new applications in the same segment if the pre-installed applications use run

management.
Property Name Description of Property Permissible Values Comments
UPLOAD_MODEL whether you want to perform | 0= No Mandatory
Model Upload
1=yes
MODEL_TYPE Released data model or 0 =released # Mandatory only in the case
Customized data model . of uploading the data model
1 = customized
DATAMODEL the path for the customized Not Applicable # Mandatory only in the case
data model of uploading the customized
datamodel
# Option selected for
MODEL_TYPE=1
DM_DIRECTORY the file name for the Not Applicable # Mandatory only in the case
customized data model of uploading the customized
datamodel
# Option selected for
MODEL_TYPE=1
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Installation

1. Navigate to the following folder path: OFS_PFT Pack/bin/.

Note: For Java 8: Edit the VerInfo.txt file in the path /OFS BFND PACK/OFS_AAI/bin/ to modify the value
for property JAVA VERSION to 1.8, and save the changes.

2. Execute the setup. sh file using the following command:

./setup.sh SILENT
3. Theinstaller will proceed with Pre-Installation Checks.

4. On Successful completion of Pre-Installation checks it will prompt for the Password of FTP/SFTP. Please enter
Infrastructure FTP/SFTP Password:
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5. Enter the Password and Proceed. The process displays the OFSAA License. Enter: Y and Proceed.

6. First AAl will be Installed.
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7. After AAl is installed, the PFT Pack installation begins.

Note: Data Model Upload may take several hours to get complete. You can check the Logs in
/OFS_PFT_ PACK/OFS_PFT/logs.
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8. Do not close the console until the installation is complete.
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10.
11.

12.
13.

Buildfile
Trying to

ng for file

.out!

.out!

.out!

5. out!

_filE.ng

Install the 1-off patch for bug number 22305774 as per the instructions in the Readme.txt packaged with the patch.
Install the 1-Off patch for bug number 22755805 as per the instructions in the Readme.txt packaged with the patch.
Install the following mandatory one-off patches for the applications mentioned:

m  PFT application: 28254269

m  FTP application: 27564796.

Refer to the Readme files available with the patches for further the installation instructions.

Perform the steps mentioned in Post Installation Configuration section.
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Verifying the Log File

Refer to the following logs files for more information:

® Refertothe Pack Install.loglocated at OFS PFT PACK/logs/ folder for OFS Profitability Application Pack
installation log file.

® Refer to the log file(s) located at OFS_PFT PACK/OFS_AAI/logs/ folder for Infrastructure installation log.

©® Refertothe OFSAAInfrastucture Install.log located at SFIC_HOME folder for Infrastructure installation log.
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CHAPTER 5 Upgrading the OFS PFT Application
Pack

This chapter provides necessary information to upgrade the Profitability Application Pack.
This chapter includes the following topics:

® Upgrading the OFS PFT Application Pack

Upgrading the OFS PFT Application Pack

Refer to the following instructions to download, extract, install, and configure this release.

1. Download the OFS PFT Application Pack v8.0.2.0.0 archive file and copy it to your OFSAA server in Binary mode.

Note: The archive files are different for every operating system like AlX, Solaris, and RHEL/Oracle Linux.

2. Login to the OFSAA Server.
3. Shut down all the OFSAAI Services. For more information, see Start/Stop OFSAA Infrastructure Services.
4. Execute the following command:

chmod -R 750 $SFIC_HOME

5. If you have Unzip utility, skip to the next step. Download the Unzip utility (OS specific) and copy it in Binary mode to
the directory that is included in your PATH variable, typically SHOME path or directory in which you have copied the
8.0.2.0.0 installer.
®  Uncompress the unzip installer file using the command:

uncompress unzip <os>.Z

Note: If you notice an error message "uncompress: not found [No such file or directory]" when the package
is not installed, contact your UNIX administrator.

m  Give EXECUTE permission to the file using the command:
chmod 751 OFS_PFT 80200 <OperatingSystem>.zip
6. Extract the contents of the OFS PFT Application Pack 8.0.2.0.0 in Download Directory installer archive file using the
following command:
unzip <os> <name of the file to be unzipped>
7. Give EXECUTE permission to the archive file. Navigate to the path OFS_PFT 80200 <OperatingSystem>.zip and

execute the command:

chmod -R 750 OFS_PFT 80200 <OperatingSystem>
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8. Rename the SILENT. template file in the installer as SILENT.props. Configure Silent.Props file for following
parameters:

Property Name Description of Property Permissible values Comments

UPLOAD_MODEL whether you want to perform | 0: No Mandatory
Model Upload

1: Yes Select "1" to perform the
Model Upload .

Select "0" to skip Model
Upload.

MODEL_TYPE Released datamodel or 0 = released # Mandatory only in the case

Customized datamodel . of uploading the datamodel
1 = customized

If UPLOAD_MODEL option is
selected as "1", then you can
choose to upload Released
Model (0) or customized
Model (1).

DATAMODEL the path for the customized Not Applicable # Mandatory only in the case
datamodel of uploading the customized
datamodel

# Option selected for
MODEL_TYPE=1

DM_DIRECTORY the file name for the Not Applicable # Mandatory only in the case
customized datamodel of uploading the customized
datamodel

# Option selected for
MODEL_TYPE=1

9. Execute setup.sh file using the following command:
./setup.sh SLIENT

Verify if the release is applied successfully by checking the log file generated in the installation folder. You can ignore
ORA-00001, ORA-00955, ORA-02260, and ORA-01430 errors in the log file. In case of any other errors, contact Oracle
Support.

10. For more information on securing your OFSAA Infrastructure, refer to the Security Guide in OTN Library.

11. After successful installation, follow these steps:

Clear the application cache. Navigate to the following path depending on the configured web application server and
delete the files.
m  Tomcat

<Tomcat installation folder>/work/Catalina/localhost/<Application
name>/org/apache/jsp

m  Weblogic

<Weblogic installation location>/domains/<Domain name>/servers/<Server
name>/tmp/ WL user/<Application name>/<auto generated folder>/jsp servlet

m  Websphere

<Websphere installation directory>/AppServer/profiles/<Profile name>/temp/<Node
name>/serverl/<Application name>/<.war file name>
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12.

13.
14.

15.

Add umask 0027 in the .profile of the UNIX account which manages the WEB server to ensure restricted access
permissions.

Restart all the OFSAAI services. For more information, see Start/Stop OFSAA Infrastructure Services.

Generate the application EAR/WAR file and redeploy the application onto your configured web application server. For
more information on generating and deploying EAR / WAR file, see Creating and Deploying EAR/WAR File.

Install the following mandatory one-off patches for the applications mentioned:
m  PFT application: 28254269
B FTP application: 27564796.

Refer to the Readme files available with the patches for further the installation instructions.
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CHAPTER 6 Post Installation Configuration

After successfulling of the Oracle Financial Services Advanced Analytical Applications Infrastructure Application Pack,
follow the post installation steps mentioned below.

This chapter includes the following topics:

Configure excludeURLList.cfg file

Configure Resource Reference

Start/Stop OFSAA Infrastructure Services

Add TNS entries in TNSNAMES.ORA file
Configuration for Oracle R distribution and Oracle R Enterprise (ORE)
Configurations for ORE Execution

Configurations for Tomcat

Configuration for Java 8

Create and Deploy the Application Pack Web Archive
Create and Deploy the Application Pack Web Archive
Access the OFSAA Application

® & &8 6 6 & & ©®© ©© & © 6

Perform Post Deployment Configurations

Note: Ensure that to clear the application cache prior to the deployment of Application Pack Web Archive.
This is applicable to all Web Servers (WebSphere, Weblogic, Tomcat). For more information, see Clearing
Application Cache section.
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Configure excludeURLList.cfqg file

To configure the excludeURLList.cfq file, follow the below steps:
1. Locate the webserver deployed area webroot/conf/excludeURLList.cfg file.
16. Modify the following entries:
n [SQLIA]./datalntegrator/ to [ALL]./datalntegrator/
] [SQLIA]./ETLExtractionServlet to [ALL]./ETLExtractionServlet
17. Save the changes and restart the webserver.

18. Resave the definition.
Configure Resource Reference

Configure the resource reference in the Web Application Server configured for OFSAA Applications. See Configuring Web
Server for details on configuring the resource reference in WebSphere, WebLogic, and Tomcat Application Servers.

Start/Stop OFSAA Infrastructure Services

Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA Applications.
This chapter details on how to start and stop OFSAA Infrastructure services. This chapter includes the following sections:
® Starting Infrastructure Services

® Starting Web Application Servers
Starting Infrastructure Services

Once the installation of Infrastructure has been completed successfully and the post-installation steps are completed, the
servers must be started. Log on to each machine and run the .profile file. All servers mentioned must be started from the
same shell encoding. The servers mentioned below are dependent on each other. It is mandatory to maintain the order in
which the servers are started. Allow each of the servers to initialize completely before starting the next server.

1. Onthe machine in which Infrastructure Application components have been installed, navigate to
SFIC_APP_HOME/common/FICServer/bin and execute the following command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the command "nohup ./ startofsaai.sh &".
Starting the process using "nohup" and "&" will return the command prompt without having to wait till the
process completes. However, this command cannot be used when you are starting the server for the first
time or starting after changing user password in the configuration database schema.You can also start the
Infrastructure Server by executing the command "nohup ./ startofsaai.sh &". Starting the process using
"nohup" and "&" will return the command prompt without having to wait till the process completes.
However, this command cannot be used when you are starting the server after changing user password in
the Configuration database schema.

2. Start ICC server:
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®  On the machine in which Infrastructure default Application components have been installed, navigate to
SFIC_HOME/ficapp/icc/bin

m  Execute the command:

./iccserver.sh

Note: Only Infrastructure Default Application Server would hold ICC component.

3. Stopping Infrastructure Services:

®  On the machine on which Infrastructure Database components have been installed, navigate to
SFIC_DB_HOME/bin and execute the command to start "Agent server":

./agentstartup.sh
Or
m  Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP data server and AM services.

Starting Web Application Servers

Start the Web Application Server depending on the type from the following table.

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to [Webshpere_Install_Directory]
/AppServer/<profiles>/<profile name>/bin and execute the command:

./startServer.sh serverl

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to <WebLogic Installation
directory>/user_projects/domains/<domain name>/bin and execute the command:
startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic Admin Console. Stop and start the
application <context name>.ear.

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat_Install_ Directory>/bin and
execute the command:

./catalina.sh run
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Stopping Infrastructure Services

To stop Infrastructure services:

1.

On the machine in which Infrastructure Application components have been installed, navigate to
SFIC_APP_HOME/common/FICServer/bin and execute the command:

./stopofsaai.sh

To stop ICC server, on the machine in which Infrastructure default Application components have been installed,
navigate to SFIC_HOME/ficapp/icc/bin and execute the command:

./iccservershutdown.sh

Note: Only Infrastructure Default Application Server would hold ICC component.

To stop Back-end server, on the machine in which Infrastructure database components have been installed, navigate
to SFIC_DB_HOME/bin and execute the command:

./agentshutdown.sh

Add TNS entries in TNSNAMES.ORA file

Add TNS entries in the tnsnames. ora file, for every schema created for the Application Pack:

To find the tnsname for the entries, follow these steps:

1.

4
5.
6

Login to the application using System Administrator privileges.

Navigate to System Configuration & Identity Management tab.

Click Administration and Configuration >> System Configuration >> Database Details.
Expand the dropdown list for Name to get the list of TNS entry names.

Alternatively, you can connect to the CONFIG schema and execute the below query:

select dbname from db master where dbname !='CONFIG'

Configuration for Oracle R distribution and Oracle R Enterprise (ORE)

This is an optional step. Skip and proceed with the next steps if OFS Enterprise Modeling Application with R scripting is not
enabled during installation.

1.

Install OFSAAIRunner Package. For more information, refer Installing OFS AAAI Runner Package. If you have already
installed OFSAAIRunner package (as part of a previous installation), uninstall it (For more information, refer
Uninstalling OFS AAAI Runner Package section), and reinstall the latest available OFSAAIRunner package.

Log in to the database with dba privileges and provide the following privilege to Configuration Schema:
®m  RQADMIN by executing the command:
GRANT RQADMIN TO <config schema>;
Log in to the database with dba privileges and provide the following privileges to Atomic Schema:
m  CREATE UNLIMITED TABLESPACE privilege by executing the command:
GRANT CREATE UNLIMITED TABLESPACE TO <atomic_ schema>;
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m  CREATE MINING MODEL privilege (to execute the Data Mining models) by executing the command:
GRANT CREATE MINING MODEL TO <atomic_schema>;

Installing OFS AAAI Runner Package

OFSAAIRunner is an R package built by the OFS Enterprise Modeling Application. It is a prerequisite for executing models
developed using R scripts. This package helps in:

©

©
(]
o

Initializing inputs
Mapping framework variables to R objects
Configuring possible outputs of the script

Storing results back to the Database

OFSAAIRunner package (OFSAATRunner 1.0.0.tar.gz) is available under SFIC_DB_HOME/lib.

Prerequisite

Oracle R & ORE should be installed on the Oracle Database server before installing OFSAAIRunner package.

Refer to the following instructions to install OFSAAIRunner package:

1.
9.

10.
11.
12.

13.

Log in to the OFSAA Server. Navigate to the folder SFIC_DB_HOME/lib.

Copy the file OFSAAIRunner_1.0.0.tar.gz in Binary mode to the Oracle Database Server.

Log in to the Oracle Database Server with the user using which Oracle Database Server installation is done.
Navigate to the directory where the file OFSAAIRunner_1.0.0.tar.gz is copied.

Install the package by executing the command:

ORE CMD INSTALL OFSAAIRunner 1. 0.0.tar.gz

Successful installation is indicated in the installation log as:
* DONE (OFSAAIRunner)

Making packages.html ... done

Note: The OFSAAIRunner package is installed in /usr/lib64/R/library.

Navigate to the directory SORACLE_HOME/R/library and check whether OFSAAIRunner package is listed there by
executing the command:

1s -1

Uninstalling OFSAAIRunner Package

Refer to the following instructions to uninstall the OFSAAIRunner package:

1.

14.

15.

Log in to the Oracle Database Server with the same username, using which Oracle Database Server installation is
done.

Enter ORE in command prompt and execute the command:
#ORE
Enter the following command to save workspace image:

>remove.packages ("OFSAAIRunner")
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16. Enter y when prompted to save the workspace image.

al)

17. Navigate to the directory SORACLE_HOME/R/library and verify the package is not listed there by executing the
command:

18. Save workspace image? [y/n/c]:y
1s -1

Configurations for ORE Execution

Follow this step:

1. AddaTNS entry in tnsnames.ora file with tns name same as that of value set for ORACLE_SID in database server.

Note: For RAC database, follow the aforementioned configuration in all machines.
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Configurations for Tomcat

To stop generating static content with one print statement per input line, you need to configure the web.xml file.

To configure web . xm1 file, perform the following steps:

1.

19.

Navigate to tomcat/conf folder.

Edit web.xm1 file as explained below:

Set the mapped file parameter to False in the servlet tag mentioned with
<servlet-name>jsp</servlet-name>.

<init-param>

<param-name>mappedfile</param-name>
<param-value>false</param-value>

</init-param>

Configuration for Java 8

This section is applicable only if you upgrade OFSAA instance from 8.x to 8.0.2.0.0. Refer to the following instructions to
extract and apply the patch.

1.

20.

If the Oracle Database version is 12c¢, copy ojdbc7. jar from SORACLE_HOME/jdbc/lib to the following locations:
B SFIC_HOME/utility/OFSAAGenerateRepository/lib/
SFIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

SFIC_HOME/ficdb/lib/

SFIC_HOME/ficapp/icc/lib/

SFIC_HOME/ficapp/common/FICServer/lib/

SFIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

SFIC_HOME/ficweb/webroot/WEB-INF/lib/

SFIC_HOME/ficdb/etl/classes/

Note: If you have Oracle 12c R1 and Java 8, then copy the ojdbc7.jar and remove ojdbcé6.jar.

If the Oracle Database version is 11g, copy ojdbc6.jar from SORACLE_HOME/jdbc/lib to the following locations:
B SFIC_HOME/utility/OFSAAGenerateRepository/lib/
SFIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

SFIC_HOME/ficdb/lib/

SFIC_HOME/ficapp/icc/lib/

SFIC_HOME/ficapp/common/FICServer/lib/

SFIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

SFIC_HOME/ficweb/webroot/WEB-INF/lib/

SFIC_HOME/ficdb/etl/classes/
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Create and Deploy the Application Pack Web Archive

On successful installation of the OFSAA Application Pack, the web archive file is automatically generated. However, you
need to deploy the generated web archive file on the Web Application Server.

For identifying the location of the generated web archive file and for generating and deploying the web archive file at any
time later, refer Creating and Deploying EAR/WAR File.

Note: Refer the Oracle Financial Services Forms Manager User Guide for instructions on Creating and
Deploying the Forms Manager Web Archive.

Create and Deploy the Application Pack Web Archive

On successful installation of the OFSAA Application Pack, the web archive file is automatically generated. However, you
need to deploy the generated web archive file on the Web Application Server.

For identifying the location of the generated web archive file and for generating and deploying the web archive file at any
time later, refer Creating and Deploying EAR/WAR File.

Note: Refer the Oracle Financial Services Forms Manager User Guide for instructions on Creating and
Deploying the Forms Manager Web Archive.

Access the OFSAA Application

Prior to accessing the OFSAA application ensure the Internet Explorer Settings are configured.

Refer to Accessing the OFSAA Application for details on accessing the OFSAA Application on successful deployment of the
application web archive.

Perform Post Deployment Configurations

Prior to using the OFSAA Application perform the Post Deployment Configuration steps detailed in Post Deployment
Configuration.
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CHAPTER 7 FAQs and Error Dictionary

This section of the document consists of resolution to the frequently asked questions and error codes noticed during
OFSAAI installation.

® Frequently Asked Questions

® Forms Framework FAQs

©® Error Dictionary

OFSAAI installer performs all the pre-requisite validation check during installation. Any errors encountered in the process

is displayed with an appropriate Error Code. You can refer to the Error Dictionary to find the exact cause and resolution to
rectify the error.
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Frequently Asked Questions

You can refer to the Frequently Asked Questions which has been developed with the interest to help you resolve some of
the OFSAAI Installation and configuration issues. This intends to share the knowledge of problem resolution to a few of the
known issues. This is not an official support document and just attempts to share the knowledge of problem resolution to
a few of the known issues.

This section includes the following topics:
® OFSAAI FAQs
® Application Pack 8.0.2.0.0 FAQs

OFSAAI FAQs

What are the different components that get installed during OFSAAI?
The different components of OFSAAI are illustrated in Figure 1-2, "Components of OFSAAI".

What are the different modes of OFSAAI installation?
OFSAAI can be installed in two modes, Silent Mode, and GUI mode.

Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier. By default, they will be
installed on single-tier. However, OFSAA Infrastructure can be deployed within the n-Tier architecture where the
Database, Web Server and Web Application Server is installed on separate tiers.

Is IDK (Java Development Kit) required during installation of OFSAA? Can it be uninstalled after OFSAA installation?
JDK is not required during installation of OFSAA and only a run time is needed for details. Refer to Hardware and
Software Requirements, Java Runtime Environment section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI installation?
Only JRE (Java Runtime Environment) is required during installation of OFSAA and cannot be uninstalled as the JRE is
used by the OFSAA system to work.

How do | know what is the Operating system, webservers and other software versions that OFSAA supports?

Refer to OFSAA Technology Stack Matrices.

What are the different files required to install OFSAAI?

To install OFSAAI, the following files are required:
setup.sh.
envCheck.sh
preinstallcheck.sh
VerInfo.txt

OFSAAInfrastructure.bin

n

u

n

]

u

B validatedXMLinputs.jar
B MyResources_en US.properties
B log4j.xml

B  OFSAAI PostInstallConfig.xml
]

OFSAAI InstallConfig.xml
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B privileges config user.sql
B privileges atomic user.sql
B XML Utility.jar
What should I do if | get the following error message during installation, "Execute Permission denied"?
Please check whether all the files provided for OFSAAI installation has execute permissions.
To give execute permissions, navigate to the path OFSAAI_80000 and execute the command:
chmod 755
"Graphical installers are not.."

If error resembles "Graphical installers are not supported by the VM. The console mode will be used instead..." then
check whether any of the X-windows software has been installed.

Example: Hummingbird Exceed is started and configured to Graphical mode installation.

Note: Type 'xclock' from prompt and this should display clock in graphical mode.

"No Java virtual machine could be..."

If the error message reads "No Java virtual machine could be found from your PATH environment variable. You must
install a VM prior to running this program", then

m  Check whether "java path" is set in PATH variable. See the Table 3-1, "Prerequisite Information" section in this
document.

®  Check whether sufficient temporary space is available.
B Ensure that the movement of OFSAAI Installer text files to the target system is done in the Text mode so that
setup.sh file does not contain control line feed characters (*M).
What should | do if | get the following error message during installation, "OracleDriver Files Not Found, Please Choose the
Right Path To Continue"?
Check whether the provided path for Oracle Driver files is correct and whether the user has permissions to access the

files.

What should I do if | get the following error message during installation, "User must have CREATE TABLE, CREATE VIEW,
CREATE TRIGGER, CREATE INDEX, CREATE SEQUENCE, CREATE PROCEDURE" even though the oracle schema user created
has the mentioned privileges?

OFSAAIl installer validates the database details provided during installation, so ensure:
m  Whether the oracle schema user has the required set of privileges for successful installation.

m  Whether the oracle schema user has been created with quota privileges on tablespace to create database
objects.

See the Table 3-1, " Prerequisite Information" section in this document.

Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAAI installation, one has to perform the Post Installation steps. See Chapter 5,
"Post Installation Configuration".
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What is to be done when OFSAAI Installation is unsuccessful?

OFSAAl installer generates log file OFSAAInfrastructure Install.login the Infrastructure Installation
Directory. There is also another log file created in the path configured in Log4j.xml. The logs of any of these reported,
Warnings/Non Fatal Errors/Fatal Errors/Exceptions should be brought to the notice of the OFSAAI Customer Support.
It is recommended not to proceed, until the reported problems are adequately addressed.

How do | completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in Uninstalling OFSAA Installation in the OFS
AAAI Installation and Configurtion Guide Release 8.0.2.0.0.

Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same database instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database permissions) to the new Atomic
schema.

m Loginto the database as sys and connect as sysdba user.
m  Execute thefile privileges config user.sql available under SFIC_HOME directory

m  Enter the database schema for which you want to grant privileges.

When should | run the MLS utility?
See the Multiple Language Support (MLS) Utility section in OFSAAI Administration Guide available on OTN.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and above.

What should | do if | get the following error message on the UNIX System terminal while executing ./setup.sh, "Insert New
Media. Please insert Disk1 or type its location"?

a. Login as root user on the Unix machine where OFSAAI is getting installed.

=

Navigate to the path /etc/security/.
Edit the file 1imits.conf to add/edit a row for the unix user installing OFSAA:

134

<Unix User> soft nofile 9216
d. After saving the changes, log in as unix user with which OFSAAI is getting installed and execute the command:
ulimit -n

The command should return the value 9216.

How does one verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the installation, a Pre-Install Check utility is
available within the Install Kit archive file. This utility can also be obtained separately by contacting Oracle Support.

See Verifying System Environment section for additional information.

How do I know if the installation is completed successfully?

The OFSAA Infrastructure installation performs a post install health check automatically on successful installation of
the product. To rerun the post install verification at a later time, perform the following steps:

a. Navigate to the path SFIC_HOME (Product Installation Directory).

b. Execute the command:
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./piverify.sh

What should one do if the installation in GUI mode is not invoked?
There are set of configuration steps required to be performed during the installation in GUI mode. Verify whether the
steps mentioned under Configuration for GUI Mode Installation section are done correctly.

What should one do if there are any exceptions or errors in installation and how to proceed?
a. Please backup the installation logs.

b. Share the backup logs with Oracle support.

What should I do if | get the following error message during OFSAAI installation on Solaris 11 system?
"Error: OFSAAI-1108
ORA-00604: error occurred at recursive SQL level 1
ORA-01882: timezone region not found"
Or
"Time zone cannot be set as null or 'localtime' "

This happens if the time zone is not set, that is NULL or it is set as 'localtime'. Set the environment variable TZ to a
valid time zone region in the .profile file. For example:

TZ=Asia/Calcutta

export TZ

What should I do if the installation process is abruptly terminated or aborted?

If the installation is abruptly terminated, then the installation process will be incomplete. To recover from this, follow
the below steps:

a. Drop the DB objects in the config schema created by OFSAAI installation.

b. Openthe .profile file and remove the entries made by the OFSAAI installation which are made between the
comment statements, #Beginning of entries by OFSAA Infrastructure installation and #End of entries by OFSAA
Infrastructure installation.

c. Delete the OFSAA install directory created by the OFSAAI installer.
d. Perform the OFSAAI installation again.

Does OFSAA support any other web server types, other than the ones stated in tech matrix and installation guide?

No, all the supported softwares and versions are stated in the OFSAA Technology Stack Matrices.

What should one do if the database connection from connection pool throws an error
"java.sql.SQLRecoverableException: 10 Error: Connection reset"?

This happens while running several database intensive tasks in parallel. To correct this error, add the line
securerandom.source=file:/dev/./urandomin the java.security configuration file available in
SIAVA_HOME/jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where the OFSAAI components are installed.

If the issue is not resolved even with the above settings, check the MTU(Maximum Transmission Unit) settings on the
linux box. For details on MTU settings and updating them, contact your system Administrator.
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What should | do when | get syntax errors/file not found error messages while invoking setup.sh file from my install

archive?

This could mostly happen:

B When installer was not unzipped correctly or corrupted during unzip.

B setup.sh file which resides within the install archive was not transferred in ASCII or text mode, which could
have corrupted the file.

To correct this, follow the steps:

a. Copy the installer (in BINARY mode) to the system on which the OFSAA Infrastructure components will be
installed.

b. Unzip the installer using the command:

unzip <OFSAAI Installer>.zip

c. The corrupted setup.sh file would have introduced certain *M characters into the file. You can remove "M
characters from setup. sh file by following the below steps:

4

*
*
L 4

Login to the server where the installer is copied.
Navigate to the directory OFSAAI_80000.
Open the setup. sh file in the vi editor using the command: vi setup.sh.

Inside vi editor in Esc mode, type: $s/"M//g

Note: To enter M, hold the CTRL key then press V and M in succesion.

€ Save the setup. sh file by typing: wg!

Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a standard or enterprise edition. So,
OFSAAI will work with standard edition as well.

We do not recommend standard edition because it will not scale and does not support partition pack, database
security vault, or advanced analytics.

What should | do if | get the following error message while executing ./reveleusstartup.sh file on the UNIX System terminal
" /reveleusstartup.sh: /java: Execute permission denied"?

®  Ensure JAVA_BIN environment variable path is set on the "unix user" terminal from where the reveleusstartup.sh
file is invoked.

B Ensure the .profile where the environment/ path settings are made has been executed successfully.

What happens when the OFSAAI Application Server does not proceed even after providing the system password?

Ensure that, the System Password provided when prompted should match with the "Oracle Configuration password"
provided during installation. Also check whether the connection to the "configuration schema" can be established
through sqlplus.
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Although the OFSAAI installation has completed successfully, when OFSAAI servers are started, and the application URL is
accessed, it gives an error message "the page cannot be found or displayed" or "Could not retrieve list of languages from
Server. Please contact the system administrator”. What should one do?

Ensure OFSAAI servers have been started and are running successfully. On the server start up parameters options,
refer to Starting Infrastructure Services section.

For more details on the issue, refer on to the Revappserver log in SFIC_APP_ HOME/common/FICServer/logs directory
or the Web Server log files.
Is it necessary to provide the specified grants to the Oracle schema user before installation? If yes, can it be revoked after
completion of installation?
The "Oracle schema" user requires the necessary grants specified before, during, and after the installation process.
Grants provided should never be revoked as the application makes use of these grants all the time.
Can we have distributed OFSAAI Application Server for load balancing?
OFSAAI Application server can be scaled out/distributed across different JVM's (machines) based on the various
services and Information Domains, in other words, Load balancing could be achieved with distribution of services.
Why do we need Ftpshare? Why is it needed on all the layers? Can we have ftpshare on another machine other than the
machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the metadata related files used in Infrastructure are stored in the
ftpshare directory. The ftpshare contains folders for each Information Domain, with each Information Domain folders
holding Erwin, log, and scripts folder. The transfer of data among the Web, Application, and Database servers in
Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers by providing App server's FTP/SFTP
credentials to the Web server and DB server users.

Yes, we can have ftpshare on another machine other than the machines where OFSAAI is installed.

Is it mandatory to provide the ftp/sftp password?
Yes, OFSAAI needs credentials of the user which has complete permissions on ftpshare directory, and should be able
to independently login to the unix server.

What are the permissions required for ftpshare and when should I give them?

It is recommended to provide permissions on ftpshare in case of installations done across different machines or VMs
(multitier installation ).

In case of single tier installation, 770 permissions can be provided if the unix users of OFSAAI and web server belong
to the same unix group.

And on any new file that is created in the 'ftpshare' folder of any installation layer should be granted specific/explicit
permission.

Port Change utility could be used to have the Port number modified, which are currently being used by the
Infrastructure application. For more information, refer Configure Infrastructure Ports section.
Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup OFSAAI.

m  SYSADMN
®  SYSAUTH
. GUEST
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Does OFSAAI Application support both FTP and SFTP?
OFSAAI supports both FTP and SFTP configuration.

Is it necessary to enable the FTP/SFTP services to use the OFSAAI?
Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards using the OFSAALI.

OFSAAI Configuration: Unable to save the server details?

Ensure the input User ID, Password, and Share Name are correct.

B Ensure FTP/SFTP services are enabled.

B Have a test FTP/SFTP connection made and confirm if they are successful.
What should | do if | get the following message message while creating Information Domain, "Please create a database
and then create the information domain"?

Information Domain is mapped to only one Database; and thus before the creation of Information Domain, at least

one database details would need to exist.
What should I do if | get the following message during startup of backend engine message server, "ConnectToDatabase:
FatalError, could not connect to the DB server"?

m  Verify whether connection to the "configuration schema" can be established through sqlplus.

m  Verify "configuration schema" password is modified post installation.

m  Ensure oracle database alias name created for oracle instance and oracle service name are same.

®  On a multi tier Installation mode, ensure TNSNAME and SID are the same in both the Application and Database

Layers.

What should | do if I get the following message during the startup of backend engine message server, "Fatal Error, failed to
get user ID from LibSmsConnect"?

Ensure Reveleus. sec file exist under the SFIC_HOME/conf directory where the Database components are installed.

Does OFSAAI Application support LDAP authentication?
OFSAAI supports LDAP configuration and authentication.

Does OFSAAI support multiple languages?
Yes, OFSAAI supports multiple languages.

Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is recommended for back-up.

What kind of security features does the OFSAAI provides?
OFSAAI provides security at:
m  Segment Level - Users can access only the segment they are mapped to.

m  Application Level - Users can perform an operation only if mapped to appropriate role and functions.

Does OFSAAI have the ability to enforce periodic password change?

OFSAAI provides configurable parameters to define number of days after which the user password would expire and
then the user is forced to change the password after expiration period.
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What is the password policy followed in OFSAAI?
OFSAAI enforces a minimum password length with a combination of Upper and Lower case characters and
alpha-numeric strings.

Which version of Erwin Data Modeller does OFSAAI support?
OFSAAI now supports ERwin version 9.2 and 9.5 generated xmls in addition to ERwin 4.1, ERwin 7.1, ERwin 7.3 and
ERwin 9.0 formats.

Does OFSAAI provide the mechanism to upload Business Data model?
OFSAAI provides two mechanisms for business data model upload:

B Easy to use GUI based Model upload mechanism to upload the Business Data Model through Unified Metadata
Manager --> Import Model.

m  OFSAAl also provides a model upload utility "upload. sh" for uploading the business data model through the
command line parameter by executing this shell script file under the path
<FIC_HOME>/ficapp/common/FICServer/bin.

Refer the section Run Model Upload Utilityof the Oracle Financial Services Analytical Applications Infrastructure User
Guide on OTN for details.
How do I apply incremental change to the existing model when the Business Data model undergoes a change?

Modified data model can be uploaded into the system and OFSAAI has the ability to compare the changes within the
data model with respect to the one already present in the system and enables propagation of incremental changes in
a consistent manner.

What are the different types of uploading a business data Model?
OFSAAI supports uploading of business data model from client desktop and also by picking up the data model from
the server location.

Can the OFSAAI "Configuration Schema" password be modified post installation?

The OFSAAI "configuration schema" password can be modified post installation. OFSAAI application stores the
password in the database and few configuration files, thus any changes to the "configuration schema" password
would necessitate updating in these. Contact OFSAAI support for more details.

Can the OFSAAI "Atomic Schema" password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the atomic schema password in
the database and few configuration files , thus any change to the atomic schema password would necessitate
updating the password.

To change the Atomic Schema password, follow the steps:

a. Loginto OFSAA.

b. Navigate to System Configuration > Database Details window. Select the appropriate connection, provide the
modified password and save.

c. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > Define Sources window. Update
the appropriate Source details.

If you are using Apache Tomcat as Web server:

a. Update the <Context> -> Resource tag details in server.xml file from the SCATALINA_HOME/conf folder. (In case
of Tomcat only Atomic <Resource> will exist).

b. Login to the WebSphere Administration Console from the left side menu.
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c. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right side.

d. Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic data
sources need to be modified).

If you are using WebLogic as Web server:

a. Login to the WebLogic Administration Console from the left side menu.

b. Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC >Data Sources.
A list of data sources will be populated on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic data
sources need to be modified).

Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs displays the message ORA-28000: the
account is locked.

Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory settings on the client and server machines.
Java memory setting varies with the data model size and the available RAM. Contact OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in User Interface, takes longer time to
load than other screens?

The Logfile in DynamicServices.xml which resides in SFIC_HOME/conf is continuously being updated/refreshed to
cache metadata. This can be observed when you are starting reveleusstartup.sh and if any of the log file (Ex:
SMSService.log)in DynamicServices.xml is being continuously refreshed for longer time.

By default, the Metadata Log file cache size is set to 1000. If in case the log is being updated beyond this limit,
retrospectively the preceding entries are overwritten. For example, the 1001th entry is overwritten by deleting the
first entry. This results in the application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, depending on the currently logged
count for the specific metadata.

m  Generate the Log report by executing the below query in config schema.
select count(l), t.metadata name, m.dsn_id
from metadata master m, metadata type master t
where m.metadata type = t.metadata type

group by t.metadata name, m.dsn_ id

m  The above query returns a list of codes with their respective metadata count. You can refer to
"metadata_type_master" table to identify the metadata name.

m View the log report to identify the metadata which is being updated/refreshed beyond the specified cache size
limit. Accordingly increase the cache size limit in Dynamicservices.xml depending on the currently logged count
for the specific metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure reported in log is 1022, increase the
limit to 2000 (approximately).

m  Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.
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What should | do if | get OutOfMemoryError while deploying EAR file in WebSphere application server?

The Java memory needs to be increased in ejbdeploy. sh file which is present under <WebSphere Install
directory>/AppServer/deploytool/itp. For example,

$JAVA CMD \

-Xbootclasspath/a:$ejbd bootpath \

Xms256m -Xmx1024m \

What configurations should | ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified Metadata Manager- Import Model, you need
to configure the required model size in struts.xml file available in the path
SFIC_WEB_HOME/webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can approximately set the max size to 3GB
(3221225472 bytes) as indicated below, in order to avoid size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and redeploy the application onto your
configured web application server. For more information on generating and deploying EAR / WAR file, refer Appendix
C.

What should | do if my Hierarchy filter is not reflecting correctly after | make changes to the underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying Hierarchy has been changed. This
can occur in hierarchy maintenance, where you have moved a member to another hierarchy branch, and that
member was explicitly selected in the Filter and is now a child of a node which is already selected in the Filter.

Refer to Support Note for the workaround.

How do you turn off unused information domains (infodoms) from cache?
Follow the below steps to turn off unused infodoms from cache:
Navigate to SFIC_HOME/conf in the APP layer of your OFSAAI installation.
m In the DynamicServices.xml file, identify the section for <Service code="20">.
B Modify the value of parameter CACHE_ON_STARTUP to O (default is 1).

B Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the application onto
your configured web application server. For more information on generating and deploying EAR / WAR file, see
Configuring Web Application Servers.

B Restart the OFSAAI Services (APP and WEB). For more information, see Appendix D.

Note: This setting will cache the Infodom metadata only for the infodoms that get accessed upon user
login. Infodoms which do not get accessed, will not be cached.

Sample code is pasted below:
<SERVICE CODE="20"

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"
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SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS>
<PARAMETER NAME="CACHE ON_ STARTUP" VALUE="0" />
<PARAMETER NAME="BACKUP XML" VALUE="1" />
<PARAMETER NAME="MAX BACKUP XML" VALUE="2" />
<PARAMETER NAME="PC NONBI BI SWITCH" VALUE="2048" />
<PARAMETER NAME="HIERARCHY NODE LIMIT" VALUE="2000" />
<PARAMETER NAME="ALIAS CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="DATASET CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="MEASURE CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHY CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="DIMENSION CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHYATTRIBUTE CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="CUBE CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="RDM CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="BUSINESSPROCESSOR CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="DERIVEDENTITY CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="LOG_GET METADATA" VALUE="false" />
<PARAMETER NAME="METADATA PARALLEL CACHING" VALUE="0O" />
</PARAMETERS>
</SERVICE>

Can I install an Application Pack on an existing Atomic schema/ Information Domain created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information Domain created manually.
Application Packs can be installed only on Atomic Schemas/Information Domain created using schema creator utility
and/ or the Application Pack installer.

What should | do if | get the following exception while trying to view the model outputs in Model Outputs screen, "Excep-
tion ->Local Path/STAGE/Output file name (No such file or directory)"?
Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the web server details screen.
This folder needs to be created under the local path on every node ,in case of web application server clustering.
What should I do if | get the following exception during OFSAA services startup, "Exception in thread "main"
java.lang.UnsatisfiedLinkError: net (Not a directory)"?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to a physical JRE installed.
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What is the optimized memory settings required for "New" model upload?

The following table lists the optimized memory settings required for "New" model upload.

X_ARGS_APP ENV Variable in OFSAAI
Upload Options Size of Data Model XML File APP Layer
Pick from Server 106 MB “-Xms1024m -Xmx1024m
36 MB “-Xms2048m -Xmx2048m
815 MB “-Xms4096m -Xmx4096m
1243 MB “-Xms6144m -Xmx6144m
Model Upload Utility 106 MB “-Xms1024m -Xmx1024m"-Xms2048m
-Xmx2048m
336 MB “-Xms4096m -Xmx4096m
815 MB “-Xms4096m -Xmx4096m
1243 MB “-Xms6144m -Xmx6144m
Save New Erwin File In Server 106 MB “-Xms1024m -Xmx1024m
336 MB “-Xms2048m -Xmx2048m
“-Xms4096m -Xmx4096m
“-Xms6144m -Xmx6144m

What is the resolution if | get the error - ORA 01792 maximum number of columns in a table or view is 1000 during T2T exe-
cution?

You should apply the below patch set from Oracle. Applicable only for 12c.
https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1
I did not enable OFS Inline Processing Engine Application license during the installation. However, | have enabled it post

installation, using the Manage OFSAA Product License(s) in the Admin Ul. Are there any other additional configurations
that | need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration Guide available on OTN.

I get an error when | try to build an Oracle OLAP cube. What should | do?
Execute the below grant on the appropriate ATOMIC schema

grant olap user to &database username

How do you turn off unused Information Domains (Infodoms) from caching?

Follow these steps to turn off unused infodoms from caching:

m  Navigate to SFIC_HOME/conf in the APP layer of your OFSAAI installation.

B Inthe DynamicServices.xml file, identify the section for <Service code="20">.
m  Modify the value of parameter CACHE ON_STARTUP to O (default is 1).
[

Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the application onto
your configured web application server. For more information on generating and deploying EAR / WAR file, refer
Creating and Deploying EAR/WAR File.

B Restart the OFSAAI Services (APP and WEB). For more information, refer to the Start/Stop OFSAA Infrastructure
Services section.
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Note: This setting will cache the Infodom metadata only for the infodoms that get accessed upon user

login. Infodoms which do not get accessed, will not be cached.

Sample code is pasted below:

<SERVICE CODE="20"

CLASS="com.

iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS>
<PARAMETER NAME="CACHE ON_STARTUP" VALUE="0" />

<PARAMETER NAME="BACKUP XML" VALUE="1" />

<PARAMETER NAME="MAX BACKUP_ XML" VALUE="2" />

<PARAMETER NAME="PC NONBI BI SWITCH" VALUE="2048" />
<PARAMETER NAME="HIERARCHY NODE LIMIT" VALUE="2000" />
<PARAMETER NAME="ALIAS CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="DATASET CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="MEASURE CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHY CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="DIMENSION CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHYATTRIBUTE CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="CUBE CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="RDM CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="BUSINESSPROCESSOR CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="DERIVEDENTITY CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="LOG GET METADATA" VALUE="false" />

<PARAMETER NAME="METADATA PARALLEL CACHING" VALUE="Q0" />
</PARAMETERS>

</SERVICE>

“While creating an Excel Mapping, after specifying the excel worksheet, the target table, and mapping each column in the
worksheet to a target table, | click SAVE and nothing happens. But when | click CANCEL, a message pops up informing me
that all changes will be discarded", what is to be done.

Check if the excel mapping creation is done using |.E 8 with JRE 1.4 plug in enabled on machine. If so, upgrade the JRE
pluginto 1.7+.
Can Multiple OFSAA Infrastructure instances share the same config schema?

No, only one OFSAA environment can be installed using one config schema.

Can Atomic schema be shared?

Yes, it can be shared between two OFSAA instances.
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While setting a firewall, which ports should be opened for communication between the Web Server (Apache HTTP Server/
Oracle HTTP Server/ IBM HTTP Server) and the Web Application Server (WebSphere/ Weblogic/ Tomcat) for OFSAAI to
operate properly?

The OFSAA Servlet port which is same as Web server port should be open. Also the web application port should be
open.
Can | modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database where older versions of OFSAA is
Installed?
Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not intending to use multi language
support.
Can | install already installed application in a different infodom?

No, it is not possible to install the same application in two different infodoms.

How can I configure the OFSAA application for High Availability?
OFSAA can have active-passive high availability. For more details, refer Configuration for High Availability- Best
Practices Guide.
I want to configure OFSAA for High Availability that is weblogic cluster on which OFSAA.ear is deployed and cluster OFSAAI
processes (such as Reveleus etc) are runnning. Is this a supported confuguration?

High Availability is available for WebLogic cluster and DB level as active-active, but is not available on the application
side. OFSAA can have active-passive high availability. For more details, refer Configuring OFSAA in Clustered
Environment Guide.

During OFSAA installation should | provide web application server's IP /Hostname and port or web server's IP/Hostname
and port, if the Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server are configured?

In case the web server is configured, you should enter the Web Server IP Address/Hostname and Port details during
OFSAA installation. Here the Servlet port should be same as the Web Server port.

If Web Server is not configured, the Web Application Server's IP Address/ Hostname and Port is required during the
installation process. Here the Servlet port should be same as the Web application Server port.
Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.2.0.0 and higher versions?
No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is a change in the way
agentservers are managed through AGENTSTARTUP.SH & AGENTSHUTDOWN.SH.
What should | do when the message server process does not open and | get the following error message, "CI18NPro-
vider::CI18NProvider, Error, unable to connect to the config database"?
This error is displayed due to the following reasons:
m  The Config Schema password is already expired.

m If the config schema password is going to expire soon and the message like "ORA-28002: the password will expire
within 6 days" displays while connecting to config schema through sqlplus.

m  The Config schema password is Modified.

To resolve the error, re-set the config schema password to the old password. Else, if the config schema password is
modified to something else then follow the below steps:

m  Delete the SFIC_HOME/conf/Reveleus.SEC file.
m  Shutdown the OFSAAI App service: cd SFIC_APP_HOME/common/FICServer/bin ./stopofsaai.sh
m  Shutdown the OFSAAI App service: cd SFIC_APP_HOME/common/FICServer/bin ./stopofsaai.sh
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m  Start the Infrastructure Server in foreground directly on the server or through XWindows software using the
command: ./startofsaai.sh

m  Enter System Password.

®  Enter the new Config schema password. The service starts and initializes if it is able to successfully connect to the
DB and generates the Reveleus.SEC file.

B Post successful startup of the service, if required, the Infrastructure server may be shut down and restarted in the
background using nohup mode.

What is the mechanism of Log File sizing and backup?

Can

OFSAAI Log files created under SFIC_APP_HOME/common/FICServer/logs &
<OFSAAI_DEPLOYED AREA>/<CONTEXT.war>/logs is configurable in RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max backup log files
(MaxBackuplndex) retained is set to 5, both of which are configurable. Increasing these parameters to a higher value
should depend on the server HW configurations and may reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:

m  Navigate to SFIC_HOME/conf where OFSAA is installed.

m  Edit the following parameters in the file Revl.og4jConfig.xml

<param name="file" : Enter the path where the Logs are to be generated.

<param name="MaxFileSize" : Provide the required file size.

<param name="MaxBackuplndex" : Provide the required number of backup files to be created.

Example:

<appender name="REVSERVERAPPENDER" class="org.apache.log4j.RollingFileAppender">
<param name="file" value="S$FIC HOME/ficapp/common/FICServer/logs/RevAppserver.log"/>
<param name="Append" value="true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackupIndex" value="5" />

<layout class="org.apache.log4j.PatternLayout">

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>

</layout>

</appender>

To configure the Deployed area logs file, follow these steps:

m  Navigate to <EAR/WAR Deploy area>/conf folder.

m  Repeat step 2 from the above section.

we modify the Log file path?

Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml.default log file path (file) is set by the
installer . This can be configured to another path.
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Can | point the environment with HTTP enabled to HTTPS after installation and vice versa?

Follow these steps:

Create SSL related certificates and import to respective servers.
Enable SSL on a desired Port ( example 9443 ) on your existing and already deployed web application servers.

Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) configured and in all the URLs specified on
below files:

SFIC _HOME/ficapp/common/FICServer/conf/FICWeb.cfg and
SFIC HOME/ficweb/webroot/conf/FICWeb.cfg

SFIC HOME/ficapp/icc/conf/WSMREService.properties
SFIC_HOME/ficweb/webroot/conf/ModelExecution.properties

SFIC HOME/ficdb/conf/MDBPublishExecution.properties

SFIC HOME/ficdb/conf/ObjAppMap.properties

SFIC HOME/utility/Migration/conf/WSMigration.properties

SFIC _HOME/utility/WSExecution/conf/WSExecution.properties
SFIC_HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl
SFIC_HOME/EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

SFIC HOME/EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServicelmpl.wsdl

Replace XML attribute/Node values as specified on below files:
SFIC HOME/ficweb/webroot/WEB-INF/web.xml

FIC WEBSERVER PORT=9443

FIC WEBPROTOCOL=https

$FIC HOME/conf/LookUpServices.xml and
SFIC_HOME/ficweb/webroot/conf/LookUpServices.xml

PORT="9443" PROTOCOL="https:"
Login to config schema and execute below SQL command to replace protocol and SSL port.

SQL> update configuration cn set cn.paramvalue='9443' where
cn.paramname='SERVLET_ENGINE_PORT';

SQL> update configuration cn set
cn.paramvalue=replace (cn.paramvalue, 'http:', 'https:') where
cn.paramname='FormsManagerCacheReload';

SQL> update web server info ws set ws.servletport='09443',ws.servletprotocol="https';

Create EAR/WAR file and Re-Deploy.
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What should | do if the sliced data model upload takes a long time to complete?

If the metadata cache size is set to a lower value than the actual count of each metadata type ( hierarchy, dataset,
dimension etc), then it gets into performance degrade issues. We have to increase the cache size for each metadata
type according to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on the metadata count in your
environment.

<PARAMETER NAME="HIERARCHY NODE LIMIT" VALUE="2000"/>

<PARAMETER NAME="ALIAS CACHE SIZE" VALUE="1000"/>

<PARAMETER NAME="DATASET CACHE SIZE" VALUE="2000"/>

<PARAMETER NAME="MEASURE CACHE SIZE" VALUE="3000"/>

<PARAMETER NAME="HIERARCHY CACHE SIZE" VALUE="2000"/>

<PARAMETER NAME="DIMENSION CACHE SIZE" VALUE="2000"/>

<PARAMETER NAME="CUBE CACHE SIZE" VALUE="1000"/>

<PARAMETER NAME="BUSINESSPROCESSOR CACHE SIZE" VALUE="2000"/>

<PARAMETER NAME="DERIVEDENTITY CACHE SIZE" VALUE="1000"/>
Metadata count can be derived based on the following queries:

select count(l) from metadata master where metadata_version=0 --— for all metadata

select count (1) from metadata master where metadata version=0 and metadata type=1l ---
for measure

select count (1) from metadata master where metadata version=0 and metadata type=2 ---
for Dimension

select count (1) from metadata master where metadata version=0 and metadata type=3 ---
for HCY

select count (1) from metadata master where metadata version=0 and metadata type=4 ---
for DATASET

select count(l) from metadata master where metadata version=0 and metadata type=59
--— for BP's

select count(l) from metadata master where metadata version=0 and metadata type=54
-—- for Alias

select count (1) from metadata master where metadata version=0 and metadata type=5 ---
for CUBES

select count(l) from metadata master where metadata version=0 and metadata type=856
--- for Derived Entity

For LDAP authentication , which server connects with the LDAP server, the Application server (where ofsaai is installed), or
Web Application server (where EAR is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP server.
The LDAP server in the setup listens on secure protocol Idaps ( port 636). | have the root certificate of the LDAP server for
SSL, and would like to know where to offload this certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer.

102 Oracle Financial Services Profitability Management Application Pack Installation Guide



Frequently Asked Questions
Chapter 7—FAQs and Error Dictionary

How to relocate FTPSHARE folder?
You can run the PortC. jar utility. For more details, refer Changing IP/ Hostname, Ports, Deployed Paths of the
OFSAA Instance section in the OFSAAI Admin Guide available on OTN.
What should | do when an entity containing many attributes (>100 columns) is selected as Source entity and the Data Map-
ping (T2T definition) save operation takes longer than expected with the hourglass in the Ul continuously rotating?
The workaround is:
m  Locate the webserver deployed area webroot/conf/excludeURLList.cfg file.
m  Modify the following entries:
[SQLIA]./datalIntegrator/ to [ALL]./datalntegrator/
[SQLIA]./ETLExtractionServlet to [ALL]./ETLExtractionServlet
B Save the changes and restart the webserver.

B Resave the definition.
Application Pack 8.0.2.0.0 FAQs

What is an Application pack?
An Application Pack is suite of products. For more information, refer About Oracle Financial Services Advanced
Analytical Applications (OFSAA) Application Packs.

Can | get a standalone installer for OFSAAI 8.0?

No. AAl is part of every application pack and installs automatically.

How does OFSAA 8.0 Application pack relate to OFSAA 7.x series?

8.0 is a new major release consolidating all products from OFSAA product suite.

Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack?
There is no upgrade path available. However, we will have migration kit / path for every product to 8.0 application
pack. Further details will be available with Oracle Support.

Does OFSAA 8.0 Application pack UPGRADE's automatically existing environments?

No. Refer Point 5. OFSAA 8.0 application pack has to be installed in an new environment and subsequently migration
path / migration kit needs to be run to migrate from 7.x to 8.0. Please note we will have migration path only from the
previously released version of OFSAA products.

Where can | download OFSAA 8.0 Application Pack?

You can download the OFSAAI 8.0 Application Pack from Oracle Software Delivery Cloud (OSDC).

What are the minimum system and software requirements for OFSAA 8.0 Application Pack?

Refer installation guide section Hardware and Software Requirements section.

Is my environment compatible with OFSAA 8.0 Application Pack?

Environment Check utility performs the task. It is part of install and can also be run separately.

Does OFSAA 8.0 Application Pack is support all Operating systems?

LINUX, AIX, SOLARIS 10, 11. Refer to Technology Matrix for the technology matrix that OFSAA suite products are/ will
be qualified on.
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How can I install OFSAA 8.0 Application Pack?

Refer to Oracle Financial Services Advanced Analytical Infrastructure Installation and Configuration Guide published in

OTN for the application pack installers.

Does this installation require any Third party Software?

Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration Guide published in OTN

lists the third party software that needs to be installed.

What languages are supported during OFSAA 8.0 Application Pack installation?
US English is the language supported.

What mode of installations OFSAA Application Pack supports? [i.e., Silent, GUI]
OFSAA Application Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0 Application Pack support Multi tier Installations?

OFSAA 8.0 does single tier installation. For more information refer to OFSAAI FAQs section.

Does this Application Pack validate all Pre-requisites required for this installation i.e., Memory, Disk Space etc.?

Yes. The pre-requisite checks are done by the respective application pack installer.

What happens if it aborts during installation of any application with in Application pack?

You must restore the system and retrigger the installation

Does this Application pack 'Rolls Back' if any of application installation fails due to errors?

Rollback of installation is not supported.

Does the Application pack installs all applications bundled?

All application pack file system files are installed but there is an option to enable the licensed products.

How can I re-install any of the Application Pack?

You can retrigger in case of failure.

Does Application pack allow enabling / disabling any of the applications installed?

Yes. You cannot disable once the product is enabled in an environment.

I have installed one application in a Application pack and can | install any of new applications within the Application pack

later point of time?

No, installation of additional applications is not required. If you wish to add an application later, you can enable the

application at that time.

How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP installations and separate
associated database instances and separate Web Server installations on the same server as long as adequate memory
is allocated for each instance and as long as each OFSAAI installation is installed using a separate UNIX user and
profile. Care should be taken if running multiple OFSAAI installations on a single server. Adequate memory will be
required for each installation as several OFSAAI processes (model upload, DEFQ services, etc) take significant amounts

of memory. So it depends on your server memory.
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Is it possible to Install OFSAA 8.0 Application pack on any one of the existing 'Infodom' where another OFSAA 8.0
application is installed?

Yes. However, the Behavioral Detection Application Pack and Compliance Regulatory Reporting Application Pack are
the exceptions. They need to be installed in a different INFODOM.
Can | select an Infodom in Application pack during installation?

Yes. You can select or change the required infodom.

Can | install all Application Packs in a 'Single Infodom'?
Yes. But Behavioral Detection Application Pack and Compliance Regulatory Reporting Application Pack are the
exceptions. They need to be installed in a different INFODOM.
Is it possible to install applications on different Infodom within the Application pack? (That is if you want to install LRM &
MR in two infodoms)

Applications within application pack have to be installed in the same information domain in the same environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0?

You can install only one infodom during installation. But after installation, you can create multiple infodoms.

Does 'Data Model' bundled is Application pack Specific or Specific to individual application?

A merged data model for all applications within the application pack is bundled and uploaded.

Is it possible to install OFS Enterprise Modeling in later point of time?
OFS Enterprise Modeling is a separate product and can be enabled as an option later from any application pack that
bundles Enterprise Modeling.

Does Application pack create sandbox automatically for the required applications?

Yes, Sandbox creation is part of application install process.

Are upgrade Kits available for individual applications or the complete Application Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all applications.

Can | upgrade AAl only?

Yes, you can upgrade AAl alone.
Can | upgrade one application within the Application Pack? (For example, | want to upgrade LRM in the Treasury Applica-
tion pack, but not MR.)

No. Not possible Upgrade is applied across packs.

Is it possible to uninstall any Application from the Application pack?

No, it is not possible to uninstall any Application from the Application Pack.

Can | uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAl in the installed environment?

No, you cannot uninstall only the application and retain AAl in the installed environment.

Oracle Financial Services Profitability Management Application Pack Installation Guide 105



Frequently Asked Questions
Chapter 7—FAQs and Error Dictionary

Can | uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAl in the installed environment?

No, you cannot uninstall only the application and retain AAl in the installed environment.

Does Application Pack contain all Language Packs supported?

Language Packs need to be installed on 8.0 application packs.

Can Il install an Application Pack over another Application Pack (that is same infodom or different infodom)?

Yes, you can install an Application Pack over another Application Pack in the same information domain or different
information domain. But Behavioural Detection Application Pack and Compliance Regulatory Reporting Application
Pack, Asset Liability Management Application Pack and Profitability Application Pack are the exceptions. They need to
be installed in a different INFODOM.

Can | use an existing manually created schema as information domain for application pack installation?

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 supports oracle 12¢ with some

additional configurations. Refer the link

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCAG55 for additional configurations.
What should I do if | get the following error message while running the schema creator utility, "HostName in input xml is
not matching with the local hostname"?

One possible reason could be the machine is configured for zonal partitioning. Ensure all the known IP Addresses of
the machine are present in the /etc/hosts file.
What are the Java versions supported in OFS PFT Application Pack version 8.0.2.0.0?

OFS PFT Application Pack supports 1.7.x and 1.8.x.

Is this release of the OFS PFT Application Pack version 8.0.2.0.0 supported on Java 8?

Yes. To install this release of the OFS PFT Application Pack version 8.0.2.0.0 on Java 8. For more information, refer to
specific notes mentioned in the sections Installer and Installation Prerequisites

Configurations supported for Java 8. Configuring the Schema Creator Utility, GUI Mode Installation, SILENT Mode
Installation.

What should | do when I get "[ERROR] - Error : APP Setup bin file failed." message during OFS_Application_PACK installa-
tion?

This is a generic error message that appears during application installation failure. You should check the installation
log files for more information about what failed the installation.

However, if the message is displayed and the log files are not generated, it could be that it is a temp directory issue.
The resolution is that your UNIX administrator has to disable the NOEXEC option. The installers extract the installation
files into the /tmp directory, and if NOEXEC is enabled, execution of binaries will not happen in the directory and the
installation fails. Re-run the installer after the configuration is changed. For detailed information, see the support
note at

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.
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Forms Framework FAQs

What should | do when | have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large volume of data.

How do I export the columns added to the grid by Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field Chooser option.

'Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What should | do?

Expand All/ Collapse All button is enabled only if the number of hierarchy nodes is less than 50. If it is more than that,
it is considered as large hierarchy and the data will be fetched dynamically when you expand each node.

Error Dictionary

This contents of this section has been created with the interest to help you resolve the installation issues if any. There is a
compilation of all the possible errors that might arise during the installation process with the possible cause and the
resolution to quickly fix the issue and proceed further with the installation.

This section includes the following topics:
©® Accessing Error Dictionary

® Error Code Dictionary
Accessing Error Dictionary

Instead of scrolling through the document to find the error code, you can use the pdf search functionality. In the "Find"
dialog available in any of the Adobe Acrobat version that you are using to view the pdf document, follow the below
instructions to quickly find the error resolution.

1.  With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on screen during Infrastructure installation.

4. Press Enter. The search results are displayed and highlighted as indicated below.

View the details of the issues, its cause, and resolution specific to the error code. Repeat the step to find an answer to any

other errors that you notice during installation. If you are not able to resolve the issue even after following the steps pro-
vided in resolution, you can contact support.oracle.com along with log files and appropriate screen shots.
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Error Code Dictionary

Error Code Cause Resolution

OFSAAI-1001 Unix shell is not "korn" shell. Change the shell type to "korn". Use chsh unix
command to change SHELL type.

Shell type can also be changed by specifying shell
path for the Unix user in /etc/passwd file.
Note: chsh command is not available in Solaris OS.

OFSAAI-1002 No proper arguments are available. Provide proper arguments. Invoke Setup.sh using
either SILENT or GUI mode.

Example: ./Setup.sh SILENT or ./Setup.sh GUI

OFSAAI-1004 File .profile is not present in Create .profile in SHOME, i.e. in the home directory

SHOME. of user.

OFSAAI-1005 File OFSAAInfrastructure.bin is not Copy OFSAAInfrastructure.bin into installation kit

present in current folder. directory.

OFSAAI-1006 File CustReg.DAT is not present in Copy CustReg.DAT into installation kit directory.

current folder.

OFSAAI-1007 File OFSAAI_InstallConfig.xml is not Copy OFSAAI_InstallConfig.xml into installation kit

present in current folder. directory.

OFSAAI-1008 File validateXMLInputs.jar is not Copy validateXMLInputs.jar into installation kit

present in current folder. directory.

OFSAAI-1009 File log4j.xml is not present in Copy log4j.xml into installation kit directory.

current folder.

OFSAAI-1010 Unknown error occurred. Make sure to provide proper argument (SILENT or
GUI) to the Setup.sh file.

OFSAAI-1011 XML validation failed. Check InfrastructurePreValidations.Log for more
details.

OFSAAI-1012 Property file with locale name does Copy MyResources_en_US.properties to the setup

not exist. kit directory and keep en_US in LOCALE tag of
OFSAAI_InstallConfig.xml.
OFSAAI-1013 File Copy
OFSAAI_InstallConfig.xmIl/OFSAAI_P | OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.
ostInstallConfig.xml not found. xml to the setup kit directory.

OFSAAI-1014 XML node value is blank. Make sure all node values except SMTPSERVER,
PROXYHOST, PROXYPORT, PROXYUSERNAME,
PROXYPASSWORD, NONPROXYHOST, or RAC_URL
are not blank.

OFSAAI-1015 XML is not well formed. Execute the command dos2unix
OFSAAI_InstallConfig.xml to convert plain text file
from DOS/MAC format to UNIX format.

OR
Make sure that OFSAAI_InstallConfig.xml is valid. Try
to open the file through Internet Explorer for a quick
way to check validity. If it is not getting opened,
create new OFSAAI_InstallConfig.xml using the
XML_Utility.jar.
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OFSAAI-1016 User installation directory contain Provide an installation path that does not contain
blank spaces. spaces. Check the tag USER_INSTALL_DIR in

OFSAAI_InstallConfig.xml file. This path should not
contain any spaces.

OFSAAI-1017 User installation directory is invalid. | Provide a valid installation path. Check if you are
able to create the directory mentioned in
USER_INSTALL_DIR tag value of
OFSAAI_InstallConfig.xml file.
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APPENDIX A Installation of R and Oracle R
Enterprise (ORE)

This is an optional step and required only if you intend to use Term Structure Parameter Estimation functionality under
Rate Management - Interest Rates, for computing term structure parameters. Both Funds Transfer Pricing and Asset
Liability Management applications require term structure parameters for all monte carlo engine based calculations (OAS,
VaR and EaR).

Following are the prerequisites:
® Install R and Oracle R Enterprise Server on the Oracle Database server. Refer to
https://docs.oracle.com/cd/E57012_01/doc.141/e57007.pdf

® ORE version supported - Oracle R Enterprise (Server) version 1.4.1
Configuration for Oracle R Enterprise

Grant the RQADMIN role to atomic schema.

You can grant the rgadmin role in SQL*Plus by logging in to the database with DBA privileges and provide the following
privilege to Atomic Schema:

ROADMIN by executing the command:
GRANT RQADMIN TO < atomic_schema>;
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APPENDIX B FTP Web Service Conﬁguration

The following installation activity describes how to setup FTP web services to support the Breakage Charge Economic Loss
calculation. The calculation logic is the same as the FTP Adjustment Rule Breakage Charge calculation. This FTP Economic
Loss WebService is now independent of EXEWebService. Note, other FTP web services are installed automatically and
require no further setup.

Approach

The FTP Web services are designed as a wrapper which will call the FTP Engine for the calculation of Economic Loss. The
FTP Web Service is available in its own context and has a specific WSDL for that context.

Architecture
FTP Web Service W?b Service ;
Client
libbcservices.so
RDBMS cpp
library
Prerequisites

® For Weblogic and WebSphere, Datasource should be present with JNDI name as jdbc/FTPWS.

® For Tomcat a separate context entry should be present in server.xml file.
Log4j configuration

log4j.properties file is already present inside WEB-INF/classed folder of the war file. Logs will be generated inside
Sroot_directory_of war/logs/webservice.log file.
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Setup Environment variable - ofsaaws.properties

ofsaaws.properties file is available in WEB-INF/classes folder. Specify the cpp_component name. Place the
component libbcservices. so under fficdb/lib/libFSGBU. Add the library location to LD LIBRARY PATH.

Note: If Webservices are deployed in an environment other than where OFSAA is deployed, then copy
/ficdb/lib/libFSGBU to webservices environment and set in LIBRARY path.

B cpp_component= libbcservices.so(libbcservices.o) - for AIX
B cpp_component=bcservices - for Solaris

B cpp_component=bcservices - for Linux
Creating FTPWebServiceAXIS.war

1. Go to the server path in which the application is running.

For Example: SFIC_HOME/FTPWebService

2. Run"ant.sh" in this folder. FTPWebServiceAXIS.war will be created in the same folder.

Deploying FTPWebServiceAXIS.war

For Tomcat:

1. Copy the above WAR file to the webapps folder of apache tomcat directory.

2. Go to conf folder of apache tomcat and add a separate context entry in server.xml file with resource name as
jdbc/FTPWS.
Example:

<Context path="/FTPWebServiceAXIS" docBase="/<Tomcat webapps> /FTPWebServiceAXIS"
debug="0" reloadable="false" crossContext="true">

<Resource auth="Container"
name="jdbc/FTPWS"
type="javax.sqgl.DataSource
driverClassName="oracle.jdbc.driver.OracleDriver
username="username"
password="password" url="jdbc:oracle:thin:Q@db-ip:dp-port:dbname"
maxActive="100"
maxIdle="30"
maxWait="10000"
removeAbandoned="true"
removeAbandonedTimeout="60"
logAbandoned="true"/>

</Context>

3. Restart the server.
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For Weblogic and Websphere:

1. Deploy FTPWlebServiceAXIS.war from admin console.

2. Create datasource for database connection with JNDI name as jdbc/FTPWS.

3. WSDLis present at following URL.
http://ipaddress:port/FTPWebServiceAXIS/services/OFSAAFTPService ?wsdl
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APPENDIX C Conﬁguring Web Server

This appendix includes the following sections:
® Configuring Web Server
® Configuring Web Application Server

Configuring Web Server

This step assumes an installation of a Web Server exists as per the prerequisites.

Refer the product specific Installation Guide/ Configuration Guide to install/ configure the Web Server. If an installation
already exists, skip and proceed to the next step.

Note: Make a note of the IP Address/ Hostname and Port of the web server. This information is required
during the installation process.

See Oracle Financial Services Analytical Applications Infrastructure Security Guide mentioned in the
Documentation Library for OFSAAI 8.0.2.0.0 (OTN), for additional information on securely configuring your
Web Server.

Ensure to enable sticky session/ affinity session configuration on the web server. Refer the respective
product specific Configuration Guide for more details. Additionally, you also need to enable the sticky
session/ affinity session configuration at Load Balancer level if you have configured a Load Balancer in front
of the web server(s).
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Configuring Web Application Server

This step assumes an installation of a web application server exists as per the prerequisites. To configure the Web
Application Server for OFSAA Deployment refer the sections below.

This section includes the following topics:
® Configuring WebSphere Application Server for Application Deployment
® Configuring WebLogic for Application Deployment

® Configuring Apache Tomcat Server for Application Deployment

Note: Make a note of the IP Address/ Hostname and Port of the web application server. This information is
required during the installation process (required if Web Server is not configured).

Add umask 0027 in the .profile of the UNIX account which manages the WEB server to ensure restricted
access permissions.

Refer OFSAA Secure Configuration Guide/ Security Guide for additional information on securely configuring
your Web Server.

Configuring WebSphere Application Server for Application Deployment

You can deploy multiple OFSAA applications on different profiles of a WebSphere application server. To create multiple
WebSphere "Profiles" in a stand-alone server, use the command line option as explained below. A profile is the set of files
that define the runtime environment. At least one profile must exist to run WebSphere Application Server.

This section includes the following topics:

Creation of New Profile in WebSphere

Manage Applications in WebSphere

Configuring WebSphere Application Server to Use a Load Balancer or Proxy Server
Delete WebSphere Profiles

WebSphere HTTPS Configuration

® & & 6 & ©

WebSphere Memory Settings

Creation of New Profile in WebSphere

The Profile is created in WebSphere through command line using the manageprofiles.sh which resides in <WebSphere
Install directory>/AppServer/bin folder.

The command to create a profile without admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile path>
-templatePath <template path> -nodeName <node name> -cellName <cell name> -hostName
<host name>"

Example:
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Susr/home>./manageprofiles.sh -create -profileName mockaix
-profilePath/websphere/webs64/Appserver/profiles/mockaix
-templatePath/websphere/webs64/Appserver/profileTemplates/default -nodeName
ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName ipa020dor
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The command to create a profile with admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile path>
-templatePath <template path> -nodeName <node name> -cellName <cell name> -hostName
<host name> -enableAdminSecurity true -adminUserName <Admin User Name> -adminPassword <

Admin User Password> -samplespassword <sample User Password>"

Example:

Susr/home>./manageprofiles.sh -create -profileName mockaix
-profilePath/websphere/webs64/Appserver/profiles/mockaix
-templatePath/websphere/webs64/Appserver/profileTemplates/default -nodeName
ipa020dorNode04 -cellName ipa020dorNode(04Cell -hostName ipa020dor -enableAdminSecurity
true -adminUserName ofsaai -adminPassword ofsaai -samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a New Profile in WebSphere, you can also use
"-validatePorts" to validate if the specified ports are not reserved or in use. Additionally, you can specify
new ports with "-startingPort <base port>" which specifies the starting port number to generate and assign
all ports for the profile. For more information on using these ports, refer WebSphere manageprofiles

command.

Manage Applications in WebSphere

To manage the installed applications in WebSphere, do the following:

1.  Open the administrator console using the following URL:
http://<ipaddress>:<Administrative Console Port>/ibm/console

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled)

Note: Administrative Console Port value is available in serverindex.xml file within <WebSphere Profile
Directory>/config/cells/<Node Cell>/nodes/<Node Name> directory.

The Integrated Solutions Console Login window is displayed.
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Integrated Solutions Console

Log in to the console.
Uiar 1D

upgsTa
Fasyword:

Log in |

Figure 2: Integrated Solutions Console Login
2. Log on with the User ID provided with the admin rights.
3. From the LHS menu, expand the Applications > Application Type> WebSphere Enterprise Applications.

The Enterprise Applications screen is displayed.

Enterprise Applications

Uis Bl Sage be massss iAitalled spsbiatisai. & plagle aoslcatisa tan Be deslered sats multiple garvas

B Frafarances
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You cun sdminkiter the folloving rescurces:

0 Oafghtiscliogban o
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[] | s -+
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Total 4

Figure 3: Enterprise Applications

4. This Enterprise Applications screen helps you to:
® Install new application
m  Uninstall existing applications

B Start or Stop the installed applications
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Configuring WebSphere Application Server to Use a Load Balancer or Proxy Server

The configuration prevents the process server from redirecting to an internal port when using a load balancer or proxy

server.
The following steps describe the configuration:

1. Enter the WebSphere URL in the format

http://HOST_NAME:PORT_NUMBER/ibm/console (use https if SSL is enabled.).

For example, http://192.168.1.0:9000/ibm/console.
2. Login with your administrator user ID and password.

3.  From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere Enterprise Application Servers to view the

Application servers window.

5. On Application servers window, click the required Application Server link. For example, serverl in the following

illustration:

Application servers

&Eplir ation servers > serverl > Web container > Custom properties

internal system configuration properties.

% Preferences

N.cl.\....l Delete
= w el
Select MName Value

You can administer the followng resources:

com.ibm.ws.webcontainerextractHostHeaderPort true
frusthostheaderport true

Taotal 2

Use this page to specify an arbitrary name and value pair. The value that is specfied for the name and value pair is a string that can set

Descrption 2

6. Click Web Container Settings > Custom Properties.
7. Add the following properties:
®  Name: trusthostheaderport
Value: true
®  Name: com.ibm.ws.webcontainer.extractHostHeaderPort

Value: true
8. Restart the WebSphere Application Server to apply the changes.

Delete WebSphere Profiles
To delete a WebSphere profile, do the following:

1. Select the check box adjacent to the required application and click Stop.

2. Stop the WebSphere profile to be deleted.
3. Navigate to WebSphere directory:
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<WebSphere_Installation_Directory>/AppServer/bin/
Execute the command:

manageprofiles.sh -delete -profileName <profile name>

Delete profile folder.

Example: <WebSphere_Installation_Directory>/AppServer/profiles/<profile_name>

Execute the command:

manageprofiles.sh -validateAndUpdateRegistry

WebSphere HTTPS Configuration

Following are the steps for configuring an HTTPS Transport on WebSphere:

1.
2.

Create a profile using the Profile Creation Wizard in WebSphere.

Note down the https port specified during this process and use the same as servlet port or web server port during
OFSAAl installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for
SILENT mode OFSAAl installation.

WebSphere Memory Settings

To configure the WebSphere Memory Settings:

1.

Navigate to Websphere applications server > Application servers > serverl > Process definition > Java Virtual
Machine.

Change the memory setting for Java Heap:
Initial heap size = 512

Maximum heap size = 3072
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Configuring WebLogic for Application Deployment

You can deploy multiple Infrastructure applications on different domains of a stand-alone weblogic application server. To
create multiple WebLogic "Domains" in a stand-alone server you can use the Domain Creation wizard. A domain is the set
of files that define the runtime environment. At least one domain must exist to run WebLogic Application Server.

Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install patch
18729264.

This section includes the following topics:
® Creating Domain in WebLogic Server
® Delete Domain in WebLogic
® Weblogic Memory Settings

Creating Domain in WebLogic Server

To create a new domain using Configuration Wizard in WebLogic, do the following:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the command:
./config.sh

The Welcome window of the Configuration Wizard is displayed.

) Fusion Middieware Configuratien Wizard AEE I

Welcome

ORACLE

& Create a new WebLogic demain

Croabe 8 WebLogis domiin i your projects directory

) Extend an existing WebLogic domain

L T 0o B0 @dd néw COMDONEnts by & ediSng Soman ahd modsy configuriton SeRngs

Figure 4: Welcome
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2. Select Create a new WeblLogic domain option and click Next.

The Select Domain Source window is displayed.

I Fusion Middinwara Configuration Wirard BEE
Select Domain Source )
ORACLE
® Generate a domain configured automatically to suppon the following products:
1 Bawe this domain on an existing templaie
Est Hep frevous | | ped

Figure 5: Select Domain Source

3. Select the Generate a domain configured automatically to support the following products option and click Next.

The Specify Domain Name and Location window is displayed.

[ Fusion Middieware Configuration Wizard BEE
Specify Demain Mame and Location
ORACLE
Enter the name and lacation for the domain:
Domanname | WockSol
Doy icomtitn’s | Mwrisbloiet vl t 0 Sbeuser_prowsctiidonars BEirals
e || o reves

Figure 6: Specify Domain Name and Location
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4. Enter the Domain Name and . Click Browse to navigate and specify the location. Click Next.

The Configure Administrator Username and Password window is displayed.

n Fusion Middleware Configuration Wicard H.m
Configure Administrator User Name and Password .
OoORACLE
. [esgard Changes
Lk P Le g
Siser passwerd | Mesees
SoorTEm ey paliweod | Seeees q
Deacwiplion Thais uimer i3 e de faull. sairmend sir sbor
Ext [ previus | [ vt |

Figure 7: Configure Administrator Username and Password

5. Enter the User name and User password to be assigned to the Administrator. Ensure that the password is of minimum

8 characters in length.

6. Re-enter the password for confirmation and add a brief Description. Click Next.

The Configure Server Start Mode and JDK window is displayed.

n Fushon biddiewars Comliguration Wirard -H |

Configure Server Start Mode and JOHK

ORACLE

|Berfone pulSing your domsin ndo production, makes Ture Bhat the production efvironiment it ssours. For mons informalion, bes the lopc Seouring
Production Ervancrmant” in tha VWeblLogc Server dooumentaion

To use WisbLogc JRockt in production, Oracis recommends dervelopng and besting wour spploations with WsbiLogec JRockt sarty in ihe proect Cycie
For inifosrrsstion sboul Vsl oo JRoCKE, ses the WisbLogc JRoCkE documssntalion

WiebLoic Domain Startup Mode | J Sedection |
=) Dewelopment Mode () Apailatile MK
L oot progsertes Sor unamiame nnd S SO8C 16,018 o usriekd 6.0_18:

Ext
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Figure 8: Configure Server Start Mode and JDK
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7. Select the following options:

In the WebLogic Domain Startup Mode section, select the required mode (Development Mode or Production Mode).
In the JDK Selection section, select Other JDK. Click Browse and navigate to the JDK location. Click Next.

The Select Optional Configuration window is displayed.

) Fusben biddieware Configuration Wizard - | £

Select Optional Configuration
ORACLE

5 Administs stion Serve
Mty Sttt

] Managed Server s, Custers and Machires
Al ow Db
Ay Sl

L] ADBMS Secuify Shone
Moty Seftings

Ext beie Erevicas - )

Figure 9: Select Optional Configuration

8. Select Administration Server. A Weblogic Server domain must have an Administration Server. You can also select
Manages Servers, Clusters and Machines and RDBMS Security Store if required. Click Next.

The Configure the Administration Server window is displayed.
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n Fusion Middieware Configuration Wizrard = X
Configure the Administration Server
ORACLE
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Figure 10 Configure the Administration Server

9. Enter Administration Server details such as the Name, Listen address, Listen Port, SSL listen port, and SSL enabled (for
secure login using https) check box. Click Next.

The Configuration Summary window is displayed.

Note: Make a note of the Listen Port or SSL Listen Port value (ex: 7007), since the same has to be re-entered
in the Servlet port field during Infrastructure installation.
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Figure 11: Configure Server Start Mode and JDK

10. Verify the configuration details of the WebLogic domain and click Create.

11. The Creating Domain window is displayed with the status indication of the domain creation process.

n Fusion Middeware Conliguration Wizard

Creating Demain

ORACLE

Diornain Looation o Ligh
Agman Sarver URL itp MpaBBrev 7007

Figure 12: Configure Server Start Mode and JDK
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12. Click Done when complete. The domain server is created enabling the deployment of multiple Infrastructure
applications on a single WeblLogic.

Note: Note down the HTTPS port specified during this process and use the same as servlet port or web
server port during OFSAAI Installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in
OFSAAI_InstallConfig.xml for silent mode OFSAAI installation

13. Add a java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ "setDomainEnv.sh" file
(Required only if self signed certificate is used).

Delete Domain in WebLogic
1. Navigate to the following directory:

<WebLogic Installation directory>/user_projects/domains/<domain name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.

3. Delete the Weblogic domain.

WebLogic Memory Settings

To configure the WebLogic Memory Settings:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072min setDomainEnv. sh file, which resides in the
folder <DOMAIN_HOME>/bin and in CommEnv . sh file which resides in the folder common/bin.

2. Edit this file for customizing memory settings and garbage collector settings depending on the available hardware

configuration.

Example 1:
if [ "${JAVA VENDOR}" = "Sun" ] ; then
WLS MEM ARGS 64BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 64BIT
WLS MEM ARGS 32BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 32BIT
else
WLS_MEM ARGS 64BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 64BIT
WLS_MEM ARGS 32BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 32BIT

Example 2:
JAVA VM=
MEM ARGS="-Xms256m -Xmx1024m"
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Configuring Apache Tomcat Server for Application Deployment

This section is applicable only when the Web Application Server type is Tomcat.
This section includes the following topics:

Tomcat User Administration

Configure Tomcat to use JAVA 64 bit Executables

Configure Servlet Port

SSL Port Configuration

Apache Tomcat Memory Settings

Uninstalling WAR Files in Tomcat

® 6 6 & & & ©

Configuration for Axis API

Tomcat User Administration

The Tomcat administration and manager application does not provide a default login. You are required to edit
"$CATALINA HOME/conf/tomcat-users.xml" asinstructed below.

This file contains an XML tag <user> for each individual user, which will display the username and password used by admin
to log on to Tomcat, and the role names to which the admin user is associated with. For example, <user name="admin"
password="admin" roles="standard-manager " />

1. Add the manager role to any one of the existing username/password combination as shown in the example above.

2. Use the same username/password to which the manager role has been assigned to access the Tomcat Application
Manager.

3. If the Tomcat server is already running, it requires a re-start after the above configuration is done.

Configure Tomcat to use JAVA 64 bit Executables

1. Navigate to the "SCATALINA_HOME/bin" folder.

2. Edit the setclasspath.sh as explained below:

3. Replace the following block of text:
# Set standard commands for invoking Java.
_RUNJAVA="$JRE HOME"/bin/java
if [ "$0s400" != "true" ]; then
_RUNJDB="$JAVA HOME"/bin/jdb

With:

# Set standard commands for invoking Java.
_RUNJAVA="$JAVA BIN"/java
if [ "$0s400" != "true" ]; then
_RUNJDB="SJAVA_BIN"/jdb

4. If the Tomcat server is already running, it requires a re-start after the above configuration is done.
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Note: In case tomcat is installed under different Unix profile, set JAVA_BIN environment variable in
.profile to include the Java Runtime Environment absolute path.

For example:

export JAVA BIN /usr/java6_64/jre/bin
export JAVA BIN = /usr/java6_64/jre/bin//sparcv9 for Solaris Sparc.

Configure Servlet Port

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if you need to use the default
port.

If you need to use a different port number, you must first configure the port in the "server.xml1" in the "conf" directory
of Tomcat Installation directory. The following steps guide you through the configuration process:

1. Navigate to SCATALINA_HOME/conf. Open server.xml and locate the tag:

"Define a non-SSL HTTP/1.1 Connector on port 8080 "

2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to the new port number that will
be used during the installation process.

3. Save your changes in "server.xml".

Note: Make a note of the servlet port configured. This information is required during the installation of
OFSAA Application Pack.

SSL Port Configuration

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the following connect tag under
"Define a SSL HTTP/1/1 Connector on port 8443"in "<Tomcat_installation_folder>/conf/server.xml" file is
uncommented for SSL Configuration. (By default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note: Make a note of the servlet port configured. This information would be required during the
installation of OFSAA Application Pack. To enable https configuration on Infrastructure, assign value 1 to
"HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for SILENT mode OFSAAI installation.

For more information related to SSL Configuration on Tomcat, refer to http://tomcat.apache.org/.
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Apache Tomcat Memory Settings

To configure the Apache Tomcat Memory Settings:
1. Locate the file catalina.sh which resides in the folder <CATALINA_HOME>/bin.

2. Edit this file for customizing the memory settings and garbage collector settings depending on the available hardware
configuration.

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

Example:
if [ -z "SLOGGING MANAGER" ]; then
JAVA OPTS="S$SJAVA OPTS -Xms512m -Xmx1024m
-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"
else
JAVA OPTS="S$SJAVA OPTS -Xms512m -Xmx1024m SLOGGING MANAGER"
Fi

Uninstalling WAR Files in Tomcat

To uninstall WAR files in tomcat, see Uninstalling WAR Files in Tomcat.

Configuration for Axis API

This step is optional and required only if the web application server used in Apache Tomcat. If you use any other web
application server, skip and proceed to next step.

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_4/webapps/axis/WEB-INF/lib and place it in under
<Tomcat Installation Directory>/lib and restart the Tomcat Server.
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APPENDIX D RPD/ Catalog Deployment, D3
and Map View Configuration for
OBIEE 11g

This appendix covers the following sections:
® Deploying Profitability Pack Dashboards and Analytics
® Deploying D3 to Entitlement Server for OBIEE 11g

® Mapview Configuration
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Deploying Profitability Pack Dashboards and Analytics

This section covers the following topics:

® Installing OBIEE Server

® Installing OBIEE Windows Administration Client

® Deploying Profitability Pack Report Analytics

® Deploying EFPA/ IPA/ RPA Application Report Analytics

Installing OBIEE Server

To install Oracle Business Intelligence Enterprise Edition (OBIEE) server, refer to Oracle Fusion Middleware Installation
Guide for Oracle Business Intelligencellg Release 1 (11.1.1). After installing Oracle Business Intelligence Enterprise Edition
(OBIEE) server, get the Enterprise Manager URL, username, password, and OBIEE installed directory from the System
Administrator.

Note: Once the OBIEE server is installed, it should be upgraded to the version as mentioned in the
Environment section.

Installing OBIEE Windows Administration Client

To install OBIEE repository administration client for Windows machine, refer to Oracle® Fusion Middleware Installation
Guide for Oracle Business Intelligencellg Release 1 (11.1.1).

Deploying Profitability Pack Report Analytics

To deploy Analytic Reports, follow these steps:
1. Stop Oracle Process Manager and Notification Server (OPMN) services by executing the following command:

<OBIEE Installed Directory>/instances/instancel/bin./opmnctl stopall

2. Copy OFS_PFT PACK.rpd from SFIC_HOME/OFSPFTPACKBI/OBIEE/11.1.1.9.5/ of Web layer to windows machine
where the OBIEE windows administration client is installed.

3. To change the default password for the repository, follow these steps:

a. Open the repository using OBIEE Windows administration client.
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Figure 1: OBIEE Windows Administration Client to Open Repository
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Figure 2: OBIEE Windows Administration Client to Select Repository from Windows Machine
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b. Enter default repository password as Admin123.

File Tools Help
Dewwe@d Lan@2adEaqhBk|®
/

e (o |
=

Iooooooool Cancel

_ Heb |

]

For Help, press F1 NUM A

Figure 3: OBIEE windows Administration Client to enter Repository Default Password

c. Click File menu, select Change Password.
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Figure 4: OBIEE Windows Administration Client to Change the Password of Repository

4.

Enter the new password and click OK.

[ [NuM[ 4

5. To configure connection pool of repository, follow these steps:

a. Inthe physical section, expand ‘Customer Insight Database' folder.
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Figure 5: OBIEE Windows Administration Client to Open Connection Pool Window
b. Double-click Customer Insight Connection Pool to open the Connection Pool Properties window.
c. Enter the following in Data Source Name text box of Connection Pool Properties window after modifying

<Database Server Host Name> and <Database Name>

(DESCRIPTION= (ADDRESS= (PROTOCOL=TCP) (HOST=<Database Server
HostName>) (PORT=1521)) (CONNECT DATA= (SERVER=DEDICATED) (SERVICE NAME=<Database
Name>) ) )

d. Enter atomic schema user in User name text box.
e. Enter atomic schema user password in Password text box.
f.  Click OK.
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Figure 6: OBIEE Windows Administration Client to modify Connection Pool variables
g. Double-click 'Customer Insight Connection Pool (Init Block)' to open the Connection Pool window (Figure 8).

h. Enter the following in Data Source Name text box of Connection Pool-VAR_CONN_POOL properties window after
modifying
<Database Server Host Name> and <Database Name>
(DESCRIPTION= (ADDRESS= (PROTOCOL=TCP) (HOST=<Database Server Host
Name>) (PORT=1521)) (CONNECT_ DATA= (SERVER=DEDICATED) (SERVICE NAME=<Databa
se Name>)))
i.  Enter atomic schema user in User name text box.
j.  Enter atomic schema password in Password text box.
k. Click OK.
6. To configure connection pool for EFPA, modify 'OFSEFPA Connection Pool' and 'OFSEFPA Init Block' connection pool
and set the property which is inside of 'EFPA' folder in the physical section.

7. Click File menu and then click Save.
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Figure 7: OBIEE Windows Administration Client to modify Connection Pool-VAR_CONN_POOL variables

8. Click Yes on the pop-up message Do you want to check global consistency?

Figure 8: OBIEE Windows Administration Client with global consistency checking message

142 Oracle Financial Services Profitability Management Application Pack Installation Guide



Appendix D—RPD/ Catalog Deployment, D3 and Map View Configuration for OBIEE 11g

9. Click OK, on the pop-up message Consistency check didn't find any errors, warning or best practices violations.

Note: Warnings on consistency check can be ignored.

~
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Figure 9: OBIEE Windows Administration Client with global consistency checking message

List of Warning Messages:

Business Model Financial Reporting:
[39090] Logical column "Financial Reporting"."Dim - Reporting Period"."Month" has invalid Sort Order column
‘Month Sort'.

Business Model Management Reporting:

[39090] Logical column "Management Reporting"."Dim - Reporting Period"."Year" has invalid Sort Order column 'Year
Calendar'.
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GLOBAL:

[39092] Presentation level "Retail Performance".."Branch"."Branch Hierarchy"."Region" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance".."Time"."Time Hierarchy"."Year" is first under presentation hierarchy,
but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance".."Product"."Product Hierarchy"."Leve20" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time_Hierarchy_Month"."Month" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy Year_Month"."Year" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time_Hierarchy_Month"."Month" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Month"."Month" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Year_Month"."Year" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet".."Reporting Period"."Time_Hierarchy_Month"."Month" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Institutional Performance".."Time"."Time Hierarchy"."Year" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time Hierarchy"."Year" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet".."Reporting Period"."Time Hierarchy"."Year" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."Account"."Account"."Gen2,Account" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."Period"."Period"."Gen2,Period" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."Years"."Years"."Gen2 Years" is first under presentation hierarchy,
but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."Scenario"."Scenario"."Gen2,Scenario" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."Entity"."Entity"."Gen2,Entity" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."Version"."Version"."Gen2,Version" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."Strategy"."Strategy"."Gen2,Strategy" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.
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[39092] Presentation level "Balance Sheet Planing".."Chart of Account"."Chart of Account"."Gen2,Chart of Account"
is first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."AttributeValue"."AttributeValue"."Gen2,AttributeValue" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."Currency"."Currency"."Gen2,Currency" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.
[39092] Presentation level "Balance Sheet Planing".."Intercompany Entity Flag"."Intercompany Entity

Flag"."Gen2,Intercompany Entity Flag" is first under presentation hierarchy, but logical level it is associated with is not
grand total level.

[39092] Presentation level "Balance Sheet Planing".."AssetClass"."AssetClass"."Gen2,AssetClass" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."COA type"."COA type"."Gen2,COA type" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet

Planing".."DelinquenciesExp"."DelinquenciesExp"."Gen2,DelinquenciesExp" is first under presentation hierarchy, but
logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."Fee Classification"."Fee Classification"."Gen2,Fee
Classification" is first under presentation hierarchy, but logical level it is associated with is not grand total level.
[39092] Presentation level "Balance Sheet Planing".."Intercompany COA Flag"."Intercompany COA

Flag"."Gen2,Intercompany COA Flag" is first under presentation hierarchy, but logical level it is associated with is not
grand total level.

[39092] Presentation level "Balance Sheet Planing".."Sample COA"."Sample COA"."Gen2,Sample COA" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planing".."curr_attrib"."curr_attrib"."Gen2,curr_attrib" is first under
presentation hierarchy, but logical level it is associated with is not grand total level

[39092] Presentation level "Institutional Performance".."Segment"."Segment Hierarchy"."Type" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.
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Deploying EFPA/ IPA/ RPA Application Report Analytics

Use the following procedure to deploy the EFPA/ IPA/ RPA applications report analytics:

Note: Ensure that Oracle Business Intelligence 11.1.1.9.5 is available.

1. Set the <Oracle Bl Instance Home> directory> =>.\

For example: /u01/OBIEE11G/instances/instancel
2. Start Weblogic AdminServer.
a. Set the < Bl Domain Home> directory> => e.g. /u01/OBIEE11G/user_projects/domains/bifoundation_domain.
b. Navigate to < Bl Domain Home >/bin and run
'nohup ./startWebLogic.sh &'

c. Bringing up this service may take a few minutes depending on your environment. Check the logs using the
command 'tail -f nohup.out'

3. Start Node Manager.
a. Setthe < WebLogic Server Home > directory> => e.g. /u01/0OBIEE11G/wiserver_10.3.
b. Navigate to <WebLogic Server Home>/server/bin and run

'nohup ./startNodeManager.sh &'.
4. Start Weblogic Managed Server(bi_server1).

a. Login onto http://localhost:7001/console using your Administrator credentials created during platform install
(Replace the hostname based on your setup).

b. Under Environment block (mid of page, towards left side), click on Servers link.

Domain Structure
bifoundation_domain

r=-Migratable Targats

““Machines

~-Work Managers

--Startup & Shutdown Classes
,.mm

B -Services

- Security Realms

- Interoperabiity
%

c. The bi_serverl line should show as shutdown state at this point.

[] | server s Machine State Status of Last Action
O |adminserver(admin] laliv-lap RUNNING Mone

"] |bi_server alivdap H i i |

1 |bi 1 liv -1 SHUTCOWN TASK COMPLETED
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d. Click on control page tab.

Summary of Servers

Configuration - Control

e. Select the bi_serverl line by clicking on the left tick box.

f.  Click start button at the top of the list and confirm starting this service.

Servers (Filtered - More Columns Exist)

Start || Resume || Suspend™ | | Shutdown * | | Restar S5L

[ | server % Machine State
[] | AdminServer{admin) lalv-lap RUMNING
bi_serverl lalivap SHUTDOWH

[ start 1| Resume | | Suspena~ | | snutdown v | | Restar S50

g. State will update to "RUNNING" mode after a few minutes.
5. Start BIEE services and login.

Starting services From EM screen:

a. Login to the EM administration screen using the url http://localhost:7001/em (Replace the hostname and port
number based on your setup). Use the login you created in BIEE installation to log in.

b. Expand 'Business Intelligence' node on the left and choose Coreapplication.

- 5% Farm_bifoundation_domain
F 3 Apolication Deployments
® [ weblogic Domain
= [ Business Inteligent

teligence

E coreapplication

E [ Metadata Repositories

Change Center: | # Lock and Edit Configuration

Overview | Capacity Management = Diagnostics | Security | Deployment

System Shutdown & Startup

)

Ip
L
Syslem Componerts
System Status Manage System
4} All components are available 3 start O step 3 Restart

c. Click on the Overview Tab,

d. Click on blue button 'Restart' (or green button 'Start' ) under the Manage System category, middle of screen,
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e. Click yes on dialog box to confirm the move. Wait for message that confirms successful restart.

If starting using EM is not successful and complaining about OPMNCTL not up, follow the starting process with
OPMNCTL.

a. Open a command prompt, navigate to <Oracle Bl Instance Home>/bin.
b. run"./opmnctl status, this will show you status of all the OBIEE core services.

c. run"./Jopmnctl startall" or "./opmnctl stopall" depending on your need.
6. Deploy RPD and webcat file(s).

a. CopyOFS_PFT PACK.rpd from SFIC_HOME/OFSPFTPACKBI/OBIEE/11.1.1.9.5/ of Web layer to windows
machine where the OBIEE windows administration client is installed.

b. Login to OBIEE - Enterprise Manager URL (http://<ip address>:<port>/em).
@ Click on hyperlink 'coreapplication' from '‘Business Intelligence' tab on left hand side.

€ Under 'coreapplication’, select the tab 'Deployment' and in that select sub-tab 'Repository'.

© advanced | Administration Help ~ | Sign Out o

Dashboards E MNew - B& Cpen ~ | Signed In A= weblogic ~

@ Click 'Lock and Edit Configuration' button located below title 'coreapplication'. Following screen is displayed.

E=RFE =
ok IE

& http://ofss222549.in.oracle.com:7001/em/faces/as/as/wiFam O = & (2 Business Intelligence Instan...

File Edit View Favorites Tools Help x
55 B Sugg. ~ aALMm... @ http... a Orac... a Orac... @ Prep... @GGP_ - ” & A > [ Qé; v Page~v Safetyv Toolsw |@|v ”
ORACLE Enterprise Manager 11g Fusion Middleware Control Setup v Help+ Log Out

= & coreapplication @ Logged in as weblogic
v % Farm_bifoundation_domain @ Business Intelligence Instance - Page Refreshed Feb 8, 2017 4:06:11 PM IST [

[ [ Application Deployments
L= [ WebLogic Domain Change Center: | J Lock and Edit Configuration [©)
W [ Business Intelligence
ap| Overview Availability Capadty Manag t Di tics Security Deployment

[ [] Esshase Servers

P tati Reposit: Schedul Marketi Mail
[ [ Metadata Repositories resentaton pository cheauier = E

BI Server Repository Apply

~
This section shows the current installed RPD. You can use this section to configure a shared RPD location.

Default RPD OFS_PFT_PACK_BID023
j Share Repository
RPD Publishing Directory

Upload BI Server Repository

Use this section to upload a new RPD and its password to your BI Server domain. You may also use this section to re-enter the
password if a mistake was made on a previous upload.

Repository File Browse...

Repository Password

Confirm Password

®100% ~
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c. RPD Deployment:

Select 'Browse' button available under 'Upload BI Server Repository' section and select OFS_PFT_PACK.rpd file
from the local folder. Enter Repository password Admin123.

d. Web catalog Deployment:
Open the analytics OBIEE URL-(http://<ipaddress>:<port>/analytics) and login with the credentials.
e. Click "Catalog" link available on the top right corner.

f.  Click "Shared Folders" and then "Un-Archive".

ORACLE Business In

Cotaios

gser View ~ v EE) @i‘a __\f
=l |

| |
|l Tasks |
.Q Shared Folders

| [£3 Expand Ej Archive
| B)Rss

i 3¢ Delete
Copy @@ Properties

. i@ Rename @ Permissions
l &P Create Shortaut

g. Browse the path where "OFS _PFT PACK.catalog"is copied in the local folder. Select the file and click "Open".

Then click "OK".
Unarchive @ %
Archive file OFS_PFT_PACK.catalog Browse...
Replace  Mone W
ACL  Inherit b
(0]4 Cancel
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h. Click "Dashboard" and click on any of the reports to ensure that all the reports are available.

Business Intelligence dministration Help = Signout &

Home | Catalog | Favorites w | Dashboards | [ New | BB Open + | Signed In As weblogic +
Most Recent(My Dashboard - page 1)
My Dashboard
BSP
Forecast Reports

= @

Finandial Reporting
Finandal Reporting
Institutional Performance
Business Summary
Customer Central
Opportunities & Activities
Relationship Manager Insights
Management Reporting
Balance Sheet
Income Statement
Key Trends
Performance Measures
Retail Performance
Business Analysis
() Customer Central
Product Summary
This page has na content, Relationship Manager Insights
To add content, dick Edit & here or in the toolbar.

Follow the bellow steps to restart all services in OBIEE "Enterprise Manager".
a. Open the EM OBIEE URL- (http://<ipaddress>:<port>/em) and login with the credentials.

b. Click the "coreapplication" link.

I e ———
Twme g Pk
) Farm biloasadasion demain 3

ety v ey ] et e

c. Click the "Restart" button.
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OIRACLE Enterprise Manager 11g Fusion Middieware Control
EiFarm~ | 2 Topology
2~ ¢+ coreapplication @
= % Farm_bifoundation_domain @Eusiness Intelligence Instance +
[ 3 Application Deployment:

&l [ Weblogic Domain Change Center: | & |ock and Edit Configuration

= [ Business Inteligence
Availabiity | Capadty Management | Diagnostics | Security | Deployment

= System Shutdown & Startup

Metadata Repositories

WUp (5)

System Components

System Status Manage System

ﬂ All components are available 3 start || [ Stop ! Restart | 3|

= Diagnostics

d. Click "Yes" to restart all Bl components.

A message is displayed as follows:

| D Processing

Restart All - In Progress.

(¥ This operation cannot be cancelled. It will continue even if the browser window is cdosed.

I

After restart is done, a confirmation message is displayed as follows:

| @ Confirmation

Restart All - Completed Successfully

l Dane

[ Close

8. Configure tnsnames.ora as follows:
a. Open"tnsnames.ora" file under the folder - <Oracle Home>/network/admin.
b. Make sure an entry is made in the tnsnames.ora to connect to atomic schema of OFSAA application.

c. Savethe tnsnames.ora.
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9. Configure ODBC data source to connect to Oracle Bl Server as follows:
a. Go To Control Panel > Administrative Tools > Data Sources (ODBC).
b. Select the 'System DSN' tab and click 'Add' Button.
c. Select a driver specific to (Oracle Bl Server 11g) and click 'Finish' Button.
d. Enter 'Name' and 'Server' details (Specify the Host Name or IP Address of the Bl Server and click 'Next').

e. Enter Oracle Bl Server login id and password (Enter User Name and Password created at the time of OBIEE
installation). Click 'Next'.

f.  Click 'Finish'.
10. Modify RDBMS connection pool and set the properties as follows:
a. Open the OBI Administration tool.
b. Select Start > Programs > Oracle Business Intelligence > Bl Administration.
c. Select File > Open > Online and select 'OFS_PFT PACK.rpd' file from the Open dialog box.
d. Enter Repository password as 'Admin123' to open it online.
e. Inthe "Physical" layer, double-click the "OFSEFPA Connection Pool" to open its properties.

f.  Enter the following in Data Source Name text box of Connection Pool Properties window,
<Database Server Host Name> and <Database Name>

(DESCRIPTION= (ADDRESS= (PROTOCOL=TCP) (HOST=<Database Server Host
Name>) (PORT=1521)) (CONNECT DATA= (SERVER=DEDICATED) (SERVICE NAME=<Database Name>)))

g. User name: <enter atomic db user name>.
Password: <enter atomic db user password>.
i.  Confirm password and Click 'OK' to close the window and click 'Save' to save the RPD file.
j. Click 'No' for the Global Consistency Message.
k. Repeat the steps from 9.f to 9.1 to set the connection properties for "OFSEFPA Init Block".

I.  Close the RPD file (File / Exit).
11. In case RPD deployment is done on Essbase, then modify ESSBASE connection pool and set the properties.
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Deploying D3 to Entitlement Server for OBIEE 11g

To deploy the D3 to entitlement server, do the following:
1. Download d3.zip of version 3.5.16 from http://d3js.org/ and place it in your local folder.

2. Unzip the d3 folder and move this to analyticsRes in your entitlement server.

Note: To view the Customer Group Structure report, copy the hashMap. js file from
SFIC_HOME/OFSPFTPACKBI/OBIEE/ and place it in to the d3 folder under analyticsRes and restart the
application from the folder.

| analyticsRes - E [ ig=~ Gj E @Find Files
@ Download [ ¥ =5 Ly Properties | £ [
/scratch/obieehome/instances/instancel /bifoundation/OracleBIPresentationServicesCormponent/coreapplication_ocbipsl/analyticsRes
] MName ) Size Changed Rights Owner
& . 23-04-2015 PM 02:22:51 PWHT-X-=- merajend
. WEB-INF 23-04-2015 PM 02:22:51 PWHT-3--~ merajend

13-07-2015 PM 02:31:54 PWHT-XI-X merajend

3. Copy the WEB_INF directory from analyticsRes into d3 folder.

3 -EE e B0 2 FindFiles o
B (o

[scratch/obieehome/instances/instancel /bifoundation/OracleBIPresentationServicesComponent/coreapplication_cbipsl/analyticsRes/d3
Name ‘ Size  Changed Rights Owner
40 13-07-2015 PMO2:31:54  rwrex--- merajend

. WEB-IMF 13-07-2015 PM 02:38:56 PWHI-XT-X merajend
|| LICENSE 2KB 07-02-2015 PM 12:28:18 PW-T--T-- merajend
d3.min.j5 148 KB 10-02-2015 AM 08:32:14 PW=-r--F-- merajend
d3.j5 329KB  10-02-2015 AM 08:32:08 PW=-F==F-= merajend
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4,

5.

Login to web logic server, go to Deployments in your domain structure, click the Lock & Edit button, and then select
Install.

ORACLE Weblogic Server® Administration Console
Change Center @ Home Log Out Preferences Record Help G

View changes and restarts Home =Summary of Deployments

Mo pending changes exist. Click the Release Summary of Deployments
Configuration button to allow others to edit the
domain. Control | Monitoring

Lock & Edi

Release Configuration This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain. Installed appli

To install a new application or module for deployment to targets in this domain, dick the Install button.
Domain Structure

bifoundation_domain

Customize this tabl
BH-Environment b Customize this table
-Deployments
Deployments
-Services ploy!
-Security Realms Instal Und
pdate Delete Start ~ Stop ~
-Interoperability |—
EH-Diagnostics
d [ | name &
[l iﬁadf.orade.businessedimr(l.ﬂ. 11.1.1.2.0)
E 'ﬁadf.orade.domain(l.ﬂ,l1.1.1.2.0)
[l 'ﬁadf.orade.domain.'n'ebapp(l.D, 11.1.1.2.0)
= adminservice (11.1.1)
How do L. =] I)
» Install an Enterprise application [ E‘.janalyﬁcs (11.1.1)
& Configure an Enterprise application (] ﬁ:‘.APS (111
# Update (redeploy) an Enterprise application -
® Start and stop a deployed Enterprise 0 =.Iasyncadminservice (11.1.1)
application -
# Monitor the modules of an Enterprise [ iﬁbi.em
application
« Deploy E76 modules 0 [ biadminservices (11.1.1)
* Install 3 Web application = i) biadminserviet (11.1.1)

System Status o Install | [ Update | [ Delete | Stat~ | | Stop ~

Health of Running Servers

| Failed (0)

Once you click on Install button, it will take you to the screenshot below where you will paste the full path to the d3
directory , check the checkbox next to d3 (open directory) and click Next.

Install Application Assistant
Back Next | Finish ‘ Cancel
Locate deployment to install and prepare for deployment
Select the file path that represents the application root directory, archive file, exploded archive directory, or application module descriptor that you want to install, You can also enter the path of the application directory or file in the Path field.

Motes: Only valid file paths are displayed below, If you cannot find your deployment files, upload your file(s) andfor confirm that your application contains the required deployment descriptors,

Path: /scratch/obieehome/instancesfinstance 1/bifoundation/CracleBIPresentationServicesComponent/coreapplication_obips1/analyticsRes/d3
Recently Used Paths: {none)
Current Location: ofss222590 { scratch f obieehome [ instances | instance 1 f bifoundation f OracleBIPresentationServicesCompanent f coreapplication_obips1 f analyticsRes

@ ® 43 {open directary)

Back Next | Finish ‘ Cancel
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6.

7.

On the next screen, you'll choose Install this deployment as an application and click Next.

ierver® Administration Console

@ Home Log Out Preferences [2«] Record Help |

Home =Summary of Deployments

2ase Install Application Assistant

edit the
Back MNet | Finish | Cancel
Choose targeting style

Targets are the servers, dusters, and virtual hosts on which this deployment will run. There are several ways you can target an application.

@ Install this deploy tas an ication

The application and its components will be targeted to the same locations, This is the most common usage.

() Install this deployment as a library

Back MNet | Finish | Cancel

Application libraries are deployments that are available for other deployments to share, Libraries should be available on all of the targets running their referencing applications.

On the next screen, select "l will make the deployment accessible from the following location" and click Finish.

:rver® Administration Console

& Home Log Qut Preferences Record Help Q
Home =Summary of Deployments

ise: Install Application Assistant

dit the
Back Next ‘ Finish | Cancsl

Optional Settings
- You can modify these settings or accept the defaults
General

What do you want to name this deployment?
Name: d3

Security

What security model do you want to use with this application?
@ DD Only: Use only roles and policies that are defined in the deployment descriptors.
") Custom Roles: Use roles that are defined in the Administration Console; use policies that are defined in the deployment descriptor.

() Custom Roles and Policies: Use only roles and policies that are defined in the Administration Console.

= ) Advanced: Use a custom model that you have configured on the realm's configuration page.

Source accessibility
How should the source files be made accessible?
() Use the defaults defined by the deployment's targets

rver
cation Recommended selection.
") Copy this application onto every target for me

During deployment, the files will be copied automatically to the managed servers to which the application is targeted.

@ 1 will make the deploy ible from the ing location

Location: [scratch/obieehomefinstances/instance1/bifoundatior

Back Mext ‘ Finish | Cancel

Provide the location from where &l targets will access this application's files. This is often a shared directory. You must ensure the application files exist in this location and that each target can reach the location.
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8. On this screen, you will have to click on Activate Changes.

LI/ LT wWebLogic Server® Administration Console

Change Center &) Home LogOut Preferences Record Help ‘ Q,
View changes and restarts Home =Summary of Deployments
Messages
Pending changes exist. They must be activated
to take effect. <« The deployment has been successfully installed.
| o Activate Changes | +# You must also activate the pending changes to commit this, and other updates, to the active system.
Undo All Changes Summary of Deployments

Contrel = Monitering
Domain Structure

bifoundation_domain
This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain. Installed applications and modules can be started, stop

Toinstall a new application or module for deployment to targets in this domain, dick the Install button,

[ Customize this table
Deployments

Install Updzte Delete Start + Stop v

[7]| mame State
adf,oracle businesseditor(1.0,11.1,1.2.0) Active

How do I... = O]
[ | aifsadf.orade.domain(1.0,11.1.1.2.0) Active

» Install an Enterprise application -

9. After activating the changes, the application will now be in a Prepared state, as in the screenshot below. You will have
to stop the application by checking the checkbox next to it and selecting Force Stop Now from the Stop menu.

ic Server® Administration Console

@) Home LogOut Preferences cord Help Q

Home Summary of Deployments.
fy, add or Summary of Deployments

Control | Moritoring

This page displays = st of Java EE applications and stand-alons appiication modules that have been installed to this domain. Installed applications and modules can be started, stopped, updated (redeployed), or deleted from the domain by first selecting the app

Toinstal a new appication or module for deplayment to targets in this domain, dick the Install button.

[ Customize this table
Deployments

Install | [ Update | [ Delete | || Statv | | Stopw.

When work completes
[] | name & State Health Type
Force Stop Now
[C] | & pgbisearch (11.1.1) Stop, but continue servidng administration requests Active Yok Enterprise Application
=] P bisecurity (11.1.1) Active o OK Enterprise Application
[ | ® ggbisecurityadmin (11.1.1) Active & oK Enterprise Applcation
= 0
[ | apbithidparty(11.1.1) Active Library
on 0| ® cale (L1 Active oK Web Appiication
application
@93 Prepared ok Web Application
rise:
] {3/DMS Application (11.1.1.1.0) Active o OK Web Application
orise 9
[ | ® ggeas (1119 Active o oK Enterprise Applcation
[} cFem Active o oK Enterprise Application
= [ | ipgema Active Library

Install | [ Update | [ Delete | || Statv | | Stopv.
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10. You can start the application by checking the checkbox next to it and selecting Servicing all requests from the Start
menu.

ver® Administration Console

{&% Home LogOut Preferences ¢ Help Q

Home >Summary of Deployments
ar Summary of Deployments

Control = Monitaring

This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain. Installed applications and modules can be started, stopped, updated {redeployed), or delete

Toinstall a new application or module for deployment to targets in this domain, dick the Install button.

[ Customize this table
Deployments

Install Updzte Delete Start ~ Stop

Servicing all requests
[[]| name & State Health
Servicing only administration requests
[ [gbisearch (11.1.1) Active o oK
F [3bisecurity (11.1.1) Active o oK
[ [3bisecurityadmin (11, 1.1) Active o oK
= B
[ | afsbithirdparty(11.1.1) Active
B Cale(11.1.1) Active oK
on
@3 Prepared Yok
B 73\DMS Application (11.1.1,1.0) Active & 0K

11. The application will now change to an Active state and ready to use.

Summary of Deployments

Control = Manitoring

This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain. Installed applications and modules can be started, stopped, updated (redeployed), or deleted from the domain by first selecting the apr|

To install a new application or madule for deployment to targets in this domain, dick the Install button.

{ Customize this table
Deployments

Install Update Delete Start~ | | Stop v

[7] | Name & State Health Type

] TIlmse.an:h {iin Active o OK Enterprise Application
[ Elh\sacunty {1.1.1) Active & 0K Enterprise Application
] fﬁlb\sacur\tyadmm (iLin Active o OK Enterprise Application
[l [%Ihwh\rdparty(ll. 11) Active Library

] ale (11.1.1) Active o OK web Application

= g3 Active oK Web Application

M1 | Ml =nmMe annlicatinn (1111 1M Artia o W wtsh Annliratinn
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Mapview Configuration

This section provides information on prerequisites, creating the mapviewer NAVTEQ data source, configuration edits and
server starting.

Note: This is just a sample configuration working on sample data provided by NAVTEQ.

This section covers the following topics:

©® Prerequisites

® Creating the Mapviewer NAVTEQ Data source

® Creating the NAVTEQ Schema

® Configuration Edits and Server Starting

® Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps
Prerequisites

NAVTEQ database dump can be imported only into an Oracle 11g database. If you have no other option than using a 10g
version, contact OBIEE/Mapviewer Product Management.

Creating the Mapviewer NAVTEQ Data source

Ensure that you have a connection to 11g Oracle database from the machine where your OBIEE platform is installed.
Create a NAVTEQ schema within that database for holding the NAVTEQ spatial data.

To create NAVTEQ schema, perform the steps as explained in the following section.

Downloading the Mapviewer NAVTEQ Database Dump

To download the Mapviewer NAVTEQ Database Dump, follow these steps:

1. Access the SampleApp Navteq dmp.zip file from the SampleApp download location (127MB):
http://www.oracle.com/technetwork/middleware/bi-foundation/obieesamplesarchive-2026956.html

2. Download and unzip the SampleApp_Navteq_dmp.zip file that contains an Oracle Database export file named:

obiee navteq.dmp

Creating NAVTEQ User

To create a NAVTEQ user, follow these steps:
1. Start a SQL*Plus session to the Oracle Database as a user with system or DBA privileges.
2.  Run the following script:

create user obiee navteq identified by obiee navteq default tablespace users quota
unlimited on users;

grant "connect" to obiee navteq;
grant "resource" to obiee navteqg;

3. Once the script is executed, verify whether you can connect to the newly created user.
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Note: The OBIEE_NAVTEQ user creation script defaults with the password obiee_navteq (same as user
name) within the script. It is recommended that you keep this value unchanged to simplify configuration.
Oracle OBIEE 11G SampleApp Deployment Instructions 32.

Creating the NAVTEQ Schema

To create NAVTEQ Schema, follow these steps:

Importing the database dmp file

1.

1.Import the Oracle Database export file - obiee_navteq.dmp into the obiee_navteq schema using the following
import command, from the command line (Command Prompt in Windows):

c:\> imp obiee navteg/obiee navteqg@connectString file=obiee navteq.dmp FULL=Y
ConnectString is the connection string to your Oracle Database 11g where the user obiee_navteq was created in the

step mentioned earlier. Wait for the import process to complete, once successfully completed, login on your DB as
obiee_navteqg/obiee_navteq and validate that you can view the schema tables and some data.

Inserting Extra Spatial Metadata

1.

Start a SQL*Plus session to the Oracle Database and connect as user obiee_navteq.

For example: c:\>sglplus obiee navteq/obiee navteg@connectString
Run the following script:

INSERT INTO user sdo maps SELECT * FROM my maps;

INSERT INTO user sdo themes SELECT * FROM my themes;

INSERT INTO user sdo styles SELECT * FROM my styles;

INSERT INTO user sdo cached maps SELECT * FROM my tile cache;

Commit;

Configuration Edits and Server Starting

Confirm that WLS server and WLS managed servers are up and running, and ensure that OMPNCTL is not running.

Note: Neither OBIS nor OBIPS are running.

MapViewerConfig.xml Edits (Optional)

1.

ok N

Open the Mapviewer console using the following URL:
http://10.228.235.83:9704/mapviewer

(replace 10.228.235.83:9704 with the correct IP address and port number on your install).
Click Admin.

Login with the username/password that you provided while installing the product.
Click Configuration. This opens the mapViewerConfig.xml on your setup.

Make the following updates to the xml file.
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<security_config> (Optional)

In the <security_config> property of this file, make the following changes:

a. Changethe <proxy enabled hosts> property to the following: Substitute the hostname, IP address and port
to the correct values on your setup.

<proxy enabled hosts>
http://dadvmc0508.us.oracle.com:9704/mapviewer
http://dadvmc0508.us.oracle.com:9704/,http://10.228.235.83:9704/
http://10.228.235.83:9704/mapviewer
</proxy enabled hosts>

b. Substitute any entries with these tags with the following property entries:
<disable direct info request> true </disable direct info request>
<disable info request> true </disable info request>
<disable csf>true</disable csf>

<enforce security role> true </enforce security role>

Predefined Data Sources

At the end of the file, in the section named Predefined Data Source, add the following data source entry.
Replace the IP address, SID, and port to the correct values of the database where the obiee_navteq schema has been
created in the above steps.

<map data source name="OBIEE NAVTEQ SAMPLE"

jdbc _host="10.229.147.238" (use your db ip)

jdbc_sid="orcl" (use your db sid)

jdbc _port="1521" (use your db port)

jdbc_user="obiee navteq"

jdbc password="!obiee navteg" (use your selected password if different from OOB)
jdbc_mode="thin"

number of mappers="3"

allow_jdbc theme based foi="false" />

Note: Ensure that all tags have been closed correctly and also the above data source is not within the
comments section (ensure that it is outside the comments section which is represented by <!-- .. -->).

Save and Restart, Verify

Click Save and Restart button at the bottom of the file.

1. Verify whether you can view OBIEE_NAVTEQ_SAMPLE as an entry in data sources.

2. Then after you are successful, there will entry in DataSources section.

3. Login to Analytic screen > Administration.

4. Click Manage map Data.

5. Click Import Layer and then choose OBIEE_COUNTRY.

6. Choose Preview MAP as OBIEE_WORLD_MAP_FAST.
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7. Same for OBIEE STATE.
8. Select Background Maps.
9. Use import Background maps and chosen OBIEE_WORLD_MAP_FAST.

10. Edit the same, add layer OBIEE COUNTRY and then OBIEE STATE. While choosing, chose the location
OBIEE_WORLD_MAP for higher Zoom value.

11. Select the zoom level for country 0 and for country 2...15.
12. Navigate back to Layers tab.
13. Edit OBIEE COUNTRY and OBIEE STATE by adding Bl Key Columns:
For Country:
a. Choose Institutional Performance>Geography>Country Description.
b. Choose Institutional Performance>Branch>Branch Country Description.
c. Choose Retail Performance>Geography>Country Description.
For State:
a. Choose Institutional Performance>Geography>State Description.
b. Choose Institutional Performance>Branch>Branch State Description.

c. Choose Retail Performance>Geography>State Description.
14. Once configuration.xml file is restarted, click Data Sources.

Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps

For NAVTEQ Maps to work, it requires the location data in our atomic schema to be in sync with the map metadata in
NAVTEQ schema. This is achieved through a new table FSI LOCATION MAP COORD, the load process of which is
described as follows.

Populate FSI LOCATION MAP COORD based on DIM LOCATION data itself, but description and codes should come from
tables OBIEE COUNTRY, OBIEE STATE, OBIEE CITY (from the DB schema configured for Maps, 'OBIEE NAVTEQ', for
example in this case) respectively for Country, State and City, and n_location_skey should be the corresponding

n location skey from DIM LOCATION.

For Instance, let us consider the following data from DIM_LOCATION.

N_LOCATION_ SKEY 1
V_LOCATION CODE HAW
V_COUNTRY_ CODE USA
V_COUNTRY DESC United States
V_STATE CODE HI
V_STATE DESC Hawaii
V_CITY CODE CITi1
V_CITY DESC Honolulu
V_ZIP CODE 96813
Now, to populate the following columns in FSI LOCATION MAP COORD:
n_location_skey = 1
v_country_code = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA
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v_country_code_map = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA
v_country_desc = OBIEE_COUNTRY.NAME United States
v_state_code = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI
v_state_code_map = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI
v_state_desc = OBIEE_STATE.STATE_NAME HAWAII
v_city_code = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu
v_city_code_map = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu
v_city_desc = OBIEE_CITY.CITY_NAME HONOLULU
v_zip_code = 96813

HTML5 Compliance of OBIEE Reports in IE11

Perform the following steps in order to verify the HTML5 compliance of OBIEE reports in IE11:
1.  Remove the compatibility settings for analytics.
2. Change the instanceconfig.xml file to make all the chart views to be shown in HTML5 by default.
You can find the instanceconfig.xml file in the following location:
OBIEE_HOME/instances/instancel/config/OracleBlPresentationServicesComponent/coreapplication_obips1
<Charts>
<DefaultWebImageType>html5</DefaultWebImageType>

</Charts>
3. Enable Mapviewer and D3 reports (to ensure that these reports show up as is).

4. Verify all the Bl reports by removing the default chart view setting (to ensure that these reports show up as usual
irrespective of HTMLS5 or flash web Image formats).

Details on OBIEE11.1.9.5

In a browser that does not support the html5 format, the image renders in the flash format instead (which is also
interactive).
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APPENDIX E Configuring Resource Reference
Web Application Servers

This appendix includes the following topics:
® Configure Resource Reference in WebSphere Application Server
® Configure Resource Reference in WebLogic Application Server

® Configure Resource Reference in Tomcat Application Server
Configure Resource Reference in WebSphere Application Server

This section is applicable only when the Web Application Server is WebSphere.
This section includes the following topics:

® Create JDBC Provider

® Create Data Source

® J2C Authentication Details

0

JDBC Connection Pooling
Create JDBC Provider

1. Open the WebSphere admin console in the browser window:

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSLis enabled). The Login
window is displayed.

2. Login with the user ID that has admin rights.
3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers to display the JDBC Providers window.
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Figure 1: JDBC Providers
4. Select the Scope from the drop-down list. Scope specifies the level at which the resource definition is visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create new JDBC provider window is
displayed.

Create a new JDBL Provider -

Crasts & Adw JDEC Pravides

Create new JDBE provider |

Set the basic configuration valves of 8 JOEC provider, which ancasosciates the specfic
wander JOBC driver implamentation classes that sre reguired to scoess the database.

Tha wigerd fillg in the nema snd the dessripticn falde but you can bype dffgrant
waluai.

Step 31 Surmemary Scope
clle G
4T

* Database type
Sratle -

# Brovider type
Cwwtle JOBC Drivar ks

#* Implamantaticn tyse
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* Nama
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Casoistion
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Figure 2: Create a new JDBC Provider
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6. Enter the following details:

Database Type - Oracle

Provider Type- Oracle JDBC Driver

Implementation Type- Connection pool data source

Name- The required display name for the resource

Description - The optional description for the resource
7. Click Next.

[ceatesnew OB Prider |

Sraste 8 naw JOBC Provider

Stap 11 Creste new Enter database class path information |
AT provider

Sl the SAsATESE ERBSIEE that reprerant tha JDBC diver desa files, whith

Step 3t Enter WabSohara{R} Application Sercar usal to define your JDBC provider. This sizerd page
dalabase clais path digplays the file namas) you supaly osly the dirsctory locations of the files. Use
IFormmkion complete directory paths when you tyoe the JOBC driver file lomations. For sxamplel
SUSQULIE ave o0 Windora{R} or /home/dbZinstl/ solibieve on Linux(THM}

Step 31 Summary

1F 2 valus is specified for vou, you may dick Next to scoect the value

=
a

Cirsctory location for “opdbod jar” which is saved 53 WebSphare varisbis
S{ORACLE JOBC _CRIVER DATH) - - —
ornche’orajdbe/ spp/eraddbe product/ 11,20 cdiant_ 1 bW

Pranvidus I Nt I:Mctl]

Figure 3: Enter database class path information

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use the trailing slash file separators.
The Oracle JDBC driver can be downloaded from the following Oracle Download site:
®  Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers
m  Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server.

Note: See JDBC Jar Files for identifying the correct ojdbc<version>.jar version to be copied.

Once downloaded, you need to place the file in the required folder in your system. While creating the JDBC Provider,
ensure that the path to the jar file in the folder is specified in the Classpath field in the previous window.

9. Click Next to display the Summary window.
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Figure 4: Summary
10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Create Data Source

The steps given below are applicable for both CONFIG and ATOMIC data source creation.
1. Open the WebSphere admin console in the browser window:

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSLis enabled). The Login
window is displayed.

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data sources page.
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Figure 5: Data Sources
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4. Select the Scope from the drop down list. Scope specifies the level at which the resource definition is visible.

5. Click New to display the Create a Data Source window.
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Figure 6: Create a data source

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive. Ensure that JNDI name is same as the "Information Domain"
name.

7. Click Next to display the Select JDBC provider window.
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Figure 7: Select JDBC provider

8. Select the option Select an Existing JDBC Provider and select the required JDBC provider from the drop-down list.
Click Next.
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Figure 8: Enter database specific properties
9. Specify the database connection URL.
For Example: jdbc:oracle:thin:@<DB_SEREVER IP>:<DB SERVER PORT>:<SID>

10. Select Data Store Helper Class Name from the drop-down list and ensure that the checkbox Use this data source in
container managed persistence (CMP) is selected.

Note: For RAC configuration, provide the RAC URL specified during installation.

For Example:
jdbc:oracle:thin:@ (DESCRIPTION= (ADDRESS LIST=(ADDRESS= (PROTOCOL=TCP) (HOST=10.11.12.

13) (port=1521)) (ADDRESS= (PROTOCOL=TCP) (HOST=10.11.12.14) (PORT=1521)) (LOAD BALANCE=n
o) (FAILOVER=yes) ) (CONNECT DATA= (SERVICE NAME=pgadb)))

11. Click Next.
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Figure 9: Setup security aliases
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12. Map the J2C authentication alias, if already created. If not, you can create a new J2C authentication alias by accessing
the link given (Global J2C authentication alias) or you can continue with the data source creation by clicking Next and
then Finish.
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Figure 10: Summary
You can also create and map J2C authentication alias after creating the data source.

13. You must create another Data source by following the above procedure with jdbc/FICMASTER as JNDI name pointing
to the "configuration schema" of Infrastructure.

J2C Authentication Details

The steps given below are applicable for creating both config and atomic J2C Authentication.
To create J2C Authentication details:

1. Select the newly created Data Source and click JAAS - J2C authentication data link under Related Items.
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Figure 11: JAAS- J2C authentication data

2. Click New under the Preferences section.
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Figure 12: JAAS- J2C authentication data- New

3. Enter the Alias, User ID, Password, and Description. Ensure the following:

®  User IDis the Oracle user ID created for the respective CONFIG and ATOMIC Schema for the "Information

Domain".

m  Specify the CONFIG database user ID and password information for the jdbc/FICMASTER data source, and specify
the ATOMIC database user ID and password information for the ATOMIC schema data source that you created

earlier.

4. Click Apply and save the details.
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JDBC Connection Pooling

To define the JDBC connection pooling ensure that you have created JDBC Provider and Data source to access the data
from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data sources page.

2. Click the newly created Data Source $DATA SOURCE$ and navigate to the path Data sources > SDATA_SOURCES >
Connection pools.

Cats sources > GAFUSION DATA SOURLE > Connection pools

Wew this pags to et properbiss that impadt the timing of connedion managsment tarke, which can affect
the parformance of your applicaton. Condider the detault valued carefully) your application reguiremanti
rright waarant changeng the e valuers,

Configuration

Landaeal Peopeeeteies

FoOpe
* Conneaction trmeosut REopErtigy
sacorids @SR - al

* MExiriuimn confacticn
109 L2 S T ]

* Menimagrm connastions

i eaffractiand
. Flw s Leivva

100 saconds
* Unured timaeout

1800 faLerds

* moged tiresout
0 pasords

Purge policy
EntiraPool W

ok|  meset | | Cancal

Figure 13: Connection Pools

3. Set the values for the following:
B Connection timeout to 0 seconds
®  Maximum connections to 100 connections
B Minimum connections to 10 connections

You can also define Reap Time, Unused Timeout, and Aged Timeout as required.
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Configure Resource Reference in WebLogic Application Server

This section is applicable only when the Web Application Server is WebLogic.

This section includes the following topics:

& & & ©

Create Data Source

Create GridLink Data Source
Configure Multi Data Sources
Advanced Settings for Data Source

JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:

o

For a Non RAC Database instance, Generic Data Source has to be created. For more information, see Create Data
Source.

For a RAC Database instance, Gridlink Data Source has to be created. For more information, see Create GridLink Data
Source.

When Load Balancing/Fail over is required, Multi Data Source has to be created. For more information, see Configure
Multi Data Sources.

Create Data Source

The steps given below are applicable for both config and atomic data source creation.

1.

Open the WebLogic admin console in the browser window:

http://<ipaddress>:<administrative console port>/console. (https if SSLis enabled). The Login
window is displayed.

Login with the Administrator Username and Password.

O=RACLE
WeblLogic Server® 11g

Administration Console

Wkt

L N e e P VLB St B

iy
Fariammd

Figure 14: Welcome
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3.

4.

From the LHS menu (Domain Structure), click Services > Data Sources to display the Summary of JDBC Data Sources

window.
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Figure 15: Summary of JDBC Data Sources

Click New and select Generic Data Source option to display the Create a New JDBC Data Source window.

You can also select GridLink Data Source or Multi Data Source while creating a Data Source. For more information,

see Create GridLink Data Source or Configure Multi Data Sources.
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Figure 16: Create a New JDBC Data Source

Enter JDBC data source Name, JNDI Name, and select the Database Type from the drop-down list. Click Next.
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Ensure the following:

® The JNDI Name field should be in the format "jdbc/informationdomain"

® Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema" of

infrastructure with jdbc/FICMASTER as JNDI name.
® JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.

® Required "Database Type" and "Database Driver" should be selected.
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Figure 17: JDBC Data Source Properties

6. Select the Database Driver from the drop-down list. You need to select the Database Driver depending on database

setup, that is, with or without RAC. Click Next.
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Figure 18: Transaction Options

7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.

8. Click Next to display the Connection Properties window.
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Figure 19: Connection Properties

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User Name, and Password.

10. Click Next to display the Test Database Connection window.
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Figure 20: Test Database Connection

11. Verify the details and click Test Configuration and test the configuration settings.

A confirmation message is displayed stating "Connection test succeeded."
12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.

Note: “User ID" is the Oracle user ID that is created for the respective "Information Domain".

"User ID" to be specified for data source with "FICMASTER" as "JNDI" name should be the Oracle user ID
created for the CONFIG schema.

13. Select the new Data Source and click the Targets tab.
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Figure 21: Select Targets

14. Select the AdminServer option and click Finish.

Create GridLink Data Source

If you have selected the option, New > GridLink Data Source while creating the "Data Source", you can directly specify the
JDBC URL as indicated.
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Figure 22: Create a New JDBC GridLinkData Source
1. Enter Data Source Name, and JNDI Name.

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA Driver checkbox is not
selected. Click Next.
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Figure 23: JDBC GridLinkData Source- Connection Properties

Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The created "Data Source" is displayed
in the list of Data Sources.

Configure Multi Data Sources

A JDBC multi data source is an abstraction around a group of data sources that provides load balancing and failover
between data sources. As with data sources, multi data sources are also bound to the JNDI tree. Applications can look up a
multi data source on the JNDI tree and then reserve a database connection from a data source. The multi data source
determines from which data source to provide the connection.

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle Database to run across a set of
clustered servers, then group of data sources can be created for instances running on a set of clustered servers and a JDBC
multi data source can be created so that applications can look up a multi data source on the JNDI tree to reserve database
connection. If a clustered server fails, Oracle continues running on the remaining servers.

1. Open the WebLogic admin console in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSLis enabled). The Login
window is displayed.

2. Login with the "User ID" that has admin rights.

3. Inthe LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources to display the Summary of JDBC
Multi Data Sources window.
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Figure 24: Summary of JDBC Multi Data Sources
4. Click New to display the New JDBC Multi Data Source screen.

Note: Ensure that the Data Sources which needs to be added to new JDBC Multi Data Source has been

created.
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Figure 25: Configure the Multi Data Source

5. Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the drop-down list. Click Next.

Note: The JNDI Name has to be specified in the format jdbc/infodomname.

JNDI Name of the Data Sources that will be added to new JDBC Multi data source should be different from

the JNDI name specified during Multi Data Source.

Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema'

of infrastructure with jdbc/FICMASTER as JNDI name for Data Source.
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Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema"

of infrastructure with jdbc/FICMASTER as JNDI name for Data Source.

JNDI Name provided in multi data source should be the same name that will be mentioned in the web.xml

file of OFSAAI Application.

You can select the Algorithm Type as Load-Balancing.
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Figure 26: Select Targets

6. Select the AdminServer check box and click Next.
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Figure 27: Select Data Source Type
7. Select the type of data source which will be added to new JDBC Multi Data Source. Click Next.

Crrate a Rew JOBL Hulli Dals Source
e feas | Cwace

eli] Data Semperes

Figure 28: Add Data Sources

8. Map the required Data Source from the Available Data Sources. Click Finish.

The New JDBC Multi Data Source is created with added data sources.
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Advanced Settings for Data Source

Select the Connection Pooling tab given under Configuration.

To verify if the data source is valid, select "Data Source name". For example, FICMASTER.

Click the new Data Source from the Summary of JDBC Data Sources window. The Settings for <Data Source Name>
window is displayed.

Go to the Advanced option at the bottom of the page, and check the Test Connection of Reserve checkbox (Enables
Weblogic Server to test a connection before giving it to a client).
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Figure 29: Settings for <Data Source Name>

Select the server and click Test Data Source.

A message is displayed indicating that the test was successful.
Once the "Data Source" is created successfully, the following messages are displayed:

All changes have been activated. No restart is necessary.
Settings updated successfully.

If not, follow the steps given above to recreate the data source.

JDBC Connection Pooling

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data source to access the data
from the database.

1.

Click the newly created Data Source SDATA_SOURCES and navigate to the path Home >Summary of Services: JDBC
>Summary of JDBC Data Sources >JDBC Data Source-<INFODDOM_NAME>

Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity Increment by 1, Statement Cache Type to
LRU, and Statement Cache Size to 10.

Click Save.

Oracle Financial Services Profitability Management Application Pack Installation Guide

181



Configure Resource Reference in Tomcat Application Server
Appendix E—Configuring Resource Reference Web Application Servers

Configure Resource Reference in Tomcat Application Server

This section is applicable only when the Web Application Server is Tomcat.
This section includes the following topics:

® Create Data Source

® JDBC Connection Pooling

® Class loader configuration for Apache Tomcat

Copy the Oracle JDBC driver file, ojdbc<version>. jar from <Oracle Home>/jdbc/lib and place it in <Tomcat Home>/lib.

Note: See Appendix S for identifying the correct ojdbc<version>.jar version to be copied.

Create Data Source

To create "data source" for OFSAA application, navigate to <Tomcat Home>/conf and edit the following block of text by
replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on the value
set for PREFIX_SCHEMA_NAME in <<APP Pack>>_SCHEMA_IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the schema name was mentioned as
ofsaaconf, then the actual schema created in the database would be DEV_ofsaaconf.

<Context path ="/<context name>" docBase="<Tomcat Installation
Directory>/webapps/<context name>" debug="0" reloadable="true" crossContext="true">

<Resource auth="Container"
name="jdbc/FICMASTER"
type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the configuration schema>"
password="<password for the above user id>"
url="7jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxActive="100"
maxIdle="30"
maxWait="10000"/>
<Resource auth="Container"
name="jdbc/< INFORMATION DOMAIN NAME >"
type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the atomic schema>"

password="<password for the above user id>"
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url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

Note: The <Resource> tag must be repeated for each Information Domain created. After the above
configuration, the "WAR" file has to be created and deployed in Tomcat.

JDBC Connection Pooling

To define the JDBC connection pooling, do the following:

1. Copy SORACLE_HOME/jdbc/lib/o5dbc<version>.jar to the path STOMCAT_DIRECTORY/lib/.

Note: Refer JDBC Jar Files for identifying the correct "ojdbc<version>.jar" version to be copied.

2. Editthe server.xml present under the path STOMCAT_DIRECTORY/conf/ with the below changes, which is required
for connection pooling.

<Context path="/ $CONTEXTNAMES" docBase=" $APP DEPLOYED PATHS " debug="0"
reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/ SINFODOM NAMES"
type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username=" SATOMICSCHEMA USERNAMES"
password="S$SATOMICSCHEMA PASSWORDS"

url="$JDBC_ CONNECTION URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"
logAbandoned="true"/>

</Context>
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Note the following:

o

® & 6 &

(<]

$APP_DEPLOYED PATHS should be replaced by OFSAAI application deployed path.
$INFODOM NAMES should be replaced by Infodom Name.

$SATOMICSCHEMA USERNAMES should be replaced by Atomic schema database user name.
SATOMICSCHEMA PASSWORDS should be replaced by Atomic schema database password.

$JDBC_CONNECTION URL should be replaced by JDBC connection string jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For
example, jdbc:oracle:thin 10.80.50.53:1521:soluint

The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on the value set for
PREFIX SCHEMA NAME in <<APP Pack>> SCHEMA IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX SCHEMA NAME is DEV and the schema name was mentioned as ofsaaconf,
then the actual schema created in the database would be DEV_ofsaaconf.

Class loader configuration for Apache Tomcat

Edit the server.xml available in STOMCAT_HOME/conf/ folder.

Add tag <Loader delegate="true" /> withinthe <Context> tag, above the <Resource> tag. This is applicable only
when the web application server is Apache Tomcat 8.

Note: This configuration is required if Apache Tomcat version is 8.
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APPENDIX F Creating and Deploying
EAR/WAR File

This appendix includes the following topics:
® Creating EAR/WAR File
® Deploying EAR/WAR File

Creating EAR/WAR File

To create EAR/WAR File, follow these steps:
1. Navigate to the SFIC_WEB_HOME directory on the OFSAA Installed server.
2. Execute ./ant.sh to trigger the creation of EAR/ WAR file.

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken" message is displayed and you will
be returned to the prompt.

4. The EAR/ WAR file - <contextname>.ear/ .war -iscreated.

Note: The <contextname> is the name given during installation.
This process overwrites any existing version of EAR file that exists in the path.
In case of OFSAA configured onTomcat installation, <contextname>.war will be created.
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Deploying EAR/WAR File

This section includes the following topics:

® Deploying EAR/WAR Files for WebSphere
® Deploying EAR / WAR File for WebLogic
® Deploying WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment of Application Pack Web Archive. This
is applicable to all Web Servers (WebSphere, Weblogic, and Tomcat). For more information, refer Clearing
Application Cache section.

Deploying EAR/WAR Files for WebSphere

To deploy WebSphere EAR/WAR File, follow these steps:

1. Start WebSphere Profile by navigating to the path
"/<Websphere_Installation_Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Name>/bin/" and execute the
command:

./startServer.sh serverl
2. Open the WebSphere admin console in the browser window:

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSLis enabled). The Login
window is displayed.

WebSphere. 5110711

WebSphere Integrated
Solutions Console

| User ID

admin

Q—/ "_> Password
oololl

Log in

Figure 1: Login Window

3. Enter the user credentials with admin privileges and click Log In.
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4. From the LHS menu, select Applications and click New Application to display the New Application window.

Mew Application -

Hew Application
This page provides links to create new applications of different types.
Install a New Application

Mew Enterprise Applicatian

Figure 2: New Application
5. Click New Enterprise Application to display the Preparing for the application installation window.

Preparing for the application installation 7

Specify the EAR, WAR, JAR, or SAR module to uplead and install.

Path to the new application

) Local file system

® Remote file system

Full path
|."'5:ralch,|‘uri:le.fwas855,|‘pruﬁlesf'I'ESTSDML‘F\AISl
NExtI Cancel I

Figure 3: Preparing for the application installation

6. Select Remote File System and click Browse. Select the EAR file generated for OFSAA to upload and install. Click Next.

How do you want to install the application?

@ Fast Path - Prompt only when additional information is reguired.

) Detailed - Show all installation options and parameters.

@ Choose to generate default bindings and mappings

I Previous I le Cancel I

Figure 4: Installation Options

Oracle Financial Services Profitability Management Application Pack Installation Guide 187



Deploying EAR/WAR File
Appendix F—Creating and Deploying EAR/WAR File

7.

Select the Fast Path option and click Next to dispay the Install New Application window.

A EL

Specify options for installing enterprise spplications snd medules.

=3 Step 1: Select Select installation options
installation options
Spacify the various opriens that are availabla for your application.
Stap 2 Map
modulas to §ervers Ll Fracompila JavaSarvar Pages filas

Dirgctory to install application

Step 3 Summary

¥ pistribute applicatien
["] wsa Binary Cenfiguration

L Draploy entarprise beans

Application nama
[aa180

m Create MBeans for resources

["] override class reloading settings far Web and EJB modules

Raload interval in sacends

D Deploy Web services

D Process ambaeddad configuration

Fils Parmilccion

Allowe all file= to be read but not written to
Allow executablas to axscuts
Allow HTML and image files to be read by everyone

[FLdll=755#, F\ 20=7 55, F\ p=7 55#. %\ a|=7 55

Application Build 1D
[Unkmewn

#allow dispatching includes to remobe resources

D Allowe servicing includes from remobe resources

Business level spplication name
Craste Mew BLA =

Asynchronous Requast Dispatch Typa
Digabled -

D Bllowe EIB reference targets to resglve sutomatically
[ ceploy client modules
[solated b

IE‘ ‘Walidate schama

EI Cancal

Figure 5: Install New Application
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8. Enter the required information and click Next to display the Map Modules to Servers window.

Instsll Mew Applicatson

Spacify aptions for installing enterpriss applications and medulss.

Map modulas to servars

Specify targets such as application servers or clusters of application seners where you want te install the medules that are
comteined in yous spplication, Modules can be installed on the same application sercer or disperied smang sevessl application
sanears. &lse, spacify tha Wab servars as targets that serve as reuters for reqeests e this applicatizn, Tha plug-in
configwration fle [plugin-cfg.eml] for each Web server is generated, bazed on the applications that are routed through.

Clustars snd sarvesa:
| webSphereicell=ofss231 17 01 Node02Cell,node=afss231 1701 Nede02 serversserverl apply

L= u}

Select Module WAL Sereer

o OFSaAL AATED, war WEE- ‘webSpheraicell=efss231 1701 Nede0Z Cell.node=ofs522 117 01 NodeDZ server=sanserl
7 e,

E | Aemication | INfwebxmi

Pravious || Neox|| Cancel |

Figure 6: Map Modules to Servers

9. Select the Web Application and click Next to display the Map Resource References to Resources window.

specify aptions for insealling esterprise applicatons and modubes.

‘Map resource references to resources |

Each resource reference that & defined o yowr apglcabon must be magped bo 8 resounce.

FeETS

s B [ R Tee—— Set Multiple MO Names * ] Moddy Bmecurce Auttanticabnn Mathod... | [ txtandsd Propertms .|
TR 10 M

Semp d: Map wirtusl E n

Reasoirce
authanzation:
OFSALT Wab AKIBD war, WEB- b OFSALMINRD E i 3 IMFD Containar
Applcation M fweb .ol Browie... Authanbcation
i thad !

Resource
ShONE Ao

b s fierichasTen Container
. i baTICASTES
Applcation EMFfwab.xerd S AuthenBeason

i e

Respurce
authonzation:

[iecorscaratginrg | Container
OFSAAL Wek a:ilbo.n':dﬂ- b/ OFECARADGINID | Browse..,
? Authanbcaton
Apsleabion - i chesd;

Pravious | Finish Cancal ]

Figure 7: Map Resource References to Resources

10. Map each resource defined in the application to a resource JNDI name defined earlier.

11. Click Modify Resource Authentication Method and specify the authentication method created earlier.

You can specify "config" for FICMASTER resource or "atomic" for atomic resource as the authentication method.
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12. Select the OFSAAI Web Application check box and click Next to display the Map Virtual hosts for Web Modules

window.

Install New Application

Step 1 Select
installation options

Step 2 Map
modules to servers

Step 3 Map
resource referances
to resources

Step 4: Map virtual
hosts for Waeb
modules

Summary

Step S

Spacify options for installing enterprise applications and medules.

them among several hosts.

H Apply Multiple Mappings

&

Specify the virtual hest whare you want to install the Web modules that are contained
in your application. You can install Waeb medules on the same virtual host or disperse

:'.--Jm:ycJ Web module

GFSAAL Web Application

| Previous | 'NEHE] | Cancel |

Figure 8: Map Virtual host for Web Modules

13. Select the Web Application check box and click Next to display the Summary page.

Step 1 Select
installation options
Step 2
modules to servers

Map

gtep 3 Map

resource references

to resources

Step 4 Map virtual
hosts for Wab
modules

Stop 5: Summary

Spwacify options for installing enterprise agplications and modules.

Summary

Summary of installation sptions

Optisns [ valuas
 Precompile JavaServer Pages fles Ma
Directory to install application

Distribute application Yes
:l.:nn Rinsry Canfiguratian Na
Degloy enterprise beans Yies
Application name IMIBB
.CI'III:I MBeans for resources . Yas
.Dvlrridl class reloading settings for Wed and EJE b
modules

Reload intarval in gacande

Deploy Web services Ne
Waldate Input off wam/fail warn
Frocass ambadded configuration I Mo

File Permission

Application Build ID

Allew dispatching includes to remote rasources
Allgw servicing includes from remote resources
.auilnu: lewel application nams

.Asmhnonus Reguast Dispatch Typa

-Nlnw EJB reference targets to resolve awtomatically
.nillﬂlpl rlisnt madulac .

.Cllm deployment mode

-Vlldlﬂ schema

| 2idlin] 550, % son7 550, " Lan7 55, "L:I-J’SS_
Unkngwn
Ne

Ne

| Disableg
MNe

Na

Isolated

| Shish hars

Figure 9: Summary
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14. Click Finish and deploy the Infrastructure Application on WebSphere.

15. On successful installation, a message is displayed. Click Save and save the master file configuration. The details are
displayed in the Master File Configuration window.

To start the application:

1. Expand Applications > Application Type > WebSphere enterprise applications to display the Enterprise Applications
window.

Enterprize Applications TE

Entesprise Applications

Use this page to manage installed applications. & single application can be deployed onto multiple sereers.

# Preferences
Scin:l Stop || Install | Uninstall Updata Raollout Updata Rameowa Fila | Export Export DOL Export Fila
P |
= i

Lelect| Name £ Application Seatus )

Wou can sdminister tha fallowing resources:

aars0 &
I fan o+
Ll +
e &
Total 4

Figure 10: Enterprise Applications
2. Select the installed application and click Start.

Note: <profile name> is the profile name given while creating the WebSphere profile.
<cell name> is the cell name given during profile creation.
<contextname> is the context name given during installation.

Deploying EAR / WAR File for WebLogic

Following are the steps for deploying Infrastructure application that would be created during installation:

1. Navigate to the path <WebLogic Installation directory>/user_projects/domains/<domain name>/bin in the machine in
which WebLogic is installed.

2. Start WebLlogic by executing the command:

./startWebLogic.sh -dé4 file

3. Open the URLin the browser window: http://<ipaddress>:<admin server port>/console. (https if SSLis
enabled). The Sign in window of the WebLogic Server Administration Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing "./reveleusstartup.sh" as
mentioned in Start Infrastructure section.

4. Logon to the WebLogic Server by entering the user credentials having privileges to deploy the EAR file.
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5. From the Domain Structure LHS menu, click Deployments to display the Summary of Deployments window.

ORACLE Weblogic Server® Administration Console

View changes and restarts

Configuration editing 8 enabied. Future

dnanges will automatcaly be activated as you of
Sanm Deplo b
madify, add or delete items in this domain. . ——

Sunvary of Deploymtnts

Control  Monitoring
Daeimain Structsre

eI

frat selacing the spohcaton neme &nd using e onirol on the page

Tio ingtall 3 rwr applcalion o madule for deployment o tarpeis in this domain, didk the Tngtal bution

¥ Customize this table

Change Center & rome Log Out Prefevences [5d Record Help ! Welcome, upg7273 | Cormected 1o

= Errarorment Thee page deplaye & ket of lava EE apobcaSons and stand-shons spolitaton modules that have been nstalad to She
Deployments domain, |retaled appicabons and modules can be started, stoopad, updated {redeploved], o delsted from the doman by

Dephayments
nacal Showing 1% 1of 1 Previous | Mext
Deployment
[ | mame & State | Health | Type Order
Mo o L. | o - e = Eriteror o E
O| = PG 7273 . Actve | % 0K 2o 300

System Status

Showing 10 1of 1 Prevous | Next

Figure 11: Summary of Deployments
6. Click Install to displlay the Install Application Assistant window.
7. Select the Exploded EAR directory after browsing to the directory where it is saved and click Next.
Explode EAR File
To explode EAR, follow the below steps:
1. Create the "applications" folder under domain name. For example:
/Bea/user_projects/domains/ <Domain _name>/applications.
2. Create <context name>.ear folder under "applications" folder.

3. Copy the <SFIC_WEB_HOME/<context name>.ear file to

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context name>.

4. Explode the <context name>.ear file by executing the command:
jar -xvf <context name>.ear

5. Delete the <context>.ear and <context>.war files (recently created)

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context name>.

6. Create a directory <context name>.war under

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context name>.

7. Copy <SFIC_WEB_HOME/<context name>.war file to

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context name>.

context name>.war

8. Explode the <context name>.war file by executing the following command to get the directory structure:

jar -xvf <context name>.war

ear

ear

ear

ear/<
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In

stall Application

To install the Application:

1. Open the Install Application Assistant.
Enstall Appheation Asariant
gt el
Locate deploymsent to inatall and prepare for deployment
Telect e Se path et represensy. the soplicaton root dinectory, srchive S, expioded snchove dreciory, or soplcaton module desenptor Tt you want insaall. You cen slso ender e path of
the apphcabon drechory or fie n the Path field
Nobe: Oty waka M 2athg e Sdaliyved Beidny, I v Sheviat fd pior deisy=nt Sed, uslaed o Siell) 8ngor 2ol Bhal wior BOSIIMIGM (3L e Fidured SEBiSy el dbidraaars
Path: cradatad 'wi1035/ O0racle/Middienane user_projects/domains/upgT 2T Mapphc ations
Recently Used Paths: ' oo
Curment Lot ation; D773 | apphcatons
o0 upQT AT Lear [npen drectory)
et Cancel
Figure 12: Install Application Assistant
2. Click Next.
Enstall Apphication Asistant
Back | | Mead Cancsl
Choose targeting style
-E"\‘,ETS are the servers, dusters, and virtual Rosts on wisch Ths depioyment v nun. There ane seversl ways you can '.3’;‘!': & SOOI Do
(#) Install this deployment as an application
The sophzation & v oo mDonenis will be targeted b e sae Bzatand. This o e Mot OYmOn LapE
) Install this deployment as a ibrary
Appicaton ibranes ane depigyments Tat are svadable for pther deployments io share. Lbranes shouid be avvadable onall of the tergets running ther 'E‘E"t":"i BODNCASTE
Blacic st Cancel
Figure 13: Install Application Assistant
3. From the Choose targeting style section, select the Install this deployment as an application option and click Next to

display the Optional Settings window.
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Install Apphoation Assistant

Back | Neaxi | Fsh | | Cance

Diplicenal Settings
w) b il these seTENgE o ooept the defels
General

o you et by name this depioyment?

Harme: upgT2r3
Secwrity
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=) DI Qwiby: Use onby robes and palicses that are defmed in the deplayment descriptors.

Custan Roles: Use robes that are defined m the Admmsistratsn Corsale; wse pabiscs that are defeed i the deplayment
deEgcrptor.

Custom Roles and Polickes: Uee only roles and policies that are defined in the Administration Console,

7 Advanced: Use a custom model that you have configured on the realm's configuration page.

Sowree sccesssbilitg

o Shiukd e source fles be made sicesshle?
= Use the delaults defimed by the deployment's tangels
Secommended teecton
' Copy this apphcation oato every targel lor me
Currg ceploymens, T Sies vl be Coped sutomatcaly I T MANAQeS SRS D0 KT T AORICALON TR 0N

1 waill make the deployment accescible from the following location

Licabian oradatalivd 1035 Oracle Middlewareuser_propscts/domarni

Back | Reod Finsh Cancel

here ol Rargets vl acoess thes applcaton’s fies. Ths s often a shered deectory. You must ensure the spplicabion Sies eestin ths locobion and that each target ©

an

Figure 14: Optional Settings

4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles and policies that are defined in the

deployment descriptors should be used.

6. Select the | will make the deployment available from the following location option under the Source accessibility

section.

7. Click Next to continue and display the Deployment Summary window.
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Ensball Applcation Assitant
B Fras =
Review your choeres and chck Fanish
Choit Finish S0 complerte the deploymens, Ths may take a fesr momenss to compiete

Additional configuration
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upg T2 e AdrrariSarier
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Figure 15: Deployment Summary

8. Select the option Yes, take me to the deployment's configuration screen option and click Finish to display the
Settings for <Deployment Name> window.
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Figure 16: Settings for <Deployment Name>

in this window. In the Overview tab you can view the complete deployment configuration.
10.
11.

Click Save to update the changes, if any.

From the LHS menu, click Deployments to display the Summary of Deployments window.

Review the general configuration details of the deployment. You can also update the configuration of the deployment
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Sammary of Deployments
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Figure 17: Summary of Deployments

12. Select the newly deployed Infrastructure application and click Start > Servicing all requests. Ensure that the
Infrastructure server is up and running.
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Figure 18: Summary of Deployments
13. The State of the deployed application is displayed as Active if started successfully.
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Deploying WAR Files on Tomcat

Before deploying the WAR files, ensure that the previously deployed applications of Infrastructure are uninstalled. See
Uninstalling Previously Deployed WAR Files in Tomcat for the procedure to uninstall the previously deployed Infrastructure
war files.

On the machine that hosts Tomcat, follow the below steps outlined to deploy Infrastructure application:

1. Copy the <context-name>.war from SFIC WEB_ HOME/<context-name .war> to <Tomcat Installation
Directory>/webapps/ directory.

Home Documentation Configuration Examples Wiki Mailing Lists Find Help
Apache Tomcat/7.0.57 ™ Apache Software Foundation
http://www apache.org/

Eecommended Reading

Server Status
Security Considerations HOW-TO
Manager App
Manager Application HOW-TO
Clustering/Session Replication HOW-TO L Manansr
Developer Quick Start
Tomeal Setup Realms & AAA Examphes Sarvet Specilicabons
Firsi ¥Web Apphcation JOBC Data T g
Managing Tomcat Documentation Getting Help
F @ Tomeat 7.0 Documentation FAQ and Mailing Lists
e A A Tomecat 7.0 Configuration The follewing mailing ists are available
FCATALINA HOME/conf/tomcat-users.xml Tomeat Wiki tomcat-snrounce
5 < M e Important ARNouUnCEme Ty, release s, EeCurmy
i T r oRIna poeia L i1 vulnarabelty notifcatons. W yolume
B T M N P
SCATALINA HOME/RUNNING. txt o -~
1 hakes-uagr
F"-_'_ﬂl_'lﬂﬂi! evelopers may be indesested in User supporn and deossson for Apgche Tl
Changelog o
. . Temcat 7.0 Sug Duistaas LA
Migration Guide TEERE
Tomeat 70 Jwealiogy

Securtty Notices Toemcat 7.9 SV Bepealiory

2. Click Manager App. The Connect to dialog box is displayed.

3. Enter the User Id and Password that has admin rights and click OK. (For user creation in tomcat, see Tomcat User
Administration. The Tomcat Web Application Manager window is displayed with the list of all the applications
deployed.
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4. Inthe Deploy section, enter the Context Path provided during the installation as " /<context-name>".

5. Enter the path where the <context-name>.war file resides (by default
"SFIC_WEB_HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.

6. On successful application deployment, a confirmation message is displayed. Start the Tomcat server. For more
information, see Starting Infrastructure Services.
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APPENDIX G Start/Stop OFSAA Infrastructure
Services

This chapter details on how to start and stop OFSAA Infrastructure services. This chapter includes the following sections:
® Starting Infrastructure Services

® Starting Web Application Servers
Starting Infrastructure Services

Once the installation of Infrastructure has been completed successfully and the post-installation steps are completed, the
servers must be started. Log on to each machine and run the .profile file. All servers mentioned must be started from the
same shell encoding. The servers mentioned below are dependent on each other. It is mandatory to maintain the order in
which the servers are started. Allow each of the servers to initialize completely before starting the next server.

1. Onthe machine in which Infrastructure Application components have been installed, navigate to
SFIC_APP_HOME/common/FICServer/bin and execute the following command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the command "nohup ./ startofsaai.sh &".
Starting the process using "nohup" and "&" will return the command prompt without having to wait till the
process completes. However, this command cannot be used when you are starting the server for the first
time or starting after changing user password in the configuration database schema.You can also start the
Infrastructure Server by executing the command "nohup ./ startofsaai.sh &". Starting the process using
"nohup" and "&" will return the command prompt without having to wait till the process completes.
However, this command cannot be used when you are starting the server after changing user password in
the Configuration database schema.

2. Start ICC server:

®  Onthe machine in which Infrastructure default Application components have been installed, navigate to
SFIC_HOME/ficapp/icc/bin

m Execute the command:

./iccserver.sh

Note: Only Infrastructure Default Application Server would hold ICC component.

3. Stopping Infrastructure Services:

®  Onthe machine on which Infrastructure Database components have been installed, navigate to
SFIC_DB_HOME/bin and execute the command to start "Agent server":

./agentstartup.sh
Or
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m  Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP data server and AM services.

Starting Web Application Servers

Start the Web Application Server depending on the type from the following table.

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to [Webshpere_Install_Directory]
/AppServer/<profiles>/<profile name>/bin and execute the command:

./startServer.sh serverl

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to <WebLogic Installation
directory>/user_projects/domains/<domain name>/bin and execute the command:
startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic Admin Console. Stop and start the
application <context name>.ear.

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat_Install_ Directory>/bin and
execute the command:

./catalina.sh run

Starting Web Application Servers

Start the Web Application Server depending on the type from the following table.

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to [Webshpere_Install_Directory]
/AppServer/<profiles>/<profile name>/bin and execute the command:

./startServer.sh serverl

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to <WebLogic Installation
directory>/user_projects/domains/<domain name>/bin and execute the command:
startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic Admin Console. Stop and start the
application <context name>.ear.

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat_Install_ Directory>/bin and
execute the command:

./catalina.sh run
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Stopping Infrastructure Services

To stop Infrastructure services:

1.  Onthe machine in which Infrastructure Application components have been installed, navigate to
SFIC_APP_HOME/common/FICServer/bin and execute the command:
./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application components have been installed,
navigate to SFIC_HOME/ficapp/icc/bin and execute the command:

./iccservershutdown.sh

Note: Only Infrastructure Default Application Server would hold ICC component.

3. To stop Back-end server, on the machine in which Infrastructure database components have been installed, navigate
to SFIC_DB_HOME/bin and execute the command:

./agentshutdown.sh
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APPENDIX H Accessing the OFSAA Application

This appendix gives details about the steps to be performed to access OFSAA Application.
Access the OFSAA Application

1. From a your desktop, open the browser and enter the URL in below format:
<scheme>://<IP address/ hostname>:<port>/<context-name>/login.jsp
For example: https://111.222.333.444:5555/0fsaa/login.jsp

The OFSAA login window is displayed as below:

Language [Us-English W
User ID |

Password

e andior its affiliatez All rights reserved

Figure: OFSAA Login Window
2. With installation of every OFSAA Application Pack, there are two seeded user profiles configured in the system:
m  SYSADMN - System Administrator
B SYSAUTH - System Authorizer

Note: For SYSADMN and SYSAUTH, the default password is passwordO.

3. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the SYSADMN login USER ID).
Enter the password that was provided during installation. On the first login, you will be prompted to change the
password.
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APPENDIX | Post Deployment Configuration

This chapter covers the following topics:

® 6 6 & & & 6

Deploying the Application

Logging as System Administrator

Creating Application Users

Mapping Application User(s) to User Group
Change ICC Batch Ownership

Mapping ICC Batch Execution Rights to User

Saving Post- Load Change Transformations

Deploying the Application

Deploying the FTP Application

The Oracle Financial Services Analytical Applications Infrastructure Application Server is started using reveleusstartup.sh.
This file can be edited for setting customized memory settings, garbage collector settings depending on the available
hardware configuration. Please raise an SR in support.Oracle.com if you have any queries related to EPM applications.

Once the installation of Oracle Financial Services Funds Transfer Pricing Management Product is completed, you must
perform the following steps:

1.
2.

Check the Log file.

Add the below mentioned entries in excludeURLList.cfg file located in the path
SFIC_WEB_HOME/webroot/conf/. These entries are required for Asset and Liability Management, Funds Transfer
pricing, Profitability Management and Hedge Management/ IFRS:
[SQLIA]./fsapps/common/batchCreate.action

[SQLIA]./fsapps/common/batchEdit.action

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra care
to avoid copying formatting characters into the cfg file.

For Administrative Reports (Admin Bl) configuration follow the steps mentioned in Oracle Financial Services
Administrative Reports on OBIEE 11g v8.0.2.0.0 - Configuration Note.docx under SFIC_ HOME/adminbi/.

Note: You can also find the Oracle Financial Services Administrative Reports on OBIEE 11g v8.0.2.0.0 -
Configuration Note on OTN.

The web . xml under the path SFIC_WB_HOME \webroot\WEB-INF\ should have Resource tag, if not present add the
tag and replace ORDEMO with the INFODOM name.

<resource-ref>
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<description>DB ConnectionORDEMO</description>

<res-ref-name>jdbc/ORDEMO</res-ref-name>

<res-type>javax.sql.DataSource</res-type>

<res—-auth>Container</res-auth>

</resource-ref>

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra care

to avoid copying formatting characters into the cfg file.

5. Execute below script as a post installation step:

SFIC_HOME/scripts/atomic/create/indexes . sql

Note: This may display some ORA errors, those can be ignored.

6. If there are ICC batch processes created having roll_portfolio and rebalance_portfolio DTs as the tasks, the parameter

list of the DTs are to be updated as:

m [f the parameters for roll portfolio are '70001', 'TP', 'TP USER1',change the parametersas: ",",",",'70001', 'TP',

‘TP USER1'".

m If the parameters for re-balance portfolio are '70001', '2', 'TP USER1', 'TP' change the parameters as:

”,“,“,”,'70001I, |2|’ ITP USER].I, ITPI.

Task Defir

Batch Maintenance = Task Definition (Add

# Task Definition

Task ID Tazki

Components TRANSFORM DATA v
% Dynamic Parameters List

Property

Datastore Type

Datastore Name

IP Address

Rule Name

Parameter List

nition

Description

Value

EDW
EPMBZDEV
10.184.134.17
Roll_Portfolic

o T000", TP, _PUSER1|

S]] <

An example as of Merge Portfolio is given below:

Pattern Code, for example, '70001'
FTP User, for example, 'TP USER 1'

Application ID, for example, 'TP' (this is a static value)

Run ID: when running via ICC batch and Simplified batch process, this parameter can be passed as ".

Process ID: when running via ICC batch and Simplified batch process, this parameter can be passed as "

Execution ID: when running via ICC batch and Simplified batch process, this parameter can be passed as "

Run Surrogate Key: when running via ICC batch and Simplified batch process, this parameter can be passed as "
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7.

8.

When to merge (roll versus rebalance): when running via ICC batch and Simplified batch process, this parameter
should always be 'N'. Maturity date identifying maturing strips to be merged on roll : when running via ICC batch
and Simplified batch process, this parameter should always be "

These parameters would appear as follows in the simplified batch parameter input block:

”I”,“,“,I70001|' ITP USER 1I, ITPI, INI, "

oThe parameter pattern to be used when RP batches are scheduling from the Run Rule Framework. When
executing from the Run Rule Framework, the user does not have to pass the Run ID, Process ID, Execution ID, and

Run Surrogate Key, as the framework itself passes these values along with the Batch ID and MISDATE. The
parameters would appear as follows:

"70001","TP USER 1","TP"," Nll’llll

Transfer the ownership of batches to the required User.

a.

b.

Login to config user.

Execute the Following anonymous pl/sql block to execute procedure
"AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP".

begin

AAI OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromUser', 'toUser', 'infodom');
end;

OR

begin

AAI OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromuser', 'touser');

end;

Parameter details:

¢ fromUser: indicates the user who currently owns the batch

& to User: indicated the user to which the ownership has to be transerred.

¢ infodom: optional parameter , if specified the ownership of batches pertaining to that Infodom will be
changed.

If the web application server is hosted on a machine other than where pack is installed, then perform the following
step.

Generate RSA key for the machine where Web application server is hosted.

Add the generated RSA key to the authorized keys list of the machine where Pack s installed.

Deplying the PFT Application

The Oracle Financial Services Analytical Applications Infrastructure Application Server is started using reveleusstartup.sh.
This file can be edited for setting customized memory settings, garbage collector settings depending on the available
hardware configuration. Please raise an SR in support.Oracle.com if you have any queries related to EPM applications.

Once the installation of Oracle Financial Services Profitability Management Product is completed, you must perform the
following steps:

Check the Log file.

1.
2.

Add the below mentioned entries in excludeURLList .cfq file located in the path
SFIC_WEB_HOME/webroot/conf/. These entries are required for Asset and Liability Management, Funds Transfer

pricing, Profitability Management and Hedge Management/ IFRS:

[SQLIA]./fsapps/common/batchCreate.action

Oracle Financial Services Profitability Management Application Pack Installation Guide 209


support.Oracle.com

Deploying the Application
Appendix I—Post Deployment Configuration

[SQLIA]./fsapps/common/batchEdit.action
3. For Administrative Reports (Admin Bl) configuration follow the steps mentioned in Oracle Financial Services
Administrative Reports on OBIEE 11g - Configuration Note.docx under SFIC_HOME/adminbi.

4. The web.xml under the path SFIC_ WB_HOME \webroot\WEB-INF\ should have Resource tag, if not present add the
tag and replace ORDEMO with the INFODOM name.
<resource-ref>
<description>DB ConnectionORDEMO</description>
<res-ref-name>jdbc/ORDEMO</res-ref-name>
<res-type>javax.sql.DataSource</res-type>
<res-auth>Container</res-auth>

</resource-ref>

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra care
to avoid copying formatting characters into the cfg file.

5. Transfer the ownership of batches to the required User.
a. Login to config user.

b. Execute the Following anonymous pl/sql block to execute procedure
"AAl_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP".

begin

AAI OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromUser', 'toUser','infodom');
end;

OR

begin

AAI OBJECT ADMIN.TRANSFER BATCH OWNERSHIP('fromuser', 'touser');

end;

Parameter details:

¢ fromUser: indicates the user who currently owns the batch

& to User: indicated the user to which the ownership has to be transerred.

¢ infodom: optional parameter, if specified the ownership of batches pertaining to that Infodom will be
changed.

6. If the web application server is hosted on a machine other than where pack is installed, then perform the following
step.

m  Generate RSA key for the machine where Web application server is hosted.

m  Add the generated RSA key to the authorized keys list of the machine where Pack s installed
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Deploying the EFPA/ IPA/ RPA Application Report Analytics

Ensure that the Oracle Business Intelligence version 11.1.1.9.5 or 11.1.1.7.1 is available.

Note: After Installation, patch 16556157 is recommended for all the customers who are using Oracle
Business Intelligence Enterprise Edition 11.1.1.7.0. This patch can be downloaded from Oracle support site.

1. Set the <Oracle Bl Instance Home> directory> =>.

For example: /u01/OBIEE11G/instances/instancel
2. Start Weblogic AdminServer.

a. Setthe < Bl Domain Home> directory>=> e.g.
/u01/0OBIEE11G/user_projects/domains/bifoundation_domain.
b. Navigate to < Bl Domain Home >/bin and run 'nohup ./startWebLogic.sh &'

c. Bringing up this service may take a few minutes depending on your environment.Check the logs using the
command 'tail -f nohup.out'

3. Start Node Manager.
a. Setthe < WebLogic Server Home > directory> =>e.g.
/u01/0OBIEE11G/wliserver_10.3.

b. Navigate to <WebLogic Server Home>/server/bin and run 'nohup ./startNodeManager.sh &'.
4. Start Weblogic Managed Server(bi_serverl).

a. Login onto http.//localhost:7001/console using your Administrator credentials created during platform install
(Replace the hostname based on your setup).

b. Under Environment block (mid of page, towards left side), click on Servers link.

Domain Structure
 bifoundation_domain
E-Environment
“Servers
-=-Virtual Hosts
t--Migratable Targets
r—-Machines
--Work Managers
“--Startup & Shutdown Classes
~-Deployments
B-Services
t--Security Realms
g-mwnperabaiw
Di i

c. The bi_serverl line should show as shutdown state at this point.

espessssssssscssssssssssnsssnnnn

Oracle Financial Services Profitability Management Application Pack Installation Guide 211



Deploying the Application
Appendix |I—Post Deployment Configuration

[ | server & Machine State Status of Last Action
[ | AdminServer (admin) lakvap RUNNING Mone

[] |bi_server1 laliv-ap SHUTDOWN TASK COMPLETED

d. Click on control page tab.

Summary of Servers

Configuration - Control

e. Select the bi_server1 line by clicking on the left tick box.

f.  Click start button at the top of the list and confirm starting this service

Servers (Filtered - More Columns Exist)

Start | | Resume || Suspend v | Shutdown v | | Restart S5L

[] | server & Machine State
El AdminServer{admin) laliv-ap RUNNING
bi_serverl laliv-ap SHUTDOWM

: Start || Resume | Suspend~ | Shutdown~ | Restart SSL

g. State will update to "RUNNING" mode after a few minutes.
5. Start BIEE services and login.

a. Starting services From EM screen.

i. Login tothe EM administration screen using the url http://localhost:7001/em (Replace the hostname and
port number based on your setup). Use the login you created in BIEE installation to log in.

ii. Expand 'Business Intelligence' node on the left and choose Coreapplication.

- -J% Farm_bifoundation_domain
® 3 Application Deployments
3 WeblLogic Domain

[+

0 =

@ coreapplication’
| 1) Metadata Repositories

|

iii. Click on the Overview Tab.
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6.

Change Center: | @ Lock and Edit Configuration

Overview  Capacity Management @ Diagnostics | Security | Deployment

System Shutdown & Startup

4

Up
i)
System Components
System Status Manage System
< All components are available 3 start 0 stop @@ Restart

iv. Click on blue button 'Restart' (or green button 'Start' ) under the Manage System category, middle of screen.
v. Click yes on dialog box to confirm the move. Wait for message that confirms successful restart.

If starting using EM is not successful and complaining about OPMNCTL not up, Follow starting process with
OPMNCTL.

i. Openacommand prompt, navigate to <Oracle Bl Instance Home>/bin.
ii. run"./opmnctl status, this will show you status of all the OBIEE core services.

iii. run"./opmnctl startall"or"./opmnctl stopall" depending on your need.

Deploy RPD and webcat file(s).

a.

Copy OFS_PFT PACK.rpd from SFIC_HOME/OFSPFTPACKBI/OBIEE11G of Web layer to windows machine where
the OBIEE windows administration client is installed.

Copy these catalog files to the local folder, where OFS_PFT_PACK.rpd has been copied.

Login to OBIEE - Enterprise Manager URL (http.//<ip address>:<port>/em).
i. Click on hyperlink 'coreapplication' from 'Business Intelligence' tab on left hand side.

ii. Under 'coreapplication’, select the tab 'Deployment' and in that select sub-tab 'Repository'.

iii. Click 'Lock and Edit Configuration' button located below title 'coreapplication'. Following screen is displayed.
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+ coreapplication g Logged inmn wehiiog

| s bekein Lt P, Rk B 1, 3083 11

Activate Changes e e e e

Copves  Capedly Mo Dagwilo Doy Depleymeel

L-J

Feeelten  Repeslory  iwles  Malebeg el

]
BI Server Reposiony s Apply Button|
S P Y S Spp— e — |

Doyl W] _papcin ptsrdor gl Albcharomm B1D LD
e By

Wpdaad Bl Sarver Rapostory

L Py oy o By i s B ] B pmpen i U e e Sgnma s g g B e b or et B e d I g ey lsier s e e 0 pren giied

-

M Presenitation Cataliog
Tha i phossn B carveed morion of e cotsog e by Presertaion Seroom . Lae B mcion b change S fonrten ! e crssiog. o = shaen e et By poevirg e franed

oo,
Catalog bocation
simlos Loo EORACLE [T ST s i o i T e o el et BOCMCMENT_TRAME iostmion

iv. RPD Deployment: Select 'Browse' button available under 'Upload Bl Server Repository' section and select
OFS_PFT PACK.rpd file from the local folder. Enter Repository password Admin123.

v. Web catalog Deployment:
® Open the analytics OBIEE URL-(http://<ipaddress>:<port>/analytics) and login with the credentials.

® Click "Catalog" link available on the top right corner.

a Advanced Administration

Favorites - Dashboards ~ E Mew BS Cpen -

® Click "Shared Folders" and then "Un-Archive".
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ORACLE" Business In
Catalog
wservew - (3 @[S90 Elv
=l |

E Tasks

(5] shared Folders

(=3 Expand Ei;] Archive

E)Rss [&] Unarchive 2

3 Delete 28 Upload

@ Copy (i@ Properties

iﬁ Rename @ Permissions

&P Create Shortaut

® Browse the path where "OFS PFT PACK.catalog" is copied in the local folder. Select the file and click

"Open". Then click "OK".

Unarchive

Archive file
Replace
ACL

Help

Financial Reporting.ca|| Browse,,.

MNone

Inherit

&

-

-

(o] conce

® Click on "Shared Folders" and then on Un-Archive. Browse the path where "OFS_PFT_PACK.catalog" is
copied in the local folder. Select the file and click "Open". Then click "OK" as shown in below diagram.

Unarchive

Archive file
Replace
ACL

Help

Management Reportini|| Browse...

MNone

Inherit

(%

-

-

() e

® Two new catalogs are available on the left hand side.
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® Click "Dashboard" and click on any of the reports to ensure that all the reports are available.

Search Al [:| il Advanced Administration Help » Sign Qut o

Home Catalog Favorites » m;ﬂ E rew ~ | BB Open +~ | Signed In As weblogic «

| Most Recent(Income Statement - Income Statement)

My Dashboard
| E Financial Reporting

Finandial Reporting

=l Management Reporting
Lﬁ Balance Sheet
(@ Income Statement
(@ Key Trends
[ Performance Measures

Steps to restart all services in OBIEE "Enterprise Manager".

Open the EM OBIEE URL- (http://<ipaddress>:<port>/em) and login with the credentials.

® Click "coreapplication" link.

(W3 AT LA Earmmpras W myad 81 foe oo wommmen s

Fame g P
- Farmn ifoumdetion domuse |
P bliatma

sedans ey

asinagr e —— e

e

T

. " Q

[ 0 v B T 06 T B s B 5 T 6 T 1
1 YFE0ELE

® Click the "Restart" button.
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ORALCLE Enterprise Manager 11g Fusion Middieware Cantrol
Hrarm» & Topology
8- {y coreapplication g

£l B Farm_bifoundaton_doman | [5] Business Inteligence Instance =
+ [ Appiication Deployments

4 3 Wieblogic Domain Change Center: | ¥ Lock snd Edit Configuration
[ Business Inteligence

E corcapplication Avalabikty | Capadty Management Diagnosbcs | Security Dephoyment
* Metadata Repodtories

El system Shutdown & Startup
e Wup (5)

Sysiem Companents

System Staltus Manage System

1 Ml comparents are avallable 3 start | [ Stop l 0 Restart 3.|

El Diagnostics

® Click "Yes" to restart all Bl components.

1, Confirmation

Are you sure you want to restart all BI components?

Yes Mo

A message is displayed as follows:

. (5 Processing

Restart All - In Progress.

(# This operation cannot be cancelled. It will continue even if the browser window is dosed.

® Once restart is done, a confirmation message is displayed as follows:

| [@ Confirmation

i Restart All - Completed Successfully

| Done
I

7. Configure tnsnames.ora file.
a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin/ folder.

b. Make sure an entry is made in the tnsnames.ora to connect to atomic schema of OFSAA application.
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m Save the tnsnames.ora file.

8. Configure ODBC data source to connect to Oracle Bl Server.

Go To Control Panel>Administrative Tools>Data Sources (ODBC).

Select the 'System DSN' tab and click 'Add' Button.

Select a driver specific to (Oracle Bl Server 11g) and click 'Finish' Button.

Enter 'Name' and 'Server' details (Specify the Host Name or IP Address of the Bl Server and click 'Next').

E B B T o

Enter Oracle Bl Server login id and password (Enter User Name and Password created at the time of OBIEE
installation). Click 'Next'.

m  Click 'Finish'.
9. Modify RDBMS connection pool and set the properties.
a. Open the OBI Administration tool.
b. Select Start > Programs > Oracle Business Intelligence > Bl Administration.
c. Select File > Open > Online and select 'OFS_PFT_PACK.rpd' file from the Open dialog box.
d. Enter Repository password as 'Admin123'.
e. Inthe "Physical" layer, double-click the "OFSEFPA Connection Pool" to open its properties.

f.  Inthe'General' tab, edit/ check the following entries:
i. Call Interface: (OClI 10g/11g).

ii. Data source name: <tnsnames.ora entry created in the step 7.b connecting to OFSAA atomic schema>.
iii. User name: <enter atomic db user name>.
iv. Password: <enter atomic db user password>.
g. Confirm password and Click 'OK' to close the window and click 'Save' to save the RPD file.
Click 'No' for the Global Consistency Message.
i.  Repeat the steps from 9.f to 9.1 to set the connection properties for "OFSEFPA Init Block".

j.  Close the RPD file (File / Exit).
10. In case RPD deployment is done on Essbase then modify ESSBASE connection pool and set the properties.

Note: This is applicable only for EFPA.

a. Open the OBI Administration tool.
b. Select Start > Programs > Oracle Business Intelligence > Bl Administration.

c. Select File > Open > Online and select the cube rpd file created as mentioned in the 3rd step (RPD Deployment On
Essbase Cubes) of section Post-Deployment Activities of OFSEFPA 8.0.2.0.0, from the Open dialog box.

d. Enter Repository password as 'Admin123'.
e. Inthe "Physical" layer, double-click the "Connection Pool" under Essbase, to open its properties.

f. Inthe 'General' tab, edit / check the following entries:

i. Call Interface: (Essbase).
ii. Essbase Server: IP Address of Essbase server.

iii. User name: <enter Essbase console user name>.

218 Oracle Financial Services Profitability Management Application Pack Installation Guide



Appendix I—Post Deployment Configuration

iv. Password: <enter Essbase console user password>. g. Confirm password and Click 'OK' to close the window
and click 'Save' to save the RPD file.

v. Click 'No' for the Global Consistency Message.

g. Close the RPD file (File > Exit).
11. Login into OFSEFPA Application using the URL: http://localhost:9704/analytics. (Replace the port number based on
your setup).

12. Once the OBIEE Environment is up and running, the OBIEE url needs to be updated in the table 'AAI_MENU_B' for an
end user to access the respective Business Intelligence Analytics Application.
Following update statement needs to be executed in the config schema:
UPDATE AAI MENU B
SET V_MENU URL = '<URL>'
WHERE V_MENU ID IN ('<List of enabled BI Analytical Links for a particular Media Pack
>")
/
COMMIT
/

For PFT Media Pack as an example:

UPDATE AATI MENU B

SET V_MENU_URL = 'http://ofss222798:7001/analytics/"
WHERE V_MENU ID IN ('OFS EFPABI LINK')

/

UPDATE AAI MENU B

SET V_MENU_URL = 'http://0fss222799:7001/analytics/"
WHERE V_MENU ID IN ('OFS RPABI LINK', 'OFS IPABI LINK')
/

COMMIT

/

(Replace the IP address and port number based on your setup.)
13. Execute the following in atomic schema to view the T2T mappings in Metadata browser(object view):
declare
result number;
begin
result:=fn mdb t2t view;
dbms output.put line(result);
exception
when others then
dbms output.put line (SQLERRM) ;

end;
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Post-deployment Activities of OFSEFPA v8.0.2.0.0

The following activities have to be done after installing and deploying OFSEFPA v8.0.2.0.0:

OBIEE Configuration:

1.

Evaluate Support Level

Evaluate function is used in filters of many reports. To support the evaluate function in reports, the value of
EVALUATE_SUPPORT_LEVEL in NOSConfig. INT file of the OBIEE server needs to be set as 2.

Path for 11G

SOBIEEHOME \instances\instance1\config\OracleBiServerComponent\coreapplication_obis1
For 12C

SOBIEEHOME/user_projects/domains/bi/config/fmwconfig/biconfig/OBIS

Changes: Set EVALUATE SUPPORT LEVEL = 2 from EVALUATE SUPPORT LEVEL = 0;
Session Variable Setting

'ENTITY' by default picks the lowest of Legal Entities in the alphabetical order.

select min(v_entity_name) from dim_org_structure

This query fetches the default legal entity that will be displayed in the obiee reports (Legal Entity drop-down) at on
load of the report.

Users can also set the default value for Entity, by following these steps:
a. Open the RPD online.
b. Under Manage Menu go to Variables and select session variable 'ENTITY'.

c. Setthe default value in default initialize section with any one of the available entity name from
DIM_ORG_STRUCTURE table in single quotes. For example: '<Entity Name>'

d. Save and check the global consistency of the RPD.
Repository Variable Setting
a. Open the RPD online.

b. Under Manage Menu go to Variables. Set Static Repository variables 'RV_Reporting Currency'and
'RV_Base Currency'.

c. Save and check the global consistency of the RPD.
RPD Deployment On Essbase Cubes(Optional)
®  During deployment use "Admin123" as OFS_PFT_PACK.rpd repository password.

m  Deployment of RPD on ESSBASE cubes will be done through an xml patch (EFPA_Cube_Patch.xml). The xml has
been provided as a part of installation and will be present at SFIC_HOME/ EFPA/repository folder.

®  Provide connection details of RDBMS in 'OFSEFPA Connection Pool' and 'OFSEFPA Init Block'. This is required to
show LCY Label in the reports, for the legal entity selected in the prompt.

m  The steps to be followed for creating cube related RPD is mentioned in the following procedure:
i. Create a folder “xmlpatch” in your system and copy the EFPA.rpd (Its RDBMS RPD) & EFPA_Cube_Patch.xml
files.

ii. Open the EFPA Repository (EFPA.rpd) in offline mode.
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E Oracle Bl Administration Tool
File Tool: Help

DeldFeds LE6 B Rah TERAGHEEH|H

Lookin: | | smlpatch - ef e mEr

Libraries

B
|

-
Computer [

File name: [eFPAmpd
. Files of type: IRapository Files (" rpd)

'y

iii. Give the repository password as “Admin123”.

E Oracle BI Administration Tool
File Tools Help

hewwseda|tar

ST RN T

=
Open Offline EFPA.rpd [E=NIEEX

S
_ Concd |

[ceeseessl
_ b |
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iv. Choose “Merge” option from File Menu.

E Oracle Bl Administration Tool - EFPA.rpd
mEdi‘t View Manage Tools Diagram Window Help

New Repository... Ctrl+N B A N =

Open 4
Multiuser 4
Source Control 4
Close

Save Ctrl+5
Save As 4
Copy As 4

Change Password...

Print Preview.,.,
Print

Import Metadata...

Compare...

Turn off Compare Mode

Check Global Consistency Ctri+K
Check Models 4

Check Cut All
Check In Changes
Undo &ll Changes

1 EFPA.rpd

2 EFPA_Dashboard_analysis.rpd
3 EFPA.rpd

4 EFPA_Cube_Final.rpd

Exit

v. Onthe Merge Repository Wizard screen, choose option as “Patch Repository Merge”.

E Oracle BI Administration Tool - EFPArpd

File Edit view Manage Tools  Diagram.  Window Hi\p
psLEE

J [ & @ | Merge Repository Wizard - Select Input Files E‘E‘g

Plesentat\'ol } Merge Type:  {~ Full Repository Merge @ Patch Repository Merge =
n Select Input Files
2

[ § Ba\aq

Fi Qriginal Master Repository: 3
% el Desfine Merge Sticteqy o pository: | select
@ Incom Repository Password:

Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIFE_T2T\xmipatch\EFPA.rpd

Repository Password: ssssssss

Patch File: I Select...
Patch Password:

Save Merged Repository as:  [D:\1_PFTBL Project Work\81_Metadata_Sheats OBIEE_T2T\xmipatch\EFPA(L).rod Select  *

Repository Password: sesssres

i

¥ Equalize during merge

Help Back Next Finish Cancel

For Help, press F1

N
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vi.

Select the Original Master Repository as “EFPA.rpd” from xmlpatch folder by clicking select option.

E Oracle BI Administration Tool - EFPA.rpd

File Edit Wiew Manage Tools

Diagram _Window

Help

Patch File:

9/27/2014

J [l & @ | Merge Repository Wizard - Select Input Files ‘ IS
Presentation| . Merge Type: ¢ Full Repostory Merge @ Patch Repository Merge ical

5 n Select Input Files E

Finand |_1L| Define Merge Sitegn Original Master Repository: |D:\LPFTBLProJect,Work\al,Memdam,sheets,oBIEE,TZT\meuat:h\EFPA.md select  »| | [ EFPAEss

@ Finang

@ Incom: [ . . g
E Select Original Repository
Modified Repository: e I | omlpatch j <) 1 @v Selet >
Name < Date modified

Save Merged Repository as: Deskiop Select
¥ Equalze during merge Libraries
13
‘Computer 4 I I _’I
- File name. [EFPARd ~] Open
L3
! Fies of type: [Repository Fies (“md) =] Cancel
Help Back | Kext Finish Cancel
For Help, press F1 A
o . “ . ” . . .
vii. Give “Admin123” as password for Original repository.
[=] oracle BI Administration Tool - EFPA.rpd
File Edit View Manage Tools Diagram Window fHelp
J O & @ | Merge Repository Wizard - Select Input Files [E=E
Presentation N Merge Type: ¢ Ful Repository Merge @ Patch Repository Merge ical
n Select Input Files
-[) Balang E
@ Finan Original Master Repository: |D:\lJFTBLProjeCt,Work\alfMemdamjheetstBIEEﬁTZT\mepatth\EFPA.rpd Select  » E
@ Finan Define Merge Strategy —
@ Incong Repository Password: PR
Modified Repository: | D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmlpatch\EFPA.rpd Select >
Repository Password: seseeeee
Patch File: | Select...
Patch Password:
Save Merged Repository as: | D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA(1).rpd Select ¥
Repository Password: ssssssss
I Equalze during merge
Back Hext Firish Cancel

Help

For Help, press F1

=
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viii. Select the xml patch file from the saved path (xmlpatch folder).

E Oracle BI Administration Tool - EFPArpd
File Edit wview Manage Tools Diagram Window Help
J [l & @ | Merge Repository Wizard - Select Input Files ‘ EIE
Presentation| } Merge Type:  {~ Full Repository Merge @ Patch Repository Merge ical
Select Input Files
n 8 EFPA
Original Master Repasitory: ID:\I,PFTBLPmJect,Wovk\&l,MeGdam,sheets,uBIEE,TZT\)(mIpat:h\EFPA.md Select  » [Za EFPA_E
Define Merge Strateqy —I*
Repository Password: ssssssss
Modified Repository: I D:\1_PFTBI Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA.rpd L
Repository Password: ssssssss
Patch File: I Select... I
Patch Password:
s
[=] select The Patch File
Save Merged Repository as: = 2l
Lockin: [} mipatch
Repos
MName +
| | EFPA_Cube_Patchxml
¥ Equalize during merge
Desktop
Libraries
Help Ih Cancel
For Help, press F1 ﬂ"j
£S
computer [l | | i
File name: |EFPA_Cube_Patchoxml ~ Open
Files of type: [XMIL Fies i) | Cancel
H H “ B ” .
ix. Give “Admin123” as Patch file password.
[=] Oracle B1 Administration Tool - EFPA.rpd
File Edit View hdanage Tools _Diagram \Window Help
J [ & @ | Merge Repositary Wizard - Select Input Files { =0 g
- Merge Type: " Full Repository Merge @ Patch Repository Merge ical
n Select Input Files =
Original Master Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIFE_T2T\xmipatch\EFPA.rpd Select  » EFP.
Define Merge Stiategy 4—
Repaository Password: W
Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA.rpd Select
Repository Password: eeeseses
Patch File: I D:\1_PFTBL Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA_Cube_Patch.xml Select...
Patch Password: IW
Save Merged Repository as: ID:\1_PFTBI_PmJect_ka\Bl_MeEdaG_Sheets_OBIEE_TZT\mepat(h\EFPA(1).rpd Select  *
Repository Password: ssssssss
¥ Egualize during merge
Help Back | Next Finish
For Help, press F1
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X.

Change the name of the merged repository to “EFPA_C1.rpd”.

E Oracle BI Administration Tool - EFPA.rpd
File Edit Wiew Manage Tools Diagram ‘window Help
J [l & @ | Merge Repository Wizard - Select Input Files ‘ = %
Presentation| _ Merge Type: " Ful Repostory Merge @ Patch Repository Merge Isiral
Select Input Files
) Balanc n '8 EF
) Finand Original Master Repository: | D:\1_PFTBI Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA.rpd select | ||E EF
@ Frand Defie Merge Strategy =
- @ Incom Repository Password: P
Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA.rpd Selet >
Repository Password: ssssssss
Patch File: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA_Cube_Patch.xml Select...
Patch Password: -
Save Merged Repository as:  [D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIEE_T2Thmipatch\EFPA(L).d Select  *
Repository Password: sesseres
s
E Select repository file to save the merged result g
¥ Equalizs during merge Saven: | | xmipstch ~ @ m-
Name = |‘| Date modified
EFPAIRd 9/27/2014 3:38 Pl
Desktop
Help J Cancel
For Help, press F1 E
Libraries
Ay
Computer 4 I I LI
File name: EFPA_Cllmpd - Save
. | -l |
L Saveastype:  [Repostory Flles (nd) = Cancel
xi. Click on Next.
[=] oracle BI Administration Tool - EFPA.ipd
File Edit View Manage Jools Diagram Window Help
J O & @ | Merge Repository Wizard - Select Input Files =S
Presentati _ Merge Type: ¢ Ful Repository Merge @ Patch Repository Merge ica
n Select Input Files
[ Baland
@ Finans Original Master Repository: ID:\ljFTBLProjacthork\E\lfMemdamjheetstBIEEﬁTZT\mepatth\EFPA.rpd Select  »
& Frion Define Merge Strategy
) Incomd Repository Password: N
Modified Repository: | D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmlpatch\EFPA.rpd Select >

Help

Patch File:

Save Merged Repository as:

I Equalze during merge

Repository Password: *reesree

| D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_Cube_Patch.xml

[

Patch Password:

| D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmlpatch\EFPA_Cl.rpd

Repository Password: sessssss

Next Firish

Cancel

Back |

For Help, press F1
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Note: If “Merge Repository Wizard — Define Merge Strategy” window opens up then skip the below steps
and proceed from “Step: xxiii” onwards. In this case the final Cube Rpd name will be “EFPA_C1.rpd”".
Otherwise proceed ahead with the below steps.

xii. Check for global consistency by clicking on “Check Global Consistency Ctrl+K” under “File” menu.

E Oracle BI Administration Tool - EFPA_C1.rpd
m Edit View Manage Tools Diagram Window Help

MNew Repository... Ctrl+N
Open 4
Multiuser 4
Source Control *
Close

Save As 4
Copy As 4

Change Password...

Import Metadata...
Compare...

Merge...

Check Global Consistency Ctri+K

1 EFPA_Cl.orpd

2 EFPA_patched.rpd

3 EFPArpd

4 EFPA_Dashboard_Analysis.rpd

Exit

xiii. It should result in no errors. Click on “OK” button.

Oracle BI Administration Tool &J

o Consistency check fixed certain object(s); there are no errars,
¥/ warnings or best practice violations left to report.
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xiv. In “xmlpatch” folder copy “EFPA_C1.rpd” and paste so that a new duplicate rpd gets created “EFPA_C1 -

Copy.rpd”.

@©v|, » Computer » Data (D:) » 1_PFTBLProject_Work » 81_Metadata_Sheets_OBIEE_T2T » xmlpatch »

File Edi

it View Tools Help

Organize

’

- Include in library « Share with +

51_InstallationOf_61_And_ML -
52_GSH_Issues
53_Translation_Config_Schema_Dump
54_Performance_Tuning

55_ReplLine_ DT
56_All_documentation_Verification
57_2_Adjustments_Project
57_GLRecon_HandOver
58_EFPA_11.1.1.7.0_Qualification
59_Disaster_Recovery_and_Issues
60_EFPA_RPD_And_Catalog_Cleanup
61_EFPA_MergeStatementGenerate

Burn New folder

MName

= EFPA.rpd
" erpazip
B| EFPA_C1 - Copy.rpd

Date modified

9/27/2014 3:38 PM
9/27/2014 3:38 PM
10/8/2014 7:00 PM

Type

RPD File
zip Archive
RPD File

Size
181 KB
74 KB
179 KB

| & erpa_ctrpd

10/8/2014 7:00 PM

RPD File

179 KB

EFPA_Cube_Patch.xml
"*a] EFPA_patched.merge_log.csv
B Steps_to_create_Cube_RPD.doc

9/27/2014 3:38 PM
10/8/2014 7:00 PM
10/8/2014 7:00 PM

XML File

Microsoft Office Ex...
Microsoft Office W...

313 KB
T KB
2,737 KB

xv. In the currently opened “EFPA_C1.rpd” click on “Merge...”

under “File” menu.

E Oracle BI Administration Tool - EFPA_C1.rpd
m Edit View Manage Tools Diagram

Window Help

MNew Repository... Ctrl+N
Open 4
Multiuser 4
Source Control 4
Close

Save Ctrl+s
Save As 4
Copy As 4
Change Password...

Print Preview..,
Print

Import Metadata...
Compare...
Turn off Compare Mocde

Check Global Consistency Ctri+K
Check Models -

Check Cut All
CheckIn Changes
Undo All Changes

1 EFPA_Cl.rpd

2 EFPA_patched.rpd

3 EFPArpd

4 EFPA_Dashboard_Analysis.rpd

Exit

. g N
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xvi. On the Merge Repository Wizard screen, choose option as “Patch Repository Merge”.

E Oracle BI Administration Tool - EFPA_Cl.rpd

File Edit view Manage Tools  Diagram.  Window Hi\p
psLEE

J [ & @ | Merge Repository Wizard - Select Input Files

= | E g
Presentation , Merge Type: " Full Repository Merge @ Patch Repository Merge cal
o 3 n Select Input Files =
Fi Original Master Repository: b EFPA|
% el Define Merge Stategy righal Master Repostory: | Select

@ Incom Repository Password:

Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_C1.rpd 7
Repository Password: ssssssss

Patch File: I Select...
Patch Password:

Save Merged Repository as:

I D:\1_PFTBI Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_C1(1).rpd Select  *

Repository Password: sesssres

¥ Equalize during merge

Help Back Next Finish Cancel

For Help, press F1

A=

I
xvii. Select the Original Master Repository as “EFPA_C1 - Copy.rpd” from xmlpatch folder by clicking select option.

E Oracle BI Administration Tool - EFPA_Cl.rpd

File Edit View Manage Tools Diagram Window Help

J [ & @ | Merge Repository Wizard - Select Input Files

) EFPA_CLipd 10/8/2014 7:00 Phv

[=[@] = |
Presentation| Select Input Files Merge Type: (" Full Repository Merge @ Patch Repository Merge Isiral
Balan n 3 Erp
Fi O | Master R itory: 3 EFP
@ frrd | | [2] vetve Hoe vy rord actor Rptory: | st ] | B
-5 Incom Repository Password:
g .
Modified Reposttory: | [&] elect Original Repository i - [ Selert b
Look i [ smipeten ] e mr
patch Fle: DR = [ 7| Date modiied Select...
= EFPA.rpd 9/27/2014 3:38 Ph
SJeFpa_C1 - Copy.rpd 10/8/2014 7:00 P!

Save Merged Repositor

Select  »

¥ Equalize during rmef

Libraries

A
Computer 4 I I LI
File rame: [EFPACT - Copypd ~| Open

Files of type: [Repostory Fies ) | Cancel |

Help

Finish Cancel

For Help, press F1

N —
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xviii.Give “Admin123” as password for Original repository.

E Oracle BI Administration Tool - EFPA_Cl.rpd
File Edit view Manage Tools  Diagram.  Window Hi\p
J [ & @ | Merge Repository Wizard - Select Input Files = g
Presentation , Merge Type: ¢ Full Repository Merge @ Patch Repository Merge cal
n Select Input Files
§ Balane EF
@ Finan Original Master Repository: |D:\LPFTBLPrmect,Work\aLMeudam,sheets,uBIEEjzr\xmlpat:h\EFPA,m - Copy.rpd Select  » EF
@) Finen [2] Define Meige Shiategy
@ ncomt Repository Password: [—
Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_C1.rpd 7
Repository Password: ssssssss
Patch File: I Select...
Patch Password:
Save Merged Repository as: |n:\1)FTBIJmJect,Work\m,Memdam,sheets,0BIEE,TZT\xmlpat:h\EFDA,cu1).rpd Select ¢
Repository Password: sesssres
¥ Equalize during merge
Help Back Next Finish Cancel
For Help, press F1 Y
xix. Select the xml patch file from the saved path (xmlpatch folder).
E Oracle Bl Administration Tool - EFPA_Cl.rpd
File Edit View Manage Tools Diagram Window Help
J [ & & | Merge Repository Wizard - Select Input Files ‘ B X
Presentation| -~ Merge Type: ¢ Ful Repository Merge @& Patch Repository Merge Isiral
Select Input Files sl
() Balan &=
@ Finang Original Master Repository: I D:\1_PFTBL Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_C1 - Copy.rpd Select  » [ EF
@) Finand Define Merge Strateqy
@ Incorm Repository Password: .
Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIFE_T2T\xmipatch\EFPA_C1.rpd Select
Repository Password: ssssssss
Patch File: I
Patch Password:
Save Merged Repository as: [ -
[=] select The Patch File - [===e| s
Lookin: |1 nipatch - e mE
Name = Date modified
¥ Equalize during merge EFPA_Cube_Patchxml
Desktop
Help > = Firiish Cancel
Libraries
For Help, press F1 Y
A
Computer Al I I LI
File name: EFPA_Cube_Patchxml - Open
. | =l |
! Files of type: [XML Fies (ami) | Cancel
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xX. Give “Admin123” as Patch file password.

E Oracle BI Administration Tool - EFPA_Cl.rpd
File Edit view Manage JTools  Biagram, window Hel
S J =T
J [ & @ | Merge Repository Wizard - Select Input Files = g
Presentation , Merge Type: ¢ Full Repository Merge @ Patch Repository Merge cal
n Select Input Files —
Original Master Repasitory: I D:\1_PFTBL Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA_C1 - Copy.rpd Select  » EFF
Define Mergs Stistegy —I*
@ Incom Repository Password: [ ge. .
Modified Repository: I D:\1_PFTBI Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_Cl.rpd L
Repository Password: ssssssss
Patch File: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA_Cube_Patch.xml Selact...
Patch Password: W
Save Merged Repository as: |D:\LPFTBLPmJect,wark\m,memdam,sheers,DBIEEJZT\mepat:h\EFPA,cu1).rpd Select *
Repository Password: .o .
¥ Equalize during merge
Help Back Next Finish Cancel |
For Help, press F1 A
H H u ”
xxi. Change the name of the merged repository to “EFPA_Cube.rpd”.
E Oracle BI Administration Tool - EFPA_Cl.rpd
File Edit wview Manage Tools Diagram Window Help
J [l & @ | Merge Repository Wizard - Select Input Files ‘ EIE
Presentation| } Merge Type:  (* Ful Repository Merge @ Patch Repository Merge Isiral
Select Input Files E-
L , a:
Original - - — — - Copy.rod Select  » @ E
Deline Meige Stategy E Select repository file to save the merged result u
Savein | ). xmipatch j [< N5 BEdrid
Modified; .rpd 7
Name = |‘| Date modified E =
= EFPAarpd 9/27/2014 338 Ph
FPA_C1 - Copy.rpd 10/8/2014 7:00 PN
Patch i ) EFpA_CLrpd 10/8/2014 700 21, | [Ioe_Patch i Select...
Save Me (1).rpd Select  *
Libraries
il
computer [l | | i
File name [EFPA_Cube pd =~ Save |
Saveastpe:  [Repostory les ("pd) =] Cancel
Help Back | Next Finish Cancel
For Help, press F1 A
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xxii. Click on Next.

E Oracle BI Administration Toal - EFPA_CLrpd
File  Edit View Manage Tools Diagram window Help

J [ & @ | Merge Repository Wizard - Select Input Files E@g
Presentation] . Merge Type: " Full Repository Merge @ Patch Repository Merge cal
) Bala n EFP|
& Finan Original Master Repository: | D:\1_PFTBI Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA_C1 - Copy.rpd Select  » EFP,
@ Fran Defie Merge Strategy
- @@ Incomf Repostory Password: [ esseesss
Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmlpatch\EFPA_C1.rpd Selet >
Repository Password: ssssssss
Patch File: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA_Cube_Patch.xml Select...

Patch Password: -

I D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA_Cube.rpd

Repository Password: sesseres

Save Merged Repository as:

¥ Equalze during merge

Help Back |

Next Finish Cancel |

A

| |

xxiii.The wizard asks for the confirmation for deletion. Please select option “Current” under Decision dropdown.

For Help, press F1
\

E Oracle BI Administration Tool - EFPA_C1 - Copy_patched.rpd
File Edit View hanage Tools Diagram window elp

J [ & @ | Merge Repository Wizard - Define Merge Strategy EI_‘Q
Presentatiof Celect Input i @ > ‘ | & =2 ‘l_ Show qualfied names k!
m elect Input Files - =
u Deofine Merge Stratogy ] Type Name Description Decision | 4| EFF
ElR Column : Year-lo-Date

Deleted from Current | Current
Deleted from Current | Current
Deleted from Current  [Current—— ~|

ﬁ Logical Table Source : FCT_LEDGER_STAT
ﬁ Logical Table Source ; FCT_MGMT_REPORTING

1]

Original repository

Modified repository Current repository

- @1 FCT_MGMT_REFORTING 4 FCT_MGMT_REFORTING 4 [ Dim - Run A
'@ ADPAMNRE - @ ADPAMNRE - &) Fact - Management Reporting
- ' - = - ' is £ Fact - Management Reporting RDBMS
T —— 3 T s 8 e e toceronis ]
EFPA_C1 - Copy.rpd EFPA_C1_equalzed_again.rpd EFPA_C1 - Copy_patched.rpd
Differences:
Following objects were deleted from the Current repository: =
“ O
™ Check consistency of the merged RPD
Help Back Mext Finish | Cancel |
Logical Table Source : "Management Reporting"."Fact - Management Reporting”."FCT_MGMT_REPORTING" : Active Source A
\
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xxiv.Click on Finish.

E Oracle BI Administration Tool - EFPA_C1 - Copy_patched.rpd

view Manage Tools_ Diagram, Window Help
[) & & | Merge Repository Wizard - Define Merge Strategy o X
Presentation 77 setect Inout Fil @ o @ B [ show qualified names
BT cetinputFles conflicts: -
Fi == —
* % F‘"a” Define Merge Stiategy [ Type Name D Decision [«
=+ inan [5: Presentation Column | Yearto-Date Deleted from Current  Current
- ) Incomy & Logical Table Source | FCT_LEDGER_STAT Deleted from Curent | Current
ﬁ Logical Table Source | FCT_MGMT_REPORTING Deleted from Current ICurrsnt A
=l
Original reposttary Modified repository Current repository
& FCT_MGMT_REFORTING - @ FCT_MGMT_REFORTING - 4 [ Dim - Run -
@ ADPAMNRE =i @ ADPAMNRE =l =[] Fact - Management Reporting =
[ ' - £ [ ' s -] Fact - Management Reporting RDBMS
< v | LA Rttt
EFPA_C1 - Copy.rpd EFPA_C1_equalized_again.rpd EFPA_C1 - Copy_patched.rpd
Differences:
E\awmg objects were deleted from the Current repository: Jﬂ
[™" Check consistency of the merged RPD
Help Finish ‘ Cancel ‘
Logical Table Source : "Management Reporting”."Fact - Management Reporting"."FCT_MGMT_REPORTING" : Active Source

This creates a merged repository (EFPA_Cube.rpd) under xmlpatch folder.

Take the “EFPA_Cube.rpd” file and deploy it using EM console on the environment where Data is to be fetched from
ESSBASE Cubes.

Note: Provide connection details of RDBMS in ‘OFSEFPA Connection Pool’ and ‘OFSEFPA Init Block’. This is
required for LCY Label in the OBIEE reports.

5. OFSAAI Startup

OFSAAI servers need to be restarted, in order to see the transformations in the Post Load Transformation screen.
6. Security Roles

Security roles are created in OBIEE to allow or disallow certain users to see selective dashboards and data. To accomplish

these user roles can be created in OBIEE. This step is optional and the procedure to create user roles is mentioned beow
(in this procedure LoB stands for Line of Business):

a. Open Admin Console of OBIEE.

b. lick on Security Realms under Domain Structure.
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c. Click on myrealm under Realms.

Change Center
View changes and restarts

Click the Lock & Edit button to modify, add or
delete items in this domain.

Lock & Edit

Release Configuration

ORACLE WeblLogic Server® Administration Consocle

Domain Structure
bifoundation_domain
+-Environment
eployments

-Diagnostics

How do I..

o Configure new security reaims
» Delete security realms

+ Change the default security realm

System Status

Health of Running Servers

[ Fakd@
[ citcad@
[ Overloaded @)
[ wamng(0)
I ok (1)

Welome, weblogic | Connected to: bifoundation_dom{

ups »BusinessAnalyst »Summary of Securty Reslms =myrssim >Summary of Security Raslms

) Home Log Out Preferences d Help Q

of Security Resims =nyresim =

Home >Sumi

Summary of Security Realms

A seaurity realm s a container for the mechanisms-including users, groups, security rales, security palicies, and security providers—that are used to protect WebLogic resaurces. You can have multiple
security reaims in a WebLogic Server domain, but only one can be set as the default (active) realm.

“This Security Realms page lists each security realm that has been configured in this WebLogic Server domain. Click the name of the realm to explore and configure that reaim.

| Customize this table

Realms (Filtered - More Columns Exist)
Click the Loek & Editbutton in the Change Center to activate all the buttons on this page

New Delete Showing 1to 10f 1 Previous | Next
Name & Default Realm
myreain ) e

New Delete

Showing 1to 1of 1 Previous | Next

d. Click on ‘User and Groups’ and then on ‘Groups’.

Change Center
View changes and restarts

Click the Lock & Edit button to modify, add or
delete items in this domain.

Lock & Edit

Release Corfiguration

ORACLE wWeblLogic Server® Administration Console

Domain Structure
bifoundation_domain
ET-Environment
eployments
[H-Services

ecurity Reaims
EB-Interoperabilty
[-Diagnostics

How do L.

« Manage users and groups
* Create groups
* Modify groups
= Delete groups

Health of Running Servers

[ Failed@
[ critcal@
[ Overloaded (0)
[ waming(@
I X ()

System Status El

8 Home Log Out Preferences rd Help

Welcome, weblogic | Comnected to: bifoundation_dom|

Home >Summary of Security Realms >myresim =Users 2nd

cups »BusinessAnalyst >Summary of Security Realms »myrealm >Summary of Security Reslms >myrealm
Settings for myrealm
Configuration | Users and Groups | Roles and Policies Providers

Credential Mappings Migration

Users | Groups

This page displays information about cach graup that has been configured i this security reaim.

| Customize this table

G
New lste Showing 1 to 10 of 14 Previous | Next

[] | Name & Description Provider

[C] | AdminChannelUsers AdminChannelUsers can access the admin channel, DefaultAuthenticator
[T | Administrators Administrators can view and modify all resource atiributes and start and stop servers. DefaultAuthenticator
7] | AppTesters AppTesters group. DefaultAuthenticator
[C] | BankGlobalcFO DefaultAuthenticator
[T | B1administrators BI Administrators Group DefaultAuthenticator
] | BrAuthers BI Authors Group DefaultAuthenticator
[T | B1Consumers EI Consumers Group DefaultAuthenticator
[T | CrossDomainConnectors CrossDemainCannectars can make inter-domain calls from foreign domains. DefaultAuthenticator
[ | Deplayers Deployers can view all resource attributes and deploy applications. DefaultAuthenticator
[ | LoBManager DefaultAuthenticator
| New | [ Delete

Showing 1 to 10 of 14 Prewvious | Next
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e. Click on ‘New’ and create two new groups with the names ‘Business Analyst’ and ‘LoBManager’.

ORACLE WebLoglc Server® Admimesation Commole 202090909090

Change Center @ Home Log Out Preferences ccord Help ‘ Q Wehume,wehhq»c‘[lunned&dtﬂ: bifoundation_dom
View clinsges ol festarts Security Realms >myresim »Users and Groups > BusinessAnalyst »Summary of Security Resf Summary of Securiy Re >myrealm
Click the Lock & Edit button to modify, add or Create a New Group
delete items in this domain.
Lok B EdE oK ‘ Cancl
Releass Corfiguration Group Properties

The following properties will be used to identify your new Group.

Dol Divachee = Indicates required fields

bifoundation_domain
Bl-Enviranment

~Deployments What would you like to name your new Group?
F}-Services
~Seaurity Realms *Name:

Business Analyst
E-Interoperability

E-Disgnostics

How would you ke to descrbe the new Group?

Description:

Please choose a pravider for the group.

Provider: Defau\l.’-\umenﬁcatorm

How do L. =
OK | || Cancel
« Create groups

» Modify groups

* Delete groups
® Create users

» Manage users and groups

System Status El
Health of Running Servers

[ Fakd(®

[ critcal (@)

[ Overioaded (0)

[ waming(0)
oK (1)

f.  Click on newly created ‘Business Analyst’ group for assigning parent group.

P ] —p—— TR

Change Center @) Home Log Out Preferences

Welcome, weblogic ‘ Connected to: bifoundation_dom)

Fiome Sy of Gactiry R . Bssiniems realyst > Suriary: of Security el rrimtary of Sacinky Resims 0 ~Businass Analyst 1
View changes and restarts :
Click the Lock & Edit button to modify, add or Settings for Business Analyst
delete ftems in this domain, i
General  Membershij
Lock & Ed | i

Releass Corfiguration Save

Domain Structure Use this page to add groups to other groups.

bifoundation_domain
EH-Environment
Srpbats Parent Groups: This group can be a member of any of these parent groups, More Info...
Beais Available: Chosen:
Services
~Security Realms [[] AdminChannelusers ~ * [C] B1Authors
- Interoperability [7] Administrators
E-Diagrostics [ AppTesters
[C] BIAdministrators ,
[ BIConsumers ©
[7] BankGlobalcFo

[] CrossDomainConnectors ~

Save
How do L. =]

 Create groups
» Modify groups
+ Delate groups

System Status =
Health of Running Servers

[ Faled(@
I critca @
[ Overloaded (0)
[ waming(®)

| JeN¢
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g.
Manager.

Create two new users under ‘Users’ tab of ‘Users and Groups’. One user for Business Analyst and another for LoB

ORACLE weblogic Server® Administration Console

& Home Log Out Preferences

Change Center Help

oups >BusinessAnalyst >Summary of Securty Resims =my

Home =Users

View changes and restarts

Click the Lock & Edit button to modify, add or

Settings for myrealm
delete items in this domain.

Configuraton = Users and Grou Roles and Polides | Credential Mappings ~ Providers
Lock & Edit 5 s o

Felease Configuration | Saps

Domain Structure This page displays information about each user that has been configured in this security realm.

bifoundation_domain
#-Environment
~-Deployments
i-Services
~-Security Realms
#-Interoperability

[ Customize this table

im >Summary of Security Realms >myreaim >BankG

Migration

Welcome, weblogic | Connected to: bifoundation_dom{

SICFO »Business Analyst =myresim >Users and Groups

b Diagnastis | MNew | elete Showing 1 to 7of 7 Previous | Next
[7]| Name ¢ Description Provider
[F] | BankalobalcFo1 DefaultAuthenticator
[ | BISystemUser BI System Lser DefaultAuthenticator
.oBManager etaultAuthenticator
[T |LoBM i DefaultAuthenticator
[C] | LOBManager2 DefaultAuthenticator
How do L. B
OradleSystemUser Oradle application software system user. DefaultAuthenticator
ch cle appl Fow FaultAuth
¢ Manage users and groups [F] | RegionalHead 1 DefaultAuthenticator
s Create users
[E] | weblogic DefaultAuthenticator
o Mocify users
« Delete users | New | | Delete Showing 1to 70f 7 Previous | Next
System Status 1=

Health of Running Servers

[ Fald@
[ critc@d@
[ Overloaded (©)
[ wamng(0)
I o (1)

ORACLE weblogic Server® Administration Console

&) Home Log Out Preferences

Change Center

View changes and restarts Home »Busin

v Resims >myres

Click the Lock & Edit button to modify, add or

Settings for businessanalyst1
delete items in this domain.

General | Passwords | Attributes

Groups

Lock & Edit

telesse Corfiguration Save

Domain Structure Use this page to canfigure group membership for this user.

bifoundation_domain

Eruironment e
Deployments arent Groups:
it Available: Chosen:
B-Services T Lo
~-Security Realms 7] BIAuthors # [l Business Analyst

B-Interoperability
B-Diagnestics

[] BIConsumers

71 BankGlobalcFo |f| »
1] crossDomainConnectors|
[C] Deployers =
[7] LoBManager ®

[ Mamibnee

=E:

Welcome, weblogic ‘ Connected to: bifoundation_domain

ankGlobalCFO

ups > businessanalystl ‘

This user can be & member of any of these parent aroups,  More Info, .

Save
How do L. =]
* Create users
System Status El

Health of Running Servers

Failed (0)
Critieal (0)
[ Overloaded (0)
Warning (0)
oK (1)
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h.

j
k.

Map the newly created users to respective groups.

Change Center

View changes and restarts

delete items in this domain.

Release Corfiguration

ORACLE WebLogic Server® Administration Consele

Click the Lock & Edit button to modify, add or Settings for businessanalyst1

Lock & Edit

&) Home Log Out Preferences

Q Welcome, weblogic \ Connected to: bifoundation_domait

Hame >Bu

cups >businessanalystl

General | Passwords  Atfributes  Groups

Save.

Domain Structure
bifoundation_domain
BlEnvironment
--Deployments
BiServices
~-Security Realms
BH-Interoperability

B Diagnostics

Use this page to configure group membership for this user.

Parent Groups:
Available: Chosen:
LI e s

[7] BlAuthors - [7] Business Analyst

This user can be a member of any of these parent groups.  More Info. ..

<

[7] BIConsumers

[7] BankGlobalCFO |f
[] CrossDomainConnectors| -
[7] Deployers

[F] LoBManager &«

I Manitnes

| ®

How do L..

 Create users

Save

System Status

Health of Running Servers

[ Faled(®)
[ chital (@
[ Overloaded (0)
| " Warning (0)
I o< (1)

Close the Admin Console of OBIEE.

Open Enterprise Manager of OBIEE.

Navigate to CoreApplication > Security > Singe Sign On > Configure and Manage Application Roles.

G8Farm» | &, Topology
-
= % Farm_bifoundation_domain
[ Application Deployments
[ ebLogic Domain
[l [ Business Intelligence
5]
[ Metadata Repositories

ORACLE Enterprise Manager 11g Fusion Middleware Control

Setup» Helpw Logd

|
<} coreapplication ® Logged in as webloc

[&] Business Intelligence Instance v Page Refreshed Mar 11, 2013 8:55:58 PM 15T |

Change Center: | @ Lock and Edit Configuration @

Overview | Availabiity = Capacity Management | Diagnos

Secure Sockets Layer  Single Sign On

Single Sign On (550) Apply

550 enables a ser to log in once and gain access to all systams without being prompted ta log in again at each of them. If 550 is enabled then Orade Business Inteligence willnat challenge the user for
Suthentication and will assume the user has already been authenticated by SS0.

Enable 550

Custom

Security Realm

B Go to the Oracle WebLogic Server Administrator Console to configure and manage the Weblogic security realm.

Application Policies and Roles

' Configure and Manage Application Policies

£ Configure and Manage Application Roles ———
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I.  Create a new application roles with the name ‘Business Analyst Role’ with display name as ‘Business Analyst Role’

and ‘LoBManager’ with display name as ‘LoB Manager Role’.

ORACLE Enterprise Manager 11g Fusion Middleware Gontrol Setpw Helpy Logd)
FiFam ~ | 4 Topology
-
=1 53 Farm_bifoundation_domain
[ Appiication Deployments
[ WebLogic Domain

I
4} coreapplication@ Logged in as weblog
Business Inteligence Instance v

Page Refreshed Mar 11, 2013 9:02:41 PM IST '
Application Roles

[
application roles are the roles used by security aware appications that are specific to the application. These roles are seeded by applications in single global policy store when the applicatons are registered. These are|
also application roles that are created in the context of end users accessing the appication.

[ To manage users and groups in the WebLogic Domain, use the Orade Webl ogic Server Security Provider,
Policy Store Provider
ElSearch

Enter search keyword for role name to query roles defined by this application. Use application stripe to search if application uses a stripe that is differerent from application name
Application Stripe [ gh

Role Name | Starts With [=] ®
Createlike... A Edit.. 3¢ Delete...
A7 Display Name Description
BlAdministrator BI Administrator Role
BlAuthor Bl Author Role
BIConsumer BI Cansumer Role
W Esystem Bl System Role
BankGlobalCFO Bank Global CFO Role
LoBManager LoB Manager Role
Regionaliad Regional Head Role
4
= Membership for BISystem
Principal Display Name Type Description
BlSystemlser User

-
= (3 Farm_bifoundation_domain
[l [ Application Deployments
) WebLogic Domain

El [ Business Inteligence
[2]|coreapplication |
] Metadata Repositories

4} coreapplication® Logged in 25 weblog
@ Business Inteligence Instance v Page Refreshed Mar 11, 2013 5:085:11 PM 15T ||

Application Roles > Create Application Role
Create Application Role oK | | cancel
General

Application Stripe obi

*RoleName | Business Analyst Role

Display Name
Description
Members
An role may need to be mapped to users or groups defined in enterprise LDAP server, or the role can be mapped to other application rokes.
o Add elete...
Name Display Name

Type
No groups ar application roles added.

m. Assign Business Analyst Group to its role and similarly ‘LoB Manager’ group to its respective role.
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HiFamy

4 Topology.

5 Farm_bifoundation_domain

23 Application Deployments

& [ webLogic Domain

) [ Business Inteligence
coreapplication|

ORACLE Enterprise Manager 11g Fusion Middleware Gontral

¢ coreapplication®
Business Inteligence Instance v

Application Roles > Create Appiication Role
Create Application Role

General

Setup Helpy Logt

Logged in as weblo(

Pags Refrashad Mar 11, 201

& [ Metadata Repositories

Applicaf ipe obi

Me | Business Analyst Role

} Add Principal
Specify aiteria to search and select the application roles that you want to grant permissions to
Members |  Esearch
An application role may need to be = ation roles.
o 4 i Type [Group =
o Add Prindipal Name | Starts With [=] ®
PName ‘ Searched Principals Type
o Qrups Pk aton ol s e Principal Dispiay Name Description
| T
CrossDomainConnectors prikhapd il
foreign domains.
BlAuthors BI Authors Group
AppTesters AppTesters group.
< Business Analyst
LoBManager
AdminChannelUsers|
AdminChannelUsers cnsccessthe (=
admin channel,
Bl Administrators
ElAdministrators i
Oracle application
OradeSystemGroup software system
L gwcain.
« [ L3
|

| ok || cancel J

n. Unarchive the catalogs by selecting ACL as ‘Preserve’.

el

| Unarchive (=]
Archive file Browse...
Replace | None [=]
ac. [T - |

Help OK || Cancel

0. After un-archiving the catalogs (Financial Reporting.catalog & Management Reporting.catalog) configure the
physical tables in database PFTBI_USER_LOB_MAP to create LoB Manager and LoB mapping.

p. Step 16: Login with corresponding LoB Manager User Id to verify if the respective LoBs are being selected. To
verify all the reports, login with Business Analyst user id.
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Metadata Browser Batches:

UMM metadata (Hierarchies, Datasets, Measures, Dimensions) can be seen in Metadata Browser by executing the
Metadata Browser Batches (MDB batches) from the Batch Execution screen of OFSAAI. The batch names are mentioned
below:

1. <INFODOM>_MDB
2. <INFODOM>_MDB_OBJECT_APPLN_MAP
Additional Configuration:

1. After deploying the latest Web catalog and RPD from the server, the default reporting periods have to be set based on
users requirements. The default value has to be set at the Reporting Period prompts by editing the dashboard and
choosing a specific value for the reporting period prompt. Following are the dasbhoard pages where the default time
period is to be selected:

a. Financial Reporting>Income Statement>Time_Hierarchy Prompt

b. Management Reporting>Balance Sheet> Time Hierarchy Prompt

c. Management Reporting>FTP Reports> Time Hierarchy FTP Prompt

d. Management Reporting>Income Statement> Time Hierarchy Prompt

e. Management Reporting>Key Trends>Time Hierarchy Prompt

f.  Management Reporting>KeyTrends>Balance Trends> Time_Hierarchy_Month Prompt

g. Management Reporting > Performance Measures> Time Hierarchy Prompt

2. Create an entry in Setup_Master table to configure the identity codes that are required for Financial Reporting
dashboard reports.

V_COMPONENT DESCas "IDENTITY CODE PFTBI FR UNALLOCATED DATA" having Identity Code value in
V_COMPONENT CODE and V_COMPONENT VALUE columns.

3. If OFSEFPA 6.1.1.0.0 is deployed on Oracle ESSBASE Cubes, then the hierarchies would need to be resaved in the
Business Hierarchy link of OFSAAI. Subsequently, rebuild the Oracle ESSBASE Cubes.

Logging as System Administrator

Post installation, the first login into Infrastructure is possible only for a System Administrator through user id "sysadmn".
This ID is created at the time of installation with the password provided during installation. Enter login id "sysadmn" and
password that was provided during installation. Click Login.
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System Administrator

System Administration refers to a process of managing, configuring, and maintaining confidential data in a multi-user
computing environment. System Administration in Security Management involves creating functions, roles, and mapping
functions to specific roles. System Administration also involves maintaining segment information, holiday list, and
restricted passwords to ensure security within the Infrastructure system.

You can access System Administrator in LHS menu of Security Management. The options available under System
Administrator are:

® Function Maintenance
Role Maintenance
Segment Maintenance

Holiday Maintenance

& & & ©

Restricted Passwords

Function Maintenance

A function in the Infrastructure system defines the privileges to access modules or components and to define or modify
metadata information associated. Function Maintenance allows you to create functions for users to ensure only those
functions are executed which are specific to the user's role.

You can access Function Maintenance by expanding System Administrator section within the tree structure of LHS menu.
The Function Maintenance window displays the function details such as Function Code, Function Name, Description, and
the number of Roles Mapped to the function. The Function Maintenance window also facilitates you to view, create,
modify, and delete functions within the system.

You can also make use of Search and Pagination options to search for a specific function or view the list of existing
functions within the system.

Role Maintenance

A role in the Infrastructure system is a collection of functions defined for a set of users to execute a specific task. You can
create roles based on the group of functions to which users are mapped.

You can access Role Maintenance by expanding System Administrator section within the tree structure of LHS menu. The
Role Maintenance window displays the role details such as Role Code, Role Name, Role Description, and the number of
Users Mapped to the role. The Role Maintenance window also facilitates you to view, create, modify, and delete roles
within the system.

You can also make use of Search and Pagination options to search for a specific role or view the list of existing roles within
the system.

Segment Maintenance

Segment is used to control access rights on a defined list of objects. It is mapped to an information domain.

Segment Maintenance in the Infrastructure system facilitates you to create segments and assign access rights. You can
have different segments for different Information Domains or same segments for different Information Domains.

User scope is controlled by segment/ folder types with which the object is associated.
® Objects contained in a public folder will be displayed irrespective of any user.

® Objects contained in a shared folder will be displayed if user belongs to a user group which is mapped to an access
type role with the corresponding folder.

® Objects contained in a private folder will be displayed only to the associated owner.
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You can access Segment Maintenance by expanding System Administrator section within the tree structure of LHS menu.
The Segment Maintenance window displays a list of available segments with details such Domain, Segment Code,
Segment Name, Segment Description, Segment/Folder Type, Owner Code, and the number of Users Mapped to the
segment. You can view, create, modify, and delete segments within the Segment Maintenance window.

You can also make use of Search and Pagination options to search for a specific role or view the list of existing roles within
the system.

Holiday Maintenance

Note: As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication is configured to
SSO Authentication and SMS Authorization.

Holiday Maintenance facilitates you to create and maintain a schedule of holidays or non-working days within the
Infrastructure system. On a holiday, you can provide access to the required users and restrict all others from accessing the
system from the User Maintenance window.

You can access Holiday Maintenance by expanding System Administrator section within the tree structure of LHS menu.
The Holiday Maintenance window displays a list of holidays in ascending order. In the Holiday Maintenance window you
can create and delete holidays.

Restricted Passwords

Note: As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication Type is selected
as SSO Authentication and SMS Authorization from System Configuration> Configuration.

Restricted Passwords facilitates you to add and store a list of passwords using which users are not permitted to access the
Infrastructure system.

You can access Restricted Passwords by expanding System Administrator section within the tree structure of LHS menu.
The Restricted Passwords window displays a list of restricted passwords and allows you to add and delete passwords from
the list.

You can also make use of Search and Pagination options to search for a specific password or view the list of existing
passwords within the system. For more information, refer Pagination and Search & Filter.

Note: While searching for any pre defined restricted password, you have to key in the entire password.
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Creating Application Users

Create the application users in the OFSAA setup prior to use.

Note: This step may not be required if you have already setup users in the OFSAA setup.

For more information refer user creation section from the Oracle Financial Services Analytical Applications Infrastructure
User Guide.

Mapping Application User(s) to User Group

Starting the OFSAA 8.0 release, with installation of Profitability Application Pack, pre-configured application user groups
are seeded. These user groups are unique to every OFSAA Application Pack and have application roles pre-configured.

Map the application user(s) to the respective Application User Group(s) and subsequently authorize the entitlements by
logging in as SYSAUTH (System Authorizer) user.

For more information on seeded User Groups, see User Group Mapping.
Change ICC Batch Ownership

All the seeded Batches in OFSDF Applications Pack will be automatically assigned to SYSADMN user during Installation. If
one user who wants to see the Batches in Batch Maintenance Menu, He needs to execute the following Queries in Config
Schema of the Database.

Syntax:

begin

AAI OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromUser', 'toUser','infodom');

end;

OR

begin

AAI OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromuser', 'touser');

end;

Where from User indicates the user who currently owns the batch, to User indicated the user
to which the ownership has to be transferred. Infodom is optional parameter, if specified
the ownership of batches pertaining to that Infodom will be changed.

Eg.
begin
AAT OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('SYSADMN', 'FSDFOP', 'OFSBFNDINFO') ;

end;
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Mapping ICC Batch Execution Rights to User

By default all users who are mapped to FSDF Admin and FSDF Operator will have the permission to execute the seeded
Batches in FSDF Application Pack. However if any other user-defined batches or any other application pack batches
created during the respective installation application packs, the user need to map the Batch execution rights for each
user/batch in the Batch Execution Rights menu under Object Administration >> Object Security.

Note: Only SYSADMN user or any user who is mapped under FSDF Admin User Group will have the access to map the
Batch execution rights menu access.
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Saving Post- Load Change Transformations

After creating users, Login to Infrastructure as any user who is mapped to FSDF Admin or FSDF Analyst group. Navigate to
Data Management Framework >> Post Load Changes.
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A New window will be displayed. Click on Each Transformation from Transformations List & Click on Stored Procedure in
the Right Panel, Click on Edit in the Top Right Menu and Click on Finish Button in Bottom.

Aqaa4if

Note: All the Transformation Stored Procedures are required to be edited and saved (Finish Button) once for
getting it is available.
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APPENDIX J Cloning an OFSAA Instance

There is a consistent need for a faster and effective approach of replicating an existing OFSAA instance for further project
developments, that is, setting up OFSAA instances that are exact copies of the current OFSAA instance. For more
information on cloning, see OFSAA Cloning Reference Guide.
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APPENDIX K OFSAA Landing Page

This appendix includes the following topics:
® OFSAA Landing Page for Profitability Administrator
® Enabling a Product within an Application Pack

OFSAA Landing Page for Profitability Administrator

On successful authentication, the OFSAA Landing Page is displayed. This is a common landing page for all users until a
preferred application landing page is set by the user in his preferences.
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» @ Data Management Tools Upload Data Model in Inerementalf Append/ Complete Refresh Maodes Tools for Data Management
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7 Filters Dimension Mahagement Filters
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» % Rate Management g Exessions &ﬁ Rate Management
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» MIFTP Rate Card

The landing page includes multiple tabs and each tab has specific links to OFSAA Infrastructure and/or Application
modules. The tabs and links are displayed based on the OFSAA Application accessed and the access roles mapped to the
logged in user.

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a tree structure. The RHS Menu
holds link(s) to modules in a navigational panel format.

The following tabs are available in the Landing Page:
® Applications tab
® Object Administration tab

® System Configuration and Identity Management tab
Applications tab

This tab lists the various OFSAA Applications that are installed in the OFSAA setup. The Select Application drop-down list
displays the OFSAA Applications, based on the logged in user and mapped OFSAA Application User Group(s). Links to
related modules within Applications and Infrastructure are grouped appropriately to maintain a unified experience.
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Object Administration tab

This tab lists the various OFSAA Information Domains created in the OFSAA setup. The Select Information Domain
drop-down list displays the OFSAA Information Domains based on the logged in user and mapped OFSAA Application User
Group(s). Links to modules that enable object traceability and migration of objects are grouped in this tab.

System Configuration & Identity Management tab

This tab lists the OFSAA Infrastructure System Configuration and Identity Management modules. These modules work
across Applications/ Information Domains and hence there are no Application and Information Domain drop-down lists in
this tab. Links to modules that allow the maintenance of setup installation and identity management tasks are grouped
together in this tab.

Note: The navigation path differs from Application to Application. That is, based on the selected
Application, the navigation varies.

For more details on how to operate on each tab, see OFSAAI User Guide available in OTN.
Enabling a Product within an Application Pack

You can also enable a product/ application within an application pack post installation at any point of time.
To enable a product through the application Ul, follow these steps:
1. Login to the application as SYSADMN user or any user with System Administrator privileges.

2. Navigate to System Configurations & Identity Management tab, expand Administration and Configuration and
select System Configuration.

3. Click Manage OFSAA Product License(s) to display the Manage OFSAA Product License(s) window is displayed.

MAKWAGE OFGAA APPLICATION PACK LICENSE

INSTALLED APPLICATION PACKS

4. Select an Application pack to view the products in it. The products are displayed in the Products in the Application
Pack grid.
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5. Select the checkbox to enable a product within the Application Pack which is not enabled during installation.

6. Click VIEW LICENSE AGREEMENT to view the license information. The License Agreement section is displayed.
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7. Select the option | ACCEPT THE LICENSE AGREEMENT and click ENABLE. A pop-up message confirmation is displayed
showing that the product is enabled for the pack.

Note: To use the newly enabled product, you need to map your application users to the appropriate
product specific User_Group(s) and subsequently, authorize the actions by logging in as System Authorizer.

For more information refer to Mapping/Unmapping Users section in the Oracle Financial Services Analytical
Applications Infrastructure User Guide 8.0. To identify the newly enabled product specific UserGroups/
Application Pack specific User_Groups, refer to the respective Application Pack specific Installation and
Configuration Guide/ User Manual.
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APPENDIX L

Additional Configuration

The following sections provide detailed module specific post installation configurations.

This appendix includes the following topics:

® 6 6 8 ® & 6 6 6 ® ® & 6 6 ©© © © ©

FTP/SFTP Configuration for File Transfer

Configuration for Dimension and Hierarchy Management
Configure Infrastructure Server Memory

Internet Explorer Settings

Retrieving Patch Information

OLAP Data Server Configuration

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance

OFSAAI Setup Information Fetching Tool

Encryption Changer

Infrastructure LDAP Configuration

Configure OFSAAI Web Services

Deploy OFSAAI Web Services

Configuration to Enable Parallel Execution of DML Statements
Configure Message Details in Forms Designer

Clearing Application Cache

Configuring Password Changes

Configuring Java Virtual Machine

Configure Internal Service (Document Upload/ Download)
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FTP/SFTP Configuration for File Transfer

In OFSAA, certain modules require transfer of files from the web application server to the OFSAA server over SSH.

Follow these steps to ensure the OFSAA server recognizes the web application server during file transfers.

1.

Login to the web application server.

2. Type sftp <user>@<OFSAA Server>
3. Specify Yes when prompted for permission.
Are you sure you want to continue connecting (Yes/No)?
4. This will add an entry into the "known_hosts" file.
5. A confirmation message is displayed:

Permanently added <OFSAA Server> RSA) to the list of known hosts.

Configuration for Dimension and Hierarchy Management

These configuration changes are applicable when Dimension Management features provided in OFSAAI are used. You can
open AMHMConfig.properties file present in the SFIC_ WEB_HOME/webroot/conf directory to set the properties for the
following:

This section includes the following topics:

® 6 6 & & 8

Configure Member Deletion

Configure Attribute Default Date Format
Configure Members Reverse Population
Configure Hierarchy Reverse Population
Configure Maximum Levels allowed in Hierarchies

Configure Node Limit for a Hierarchy Tree

Configuration for Dimension and Hierarchy Management has to be done only after the application/solution installation is
done. The properties specific to Information Domain are:

o
©

$INFODOMS=<Name of the Information Domain>

$DIMENSION ID$=<Dimension ID for which the property to be set>

Configure Member Deletion

This property should be set to allow the user to delete the Members for the Dimension.

Value Code Example
# Member Deletion Configuration - MEMBER_DEL-SINFODOMS-SDIMENSIO MEMBER_DEL-ORAFUSION-1=Y
VALUE- Y/N N_IDS=SVALUES
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Configure Attribute Default Date Format

This property should be set to display the Default Date Format for Date type Attribute in Attributes window.

Value

Code

Example

# Attribute Default Date Format -
DB_DATE_FORMAT:DD-MON-YYYY

ATTR_DEF_DATE_FORMAT-$INFODOMS$=
$DB_DATE_FORMATS

ATTR_DEF_DATE_FORMAT-ORAFUSION=D
D/MON/YYYY

Configure Members Reverse Population

This property should be set for reverse population of Members for the Dimensions in required Information Domains.

Value

Code

Example

# Members Reverse population - VALUE-
Y/N

MEMBER_REVERSE_POP-SINFODOMS-SD
IMENSION_ID$=SVALUES

MEMBER_REVERSE_POP-ORAFUSION-1=
Y

Configure Hierarchy Reverse Population

This property should be set for reverse population of Hierarchies for the Dimensions in required Information Domains.

Value

Code

Example

#Hierarchy Reverse population - VALUE-
Y/N

HIERARCHY_REVERSE_POP-SINFODOMS-
SDIMENSION_IDS=$SVALUES

HIERARCHY_REVERSE_POP-ORAFUSION-1
=Y

Configure Maximum Levels allowed in Hierarchies

This property is required to set the maximum levels allowed to build the Hierarchies tree structure.

Value

Code

Example

#Hierarchy Maximum level allowed for
the hierarchy in particular Information
Domain - VALUE - Integer number

MAX_DEPTH-SINFODOMS=SVALUES

MAX_DEPTH-FUSION=15

Hierarchies greater than 15 levels are not supported within OFSAA EPM applications (ALM, FTP, PFT, and HM). If the hier-
archy data contains more than 15 levels, OFSA_IDT_ROLLUP will not be populated. The number of hierarchy levels
allowed for OFSAA EPM key dimensions must be less than or equal to 15.

® If the Hierarchy Reverse Population setting is set to "Y" and more than 15 levels exist in the data, then the following
alert is displayed "The number of levels exceeds the limit".

® Ifthe maximum level allowed setting is set greater than 15 and Hierarchy Reverse Population is set to "Y", then
following error is displayed "Error occurred in Reverse Populating the hierarchy".
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Configure Node Limit for a Hierarchy Tree

This property is required to display the Hierarchy as a small or a large hierarchy. If the tree node limit exceeds the set limit,
the Hierarchies are treated as large Hierarchy.

Value

Code

Example

#Tree node limit for the hierarchy - Values
is Integer number

TREE_NODE_LIMIT=SVALUES

TREE_NODE_LIMIT=30

Configure Infrastructure Server Memory

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic can be edited for
customizing memory settings and garbage collector settings depending on the available hardware configuration as
explained below. These settings are base minimum and has to be incremented considering the deployment metrics into
account. The increments are usually handled in multiples of 128mb for heap and 64mb for stack.

Infrastructure Application Server Memory Settings

You can configure the Infrastructure Application Memory settings as follows:

1. Locate .profile file.

2. Edit X_ARGS field in this file for customizing memory settings and garbage collector settings depends on the hardware

configuration.

This has a default value X ARGS="-Xms200m"

X ARGS=" "S$X ARGS" S$DELIM -Xmx2048m"

Note: Modify X_ARGS_APP variable in the .profile file to customize Java Memory Settings for Model Upload
based on the Data Model size.

For Run and Rule executions, the following value is recommended:

X_ARGS_RNEXE="-Xms1lg -Xmx1g
XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M -XX:+UseParallelOldGC -XX:+DisableExplicitGC"

X_ARGS_RLEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M
XX:+UseParallelOldGC -XX:+DisableExplicitGC"
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Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet Explorer, that is, 100%. Cookies should be

enabled.

application.

1.

Open Internet Explorer. Select Tools > Internet Options. The Internet Options window is displayed.

ey s — i
Website Data Settings .L

e, —
Temparary Intermeet Files | Mstory ] PR T

Internet Explorer gtores copied of webpages, images, and media
for faster viewing later.

Chieck for newer versions of stored pages:
@ Every time I visit the webpage

Ewiery time [ start Inbenmet Explorer
Automatcally
Metwer

Digk space to use (3-102494E) 250 H

(Recommended: 50-25008)
Cument locakon:

C:Wsers'shrewal \AppData Local MiorasoftWwindows Tempaorary
Irterret Files',

Move foider... | | Vewobjects | | Viewfiles |

= ]I

Cancel

J

2. Click the Settings button. The Settings window is displayed.
3. Select the option Everytime | Visit the webpage and click OK.
Internet Options -
General ;Seu.mhllﬂrwa:.'_i:mm Connectons | Programs | Advanced |
Hame page
/? To create home page tabs, type sach address anits own ine.
i aboutblank
| usgment | | usedefaut || Usemewimb |
Startup
Start with tabs from the kst session
& Start with home page
Tabs
Chiange how webpages are displayed in tabs. Tabs
Browesing history
Dibete temporary fles, history, cockies, saved passwords, and web
foemn infarmation.
Deederte brajysing history on exdt
Delate... ] | Settings
Appearance
[ colrs Lam-lan!s|| Fogts |iMc=ssﬂ-tr|
oK Conced | &
4.

5.

change the security settings.

Click Default Level under Security level for this zone.

In the Internet Options window, select the Security tab and select the Internet option under Select a zone to view or
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General Security  Privacy Content Connections Programs Advanced

Select a zone to view or change security settings.

@ ¢ v O

Internet  Localintranet Trusted sites  Restricted
sites

Internet

Sites
q Thiz zone is for Internet websites,

except those listed in trusted and
restricted zones.

Security level for this zone
Allowed levels for this zone: Medium to High
Medium-high
- Appropriate for most websites
- - Prompts before downloading potentially unsafe

content
- Unsigned ActiveX controls will not be downloaded

Enable Protected Mode {requires restarting Internet Explorer)

Custom level... Default level

Reset all zones to default level

0K Cancel Apply

6. Click OK to save.

7. Inthe Internet Options window, select the Privacy tab and select the Turn on Pop-up Blocker option under Pop-up
Blocker settings.
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General Security Privacy Content Connections Programs Advanced
Settings

Sites Advanced

Location

Mewver websites to request your Cloar tes
physical location =

Pop-up Blocker

[#] Turn on Pop-up Blocker Settings

InPrivate

[~] Disable toolbars and extensions when InPrivate Browsing starts

oK Cancel Apply

Exceptions

" Pop-ups are cumently blocked. You can allow pop-ups from specific
#!| websites by adding the site to the list below.

Address of website to allow:

| Add

Allowed sites:

* custhelp.com SRR
~oracle.com

* oraclecloud.com Remove all...
* oraclecorp.com
* oraclevpn.com

ess excelityglobal com

Motifications and blocking level:

Play a sound when a pop-up is blocked.
[+] Show Motification bar when a pop-up is blocked.
Blocking level:

Medium: Block most automatic pop-ups v

Leam more about Popup Blocker

8. Click Settings. The Pop-up Blocker Settings window is displayed.
9. Enter the URL of the OFSAA Application in the Address of Website to Allow: field.
10. Click Add. The OFSAA URL is displayed in the Allowed Sites section.

11. Click Close.
12. Click OK in the Internet Options window.

Retrieving Patch Information

To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.

2. Navigate to Object Administration tab, expand Utilities and click Patch Information.

3. The window displays the list of patches installed on the OFSAA setup across Applications/ Platform.
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OLAP Data Server Configuration

This section is applicable if you are using the OLAP feature of OFSAAI.

The following parameters must be set to ensure that the system limitations are not exceeded at any stage. The values for
these OS parameters should be specified based on the expected load at each implementation site.

Example:

Process Memory Limit

Max Thread Stack Size

Max Number of Threads per Process

® Sort Buffer settings: This must be set at the Essbase application level appropriate to the anticipated load.

® Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data Services that is
communicating with an OLAP Data Server, it is imperative to ensure that the cleanup of the old instance is completed
on the OLAP Data Server before restarting the OFSAAI Server. Pause for a period of time based on the load the system
was subjected to, before restarting the Data Services subsystem.

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance
For information on this section, refer OFS Analytical Applications Infrastructure Administration User Guide in OTN.

OFSAAI Setup Information Fetching Tool

Executing the Setuplinfo.jar file available in the FIC_HOME path will help you retrieve the related information about the
OFSAAI Set up such as Operating System Name and version, Database Type and Version, OFSAAI architecture, Log file
locations and so on.

To execute SetupInfo.jar in console:
1. Navigate to the path SFIC_HOME.
2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.
Encryption Changer

This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the encrypted values of the OFSAAI setup
according to the new key.

To execute EncryptC.jar in console:
1. Navigate to the path SFIC_HOME.
2. Enter the command:

java -jar EncryptC.jar

A confirmation message is displayed after execution.
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Once executed, you need to create and deploy the EAR / WAR file depending on the configured Web Application Server.
For more information, see Creating and Deploying EAR/WAR File.

Infrastructure LDAP Configuration

For more information on LDAP configuration, see OFSAAI Administration Guide.
Configure OFSAAI Web Services

Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or "synchronously" execute requested
tasks offered by OFSAAI. The configuration steps given below are to be done only if you are using the Web Services feature
of OFSAAL.

Configure DynamicWSConfig.xml File

For each third party web service that needs to be accessed using the OFSAAI Web services framework and the operations
to be invoked, corresponding entries are to be made in the DynamicWSConfig.xml template file.

The variable <webServer> denotes any one of the application server, i.e. WebSphere, WebLogic, or Tomcat.

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation Directory>/EXEWebService/
<WebServer>/ROOT/conf directory. This file can be placed in any directory that is accessible by the application and this
location must be specified in the web.xm1 file, as WSCONFIGFILE parameter.

The DynamicWSConfig.xml template file will be in <WebServer Deployment Path>/
EXEWebService.ear/EXEWebService.war/conf directory.
This template is given below:
<XML>
<WEBSERVICES>
<WEBSERVICE CODE="$CODE"
ENDPOINT="SENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE"
XMLNS XSD="$XMLNS XSD" ENCODINGSTYLE="$ENCODINGSTYLE"
SERVICENAME="$SERVICENAME" PORTTYPENAME="S$PORTTYPENAME"
SESSION MAINTAIN PROPERTY="S$SESSION MAINTAIN PROPERTY"
USERNAME="$USERNAME"
PASSWORD="$PASSWORD" STYLE="$WEBSERVICESTYLE"
STUBIMPLEMENTATION="$STUBIMPLEMENTATION">
<OPERATION CODE="$CODE"
NAME="$NAME"
SOAPACTION="S$SOAPACTION"
STYLE="$STYLE"
PACKAGENAME="S$PACKAGENAME ">
<INPUT ORDER="$ORDER"
PARAMNAME="$PARAMNAME"
ARGTYPE="$ARGTYPE"
CLASSNAME="S$CLASSNAME" />
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<OUTPUT PARAMNAME="$PARAMNAME"
RETURNTYPE="SRETURNTYPE"
CLASSNAME="S$CLASSNAME" />
</OPERATION>
</WEBSERVICE>
</WEBSERVICES>

</XML>

The DynamicWSConfig.xml has the placeholders as tabulated below. These have to be updated depending on the web
service chosen and the mode of accessing it. For each Web service to be accessed, the entire webservice tag in the
DynamicWSConfig.xml file must be repeated. The placeholders tabulated below should be set in accordance to the
parameters published in the third party wsdl files (webservices) to be accessed. The stub class specified must implement
the "com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF" interface.

Attributes for WEBSERVICE tag

Placeholder Description

SCODE Unique number within the xml file and cannot be 999 or 0.

SENDPOINT soap: address location in the wsdl: service name tag of the wsdl file.
STARGETNAMESPACE The attribute value for the targetNamespace of the wsdl: definitions tag.
SXMLNS_XSD The attribute value for the xmins:s of the wsdl:definitions tag
SENCODINGSTYLE The attribute value for the xmlIns:soapenc of the wsdl:definitions tag.
SSERVICENAME Name of the service found under the wsdl:service name tag of the wsdl file.
SPORTTYPENAME wsdl port type name as mentioned in the wsdl file.

SSESSION_MAINTAIN_PROPERTY

This could be given as "" also.

SUSERNAME

n

User name to access the web services. Enter "" if no user name is required.

SPASSWORD

nn

Password to access the web services. Enter "" if no password is required.

SWEBSERVICESTYLE

This can take either "rpc" in case of DIl mode of invoking web services or "stub" in case of
static mode. This is a mandatory parameter.

SSTUBIMPLEMENTATION

Fully qualified class name (package name.classname).

Attributes for OPERATION tag

Ensure that the "operation tag attributes" are repeated for each of the operation tags.

Placeholder Description

SCODE Should be unique within the Webservice tag.

SNAME The name of the Function that is to be called by the wsdl file.

SSOAPACTION The URL for the Operation to access. This is associated with the Operation tag of the wsdl
file.

SSTYLE This can take "rpc" if the web services invoking is in DIl mode or "stub" if it is in static
mode. This is a mandatory parameter.

SPACKAGENAME Represents the JAXB package of input object.
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Attributes for INPUT tag

Placeholder Description

SORDER The sequential number of the INPUT tag. Should start from 0. This is in line with the input
order of the arguments that the APl accepts which is called by this operation.

SPARAMNAME Input parameter name to be called by the wsdl file.

SARGTYPE Input Parameter Data Type. If the input argument type is complex object, specify
SARGTYPE as "xmlstring".

SCLASSNAME Represents class name of input object parameter.

Attributes for OUTPUT tag

Placeholder Description

SPARAMNAME Output parameter name to be returned by the web service.

SRETURNTYPE Output parameter Data Type. If the web service response is a complex object, then specify
SRETURNTYPE as "object".

SCLASSNAME Represents class name of output object parameter.

web.xml Entries

1. This step is optional and required only if the web application server used is Tomcat. In case of any other application
server, skip and proceed with next step.

Navigate to SFIC_HOME/webroot/WEB-INF/ and edit the web . xm1 file. Set parameter value DOCSERVICEAPP to

EXEWebServiceAXIS.

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and edit the web . xm1 file

as explained below.

Note: In case of Java 7 when Weblogic is used as web application server replace following line of <OFSAAI
Installation Directory>/EXEWebService/Weblogic/ROOT/WEB-INF/web . xn1 file that is

<?xml version='1.0"'

encoding='UTF-8"'?>

<web-app id="WebApp ID" version="3.0"

xmlns="http://java.sun.com/xml/ns/javaee"

xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xsi:schemalocation="http://java.sun.com/xml/ns/javaee

http://java.sun.com/xml/ns/javaee/web-app 3 0.xsd" metadata-complete="true">

with

<?xml version='1.0"'

encoding='UTF-8"'?>

<web-app xmlns="http://java.sun.com/xml/ns/j2ee"

xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
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Entry for WSConfig File

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer Deployment Path>/
EXEWebService.ear/EXEWebService.war/conf directory. This file can be placed in any directory that is accessible by the
application.

The path where the WSCONFIG file is placed must be specified in place of SWSCONFIGFILELOCATIONS in the below block
of text in web.xml.
<context-param>
<description>WebServices Configuration File</description>
<param-name>WSCONFIGFILE</param-name>
<param-value>$SWSCONFIGFILELOCATIONS</param-value>
<!--Specify the Location of DynamicWSConFig.xml-->

</context-param>
Proxy Settings

Replace the following <param-value> given in bold in the following block of text in web . xm1 file, with appropriate
values.
If no values are required, leave the <param-value> blank.
<context-param>
<description>http Proxy Host</description>
<param-name>http.proxyHost</param-name>
<param-value>$PROXYHOSTS$</param-value>
<!-- Specify the IP address or hostname of the http proxy server-->
</context-param>
<context-param>
<description>http Proxy Port</description>
<param-name>http.proxyPort</param-name>
<param-value>$PROXYPORTS$</param-value>
<!--Port Number for the Proxy Server-->
</context-param>
<context-param>
<description>http proxy UserName</description>
<param-name>http.proxyUserName</param-name>
<param-value>$PROXYUSERNAMES</param-value>
<!-- User ID To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http proxy Password</description>
<param-name>http.proxyPassword</param-name>
<param-value>$PROXYPASSWORDS</param-value>
<!-- User Password To get authenticated by proxy server-->

</context-param>
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<context-param>
<description>http non-ProxyHosts</description>
<param-name>http.nonProxyHosts</param-name>
<param-value>$NONPROXYHOSTS$</param-value>

<!--Hosts for which the proxy settings should get by-passed (Note: Separate them by
"|" symbol) -->

</context-param>
OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAAI installation and should be accessible.

Replace $SFIC HOMES in the following block of text in web . xml with <WebServer Deployment
Path>/EXEWebService.ear/EXEWebService.war.

<context-param>
<description>OFSAAI Web Home</description>
<param-name>FIC HOME</param-name>
<param-value>$FIC HOMES</param-value>
<!--OFSAAI Installation Folder-->

</context-param>

<context-param>
<description>OFSAAI Web Home</description>
<param-name>FIC PHYSICAL HOME</param-name>
<param-value>$FIC HOMES</param-value>
<!--OFSAAI Installation Folder-->

</context-param>
DynamicWSConfig.xml

For each third party web service that needs to be accessed using the OFSAAI Web services framework, and the operation
to be invoked, make corresponding entries into this file. This file is to be placed in the location that is specified in the
web.xml, as WSCONFIGFILE parameter.

Deploy OFSAAI Web Services

You can deploy OFSAAI Web Services separately if you had not configured OFSAAI Web Services as part of the installation.
1. Complete the manual configuration of OFSAAI Web Services.
2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> and execute the command:

./ant.sh
3. This will trigger the EAR/WAR file creation, which is required for the deployment.

4. Deploy the generated ExEWebService.EAR/EXEWebService.WAR file into the WebServer.

If you have already configured OFSAAI Web Services as part of the installation, deploy the generated
EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI Deployment area in WebServer profile.
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Configuration to Enable Parallel Execution of DML Statements

A configuration file, OracleDB.conf has been introduced to accommodate any configurable parameter related to
operations on oracle database. If you do not want to set a parameter to a specific value, then the respective parameter
entry can be removed/commented off form the OracleDB. conf file which resides in the path SFIC_DB_HOME/conf.

As of now, the OracleDB. conf file has only one parameter namely CNF_DEGREE_OF PARALLELISM. This parameter
indicates the degree of parallelism to be used for a DML operation if parallel DML is explicitly enabled in the session with
the ENABLE PARALLEL DML clause of the ALTER SESSION statement. The default mode of a session is DISABLE
PARALLEL DML.If CNF_DEGREE OF PARALLELISM is not set, then the default degree, as decided by Oracle will be used.

Configure Message Details in Forms Designer

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries module by updating the
details of mail server in the "NotificationConfig.cfg" file which resides in the path
SFIC_APP_HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message details are included in
Administration > Security Management > User Administrator > User Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Parameter Description

SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server.

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true’, otherwise set value to 'false'.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be authenticated, otherwise set to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if authentication is not required use a dummy
value.

SMTP_PASSWORD Password required for logging into SMTP server, if authentication is not required use a dummy
value.

SMTP_MAILID If the Messages has to go from a Particular ID that ID need to be added. Exchange server forces
you set a valid ID that is there in the exchange server (Based on Security settings).

Ensure that the authorized User details are included in Administration > Security Management > User Administrator > User
Maintenance window.

Clearing Application Cache

This is applicable to all Web Servers (i.e. WebSphere, WebLogic, and Tomcat).

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, navigate to the following path
depending on the WebServer configured and clear the cache:

® Tomcat: <Tomcat installation folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

® Weblogic: <Weblogic installation location>/domains/<Domain name>/servers/<Server
name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet

® WebSphere: <Websphere installation directory>/AppServer/profiles/<Profile name>/temp/<Node
name>/serverl/<Application name>/<.war file name>
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Configuring Password Changes

This section explains about how to modify the OFSAA Infrastructure Config Schema and Atomic Schema passwords.

OFSAA Infrastructure Config Schema Password Modification

To change the Config Schema password, perform the following steps:

1.
2.
3.

Change the Config schema User Password in the database.
Delete the SFIC_HOME/conf/Reveleus.SEC file.

Shutdown the OFSAAI App service:

cd $FIC_APP HOME/common/FICServer/bin
./stopofsaai.sh

Start the Infrastructure Server in foreground directly on the server or through X-Windows software using the
command:

./startofsaai.sh

At the prompt, enter System Password. Enter the "new Config schema" password. The service will start and initialize
itself if it is able to successfully connect to the DB.

Post successful startup of the service, if required, the Infrastructure server may be shut down and restarted in the
background using nohup mode.

OFSAA Infrastructure Atomic Schema Password Modification

To change the Atomic Schema password, perform the following steps:

1.
2.

Change the Atomic schema User Password in the database.

Login to the application from the browser using SYSADMN account or any user id, which has System Administrator
role mapped.

Navigate to System Configuration > Database Details window. Modify the password as explained in the following
steps:

a. From the Database Master window, select the connection whose password you want to modify and click 4
button from the toolbar.

m  Click 4 button corresponding to the Alias Name. The Alias Details window is displayed.
m  Modify the password in the Auth String field.

If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag details in Server.xml file from the
SCATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will exist).

If you are using WebSphere as Web server:
a. Login to the WebSphere Administration Console, from the left side menu.
b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic data
sources will need to be modified).
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If you are using WebLogic as Web server:

a. Login to the WebLogic Administration Console, from the left side menu.

b. Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC >Data Sources.
A list of data sources will be populated on the right side.

m  Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic data
sources need to be modified).

6. Restart the OFSAAI services.
Configuring Java Virtual Machine

While running several database intensive tasks in parallel, fetching the database connection from connection pool may
face an error. To ensure no such error is encountered, add the line securerandom. source=file:/dev/./urandomin
the java.security configuration file available in SIAVA_HOME/jre/lib/security/ path.

This needs to be configured on all the machines or virtual machines where the OFSAAI database components (ficdb layer)
are installed.

Configure Internal Service (Document Upload/ Download)

This step can be ignored if it has already been configured as part of any previous IR/ML installation.

The Document Upload/Download feature has undergone a change and can now be configured to use Internal service for
document upload/ download instead of the earlier ExeWebService.

To facilitate Internal service for document upload/ download, perform the following configurations:
1. Create the folders download, upload, TempDocument and Temp in the local path of Web application server and
provide Read/Write permission.
m To find the exact location, execute the following query in CONFIG schema:
select localpath from web server info
B To create folders with Read/Write permission, execute the command:
mkdir -m 777 download upload TempDocument Temp
2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write permission.
m  To find the exact location, execute the query in CONFIG schema:
select ftpdrive from app server info
m  To create folder with Read/Write permission, execute the command:

mkdir -m 777 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to FALSE in the Configuration table in CON-
FIG schema and hence the application "ExeWebService" will not be used. It is recommended that the value to be set to
FALSE and use the Internal service for document upload/ downloads. If you intend to continue using the External ExeWeb-
Service, set the value to TRUE.

Navigate to SFIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier and type ./ant.sh. This triggers the
creation of EAR/WAR file EXEWebService.ear/.war. The EAR/WAR file EXEWebService.ear/.war will be createdin
SFIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier. Redeploy the generated EAR/WAR file onto your
configured web application server.
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APPENDIX M Patching Your OFS PfOﬁtabI/Ity
Pack Installation

Oracle strongly recommends installing the latest available patchset so as to be up to date with the various releases of the
OFSAA Infrastructure product.

Refer http://support.oracle.com for more information on latest releases.
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APPENDIX N Grants for Atomic/ Config Schema

This Appendix includes the following sections:
® Grants for Atomic Schema
® Grants for Config Schema

® Grants on Config Schema Entities for Atomic Users
Grants for Atomic Schema

Atomic Schema creation requires certain grants for object creation. This can be located in
SFIC_ HOME/privileges atomic user.sql file

grant create SESSION to &database username

/

grant create PROCEDURE to &database username

/

grant create SEQUENCE to &database username

/

grant create TABLE to &database username

/

grant create TRIGGER to &database username

/

grant create VIEW to &database username

/

grant create MATERIALIZED VIEW to &database username
/

grant select on SYS.V SPARAMETER to &database username
/

grant create SYNONYM to &database username

/

Grants for Config Schema

Config Schema creation requires certain grants for object creation. This can be located in
SFIC_HOME/privileges config user.sql file

The following are the Grants for Config Schema:

grant create SESSION to &database username

/

grant create PROCEDURE to &database username
/

grant create SEQUENCE to &database username
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/

grant create TABLE to &database username

/

grant create TRIGGER to &database username

/

grant create VIEW to &database username

/

grant create MATERIALIZED VIEW to &database username
/

grant select on SYS.V SPARAMETER to &database username
/

grant create SYNONYM to &database username

/

Grants on Config Schema Entities for Atomic Users

Atomic Schema creation requires certain grants for config schema object access. This can be located in
SFIC_HOME/config table privileges for atomic user.sql file.

The following are the Grants for Config Schema entities for Atomic Users:

grant select on CSSMS USR PROFILE to &database username

/

grant select on CSSMS ROLE MAST to &database username

/

grant select on CSSMS GROUP MAST to &database username

/

grant select on CSSMS FUNCTION MAST to &database username

/

grant select on CSSMS USR GROUP MAP to &database username

/

grant select on CSSMS USR GROUP DSN SEG MAP to &database username
/

grant select on CSSMS ROLE FUNCTION MAP to &database username
/

grant select on CSSMS GROUP ROLE MAP to &database username
/

grant select on CSSMS SEGMENT MAST to &database username

/

grant select on BATCH TASK to &database username

/

grant select on CSSMS USR DSN SEG MAP to &database username
/

grant select on CSSMS USR ROLE MAP to &database username
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/

grant select on CSSMS METADATA SEGMENT MAP to &database username
/

grant select on BATCH RUN to &database username

/

grant select on PR2 FILTERS to &database username

/

grant select on PR2 TASK FILTER to &database username

/

grant select on PR2 TASK FILTER DETAIL to &database username
/

grant select on ST STRESS MASTER to &database username

/

grant select on ST SCENARIO MASTER to &database username
/

grant select on ST SHOCK MASTER to &database username

/

grant select on BATCH MASTER to &database username

/

grant select on ICC MESSAGELOG to &database username

/

grant select on PR2 MASTER to &database username

/

grant select on PR2 RUN REQUEST to &database username

/

grant select on MF MODEL SCRIPT MASTER to &database username
/

grant select on MF INPUT VALUES to &database username

/

grant select on MF MODEL OUTPUT VALUES to &database username
/

grant select on DB MASTER to &database username

/

grant select on DSNMASTER to &database username

/

grant select on pr2 rule map to &database username

/

grant delete on pr2 rule map pr to &database username

/

grant insert on pr2 rule map pr to &database username

/

grant update on pr2 rule map pr to &database username
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/

grant select on pr2 rule map pr to &database username

/

grant delete on pr2 rule map pr tmp to &database username

/

grant insert on pr2 rule map pr tmp to &database username

/

grant update on pr2 rule map pr tmp to &database username

/

grant select on pr2 rule map pr tmp to &database username

/

grant select on pr2 rule map exclude to &database username

/

grant delete on pr2 rule map exclude pr to &database username
/

grant insert on pr2 rule map exclude pr to &database username
/

grant update on pr2 rule map exclude pr to &database username
/

grant select on pr2 rule map exclude pr to &database username
/

grant delete on pr2 rule map exclude pr tmp to &database username
/

grant insert on pr2 rule map exclude pr tmp to &database username
/

grant update on pr2 rule map exclude pr tmp to &database username
/

grant select on pr2 rule map exclude pr tmp to &database username
/

grant select on pr2 run object to &database username

/

grant select on pr2 run object member to &database username

/

grant select on pr2 run map to &database username

/

grant select on pr2 run execution b to &database username

/

grant select on pr2 run execution filter to &database username
/

grant select on pr2 firerun filter to &database username

/

grant select on pr2 filters to &database username
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/

grant select on configuration to &database username

/

grant select on batch parameter to &database username

/

grant select on component master to &database username

/

grant select on MDB OBJECT TYPE ATT LAYOUT to &database username
/

grant select on REV_OBJECT ATTRIBUTE DTL to &database username
/

grant select on FORMS LOCALE MASTER to &database username

/

grant select on mdb object dependencies to &database username
/

grant select on mdb execution details to &database username

/

grant select on REV_STAT DATA to &database username

/

grant select on REV_OBJECT REPOSITORY B to &database username
/

grant select on REV_OBJECT REPOSITORY TL to &database username
/

grant select on REV_OBJECT ATTRIBUTE DTL MLS to &database username
/

grant select on REV_OBJECT APPLICATION MAP to &database username
/

grant select on MDB OBJ EXPR DETAILS to &database username

/

grant select on MDB EXECUTION DETAILS to &database username

/

grant select on REV _OBJECT TYPES CD to &database username

/

grant select on REV _OBJECT TYPES MLS to &database username

/

grant select on REV_APPLICATIONS CD to &database username

/

grant select on REV_APPLICATIONS MLS to &database username

/

grant select on METADATA BROWSER LOCALE to &database username
/

grant select on MDB STAT DATA to &database username
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/
grant select on MDB OBJECT TYPE LAYOUT to &database username
/
grant select on ofsa md id ref to &database username
/
grant select on MDB ETL MAPPING to &database username
/
grant select on setupinfo to &database username
/
grant select on LOCALEREPOSITORY to &database username
/
grant select on MF MODEL MASTER to &database username
/
grant select on MF SANDBOX MASTER to &database username
/
grant select on MF VARIABLE MASTER to &database username
/
grant select on MF TECHNIQUE MASTER to &database username
/
grant select on MDB RULE SOURCE HEADER to &database username
/
grant select on MDB RULE TARGET HEADER to &database username
/
grant select on MDB RULE TARGET MEMBER HEADER to &database username
/
grant select on MDB RULE GRID DATA to &database username
/
grant select on MDB MODEL MAPPING to &database username
/
grant delete on AAI MAP MAPPER to &database username
/
grant insert on AAI MAP MAPPER to &database username
/
grant update on AAI MAP MAPPER to &database username
/
grant select on AAI MAP MAPPER to &database username
/
grant select on RTI UI EXCLUDE PDM LIST to &database username
/
grant select on RTI VIR PHY TBL NAME to &database username
/
grant select on infodom patches to &database username
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APPENDIX O Configuring Application Pack XML

Files

This appendix includes the following topics:

® OFS_PFT_PACK.xml

® Configuring OFS_PFT_SCHEMA_IN.xml

OFS_PFT_PACK.xml

The oFs_PFT PACK.xmnl file holds details on the various products that are packaged together in Profitability Application

Pack.

This section details the various tags/ parameters available in the file and the values that need to be updated. Prior to
installing the Profitability Application Pack in SILENT mode, it is mandatory to update this file.

Note: If you are installing in the GUI mode, then this file need not be updated.

<APP>

</APP>
<APP>

</APP>
<APP>

</APP>
<APP>

</APP>
<APP>

</APP>
<APP>

</APP>

<APP_PACK_CONFIG>
<APP_PACK_ID>0FS_PFT_PACK=</APP_PACK_ID>
<APP_PACK_NAME>Financial services profitability Applications Pack</APP_PACK_NAME>
<APP_PACK_DESCRIPTION=>Applications for profitability in the Banking and Financial Services Domain</APP_PACK_DESCRIPTION>
<VERSION>8.0.0.0.0</VERSION>

</APP_PACK_CONFIG>

<APP_ID PREREQ="" DEF_SEL_FLG="YES" ENABLE="YES">OFS_AAI</APP_ID>
<APP_NAME>Financial Services analytical applications Infrastructure</APP_NAME>
<APP_DESCRIPTION>Base Infrastructure for Analytical Applications</APP_DESCRIPTION>
<VERSION>8.0.0.0.0</VERSION>

<APP_ID PREREQ="OFS_AAI" ENABLE="YES">OFS_PFT</APP_ID>

<APP_NAME>Financial Services Profitability Management</APP_NAME>
<APP_DESCRIPTION>=Application for Profitability Management</APP_DESCRIPTION>
<VERSION>8.0.0.0.0</VERSION>

<APP_ID PREREQ="OFS_AAI" ENABLE="YES">OFS_FTP</APP_ID>
<APP_NAME>Financial services Funds Transfer Pr'ic‘ing<jAPP_NAME>
<APP_DESCRIPTION>Application for Funds Transfer Pricing</APP_DESCRIPTION>
<VERSION>8.0.0.0.0</VERSION>

<APP_ID PREREQ="OFS_AAI" ENABLE="YES">OFS_IPA</APP_ID>

<APP_NAME>Financial Services Institutional pPerformance analytics</APP_NAME>
<APP_DESCRIPTION>Application for Institutional Performance analytics</APP_DESCRIPTION>
<VERSION>8.0.0.0.0</VERSION>

<APP_ID PREREQ="OFS_AAI" ENABLE="YES'">OFS_RPA</APP_ID>

<APP_NAME>Financial Services Retail Performance analytics</APP_NAME>
<APP_DESCRIPTION>Application for Retail performance Analytics</APP_DESCRIPTION>
<VERSION>8.0.0.0.0</VERSION>

<APP_ID PREREQ="OFS_AAI" ENABLE="YES'">0OFS_EFPA</APP_ID>

<APP_NAME>Financial Services Enterprise Financial performance analytics</APP_NAME>
<APP_DESCRIPTION>Application for Enterprise Financial performance aAnalytics</APP_DESCRIPTION>
<VERSION>8.0.0.0.0</VERSION>
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Al Default Value/
Tag Name/ Attribute Name Description (Y/ N) Permissible Value Comments
APP_PACK_ID Unique Application Y Unique Seeded Value DO NOT modify this
Pack Identifier value.
APP_PACK_NAME Unique Application Y Unique Seeded Value DO NOT modify this
Pack Name value.
APP_PACK_DESCRIPTION Unique Application Y Unique Seeded Value DO NOT modify this
Pack Description value.

VERSION Unique release version | Y Unique Seeded Value DO NOT modify this
value.

APP Unique Application Y Unique Seeded Value DO NOT remove these

Entries tags.
APP_ID Unique Application Y Unique Seeded Value DO NOT modify this
Identifier value.
APP_ID/ PREREQ Prerequisite Y Unique Seeded Value For most applications
Application/ Product Infrastructure would be
the prerequisite set. For
certain other
applications, an
appropriate Application
ID would be set.
DO NOT modify this
value.

APP_ID/ DEF_SEL_FLAG Default Selected Flag Y Default - YES In all Application Packs,
Infrastructure would have
this value set to "YES".
DO NOT modify this
value.

APP_ID/ ENABLE Enable Application/ YES if Default - YES for Set this attribute-value to

Product installing in Infrastructure YES against every APP_ID
SILENT which is licensed and
mode. NO for Others should be enabled for
Permissible - YES or use.
NO "
Note: Application/
Product once enabled
cannot be disabled.
However, Application/
Product not enabled
during installation can be
enabled later through the
Administration Ul.
APP_NAME Unique Application/ Y Unique Seeded Value DO NOT modify this
Product Name value.
APP_DESCRIPTION Unique Application/ Y Unique Seeded Value DO NOT modify this
Product Name value.

VERSION Unique release version | Y Unique Seeded Value DO NOT modify this
value.
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Configuring OFS_PFT_SCHEMA_IN.xml

Creating database schemas, objects within schemas and assigning appropriate grants are the primary steps in the
installation process of OFSAA Applications. The OFS_ALM SCHEMA IN.xml file contains details on the various application
schemas that should be created prior to the Application Pack installation.

[<APPPACKSCHEMA>
<APP_PACK_TID>OFS_PFT_PACK</APP_PACK_TD>
<IDBC_URL>Jjdbc:oracle:thin:@ofs5222763:1521 :FTPDEV</IDBC_URL>
<JDBC_DRIVER>oracle. jdbc. driver.oracleDriver</IDEC_DRIVER>
<HOST>10.184.149. 241%/HOST>
<SETUPINFO NAME="DEV" />
<PASSWORD APPLYSAMEFORALL="Y" DEFAULT="" />
<5CHEMAS>
" name="pftconf”
" name="pfratm”
" name="pfratm”
" name="pfratm”
" name="pfratm” PASSWORD=""
<SCHEMA TYPE="ATOMIC" NaME="pftatm" PASSWORD=""

SERS" TEMPTABLESPACE="TEMP"  QuUOTA="" />

' DEFAULTTABLESPACE='"USERS" TEMPTABLESPACE="TEMP"
' DEFAULTTABLESPACE='"USERS" TEMPTABLESPACE="TEMP"
' DEFAULTTABLESPACE='"USERS" TEMPTABLESPACE="TEMP"
" DEFAULTTABLESPACE="USERS" TEMPTABLESPACE="TEMP" QI
""" DEFAULTTABLESPACE="USERS" TEMPTABLESPACE="TEMP"

</SCHEMAS>
</APPPACKSCHEMA>
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The following table gives details about the various tags/ parameters available in the file and the values that need to be
updated. Prior to executing the schema creator utility, it is mandatory to update this file.

Tag Name/ Attribute
Name

Description

Mandatory
(Y/ N)

Default Value/ Permissible
Value

Comments

<APP_PACK_ID>

Seeded unique ID for
the OFSAA Application
Pack

Y

Seeded

DO NOT modify this
value.

<JDBC_URL>

Enter the JDBC URL.

Note: You can enter
RAC and NON-RAC
enabled database
connectivity URL.

Mandatory

Example,

jdbc:oracle:thin:@<HOST/IP>:<
PORT>:<SID>

or

jdbc:oracle:thin:@//[HOST][:P
ORT]/SERVICE

or

jdbc:oracle:thin:@(DESCRIPTIO
N=(ADDRESS_LIST=(ADDRESS=(
PROTOCOL=TCP)(HOST=[HOST]
)(port=[PORT]))(ADDRESS=(PR
OTOCOL=TCP)(HOST=[HOSTI)(P
ORT=[PORT]))(LOAD_BALANCE
=yes)(FAILOVER=yes))(CONNEC
T_DATA=(SERVICE_NAME=[SER
VICE])))

For example,
jdbc:oracle:thin:@//dbhost.ser
ver.com:1521/servicel

or

jdbc:oracle:thin:@//dbshost.se
rver.com:1521/scan-1

or

jdbc:oracle:thin:@(DESCRIPTIO
N=(ADDRESS_LIST=(ADDRESS=(
PROTOCOL=TCP)(HOST=dbhost
1.server.com)(port=1521))(AD
DRESS=(PROTOCOL=TCP)(HOST
=dbhost2.server.com)(PORT=1
521))(LOAD_BALANCE=yes)(FAI
LOVER=yes))(CONNECT_DATA=(
SERVICE_NAME-=servicel)))
Ensure to add an entry (with
SID/ SERVICE NAME) in the
tnsnames.ora file on the OFSAA
server. The entry should match
with the SID/ SERVICE NAME
used in the JDBC URL.
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Tag Name/ Attribute LU 2 Default Value/ Permissible
Name Description (Y/ N) Value Comments
<JDBC_DRIVER> By default this driver Mandatory Example, Only JDBC Thin Driver is
name is seeded. oracle.jdbc.driver.OracleDriver supported.
Note: Do not edit this DO NOT modify this
attribute value. value.
<HOST> Enter the Hosthame/ Mandatory Host Name/ IP Address
IP Address of the
system on which you
are installing the
OFSAA components.
<SETUPINFO>/ Identifies if the value N YES or NO Default value is YES
PREFIX_SCHEMA_NAME | specified in
<SETUPINFO>/ NAME
attribute should be
prefixed to the schema
name.
<SETUPINFO>/ NAME Enter the acronym for Mandatory Accepts strings with a This name would appear
the type of minimum length of two and in the OFSAA Landing
implementation. This maximum of four. Page as "Connected To:
information will be XXXX"
displayed in the OFSAA Example, .
Home Page. DEV. SIT. PROD The schemas being
T created would get this
Note: On executing the prefix. For E.g.
schema creator utility, dev_ofsaaconf,
this value will be uat_ofsaaconf etc.
prefixed with each
schema name. For
example:
dev_ofsaaconf,
uat_ofsaaatm.
<PASSWORD>/ Enter the password if Optional The maximum length allowed
DEFAULT* you want to set a is 30 characters. Special

default password for
all schemas.

Note: You also need to
set APPLYSAMEFORALL
attribute as Y to apply
the default password
for all the schemas.

characters are not allowed.
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Tag Name/ Attribute LU 2 Default Value/ Permissible
Name Description (Y/ N) Value Comments
<PASSWORD>/ Enter as Y if you want Mandatory Default- N Note: Setting this
APPLYSAMEFORALL to apply the password . attribute value is
specified in DEFAULT Permissible - Y or N mandatory, If DEFAULT
attribute for all the attribute is set.
schemas.
If you enter as N, you
need to provide
individual passwords
for all schemas.
Note: In case you have
entered Y in
APPLYSAMEFORALL
attribute and also have
specified individual
passwords for all the
schemas, then the
specified individual
passwords will take
precedence.
<SCHEMA>/ TYPE The different types of Mandatory ATOMIC/CONFIG/SANDBOX/A Only One CONFIG schema
schemas that are DDON can exist in the file.
supported in this Note: SANDBOX AND ADDON | This schema identifies as
release are ATOMIC, .
CONFIG, SANDBOX, schemas are m?t appllcable for | the CONFIGURATION
and ADDON. OFS AAAI Application Pack. schema that holds. the
OFSAA setup details and
By default, the other metadata
schemas types are information.
seeded based on the Multiple ATOMIC/
Application Pack.
SANDBOX/ ADDON
Note: Do not edit this schemas can exist in the
attribute value. file.
ATOMIC schema refers to
the Information Domain
schema. SANDBOX
schema refers to the
SANDBOX schema.
ADDON schema refers to
other miscellaneous
schema (not applicable
for this Application Pack).
Note: The Profitability
Pack supports only one
Atomic Schema.
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Tag Name/ Attribute LU 2 Default Value/ Permissible
Name Description (Y/ N) Value Comments
<SCHEMA>/ NAME By default, the Mandatory The permissible length is 15 SETUPINFO/ NAME
schemas names are characters and only attribute value would be
seeded based on the alphanumeric characters prefixed to the schema
Application Pack. allowed. No special characters name being created.
allowed except underscore '_".
You can edit the P - For E.g. if name is set as
schema names if 'ofsaaatm' and setupinfo
required. as 'uat' then schema
being created would be
Note: The Schema , ,
. . uat_ofsaaatm'.
Name will have a prefix
of the SETUPINFO/ NAME should be same
NAME attribute. where APP_GRP=1 for all
SCHEMA t Not
SCHEMA NAME must EMA tags (No
applicable for this
be same for all the .
Application Pack).
ATOMIC Schemas of
applications within an
Application Pack.
<SCHEMA>/ Enter the password of Optional The maximum length allowed Note: You need to
PASSWORD* the schema to be is 30 characters. Special mandatorily enter the
created. characters are not allowed. password if you have set
Note: If this attribute i the <PASSWORD>/
ote: ITthis attribute s APPLYSAMEFORALL
left blank, then the .
e attribute as N.
password specified in
the
<PASSWORD>/DEFAUL
T attribute is applied as
the Schema Password.
<SCHEMA>/ APP_ID By default, the Mandatory Unique Seeded Value Identifies the
Application ID is Application/ Product for
seeded based on the which the schema is
Application Pack. being created.
Note: Do not edit this DO NOT modify this
attribute value. value.
<SCHEMA>/ Enter the available Optional Default - USERS Modify this value to
DEFAULTTABLESPACE default tablespace for . . . associate any valid
Permissible - Any existing valid .
DB User. tablespace with the
tablespace name. schema
Note: If this attribute is '
left blank, then USERS
is set as the default
tablespace.
<SCHEMA>/ Enter the available Optional Default - TEMP Modify this value to
TEMPTABLESPACE temporary tablespace associate any valid

for the DB User.

Note: If this attribute is
left blank, then TEMP
is set as the default
tablespace.

Permissible - Any existing valid
temporary tablespace name.

tablespace with the
schema.
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Information Domain to
associate this schema.

The schema creator
utility automatically
derives an Information
Domain Name based
on the Application
Pack if no value is
specified for this
attribute.

characters and only
alphanumeric characters
allowed. No special characters
allowed.

Tag Name/ Attribute LU 2 Default Value/ Permissible
Name Description (Y/ N) Value Comments
<SCHEMA>/ QUOTA Enter the quota to be Optional Example, Modify this value to grant
set on the specified quota on
DEFAULTTABLESPACE 600M/m the mentioned
attribute for the 20G/g tablespace to the user.
schema/ user. By o
default, the quota size UNLIMITED/unlimited
is set to
500M.Minimum:
500M or Unlimited on
default Tablespace
<SCHEMA>/ INFODOM Enter the name of the Optional Permissible length is 16
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APPENDIX P Conﬁguring

OFSAAI _InstallConfig.xml File

To install the OFSAAI InstallConfig.xml file:
1. Navigate to OFS_PFT_PACK/OFS_AAl/conf/.

2. Openthefile OFSAATI InstallConfig.xml in text editor.

lk7xml version="1.0" encoding="UTF-8"7>

<UserInteractionss
<Layer name="GENERAL">
<InteractionGroup name="WebServerType" >
<Interactionvariable name="WEBAPPSERVERTYPE'>l</Interactionvariable>
</InteractionGroup>
<InteractionGroup name="OFSAA Infrastructure Server Details">
<Interactionvariable name="DBSERVER_IP">10.184.149. 54</Interactionvariables
</InteractionGroup>
<InteractionGroup name="Database Details" >
<Interactionvariable name="ORACLE_SID/SERVICE_NAME">FTPDEV</Interactionvariable>

</InteractionGroup>
<InteractionGroup name="OLAP Detail">
<Interactionvariable name="OLAP_SERVER_IMPLEMENTATION"=0</Interactionvariable>
</InteractionGroup>
<InteractionGroup name="sSFTP Details"s
<Interactionvariable name="SFTP_ENABLE">1</Interactionvariable>
<Interactionvariable name="FILE_TRANSFER_PORT">22</Interactionvariablex
</InteractionGroup>
<InteractionGroup name="Locale Detail">
<Interactionvariable name="LOCALE"=en_Us</Interactionvariablex>
</InteractionGroup>
<InteractionGroup name="0FSAA Infrastructure Communicating ports” =
<Interactionvariable name: AVAPORT">9999</Interactionvariable>
<Interactionvariable name IATIVEPORT '=6666</Interactionvariables>
<Interactionvariable name: GENTPORT">8510</Interactionvariable>
<Interactionvariable name: CCPORT"=6507</Interactionvariable>
<Interactionvariable name CCNATIVEPORT '>6509</Interactionvariable>
<Interactionvariable name:
<Interactionvariable name:
<Interactionvariable name.
<Interactionvariable name="AMPORT">6505</Interactionvariable>
</InteractionGroup>
<InteractionGroup name="WEB_DETAILS" >
<Interactionvariable name="HTTPS_ENABLE">0</Interactionvariable>
<Interactionvariable name="WEB_SERVER_IP">10.184.149.241</Interactionvariable>
<Interactionvariable name="wWEB_SERVER_PORT">8080</Interactionvariables
<Interactionvariable ONTEXT_NAME ">0FSAAL</Interactionvariables>
<Interactionvariable
<Interactionvariable name="WEB_LOCAL_PATH">/scratch/mediapack/ftpshare</Interactionvariables
</InteractionGroup>
<InteractionGroup name=" Weblogic Setup Details” =
<Interactionvariable name="WEBLOGIC_DOMAIN_HOME">NA</Interactionvariable>
</InteractionGroup>
<InteractionGroup name="OFSAAI FTP Details">
<Interactionvariable name="OFSAAI_FTPSHARE_PATH">/scratch/mediapack/ftpshare</Interactionvariables
<Interactionvariable name="OFSAAI_SFTP_USER_ID"»mediapack</Interactionvariable>
</InteractionGroup>
</Layers>
</UserInteractions>

<Interactionvariable name="ABS_DRIVER_PATH">/scratch/oracle/app/product/11.2.0.3/client_1/jdbc/Tib</Interactionvariable>

EBAPP_CONTEXT_PATH">/scratch/mediapack/apache-tomcat-7.0.19/webapps</Interactionvariable>

3. Configure the OFSAAT InstallConfig.xml as mentioned inthe below table:
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4. You need to manually set the InteractionVariable parameter values as mentioned in the table. If a value is not
applicable, enter NA and ensure that the value is not entered as NULL.

InteractionVariabe Name

DBSERVER_IP Identifies the hostname or IP address of the system on which the Yes
Database Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable name="DBSERVER_
IP">14.15.16.17</InteractionVariable> or

<InteractionVariable name="DBSERVER_
IP">dbhost.server.com</InteractionVariable

>

ORACLE_SID/SERVICE_ Identifies the Oracle DB Instance SID or SERVICE_NAME Yes
NAME
Note: The Oracle_SID value should be exactly the same as it is
mentioned in JDBC_URL.

For example, <InteractionVariable name="ORACLE_SID/SERVICE_

NAME">ofsaser</InteractionVariable>

ABS_DRIVER_PATH Identifies the directory where the JDBC driver (ojdbc<version>.jar) Yes
exists. This would typically be the

$SORACLE_HOME/jdbc/lib

For example, <InteractionVariable name="ABS_DRIVER_
PATH">">/oradata6/revwb7/oracle

</InteractionVariable>

Note: See JDBC Jar Files for identifying the correct "ojdbc<version>.jar"
version to be copied.

OLAP_SERVER_ Identifies if the OFSAA Infrastructure OLAP component needs to be No
IMPLEMENTATION configured depending on whether you intend to use the OLAP feature.

The below numeric value should be set depending on the choice:

YES-1

NO-0

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set in .profile:
ARBORPATH, HYPERION_HOME and ESSBASEPATH.

SFTP_ENABLE Identifies if the SFTP (Secure File Transfer Protocol) feature is to be Yes
enabled. The below numeric value should be set depending on the
choice:
SFTP-1
FTP-0

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using SFTP instead of FTP
because SFTP is considered more secure. However, a client may choose to ignore this recommendation and to use FTP by setting
SFTP_ENABLE to 0. This selection may be changed later by using the OFSAAI administration interface.

FILE_TRANSFER_PORT Identifies the port used for the file transfer service. The default value Yes
specified is 22 (SFTP). Specify value as 21 or any other PORT value if
value for SFTP_ENABLE is 0.

For example, <InteractionVariable name="FILE_TRANSFER_
PORT">21</InteractionVariable>
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InteractionVariabe Name

LOCALE

Identifies the locale information to be used during the installation. This Yes
release of the OFSAA Infrastructure supports only US English.

For example, <InteractionVariable
name="LOCALE">en_US</InteractionVariable>

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default values mentioned below are set
in the installation. If you intend to specify a different value, update the parameter value accordingly and ensure this port value is in

the range of 1025 to 65535

and the respective port is enabled.

JAVAPORT 9999 Yes
NATIVEPORT 6666 Yes
AGENTPORT 6510 Yes
ICCPORT 6507 Yes
ICCNATIVEPORT 6509 Yes
OLAPPORT 10101 Yes
MSGPORT 6501 Yes
ROUTERPORT 6500 Yes
AMPORT 6505 Yes

Note: If value for HTTPS_EN

configured on your web application server. For more details on configuring your setup for HTTPS.

ABLE is set to 1, ensure you have a valid certificate available from a trusted CA and the same is

HTTPS_ENABLE

Identifies if the Ul should be accessed using HTTP or HTTPS scheme. The | Yes
default value set is 0. The below numeric value should be set depending
on the choice:

YES-1
NO -0

For example, <InteractionVariable
name="HTTPS_ENABLE">0</InteractionVariable>

WEB_SERVER_IP

Identifies the HTTP Server IP/ Hostname or Web Application Server IP/ No
Hostname, to be used for accessing the Ul. This IP would typically be the
HTTP Server IP.

If no separate HTTP Server is available, the value should be Web
Application Server IP/Hostname.

For example, <InteractionVariable name="WEB_SERVER_
IP">10.11.12.13</InteractionVariable>

or

<InteractionVariable name="WEB_SERVER _
IP">myweb.server.com</InteractionVariable>

WEB_SERVER_PORT

Identifies the Web Server Port. This would typically be 80 for non SSLand | No
443 for SSL. If no separate HTTP Server exists, the value should be the
port configured for Web Server.

Note: The port value will not be accepted as 80 if HTTPS_ENABLE is 1 and
as 443, if HTTPS_ENABLE is O.

For example, <InteractionVariable name="WEB_
SERVER_PORT">80</InteractionVariable>
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InteractionVariabe Name

CONTEXT_NAME

Identifies the web application context name which will be used to build
the URL to access the OFSAA applications. The context name can be
identified from a URL as below:

<scheme>://<host>:<port>/<context-name>/lo gin.jsp
Sample URL:
https://myweb:443/ofsaadev/login.jsp

For example, <InteractionVariable name="CONTEXT_
NAME">ofsaadev</InteractionVariable>

Yes

WEBAPP_CONTEXT_PATH

Identifies the absolute path of the exploded .ear file on the web
application server.

For Tomcat, specify the Tomcat directory path till

/webapps, such as

/oradata6/revwb7/tomcat/webapps/.

For WebSphere, enter the WebSphere path as

<WebSphere profile directory>/installedApps/

<NodeCellName>. For example,
/data2/test//WebSphere/AppServer/profiles/

<Profile_

Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host name.

For WebLogic, provide the WebLogic home directory path as /<WebLogic
home directory path>/bea/wlserver_10.3

Note: For WebLogic, value specified for this attrbute is ignored and value
provided against attribute WEBLOGIC_DOMAIN_HOME is considered.

Yes

WEB_LOCAL_PATH

Identifies the absolute path to any directory on the web application
server that can hold temporary files being uploaded as part of the
applications usage. User can set this in FTPSHARE location to avoid the
confusion

Note: In case of a clustered deployment, ensure this path and directory
is same on all the nodes.

Yes

WEBLOGIC_DOMAIN_HO
ME

Identifies the WebLogic Domain Home. Specify the value only if
WEBSERVERTYPE is set as 3 (WebLogic).

For example, <InteractionVariable name="WEBLOGIC_DOMAIN_
HOME">/home/weblogic/bea/user_ projects/domains/mydomain

</InteractionVariable>

Yes. Specify the value only
if WEBSERVERTYPE is set
as 3 (WebLogic)
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InteractionVariabe Name

OFSAAI_FTPSHARE_PATH

Identifies the absolute path to the directory identified as file system
stage area.

Note:

The directory should exist on the same system on which the OFSAA
Infrastructure is being installed (can be on a separate mount).

The user mentioned in APP_SFTP_USER_ID parameter below should
have RWX permission on the directory.

For example, <InteractionVariable
name="APP_FTPSHARE_PATH">">/oradata6/revwb7/ftpshare</Interacti
onVariable>

Yes

OFSAAI_SFTP_USER_ID

Identifies the user who has RWX permissions on the directory identified
under parameter APP_FTPSHARE_PATH above.

Yes

HIVE_SERVER_PORT

Not applicable

HIVE_SERVER_FTPDRIVE

Not applicable

HIVE_SERVER_FTP_USERI
D

Not applicable

HIVE_SERVER_FTP_PROT
ocoL

Not applicable
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APPENDIX Q

Application specific User Group mappings:

© PFT:

m  Profitability Application Administrator
m  Profitability Application Analyst
m  Profitability Application Auditor

© FTP:

B Fund Transfer Pricing Application Administrator
B Fund Transfer Pricing Application Analyst

®  Fund Transfer Pricing Application Auditor

® IPA:

m  |PA Administrator

m  |PA Bl Analyst

B |PA Data Analyst

©® RPA:

B RPA Administrator

m  RPA Bl Analyst

m  RPA Data Analyst

® EFPA:

®  EFPA Administrator

m  EFPA Bl Analyst

m  EFPA Data Analyst

User Group Mapping
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APPENDIX R R Dependencies

R code of the application requires dependent packages to be installed before the Reporting Line Forecast batch is
executed. Usage of the predictive model requires installation of packages - tseries, lattice, and R Oracle. Verify that lattice
and R Oracle are compatible with each other.

Package installation instructions can be found at:
http://cran.r-project.org/doc/manuals/r-release/R-admin.html#Installing-packages
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APPENDIX S Visibili ty

This appendix includes the following topics:
® Data Visibility

® Report Visibility

® Metadata Visibility

Data Visibility

Data visibility refers to the data control established on the results fetched by reports depending on the user logged in.
For each user, only those accounts which are directly handled or are handled by a subordinate are visible.

If the logged in user is an RM, then only those accounts which are associated to that user's organizational hierarchy will be
fetched. This is achieved through FSI M USER MANAGER MAP table.

If a user is Relationship Manager (RM), then the particular log in ID and the manager code from DIM MANAGEMENT table
have to be populated into FSI M USER MANAGER MAP table. Also, the table FCT ACCOUNT MGR_REL should have the
necessary details for the relationship manager to account mapping.

A user logging in without any associated Manager code should have access to the entire data available.

The entriesto FSI_M USER MANAGER MAP table have to be manually inserted. It has two columns, Vv_USERNAME and
V_MANAGER CODE. The V_USERNAME has to be inserted with the login username created in OBIEE and V_MANGER CODE
has to be inserted with the manager code of the corresponding user from DIM MANAGEMENT table.

Example

The following diagram depicts a hierarchy of Relationship Managers:

RM1

RM2 RM5

RM3 |} RM4 | § RM6

The data visibility for each of the Relationship Managers, starting from the top of the hierarchy is as follows:

® RM1 user has control over the data associated to that user along with the data associated to the immediate
subordinates, that is, RM2, RM5, and their subordinates till the end of the hierarchy.

® RM2 user has control over the data associated to that user along with the data associated to the immediate
subordinates, that is, RM3, RM4, and their subordinates till the end of the hierarchy.

® RMS5 user has control over the data associated to that user along with the data associated to the immediate
subordinate, that is, RM6 and his subordinates till the end of the hierarchy.
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If the logged in user is a Sales Representative (SR), the data associated with the opportunities managed by the respective
Sales Representatives are visible. Each Sales Representative will have unique skey values and accounts related to those
skeys are displayed in reports.

Report Visibility

The Report's visibility is restricted as given in the following table:

Application Role Dashboards Available

Business Analyst Summary

Customer Summary
Cross-Sell

Top 10 Opportunities
Opportunities

Activities

Customer Performance
Product Performance

Line of Business Performance

Balance Sheet

Relationship Manager Opportunities
Activities

Relationship Manager Performance

Sales Representative Opportunities
Activities
Administrator All Reports

The Reports visibility for the different roles has to be handled by setting proper catalog Permissions. The steps to setup
these permissions are described in Setting Up Dashboard Visibility under Configure Roles and Groups of this document.
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Metadata Visibility

Accessibility to presentation layer objects for creating ad-hoc reports varies from user-to-user depending on the

application role the user is allocated.

The following are the requirements for viewing the metadata in RPD:

Application Role

Tables for Ad-hoc Reporting

Business Analyst role

Fact-Account Summary
Fact Account Profitability
Fact Opportunity

Fact Opportunity Activity
Fact Management Forecast

Fact Customers

Relationship Manager role

Fact Relationship Manager Contribution
Fact Relationship Manager Profitability
Fact Opportunity

Fact Opportunity Activity

Sales Representative role

Fact Opportunity
Fact Opportunity Activity

Fact Sales Representative Compensation

Administrative role (WebLogic)

All tables
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APPENDIX T

JDBC Jar Files

The ojdbc<version>.jar file should be copied based on Database and Java version. Refer to the following table for

details:

Oracle Database version

JDK/JRE Version supported

JDBC Jar files specific to the release

12.1 or 12cR1

JDK 8, JDK 7 and JDK 8

ojdbc7.jar for JDK 7/IDK 8

11.2 or 11gR2

JDK 7 supported in 11.2.0.3 and 11.2.0.4

ojdbcé.jar for JDK 7
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APPENDIX U Migration for Excel Upload

This appendix provides detailed instructions to migrate for excel upload and covers the following topics:

©® Prerequisites
® Migration for Excel Upload
Prerequisites

The following are the prerequistes for migration:

©

(]
o
o

Data model in ATOMIC schemas should be same on the source and target setups.
OFS AAI (platform) patch level version should be same on the source and target setups.
PL/SQL Developer to connect and query the database.

WinSCP to connect and access server file system.

Migration for Excel Upload

To migrate, follow these steps:

1.

Open PL/SQL Developer and logon to the source setup's configuration (CONFIG) schema by entering the appropriate
username and password.

In a new SQL window query the data of table EXCEL_MAPPING_MASTER.

Open a new session in PL/SQL developer and logon to the target setup's configuration (CONFIG) schema by entering
the appropriate username and password.

Insert the records from Step 1 above in to this table.

In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name with the target infodom name.

Note: If all the mappings can work out of the single target Infodom, update same Infodom value across all
rows. If only few mappings will work out of the target infodom, update the infodom value for selective
records. Excel upload mappings will work only if the target infodom has same data model entities as used
in the mappings defined on source setup.

Update V_CREATED_BY column with the name of any user present in the target setup that has appropriate roles to
perform Excel Upload tasks.

Note: It is mandatory to update values for V_INFODOM and V_CREATED_BY columns.

Open WinSCP and login a new session by entering the host name, port number, user name and password to access
the source setup.

Navigate to the folder referred as FTPSHARE.
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10.

11.

12.

13.

Copy the excel-entity mapping xml file(s) which are located in this folder according to their folder structure on to your
desktop. For example: /ftpshare /STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/SEXCEL_FILE_NAME.xml

Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL_NAME column of
EXCEL_MAPPING_MASTER table.

Copy the excel templates (.xls/ .xIsx) file(s) which are located in this folder according to their folder structure on to
your desktop. For example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/* .xls or *.xlsx

Note: Ignore this step if files are not present at the location.

Login a new session in WinSCP by entering the host name, port number, user name and password to access the target
setup.

Copy the xml file(s) from Step3 to the below location in the target setup. For example:
/ftpshare/STAGE/ExcelUpload/STARGET INFODOM_NAME/SEXCEL_FILE_ NAME.xml

Note: STARGET_INFODOM_NAME should be target setup infodom in which you have uploaded the
appropriate data model and the name should be same as the V_INFODOM column value updated in
EXCEL_MAPPING_MASTER table.

Copy the xls/ xIsx file(s) from Step 3 to the below location in target setup. For example:
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.
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APPENDIX V Upgrading an Existing OFSAA
8.0.x Java 7 Instance to Java 8

This appendix explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8. It consists
of the following topics:

® Prerequisites

® Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8

® Web Application Server Configurations

® OFSAA Generic Configurations

® OFSAA Configurations for New Web Application Server Installation
Prerequisites

The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:
® Java 8 should be installed on the OFSAA server and Web Application Server.

® Oracle Weblogic Server should be 12.1.3.0 or above. Download and install patch 18729264 from
http://support.oracle.com/.

Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8

To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:
1. Configure Web Application Server to Java 8. For more information, see Web Application Server Configurations.

2. Configure the OFSAA instance to Java 8. For more information, see OFSAA Generic Configurations. For a newly
installed Web Application Server, refer OFSAA Configurations for New Web Application Server Installation.

3. Restart the OFSAA services. For more information, see Start/Stop OFSAA Infrastructure Services section.

4. Generate the application EAR/WAR file and redeploy the application onto your configured web application server. For
more information on generating and deploying EAR / WAR file, see Creating and Deploying EAR/WAR File.
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Web Application Server Configurations

This section describes the changes to be made in the Web Application Server. Following are the two options to perform
Web Application Server Configurations which are listed as follows:

® Upgrade the existing Web Application Server installation to Java 8

® Install a new instance of the Web Application Server with Java 8

This section consists of the following topics:
® Oracle Weblogic Server Updates
® Apache Tomcat Server Updates

Oracle WebLogic Server Updates

Perform the following configurations to upgrade the existing WebLogic server instance to Java 8:
1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wiserver.
2. Editthe product.properties file. Set JAVA HOME, WLS_JAVA HOME, JAVAHOME properties to the new Java path
and java.vm.version to the new Java version. For example:
JAVA HOME=/usr/java/jrel.8.0_ 45
WLS JAVA HOME=/usr/java/jrel.8.0 45
JAVAHOME=/usr/java/jrel.8.0 45
java.vm.version=1.8.0_45

3. Navigate to <WLS_HOME>/Middleware/Oracle_Home/user_projects/domains/<domain>/bin. Update
SUN_JAVA HOME, DEFAULT JAVA HOME, JAVA HOME in the setDomainEnv. sh file to point to the new Java path.
For example:

SUN_JAVA HOME="/usr/java/jrel.8.0 45"
DEFAULT_SUN_JAVA HOME="/usr/java/jrel.8.0_ 45"
JAVA HOME="/usr/java/jrel.8.0_ 45"
4. Clear the Application cache. Navigate to the following path and delete the files:

<Weblogic installation location>/domains/<Domain name>/servers/<Server name>/tmp/ WL _user/<Application
name>/qaelce/jsp_servlet

If you want to install a new instance of the Oracle WebLogic Server, follow these steps:

1. Install Oracle WebLogic Server 12.1.3.x on Java 8.

2. Perform the configurations for the newly installed WebLogic server. For more information refer Configuring Resource
Reference in Weblogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be set same as that of the existing Domain.
Note down the new Domain path to perform OFSAA Configurations.

Apache Tomcat Server Updates

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 7 to Java 8:
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1. Login to the Apache Tomcat Server as a non-root user.

2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For Example:
JAVA HOME=/usr/java/jrel.8.0 45

3. Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:
1. Install Apache Tomcat Server 8 with Java 8.

2. Perform the configurations for the newly installed Tomcat server. For more information refer Configuring Resource
Reference in Tomcat Application Server.

Note: Update the Connector Port in /apache-tomcat-8.0.21/conf/server.xml file to that of the existing
Tomcat instance. Note down the new deployment path to perform OFSAA Configurations.

OFSAA Generic Configurations

This section consists of the following topics:
® User .profile Settings

® Configurations for Java 8
User .profile Settings

Perform the following configurations:
1. Login to the OFSAA Server as a non-root user.
2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For Example,

PATH=/usr/java/jrel.8.0 45/jre
JAVA BIN=/usr/java/jrel.8.0 45/jre/bin
LD LIBRARY PATH=$LD LIBRARY PATH:/usr/java/jrel.8.0 45/jre/lib/amd64/server

Configurations for Java 8

Perform the configurations explained in the section Configuration for Java 8.
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OFSAA Configurations for New Web Application Server Installation

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or Apache Tomcat Server 8.0.
Follow these steps:

1.

Modify the following parameters in the Configuration table present in the Config Schema with the new Domain Path
in case of WebLogic or with the new deployment path in case of Tomcat:

B DeFiHome
B REV IMG PATH

m EMBEDDED JSP_JS PATH

2. Login to the OFSAA Server as a non-root user.
3. Navigate to SFIC_HOME/ficweb/webroot/WEB_INF and update the following parameters in the web . xm1 file with the
new Domain path in case of WebLogic or with the new deployment path in case of Tomcat:
B FIC PHYSICAL HOME LOC
m  FIC_HOME
m ICC SERVLET LOG FILE
4. Navigate to SFIC_HOME/ficweb/webroot/conf and update the Domain path in case of WebLogic or with the new
deployment path in case of Tomcat:
OFSAALogger.xml
B MDBLogger.xml
B RevLog4jConfig.xml
B RFDLogger.xml
B  ExportLog4jConfig.xml
B RFDLogger.xml
B PR2Logger.xml
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	12. Click Done when complete. The domain server is created enabling the deployment of multiple Infrastructure applications on a single WebLogic.
	13. Add a java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ "setDomainEnv.sh" file (Required only if self signed certificate is used).

	Delete Domain in WebLogic
	1. Navigate to the following directory:
	2. Execute stopWebLogic.sh to stop the Weblogic domain.
	3. Delete the Weblogic domain.

	WebLogic Memory Settings
	1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in setDomainEnv.sh file, which resides in the folder <DOMAIN_HOME>/bin and in CommEnv.sh file which resides in the folder common/bin.
	2. Edit this file for customizing memory settings and garbage collector settings depending on the available hardware configuration.


	Configuring Apache Tomcat Server for Application Deployment
	Tomcat User Administration
	1. Add the manager role to any one of the existing username/password combination as shown in the example above.
	2. Use the same username/password to which the manager role has been assigned to access the Tomcat Application Manager.
	3. If the Tomcat server is already running, it requires a re-start after the above configuration is done.

	Configure Tomcat to use JAVA 64 bit Executables
	1. Navigate to the "$CATALINA_HOME/bin" folder.
	2. Edit the setclasspath.sh as explained below:
	3. Replace the following block of text:
	4. If the Tomcat server is already running, it requires a re-start after the above configuration is done.

	Configure Servlet Port
	1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag:
	2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to the new port number that will be used during the installation process.
	3. Save your changes in "server.xml".

	SSL Port Configuration
	Apache Tomcat Memory Settings
	1. Locate the file catalina.sh which resides in the folder <CATALINA_HOME>/bin.
	2. Edit this file for customizing the memory settings and garbage collector settings depending on the available hardware configuration.
	3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

	Uninstalling WAR Files in Tomcat
	Configuration for Axis API



	Appendix D RPD/ Catalog Deployment, D3 and Map View Configuration for OBIEE 11g
	Deploying Profitability Pack Dashboards and Analytics
	Installing OBIEE Server
	Installing OBIEE Windows Administration Client
	Deploying Profitability Pack Report Analytics
	1. Stop Oracle Process Manager and Notification Server (OPMN) services by executing the following command:
	2. Copy OFS_PFT_PACK.rpd from $FIC_HOME/OFSPFTPACKBI/OBIEE/11.1.1.9.5/ of Web layer to windows machine where the OBIEE windows administration client is installed.
	3. To change the default password for the repository, follow these steps:
	a. Open the repository using OBIEE Windows administration client.
	b. Enter default repository password as Admin123.
	c. Click File menu, select Change Password.

	4. Enter the new password and click OK.
	5. To configure connection pool of repository, follow these steps:
	a. In the physical section, expand ‘Customer Insight Database' folder.
	b. Double-click Customer Insight Connection Pool to open the Connection Pool Properties window.
	c. Enter the following in Data Source Name text box of Connection Pool Properties window after modifying
	d. Enter atomic schema user in User name text box.
	e. Enter atomic schema user password in Password text box.
	f. Click OK.
	g. Double-click 'Customer Insight Connection Pool (Init Block)' to open the Connection Pool window (Figure 8).
	h. Enter the following in Data Source Name text box of Connection Pool-VAR_CONN_POOL properties window after modifying
	i. Enter atomic schema user in User name text box.
	j. Enter atomic schema password in Password text box.
	k. Click OK.

	6. To configure connection pool for EFPA, modify 'OFSEFPA Connection Pool' and 'OFSEFPA Init Block' connection pool and set the property which is inside of 'EFPA' folder in the physical section.
	8. Click Yes on the pop-up message Do you want to check global consistency?
	9. Click OK, on the pop-up message Consistency check didn't find any errors, warning or best practices violations.

	Deploying EFPA/ IPA/ RPA Application Report Analytics
	1. Set the <Oracle BI Instance Home> directory> =>.\
	2. Start Weblogic AdminServer.
	a. Set the < BI Domain Home> directory> => e.g. /u01/OBIEE11G/user_projects/domains/bifoundation_domain.
	b. Navigate to < BI Domain Home >/bin and run
	c. Bringing up this service may take a few minutes depending on your environment. Check the logs using the command 'tail -f nohup.out'

	3. Start Node Manager.
	a. Set the < WebLogic Server Home > directory> => e.g. /u01/OBIEE11G/wlserver_10.3.
	b. Navigate to <WebLogic Server Home>/server/bin and run

	4. Start Weblogic Managed Server(bi_server1).
	a. Login onto http://localhost:7001/console using your Administrator credentials created during platform install (Replace the hostname based on your setup).
	b. Under Environment block (mid of page, towards left side), click on Servers link.
	c. The bi_server1 line should show as shutdown state at this point.
	d. Click on control page tab.
	e. Select the bi_server1 line by clicking on the left tick box.
	f. Click start button at the top of the list and confirm starting this service.
	g. State will update to "RUNNING" mode after a few minutes.

	5. Start BIEE services and login.
	a. Login to the EM administration screen using the url http://localhost:7001/em (Replace the hostname and port number based on your setup). Use the login you created in BIEE installation to log in.
	b. Expand 'Business Intelligence' node on the left and choose Coreapplication.
	c. Click on the Overview Tab,
	d. Click on blue button 'Restart' (or green button 'Start' ) under the Manage System category, middle of screen,
	e. Click yes on dialog box to confirm the move. Wait for message that confirms successful restart.
	a. Open a command prompt, navigate to <Oracle BI Instance Home>/bin.
	b. run "./opmnctl status, this will show you status of all the OBIEE core services.
	c. run "./opmnctl startall" or "./opmnctl stopall" depending on your need.

	6. Deploy RPD and webcat file(s).
	a. Copy OFS_PFT_PACK.rpd from $FIC_HOME/OFSPFTPACKBI/OBIEE/11.1.1.9.5/ of Web layer to windows machine where the OBIEE windows administration client is installed.
	b. Login to OBIEE - Enterprise Manager URL (http://<ip address>:<port>/em).
	c. RPD Deployment:
	d. Web catalog Deployment:
	e. Click "Catalog" link available on the top right corner.
	f. Click "Shared Folders" and then "Un-Archive".
	g. Browse the path where "OFS_PFT_PACK.catalog" is copied in the local folder. Select the file and click "Open". Then click "OK".
	h. Click "Dashboard" and click on any of the reports to ensure that all the reports are available.

	7. Follow the bellow steps to restart all services in OBIEE "Enterprise Manager".
	a. Open the EM OBIEE URL- (http://<ipaddress>:<port>/em) and login with the credentials.
	b. Click the "coreapplication" link.
	c. Click the "Restart" button.
	d. Click "Yes" to restart all BI components.

	8. Configure tnsnames.ora as follows:
	a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin.
	b. Make sure an entry is made in the tnsnames.ora to connect to atomic schema of OFSAA application.
	c. Save the tnsnames.ora.

	9. Configure ODBC data source to connect to Oracle BI Server as follows:
	a. Go To Control Panel > Administrative Tools > Data Sources (ODBC).
	b. Select the 'System DSN' tab and click 'Add' Button.
	c. Select a driver specific to (Oracle BI Server 11g) and click 'Finish' Button.
	d. Enter 'Name' and 'Server' details (Specify the Host Name or IP Address of the BI Server and click 'Next').
	e. Enter Oracle BI Server login id and password (Enter User Name and Password created at the time of OBIEE installation). Click 'Next'.
	f. Click 'Finish'.

	10. Modify RDBMS connection pool and set the properties as follows:
	a. Open the OBI Administration tool.
	b. Select Start > Programs > Oracle Business Intelligence > BI Administration.
	c. Select File > Open > Online and select 'OFS_PFT_PACK.rpd' file from the Open dialog box.
	d. Enter Repository password as 'Admin123' to open it online.
	e. In the "Physical" layer, double-click the "OFSEFPA Connection Pool" to open its properties.
	f. Enter the following in Data Source Name text box of Connection Pool Properties window,
	g. User name: <enter atomic db user name>.
	h. Password: <enter atomic db user password>.
	i. Confirm password and Click 'OK' to close the window and click 'Save' to save the RPD file.
	j. Click 'No' for the Global Consistency Message.
	k. Repeat the steps from 9.f to 9.l to set the connection properties for "OFSEFPA Init Block".
	l. Close the RPD file (File / Exit).

	11. In case RPD deployment is done on Essbase, then modify ESSBASE connection pool and set the properties.


	Deploying D3 to Entitlement Server for OBIEE 11g
	1. Download d3.zip of version 3.5.16 from http://d3js.org/ and place it in your local folder.
	2. Unzip the d3 folder and move this to analyticsRes in your entitlement server.
	3. Copy the WEB_INF directory from analyticsRes into d3 folder.
	4. Login to web logic server, go to Deployments in your domain structure, click the Lock & Edit button, and then select Install.
	5. Once you click on Install button, it will take you to the screenshot below where you will paste the full path to the d3 directory , check the checkbox next to d3 (open directory) and click Next.
	6. On the next screen, you'll choose Install this deployment as an application and click Next.
	7. On the next screen, select "I will make the deployment accessible from the following location" and click Finish.
	8. On this screen, you will have to click on Activate Changes.
	9. After activating the changes, the application will now be in a Prepared state, as in the screenshot below. You will have to stop the application by checking the checkbox next to it and selecting Force Stop Now from the Stop menu.
	10. You can start the application by checking the checkbox next to it and selecting Servicing all requests from the Start menu.
	11. The application will now change to an Active state and ready to use.

	Mapview Configuration
	Prerequisites
	Creating the Mapviewer NAVTEQ Data source
	Downloading the Mapviewer NAVTEQ Database Dump
	1. Access the SampleApp_Navteq_dmp.zip file from the SampleApp download location (127MB):
	2. Download and unzip the SampleApp_Navteq_dmp.zip file that contains an Oracle Database export file named:

	Creating NAVTEQ User
	1. Start a SQL*Plus session to the Oracle Database as a user with system or DBA privileges.
	2. Run the following script:
	3. Once the script is executed, verify whether you can connect to the newly created user.


	Creating the NAVTEQ Schema
	1. 1. Import the Oracle Database export file - obiee_navteq.dmp into the obiee_navteq schema using the following import command, from the command line (Command Prompt in Windows):
	2. ConnectString is the connection string to your Oracle Database 11g where the user obiee_navteq was created in the step mentioned earlier. Wait for the import process to complete, once successfully completed, login on your DB as obiee_navteq/obiee_...
	1. Start a SQL*Plus session to the Oracle Database and connect as user obiee_navteq.
	2. Run the following script:

	Configuration Edits and Server Starting
	MapViewerConfig.xml Edits (Optional)
	1. Open the Mapviewer console using the following URL:
	2. Click Admin.
	3. Login with the username/password that you provided while installing the product.
	4. Click Configuration. This opens the mapViewerConfig.xml on your setup.
	5. Make the following updates to the xml file.
	a. Change the <proxy_enabled_hosts> property to the following: Substitute the hostname, IP address and port to the correct values on your setup.
	b. Substitute any entries with these tags with the following property entries:


	Predefined Data Sources
	1. At the end of the file, in the section named Predefined Data Source, add the following data source entry.
	2. Replace the IP address, SID, and port to the correct values of the database where the obiee_navteq schema has been created in the above steps.

	Save and Restart, Verify
	1. Verify whether you can view OBIEE_NAVTEQ_SAMPLE as an entry in data sources.
	2. Then after you are successful, there will entry in DataSources section.
	3. Login to Analytic screen > Administration.
	4. Click Manage map Data.
	5. Click Import Layer and then choose OBIEE_COUNTRY.
	6. Choose Preview MAP as OBIEE_WORLD_MAP_FAST.
	7. Same for OBIEE STATE.
	8. Select Background Maps.
	9. Use import Background maps and chosen OBIEE_WORLD_MAP_FAST.
	10. Edit the same, add layer OBIEE COUNTRY and then OBIEE STATE. While choosing, chose the location OBIEE_WORLD_MAP for higher Zoom value.
	11. Select the zoom level for country 0 and for country 2...15.
	12. Navigate back to Layers tab.
	13. Edit OBIEE COUNTRY and OBIEE STATE by adding BI Key Columns:
	a. Choose Institutional Performance>Geography>Country Description.
	b. Choose Institutional Performance>Branch>Branch Country Description.
	c. Choose Retail Performance>Geography>Country Description.
	a. Choose Institutional Performance>Geography>State Description.
	b. Choose Institutional Performance>Branch>Branch State Description.
	c. Choose Retail Performance>Geography>State Description.

	14. Once configuration.xml file is restarted, click Data Sources.


	Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps
	HTML5 Compliance of OBIEE Reports in IE11
	1. Remove the compatibility settings for analytics.
	2. Change the instanceconfig.xml file to make all the chart views to be shown in HTML5 by default.
	3. Enable Mapviewer and D3 reports (to ensure that these reports show up as is).
	4. Verify all the BI reports by removing the default chart view setting (to ensure that these reports show up as usual irrespective of HTML5 or flash web Image formats).
	Details on OBIEE11.1.9.5



	Appendix E Configuring Resource Reference Web Application Servers
	Configure Resource Reference in WebSphere Application Server
	Create JDBC Provider
	1. Open the WebSphere admin console in the browser window:
	2. Login with the user ID that has admin rights.
	3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers to display the JDBC Providers window.
	4. Select the Scope from the drop-down list. Scope specifies the level at which the resource definition is visible.
	5. Click New to add new JDBC Provider under the Preferences section. The Create new JDBC provider window is displayed.
	6. Enter the following details:
	7. Click Next.
	8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use the trailing slash file separators.
	9. Click Next to display the Summary window.
	10. Verify the details and click Finish to create the JDBC Provider.
	11. The options to Save and Review are displayed. Click Save.

	Create Data Source
	1. Open the WebSphere admin console in the browser window:
	2. Login with the user id that has admin rights.
	3. Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data sources page.
	4. Select the Scope from the drop down list. Scope specifies the level at which the resource definition is visible.
	5. Click New to display the Create a Data Source window.
	6. Specify the Data Source name and JNDI name for the new "Data Source".
	7. Click Next to display the Select JDBC provider window.
	8. Select the option Select an Existing JDBC Provider and select the required JDBC provider from the drop-down list. Click Next.
	9. Specify the database connection URL.
	10. Select Data Store Helper Class Name from the drop-down list and ensure that the checkbox Use this data source in container managed persistence (CMP) is selected.
	11. Click Next.
	12. Map the J2C authentication alias, if already created. If not, you can create a new J2C authentication alias by accessing the link given (Global J2C authentication alias) or you can continue with the data source creation by clicking Next and then ...
	13. You must create another Data source by following the above procedure with jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of Infrastructure.

	J2C Authentication Details
	1. Select the newly created Data Source and click JAAS - J2C authentication data link under Related Items.
	2. Click New under the Preferences section.
	3. Enter the Alias, User ID, Password, and Description. Ensure the following:
	4. Click Apply and save the details.

	JDBC Connection Pooling
	1. Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data sources page.
	2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data sources > $DATA_SOURCE$ > Connection pools.
	3. Set the values for the following:


	Configure Resource Reference in WebLogic Application Server
	Create Data Source
	1. Open the WebLogic admin console in the browser window:
	2. Login with the Administrator Username and Password.
	3. From the LHS menu (Domain Structure), click Services > Data Sources to display the Summary of JDBC Data Sources window.
	4. Click New and select Generic Data Source option to display the Create a New JDBC Data Source window.
	5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the drop-down list. Click Next.
	6. Select the Database Driver from the drop-down list. You need to select the Database Driver depending on database setup, that is, with or without RAC. Click Next.
	7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.
	8. Click Next to display the Connection Properties window.
	9. Enter the required details such as the Database Name, Host Name, Port, Oracle User Name, and Password.
	10. Click Next to display the Test Database Connection window.
	11. Verify the details and click Test Configuration and test the configuration settings.
	12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.
	13. Select the new Data Source and click the Targets tab.
	14. Select the AdminServer option and click Finish.

	Create GridLink Data Source
	1. Enter Data Source Name, and JNDI Name.
	2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The created "Data Source" is displayed in the list of Data Sources.

	Configure Multi Data Sources
	1. Open the WebLogic admin console in the browser window:
	2. Login with the "User ID" that has admin rights.
	3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources to display the Summary of JDBC Multi Data Sources window.
	4. Click New to display the New JDBC Multi Data Source screen.
	5. Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the drop-down list. Click Next.
	6. Select the AdminServer check box and click Next.
	7. Select the type of data source which will be added to new JDBC Multi Data Source. Click Next.
	8. Map the required Data Source from the Available Data Sources. Click Finish.

	Advanced Settings for Data Source
	1. Click the new Data Source from the Summary of JDBC Data Sources window. The Settings for <Data Source Name> window is displayed.
	2. Select the Connection Pooling tab given under Configuration.
	3. Go to the Advanced option at the bottom of the page, and check the Test Connection of Reserve checkbox (Enables Weblogic Server to test a connection before giving it to a client).
	4. To verify if the data source is valid, select "Data Source name". For example, FICMASTER.
	5. Select the server and click Test Data Source.
	6. Once the "Data Source" is created successfully, the following messages are displayed:

	JDBC Connection Pooling
	1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Home >Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data Source-<INFODDOM_NAME>
	2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.
	3. Click Save.


	Configure Resource Reference in Tomcat Application Server
	Create Data Source
	JDBC Connection Pooling
	1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path $TOMCAT_DIRECTORY/lib/.
	2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the below changes, which is required for connection pooling.

	Class loader configuration for Apache Tomcat


	Appendix F Creating and Deploying EAR/WAR File
	Creating EAR/WAR File
	1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server.
	2. Execute ./ant.sh to trigger the creation of EAR/ WAR file.
	3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken" message is displayed and you will be returned to the prompt.
	4. The EAR/ WAR file - <contextname>.ear/ .war - is created.

	Deploying EAR/WAR File
	Deploying EAR/WAR Files for WebSphere
	1. Start WebSphere Profile by navigating to the path "/<Websphere_Installation_Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Name>/bin/" and execute the command:
	2. Open the WebSphere admin console in the browser window:
	3. Enter the user credentials with admin privileges and click Log In.
	4. From the LHS menu, select Applications and click New Application to display the New Application window.
	5. Click New Enterprise Application to display the Preparing for the application installation window.
	6. Select Remote File System and click Browse. Select the EAR file generated for OFSAA to upload and install. Click Next.
	7. Select the Fast Path option and click Next to dispay the Install New Application window.
	8. Enter the required information and click Next to display the Map Modules to Servers window.
	9. Select the Web Application and click Next to display the Map Resource References to Resources window.
	10. Map each resource defined in the application to a resource JNDI name defined earlier.
	11. Click Modify Resource Authentication Method and specify the authentication method created earlier.
	12. Select the OFSAAI Web Application check box and click Next to display the Map Virtual hosts for Web Modules window.
	13. Select the Web Application check box and click Next to display the Summary page.
	14. Click Finish and deploy the Infrastructure Application on WebSphere.
	15. On successful installation, a message is displayed. Click Save and save the master file configuration. The details are displayed in the Master File Configuration window.
	1. Expand Applications > Application Type > WebSphere enterprise applications to display the Enterprise Applications window.
	2. Select the installed application and click Start.

	Deploying EAR / WAR File for WebLogic
	1. Navigate to the path <WebLogic Installation directory>/user_projects/domains/<domain name>/bin in the machine in which WebLogic is installed.
	2. Start WebLogic by executing the command:
	3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console. (https if SSL is enabled). The Sign in window of the WebLogic Server Administration Console is displayed.
	4. Log on to the WebLogic Server by entering the user credentials having privileges to deploy the EAR file.
	5. From the Domain Structure LHS menu, click Deployments to display the Summary of Deployments window.
	6. Click Install to displlay the Install Application Assistant window.
	7. Select the Exploded EAR directory after browsing to the directory where it is saved and click Next.
	1. Create the "applications" folder under domain name. For example:
	2. Create <context_name>.ear folder under "applications" folder.
	3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to <WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear
	4. Explode the <context_name>.ear file by executing the command:
	5. Delete the <context>.ear and <context>.war files (recently created) <WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear
	6. Create a directory <context_name>.war under <WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear
	7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear/< context_name>.war
	8. Explode the <context_name>.war file by executing the following command to get the directory structure:
	1. Open the Install Application Assistant.
	2. Click Next.
	3. From the Choose targeting style section, select the Install this deployment as an application option and click Next to display the Optional Settings window.
	4. Enter a Name for the deployment if required.
	5. Under the Security section, select the DD only option to specify that only roles and policies that are defined in the deployment descriptors should be used.
	6. Select the I will make the deployment available from the following location option under the Source accessibility section.
	7. Click Next to continue and display the Deployment Summary window.
	8. Select the option Yes, take me to the deployment's configuration screen option and click Finish to display the Settings for <Deployment Name> window.
	9. Review the general configuration details of the deployment. You can also update the configuration of the deployment in this window. In the Overview tab you can view the complete deployment configuration.
	10. Click Save to update the changes, if any.
	11. From the LHS menu, click Deployments to display the Summary of Deployments window.
	12. Select the newly deployed Infrastructure application and click Start > Servicing all requests. Ensure that the Infrastructure server is up and running.
	13. The State of the deployed application is displayed as Active if started successfully.

	Deploying WAR Files on Tomcat
	1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to <Tomcat Installation Directory>/webapps/ directory.
	2. Click Manager App. The Connect to dialog box is displayed.
	3. Enter the User Id and Password that has admin rights and click OK. (For user creation in tomcat, see Tomcat User Administration. The Tomcat Web Application Manager window is displayed with the list of all the applications deployed.
	4. In the Deploy section, enter the Context Path provided during the installation as "/<context-name>".
	5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.
	6. On successful application deployment, a confirmation message is displayed. Start the Tomcat server. For more information, see Starting Infrastructure Services.



	Appendix G Start/Stop OFSAA Infrastructure Services
	Starting Infrastructure Services
	1. On the machine in which Infrastructure Application components have been installed, navigate to $FIC_APP_HOME/common/FICServer/bin and execute the following command to start the Infrastructure Server.
	2. Start ICC server:
	3. Stopping Infrastructure Services:

	Starting Web Application Servers
	Starting Web Application Servers
	Stopping Infrastructure Services
	1. On the machine in which Infrastructure Application components have been installed, navigate to $FIC_APP_HOME/common/FICServer/bin and execute the command:
	2. To stop ICC server, on the machine in which Infrastructure default Application components have been installed, navigate to $FIC_HOME/ficapp/icc/bin and execute the command:
	3. To stop Back-end server, on the machine in which Infrastructure database components have been installed, navigate to $FIC_DB_HOME/bin and execute the command:



	Appendix H Accessing the OFSAA Application
	Access the OFSAA Application
	1. From a your desktop, open the browser and enter the URL in below format:
	2. With installation of every OFSAA Application Pack, there are two seeded user profiles configured in the system:
	3. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the SYSADMN login USER ID). Enter the password that was provided during installation. On the first login, you will be prompted to change the password.


	Appendix I Post Deployment Configuration
	Deploying the Application
	Deploying the FTP Application
	1. Check the Log file.
	2. Add the below mentioned entries in excludeURLList.cfg file located in the path $FIC_WEB_HOME/webroot/conf/. These entries are required for Asset and Liability Management, Funds Transfer pricing, Profitability Management and Hedge Management/ IFRS:
	3. For Administrative Reports (Admin BI) configuration follow the steps mentioned in Oracle Financial Services Administrative Reports on OBIEE 11g v8.0.2.0.0 - Configuration Note.docx under $FIC_HOME/adminbi/.
	4. The web.xml under the path $FIC_WB_HOME \webroot\WEB-INF\ should have Resource tag, if not present add the tag and replace ORDEMO with the INFODOM name.
	5. Execute below script as a post installation step:
	6. If there are ICC batch processes created having roll_portfolio and rebalance_portfolio DTs as the tasks, the parameter list of the DTs are to be updated as:
	7. Transfer the ownership of batches to the required User.
	a. Login to config user.
	b. Execute the Following anonymous pl/sql block to execute procedure "AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP".

	8. If the web application server is hosted on a machine other than where pack is installed, then perform the following step.

	Deplying the PFT Application
	1. Check the Log file.
	2. Add the below mentioned entries in excludeURLList.cfg file located in the path $FIC_WEB_HOME/webroot/conf/. These entries are required for Asset and Liability Management, Funds Transfer pricing, Profitability Management and Hedge Management/ IFRS:
	3. For Administrative Reports (Admin BI) configuration follow the steps mentioned in Oracle Financial Services Administrative Reports on OBIEE 11g - Configuration Note.docx under $FIC_HOME/adminbi.
	4. The web.xml under the path $FIC_WB_HOME \webroot\WEB-INF\ should have Resource tag, if not present add the tag and replace ORDEMO with the INFODOM name.
	5. Transfer the ownership of batches to the required User.
	a. Login to config user.
	b. Execute the Following anonymous pl/sql block to execute procedure "AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP".

	6. If the web application server is hosted on a machine other than where pack is installed, then perform the following step.

	Deploying the EFPA/ IPA/ RPA Application Report Analytics
	1. Set the <Oracle BI Instance Home> directory> =>.
	2. Start Weblogic AdminServer.
	a. Set the < BI Domain Home> directory> => e.g.
	b. Navigate to < BI Domain Home >/bin and run 'nohup ./startWebLogic.sh &'
	c. Bringing up this service may take a few minutes depending on your environment.Check the logs using the command 'tail -f nohup.out'

	3. Start Node Manager.
	a. Set the < WebLogic Server Home > directory> => e.g.
	b. Navigate to <WebLogic Server Home>/server/bin and run 'nohup ./startNodeManager.sh &'.

	4. Start Weblogic Managed Server(bi_server1).
	a. Login onto http://localhost:7001/console using your Administrator credentials created during platform install (Replace the hostname based on your setup).
	b. Under Environment block (mid of page, towards left side), click on Servers link.
	c. The bi_server1 line should show as shutdown state at this point.
	d. Click on control page tab.
	e. Select the bi_server1 line by clicking on the left tick box.
	f. Click start button at the top of the list and confirm starting this service
	g. State will update to "RUNNING" mode after a few minutes.

	5. Start BIEE services and login.
	a. Starting services From EM screen.
	i. Log in to the EM administration screen using the url http://localhost:7001/em (Replace the hostname and port number based on your setup). Use the login you created in BIEE installation to log in.
	ii. Expand 'Business Intelligence' node on the left and choose Coreapplication.
	iii. Click on the Overview Tab.
	iv. Click on blue button 'Restart' (or green button 'Start' ) under the Manage System category, middle of screen.
	v. Click yes on dialog box to confirm the move. Wait for message that confirms successful restart.

	b. If starting using EM is not successful and complaining about OPMNCTL not up, Follow starting process with OPMNCTL.
	i. Open a command prompt, navigate to <Oracle BI Instance Home>/bin.
	ii. run "./opmnctl status, this will show you status of all the OBIEE core services.
	iii. run "./opmnctl startall" or "./opmnctl stopall" depending on your need.


	6. Deploy RPD and webcat file(s).
	a. Copy OFS_PFT_PACK.rpd from $FIC_HOME/OFSPFTPACKBI/OBIEE11G of Web layer to windows machine where the OBIEE windows administration client is installed.
	b. Login to OBIEE - Enterprise Manager URL (http://<ip address>:<port>/em).
	i. Click on hyperlink 'coreapplication' from 'Business Intelligence' tab on left hand side.
	ii. Under 'coreapplication', select the tab 'Deployment' and in that select sub-tab 'Repository'.
	iii. Click 'Lock and Edit Configuration' button located below title 'coreapplication'. Following screen is displayed.
	iv. RPD Deployment: Select 'Browse' button available under 'Upload BI Server Repository' section and select OFS_PFT_PACK.rpd file from the local folder. Enter Repository password Admin123.
	v. Web catalog Deployment:
	vi. Steps to restart all services in OBIEE "Enterprise Manager".


	7. Configure tnsnames.ora file.
	a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin/ folder.
	b. Make sure an entry is made in the tnsnames.ora to connect to atomic schema of OFSAA application.

	8. Configure ODBC data source to connect to Oracle BI Server.
	a. Go To Control Panel>Administrative Tools>Data Sources (ODBC).
	b. Select the 'System DSN' tab and click 'Add' Button.

	9. Modify RDBMS connection pool and set the properties.
	a. Open the OBI Administration tool.
	b. Select Start > Programs > Oracle Business Intelligence > BI Administration.
	c. Select File > Open > Online and select 'OFS_PFT_PACK.rpd' file from the Open dialog box.
	d. Enter Repository password as 'Admin123'.
	e. In the "Physical" layer, double-click the "OFSEFPA Connection Pool" to open its properties.
	f. In the 'General' tab, edit/ check the following entries:
	i. Call Interface: (OCI 10g/11g).
	ii. Data source name: <tnsnames.ora entry created in the step 7.b connecting to OFSAA atomic schema>.
	iii. User name: <enter atomic db user name>.
	iv. Password: <enter atomic db user password>.

	g. Confirm password and Click 'OK' to close the window and click 'Save' to save the RPD file.
	h. Click 'No' for the Global Consistency Message.
	i. Repeat the steps from 9.f to 9.l to set the connection properties for "OFSEFPA Init Block".
	j. Close the RPD file (File / Exit).

	10. In case RPD deployment is done on Essbase then modify ESSBASE connection pool and set the properties.
	a. Open the OBI Administration tool.
	b. Select Start > Programs > Oracle Business Intelligence > BI Administration.
	c. Select File > Open > Online and select the cube rpd file created as mentioned in the 3rd step (RPD Deployment On Essbase Cubes) of section Post-Deployment Activities of OFSEFPA 8.0.2.0.0, from the Open dialog box.
	d. Enter Repository password as 'Admin123'.
	e. In the "Physical" layer, double-click the "Connection Pool" under Essbase, to open its properties.
	f. In the 'General' tab, edit / check the following entries:
	i. Call Interface: (Essbase).
	ii. Essbase Server: IP Address of Essbase server.
	iii. User name: <enter Essbase console user name>.
	iv. Password: <enter Essbase console user password>. g. Confirm password and Click 'OK' to close the window and click 'Save' to save the RPD file.
	v. Click 'No' for the Global Consistency Message.

	g. Close the RPD file (File > Exit).

	11. Login into OFSEFPA Application using the URL: http://localhost:9704/analytics. (Replace the port number based on your setup).
	12. Once the OBIEE Environment is up and running, the OBIEE url needs to be updated in the table 'AAI_MENU_B' for an end user to access the respective Business Intelligence Analytics Application.
	13. Execute the following in atomic schema to view the T2T mappings in Metadata browser(object view):

	Post-deployment Activities of OFSEFPA v8.0.2.0.0
	1. Evaluate Support Level
	2. Session Variable Setting
	a. Open the RPD online.
	b. Under Manage Menu go to Variables and select session variable 'ENTITY'.
	c. Set the default value in default initialize section with any one of the available entity name from DIM_ORG_STRUCTURE table in single quotes. For example: '<Entity Name>'
	d. Save and check the global consistency of the RPD.

	3. Repository Variable Setting
	a. Open the RPD online.
	b. Under Manage Menu go to Variables. Set Static Repository variables 'RV_Reporting_Currency' and 'RV_Base_Currency'.
	c. Save and check the global consistency of the RPD.

	4. RPD Deployment On Essbase Cubes(Optional)
	i. Create a folder “xmlpatch” in your system and copy the EFPA.rpd (Its RDBMS RPD) & EFPA_Cube_Patch.xml files.
	ii. Open the EFPA Repository (EFPA.rpd) in offline mode.
	iii. Give the repository password as “Admin123”.
	iv. Choose “Merge” option from File Menu.
	v. On the Merge Repository Wizard screen, choose option as “Patch Repository Merge”.
	vi. Select the Original Master Repository as “EFPA.rpd” from xmlpatch folder by clicking select option.
	vii. Give “Admin123” as password for Original repository.
	viii. Select the xml patch file from the saved path (xmlpatch folder).
	ix. Give “Admin123” as Patch file password.
	x. Change the name of the merged repository to “EFPA_C1.rpd”.
	xi. Click on Next.
	xii. Check for global consistency by clicking on “Check Global Consistency Ctrl+K” under “File” menu.
	xiii. It should result in no errors. Click on “OK” button.
	xiv. In “xmlpatch” folder copy “EFPA_C1.rpd” and paste so that a new duplicate rpd gets created “EFPA_C1 - Copy.rpd”.
	xv. In the currently opened “EFPA_C1.rpd” click on “Merge…” under “File” menu.
	xvi. On the Merge Repository Wizard screen, choose option as “Patch Repository Merge”.
	xvii. Select the Original Master Repository as “EFPA_C1 - Copy.rpd” from xmlpatch folder by clicking select option.
	xviii. Give “Admin123” as password for Original repository.
	xix. Select the xml patch file from the saved path (xmlpatch folder).
	xx. Give “Admin123” as Patch file password.
	xxi. Change the name of the merged repository to “EFPA_Cube.rpd”.
	xxii. Click on Next.
	xxiii. The wizard asks for the confirmation for deletion. Please select option “Current” under Decision dropdown.
	xxiv. Click on Finish.

	5. OFSAAI Startup
	6. Security Roles
	a. Open Admin Console of OBIEE.
	b. lick on Security Realms under Domain Structure.
	c. Click on myrealm under Realms.
	d. Click on ‘User and Groups’ and then on ‘Groups’.
	e. Click on ‘New’ and create two new groups with the names ‘Business Analyst’ and ‘LoBManager’.
	f. Click on newly created ‘Business Analyst’ group for assigning parent group.
	g. Create two new users under ‘Users’ tab of ‘Users and Groups’. One user for Business Analyst and another for LoB Manager.
	h. Map the newly created users to respective groups.
	i. Close the Admin Console of OBIEE.
	j. Open Enterprise Manager of OBIEE.
	k. Navigate to CoreApplication > Security > Singe Sign On > Configure and Manage Application Roles.
	l. Create a new application roles with the name ‘Business Analyst Role’ with display name as ‘Business Analyst Role’ and ‘LoBManager’ with display name as ‘LoB Manager Role’.
	m. Assign Business Analyst Group to its role and similarly ‘LoB Manager’ group to its respective role.
	n. Unarchive the catalogs by selecting ACL as ‘Preserve’.
	o. After un-archiving the catalogs (Financial Reporting.catalog & Management Reporting.catalog) configure the physical tables in database PFTBI_USER_LOB_MAP to create LoB Manager and LoB mapping.
	p. Step 16: Login with corresponding LoB Manager User Id to verify if the respective LoBs are being selected. To verify all the reports, login with Business Analyst user id.

	1. <INFODOM>_MDB
	2. <INFODOM>_MDB_OBJECT_APPLN_MAP
	1. After deploying the latest Web catalog and RPD from the server, the default reporting periods have to be set based on users requirements. The default value has to be set at the Reporting Period prompts by editing the dashboard and choosing a speci...
	a. Financial Reporting>Income Statement>Time_Hierarchy Prompt
	b. Management Reporting>Balance Sheet> Time Hierarchy Prompt
	c. Management Reporting>FTP Reports> Time Hierarchy FTP Prompt
	d. Management Reporting>Income Statement> Time Hierarchy Prompt
	e. Management Reporting>Key Trends>Time Hierarchy Prompt
	f. Management Reporting>KeyTrends>Balance Trends> Time_Hierarchy_Month Prompt
	g. Management Reporting > Performance Measures> Time Hierarchy Prompt

	2. Create an entry in Setup_Master table to configure the identity codes that are required for Financial Reporting dashboard reports.
	3. If OFSEFPA 6.1.1.0.0 is deployed on Oracle ESSBASE Cubes, then the hierarchies would need to be resaved in the Business Hierarchy link of OFSAAI. Subsequently, rebuild the Oracle ESSBASE Cubes.


	Logging as System Administrator
	System Administrator
	Function Maintenance
	Role Maintenance
	Segment Maintenance
	Holiday Maintenance
	Restricted Passwords


	Creating Application Users
	Mapping Application User(s) to User Group
	Change ICC Batch Ownership
	Mapping ICC Batch Execution Rights to User
	Saving Post- Load Change Transformations

	Appendix J Cloning an OFSAA Instance
	Appendix K OFSAA Landing Page
	OFSAA Landing Page for Profitability Administrator
	Applications tab
	Object Administration tab
	System Configuration & Identity Management tab

	Enabling a Product within an Application Pack
	1. Login to the application as SYSADMN user or any user with System Administrator privileges.
	2. Navigate to System Configurations & Identity Management tab, expand Administration and Configuration and select System Configuration.
	3. Click Manage OFSAA Product License(s) to display the Manage OFSAA Product License(s) window is displayed.
	4. Select an Application pack to view the products in it. The products are displayed in the Products in the Application Pack grid.
	5. Select the checkbox to enable a product within the Application Pack which is not enabled during installation.
	6. Click VIEW LICENSE AGREEMENT to view the license information. The License Agreement section is displayed.
	7. Select the option I ACCEPT THE LICENSE AGREEMENT and click ENABLE. A pop-up message confirmation is displayed showing that the product is enabled for the pack.


	Appendix L Additional Configuration
	FTP/SFTP Configuration for File Transfer
	1. Login to the web application server.
	2. Type sftp <user>@<OFSAA Server>
	3. Specify Yes when prompted for permission.
	4. This will add an entry into the "known_hosts" file.
	5. A confirmation message is displayed:

	Configuration for Dimension and Hierarchy Management
	Configure Member Deletion
	Configure Attribute Default Date Format
	Configure Members Reverse Population
	Configure Hierarchy Reverse Population
	Configure Maximum Levels allowed in Hierarchies
	Configure Node Limit for a Hierarchy Tree

	Configure Infrastructure Server Memory
	Infrastructure Application Server Memory Settings
	1. Locate .profile file.
	2. Edit X_ARGS field in this file for customizing memory settings and garbage collector settings depends on the hardware configuration.


	Internet Explorer Settings
	1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options window is displayed.
	2. Click the Settings button. The Settings window is displayed.
	3. Select the option Everytime I Visit the webpage and click OK.
	4. In the Internet Options window, select the Security tab and select the Internet option under Select a zone to view or change the security settings.
	5. Click Default Level under Security level for this zone.
	6. Click OK to save.
	7. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up Blocker option under Pop-up Blocker settings.
	8. Click Settings. The Pop-up Blocker Settings window is displayed.
	9. Enter the URL of the OFSAA Application in the Address of Website to Allow: field.
	10. Click Add. The OFSAA URL is displayed in the Allowed Sites section.
	11. Click Close.
	12. Click OK in the Internet Options window.

	Retrieving Patch Information
	1. Login to the OFSAA application as a user with Object AdminAdvanced Role.
	2. Navigate to Object Administration tab, expand Utilities and click Patch Information.
	3. The window displays the list of patches installed on the OFSAA setup across Applications/ Platform.

	OLAP Data Server Configuration
	Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance
	OFSAAI Setup Information Fetching Tool
	1. Navigate to the path $FIC_HOME.
	2. Enter the command:

	Encryption Changer
	1. Navigate to the path $FIC_HOME.
	2. Enter the command:

	Infrastructure LDAP Configuration
	Configure OFSAAI Web Services
	Configure DynamicWSConfig.xml File
	Attributes for WEBSERVICE tag
	Attributes for OPERATION tag
	Attributes for INPUT tag
	Attributes for OUTPUT tag
	web.xml Entries
	1. This step is optional and required only if the web application server used is Tomcat. In case of any other application server, skip and proceed with next step.
	2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and edit the web.xml file as explained below.

	Entry for WSConfig File
	Proxy Settings
	OFSAAI Home Entry
	DynamicWSConfig.xml

	Deploy OFSAAI Web Services
	1. Complete the manual configuration of OFSAAI Web Services.
	2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> and execute the command:
	3. This will trigger the EAR/WAR file creation, which is required for the deployment.
	4. Deploy the generated EXEWebService.EAR/EXEWebService.WAR file into the WebServer.

	Configuration to Enable Parallel Execution of DML Statements
	Configure Message Details in Forms Designer
	Clearing Application Cache
	Configuring Password Changes
	OFSAA Infrastructure Config Schema Password Modification
	1. Change the Config schema User Password in the database.
	2. Delete the $FIC_HOME/conf/Reveleus.SEC file.
	3. Shutdown the OFSAAI App service:
	4. Start the Infrastructure Server in foreground directly on the server or through X-Windows software using the command:
	5. Post successful startup of the service, if required, the Infrastructure server may be shut down and restarted in the background using nohup mode.

	OFSAA Infrastructure Atomic Schema Password Modification
	1. Change the Atomic schema User Password in the database.
	3. Navigate to System Configuration > Database Details window. Modify the password as explained in the following steps:
	a. From the Database Master window, select the connection whose password you want to modify and click button from the toolbar.

	4. If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag details in Server.xml file from the $CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will exist).
	5. If you are using WebSphere as Web server:
	a. Login to the WebSphere Administration Console, from the left side menu.
	b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right side.
	c. Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic data sources will need to be modified).
	a. Login to the WebLogic Administration Console, from the left side menu.
	b. Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC >Data Sources. A list of data sources will be populated on the right side.

	6. Restart the OFSAAI services.


	Configuring Java Virtual Machine
	Configure Internal Service (Document Upload/ Download)
	1. Create the folders download, upload, TempDocument and Temp in the local path of Web application server and provide Read/Write permission.
	2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write permission.


	Appendix M Patching Your OFS Profitability Pack Installation
	Appendix N Grants for Atomic/ Config Schema
	Grants for Atomic Schema
	Grants for Config Schema
	Grants on Config Schema Entities for Atomic Users

	Appendix O Configuring Application Pack XML Files
	OFS_PFT_PACK.xml
	Configuring OFS_PFT_SCHEMA_IN.xml

	Appendix P Configuring OFSAAI_InstallConfig.xml File
	1. Navigate to OFS_PFT_PACK/OFS_AAI/conf/.
	2. Open the file OFSAAI_InstallConfig.xml in text editor.
	3. Configure the OFSAAI_InstallConfig.xml as mentioned in the below table:
	4. You need to manually set the InteractionVariable parameter values as mentioned in the table. If a value is not applicable, enter NA and ensure that the value is not entered as NULL.

	Appendix Q User Group Mapping
	Appendix R R Dependencies
	Appendix S Visibility
	Data Visibility
	Report Visibility
	Metadata Visibility

	Appendix T JDBC Jar Files
	Appendix U Migration for Excel Upload
	Prerequisites
	Migration for Excel Upload
	1. Open PL/SQL Developer and logon to the source setup's configuration (CONFIG) schema by entering the appropriate username and password.
	2. In a new SQL window query the data of table EXCEL_MAPPING_MASTER.
	3. Open a new session in PL/SQL developer and logon to the target setup's configuration (CONFIG) schema by entering the appropriate username and password.
	4. Insert the records from Step 1 above in to this table.
	5. In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name with the target infodom name.
	6. Update V_CREATED_BY column with the name of any user present in the target setup that has appropriate roles to perform Excel Upload tasks.
	7. Open WinSCP and login a new session by entering the host name, port number, user name and password to access the source setup.
	8. Navigate to the folder referred as FTPSHARE.
	9. Copy the excel-entity mapping xml file(s) which are located in this folder according to their folder structure on to your desktop. For example: /ftpshare /STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml
	10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder according to their folder structure on to your desktop. For example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx
	11. Login a new session in WinSCP by entering the host name, port number, user name and password to access the target setup.
	12. Copy the xml file(s) from Step3 to the below location in the target setup. For example: /ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME.xml
	13. Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx


	Appendix V Upgrading an Existing OFSAA 8.0.x Java 7 Instance to Java 8
	Prerequisites
	Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8
	1. Configure Web Application Server to Java 8. For more information, see Web Application Server Configurations.
	2. Configure the OFSAA instance to Java 8. For more information, see OFSAA Generic Configurations. For a newly installed Web Application Server, refer OFSAA Configurations for New Web Application Server Installation.
	3. Restart the OFSAA services. For more information, see Start/Stop OFSAA Infrastructure Services section.
	4. Generate the application EAR/WAR file and redeploy the application onto your configured web application server. For more information on generating and deploying EAR / WAR file, see Creating and Deploying EAR/WAR File.

	Web Application Server Configurations
	Oracle WebLogic Server Updates
	1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.
	2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, JAVAHOME properties to the new Java path and java.vm.version to the new Java version. For example:
	3. Navigate to <WLS_HOME>/Middleware/Oracle_Home/user_projects/domains/<domain>/bin. Update SUN_JAVA_HOME, DEFAULT_JAVA_HOME, JAVA_HOME in the setDomainEnv.sh file to point to the new Java path. For example:
	4. Clear the Application cache. Navigate to the following path and delete the files:
	1. Install Oracle WebLogic Server 12.1.3.x on Java 8.
	2. Perform the configurations for the newly installed WebLogic server. For more information refer Configuring Resource Reference in Weblogic Application Server.

	Apache Tomcat Server Updates
	1. Login to the Apache Tomcat Server as a non-root user.
	2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For Example:
	3. Clear the Application cache. Navigate to the following path and delete the files:
	1. Install Apache Tomcat Server 8 with Java 8.
	2. Perform the configurations for the newly installed Tomcat server. For more information refer Configuring Resource Reference in Tomcat Application Server.


	OFSAA Generic Configurations
	User .profile Settings
	1. Login to the OFSAA Server as a non-root user.
	2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For Example,

	Configurations for Java 8

	OFSAA Configurations for New Web Application Server Installation
	1. Modify the following parameters in the Configuration table present in the Config Schema with the new Domain Path in case of WebLogic or with the new deployment path in case of Tomcat:
	2. Login to the OFSAA Server as a non-root user.
	3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following parameters in the web.xml file with the new Domain path in case of WebLogic or with the new deployment path in case of Tomcat:
	4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in case of WebLogic or with the new deployment path in case of Tomcat:



